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• This manual explains teaching, playback, editing operations of jobs and files, operation 
management of MotoSim EG-VRC.  Read this manual carefully and be sure to understand its 
contents before operation.

• General items related to safety are listed in instruction manuals supplied with the manipulator.  To 
ensure correct and safe operation, carefully read the instructions on safety before reading this 
manual.

• Some drawings in this manual are shown with the protective covers or shields removed for clarity.  
Be sure all covers and shields are replaced before operating this product.

• The drawings and photos in this manual are representative examples and differences may exist 
between them and the delivered product.

• YASKAWA may modify this model without notice when necessary due to product improvements, 
modifications, or changes in specifications.  If such modification is made, the manual number will 
also be revised.

• If your copy of the manual is damaged or lost, contact a YASKAWA representative to order a new 
copy.  The representatives are listed on the back cover.  Be sure to tell the representative the 
manual number listed on the front cover.

• YASKAWA is not responsible for incidents arising from unauthorized modification of its products.  
Unauthorized modification voids your product’s warranty.

• Software described in this manual is supplied against licensee only, with permission to use or copy 
under the conditions stated in the license.  No part of this manual may be copied or reproduced in 
any form without written consent of YASKAWA.

This instruction manual is applicable to both FS100 (a controller for small-sized 
manipulators) and FS100L (a controller for large and medium-sized manipulators).
The description of “FS100” refers to both ”FS100” and “FS100L” in this manual unless 
otherwise specified.

MANDATORY

CAUTION

NOTE
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We suggest that you obtain and review a copy of the ANSI/RIA National Safety Standard for Industrial 
Robots and Robot Systems (ANSI/RIA R15.06-2012). You can obtain this document from the Robotic 
Industries Association (RIA) at the following address:

Robotic Industries Association
900 Victors Way
P.O. Box 3724

Ann Arbor, Michigan 48106
TEL: (734) 994-6088
FAX: (734) 994-3338

www.roboticsonline.com

Ultimately, well-trained personnel are the best safeguard against accidents and damage that can result 
from improper operation of the equipment. The customer is responsible for providing adequately 
trained personnel to operate, program, and maintain the equipment. NEVER ALLOW UNTRAINED 
PERSONNEL TO OPERATE, PROGRAM, OR REPAIR THE EQUIPMENT!

We recommend approved Yaskawa training courses for all personnel involved with the operation, 
programming, or repair of the equipment.

This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to part 15 of the FCC rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instruction manual, may cause harmful interference to radio communications.
IV
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Notes for Safe Operation

Before using this product, read this manual and all the other related documents carefully to ensure 
knowledge about the product and safety, including all the cautions. 
In this manual, the Notes for Safe Operation are classified as “WARNING”, “CAUTION”, 
“MANDATORY”, or ”PROHIBITED”.

Even items described as “CAUTION” may result in a serious accident in some situations.  At any rate, 
be sure to follow these important items.

Notation for Menus and Buttons

Descriptions of the programming pendant, buttons, and displays are shown as follows:

Indicates a potentially hazardous situation which, if not avoided, 
could result in death or serious injury to personnel.

Indicates a potentially hazardous situation which, if not avoided, 
could result in minor or moderate injury to personnel and 
damage to equipment.  It may also be used to alert against 
unsafe practices.

Always be sure to follow explicitly the items listed under this 
heading.

Must never be performed.

To ensure safe and efficient operation at all times, be sure to follow all instructions, even if 
not designated as “CAUTION” and “WARNING”.

Item Manual Designation

Menu
The menus displayed on screen are denoted with { }.
ex. {TOOL}.

Button
The buttons, check boxes, radio buttons displayed on 
screen are denoted with [ ].
ex. [Close]; [Sync] check box; [Fast] radio button.

WARNING

CAUTION

MANDATORY

PROHIBITED

NOTE
V

HW0485348
5 of 671



  
Description of the Operation Procedure  

156225-1CD
Description of the Operation Procedure

In the explanation of the operation procedure, the expression "Select • • • " means the following 
operations:

• To move the cursor to the object item and left-click on it with the mouse.
• To pick out the object item by the tab key and press the Enter key.

(In case of selecting a menu, use arrow keys instead of the tab key to pick out the object 
item, then press the Enter key.)

Registered Trademark

In this manual, names of companies, corporations, or products are trademarks, registered trademarks, 
or bland names for each company or corporation.  The indications of (R) and TM are omitted.
VI
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Customer Support Information

If you need assistance with any aspect of your EG-VRC for Windows system, please contact Motoman 
Customer Support at the following 24-hour telephone number:

For routine technical inquiries, you can also contact Motoman Customer Support at the following 
e-mail address:

When using e-mail to contact Motoman Customer Support, please provide a detailed description of 
your issue, along with complete contact information. Please allow approximately 24 to 36 hours for a 
response to your inquiry.

Please have the following information ready before you call Customer Support:

techsupport@motoman.com

Please use e-mail for routine inquiries only. If you have an urgent or emergency need for 
service, replacement parts, or information, you must contact Motoman Customer Support 
at the telephone number shown above. 

• System EG-VRC for Windows

• Robots ___________________________

• Controller DX200, DX100, FS100 & NX100

• Software Version Access this information on the Programming Pendant’s LCD 
display screen by selecting {MAIN MENU} - {SYSTEM INFO} - 
{VERSION}

• Robot Serial Number Located on the robot data plate

• Robot Sales Order Number Located on the DX200, DX100, FS100 & NX100 controller data 
plate

(937) 847-3200

NOTE
VII
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1 Introduction

1.1 Overview of MotoSim EG-VRC

MotoSim EG-VRC is a software which has been developed as an offline teaching system for YASKAWA 
industrial robot MOTOMAN series.
MotoSim EG-VRC reduces teaching time requiring an actual robot, supports improvement of 
productivity and insures operator’s safety by enabling robot teaching on a personal computer.
MotoSim EG-VRC is an application software for MS-Windows having excellent operability and many 
advantages such as running multiple applications at once. 

1.1.1 Difference of the operation from 5.00

The appearance of MotoSim EG-VRC Ver 5.00 differs greatly from Ver 4.10 or before. 
Therefore, the difference in the operation method of a main screen is summarized so that the user 
before Ver 4.10 could get used early. 

• Runs two or more MotoSim EG-VRC. However, the number of the cells which can be 
used by MotoSim EG-VRC is one. 

• section n "Docking Window"
• section n "Quick Access Toolbar"
• section n "Comparison Table with the New Menu from the Old Menu and the Old Tool Bar"
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1.2 Notice and Restriction about MotoSim EG-VRC

1.2.1 Optional Function of Controller

Below is a list of the available optional functions on MotoSim EG-VRC.  For any other optional function 

not listed below, please consult with your Yaskawa representative.

*1 Standard function for FS100.

*2  Please refer to section 1.2 "Notice and Restriction about MotoSim EG-VRC" for 
Functional safety.

Please refer to section 
section 15.4 "Standard function about DX200" 
section 15.5 "Standard function about DX100"

for the list of available standard function.

Function Name DX200 DX100 FS100 NX100

Relative Job    

TCP    

Macro Instruction    

I/F Panel    

External Reference Point    

Parallel Start Instruction    

Coordinated Instruction    

Extended Control Group    

Station Angle Display    ―

Softlimits Customization   ― ―

Tool No. Switching    

SI Unit Indication    ―

Display IO Name in Job   *1 ―

Variable Allocation    ―

Functional safety *2 ― ― ―
1-2
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1.2.2 Using data saved from a real controller with 
         MotoSim EG-VRC

To use the data saved from a real controller, depending on the environment, there are circumstance 
where the "CMOS.BIN' from the real controller can be used.
However, in some cases there may be problem cause by "CMOS.BIN" version incompatibility.  In such 
cases, please use the individual data file save from the real controller for the jobs, condition files, 

parameters, etc. to reconstruct the system environment.

1.2.3 Using MotoSim EG-VRC data on a real controller 

Some data created with MotoSim EG-VRC can be use on the real controller, and some data cannot be 

use.

1.2.4 Function depending on the system version of 
controller

Some functions of MotoSim EG-VRC can not use depending on the system version of controller. 
Please refer to section 15.6 "List of Function depending on the system version of controller".

In regard to the FS100 controller, the "CMOS.BIN" file saved from a real controller can not 
be used with MotoSim EG-VRC to create the environment.

Usable data

Job
Condition files
General data
All the name data

Unusable data
Parameters
CIO Program

• The "CMOS.BIN" file cannot be saved from MotoSim EG-VRC.
Therefore, the "CMOS.BIN" cannot be used with a real controller.

• Option function selected by MotoSim EG-VRC can not be executed on the real robot.
• Parameter file or CIO program file of MotoSim EG-VRC can not be executed on the real 

robot. YASKAWA is not responsible for incidents arising from using these files.

NOTE

NOTE
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1.2.5 Restriction of Function of Controller

• MotoSim EG-VRC can not be connected to the real robot or pendant.
• MotoSim EG-VRC can not simulate the job in real time.
• MotoSim EG-VRC can not simulate CIO in real time.
• The function needed the special hardware (sensor, COMARC etc.) is disable.
• VPP is not supported the Enable Switch.
• MotoSim EG-VRC is supported the standard controller version only.
• The simulated coasting range is different from the real robot, when the emergency stop is 

done.
• Functional Safety is not supported.
• Some INFORM connecting to the external device is not supported. ARCON/ARCOF 

SVSPOT SVSPOTMOV are supported.
• In regard to the NX100 controller, SVSPOT and SVSPOTMOV are not supported.
• Data transmission is not supported.
• Remote mode is not supported.
• Collision Detection is not supported.
• The standard CIO ladder is supported only. Modified CIO ladder is out of guaranteed 

operating range. So, lamps at the top of VPP (ex. servo lamp) may not work correctly, or 
IO Connect/IO Monitor/IO Event may not work correctly.

• Loading batch CMOS file "CMOSxx.HEX" saved from memory expanded system is 
supported only.

• Saving batch CMOS file "CMOSxx.HEX" and all CMOS area file "ALCMSxx.HEX" is not 
supported.

• In regard to the FS100 controller series, Loading/Saving/Verifying/Deleting the batch files 
and the all CMOS area file is not supported.
The appropriate files are "JOBxx.HEX", "CMOSxx.HEX", and "ALCMSxx.HEX".

• Ladder editor, PP application for arc welding, and MOTOPAL are not supported.
• MotoPlus function, MotomanSync function, and the applications used these functions are 

not supported.
• PP customize function is not supported.
• The simulation of spot gun change system is not supported.
• "PP display scroll function DX200 by touching operation" of DX200 controller is not 

available.
• Function of MotoSim EG-VRC for Function Safety is available only when the controller is 

DX200 and Function safety option is available.
• Function safety in which a simulation is possible on MotoSim EG-VRC is as follows.

Robot Range Limit
Axis Range Limit
Speed Limit
Tool Angle Monitor

Following function safety can not be simulated on MotoSim EG-VRC.
Axis Speed Monitor
Tool Change Monitor
Safety Signal
1-4
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• When the edited files are loaded to DX200, it is necessary to put in "SAFETY MODE", 
and to disable "SAVE DATA CRC CHECK FUNC.(FSU)". After loading, please make sure 
to enable "SAVE DATA CRC CHECK FUNC.(FSU)".
And, please make sure to check the settings on DX200.

1.2.6 Accuracy

• Positional Accuracy
When the job made in MotoSim EG-VRC is executed on the real robot, teaching points 
may be misaligned by the strain and placement error of work, and the deflection of robot. 
So, check the teaching points by NEXT/BACK, and modify them.

• Trajectory Accuracy
The simulated trajectory range is different from the real robot. When the job made in 
MotoSim EG-VRC is executed on the real robot, check the teaching points by NEXT/
BACK, and do test running. After sufficient operation check, execute playback.

• Cycle time Accuracy
The simulated cycle time is different from the real robot. If robot job contain the position 
level "PL=0" in move command, the resulting cycle time simulation may not provide 
sufficient accuracy compared to the actual robot.

• Robot model Accuracy
Robot model is only external form, bolt hole and anchor bolt may be left out. Movable 
parts other than robot (ex. cable) can not be simulated.

1.2.7 Hardware Requirements

When simulate follow situation, PC with high-end CPU or graphic board may need.
• Multiple controllers are used. (4 or more)
• High-capacity CAD data is used.
• Collision check is used.

1.2.8 Supported robot model

The robot models supported by MotoSim EG-VRC are those displayed on the virtual pendant for the 
controller version selected at the time of creation.  Please refer to section 15.7 "List of Manipulator 
Models and Offset Values Supported by MotoSim EG-VRC" for the list of available model. 
However, for similar robot model that only have differences in the details of their shape, it maybe 
possible to do simulation using the standard robot model (model ending with A0*).
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1.3 Environment Required for MotoSim EG-VRC

To run MotoSim EG-VRC, the following hardware and software are required:   

*1 MS-Windows 7 are registered trademarks of Microsoft Corporation, USA.

OS
32bit    Microsoft Windows 7 Service Pack1 (32bit / 64bit)
64bit    Microsoft Windows 7 Service Pack1 (64bit)
JAPANESE and ENGLISH Windows version are supported only. *1

CPU Intel® Core™ 2 Duo or more multi-core processor.

Memory 2 GB or more

Hardware Disk 1 GB or more

Monitor
Supported by MS-Windows 
(256 colors or more)

Hardware Key
Used under single user environment.
For details, refer to section 1.4 "Hardware Key" in the following 
section.

Other Graphic Board for 3D.

MotoSim EG-VRC may not execute correctly, because of PC model, Graphic Board, other 
connected peripherals, and installed software, etc.NOTE
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1.4 Hardware Key

For proper operation, connect provided hardware lock key (USB type) to the personal
 computer before using this software.

Check and execute <Checking the computing environment> <Installing the driver> 
before connecting the key to USB port.

<Checking the computing environment>
Multi-connection of USB type key is not available for one USB port because of hardware structure.  
Therefore, only one key can be connected to one USB port.  When installing multiple offline software 
into one personal computer and multi-connectiong USB keys, use the personal computer which is 
provided same numbers of USB ports as the number of software to be installed.

<Installing the driver>  

Execute "\SentinelDriver\Sentinel System Driver Installer 7.5.7.exe" of installation CD-ROM. Refer to 
"\SentinelDriver\Manual\SafeNet_Sentinel_EndUser_Guide.pdf" for the details of
installation.

Refer to section 15.7 "List of Manipulator Models and Offset Values Supported by MotoSim EG-VRC" 
for other countermeasures concerning hardware key.

Please install the driver after detaching the all sentinel hardware key from the personal
computer.

• Be sure to install the driver.
• When installing the driver, be sure to login in administrator mode in order to add files to 

system folder and input information in registry.
• If a key is connected to personal computer before installing the driver, the message 

concerning the driver is displayed. In this case, and detach the key from personal 
computer and then install the driver.
If a key is connected to personal computer before installing the driver under Windows 95/
98/NT4.0/2000/XP environment, Windows wizard ([Add New Hardware] Wizard)
starts up. In this case, push [cancel], and detach the key from personal computer and 
then install the driver.

• When installing the driver under Windows NT4.0, 2000 environment, please install the 
driver located in the folder "\SentinelDriver\SSD5411\SSD5411-32bit.EXE" of installation 
CD-ROM.
For the driver installation procedure, please consult the installation manual
 "\Sentinel-Driver\SSD5411\Manual\us\Readme.pdf".

NOTE

NOTE
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1.5 Installing MotoSim EG-VRC

1. It is strongly recommended that you exit all applications before running the setup 

program. 

2. When the install CD is inserted into the CD-ROM drive, the [MotoSim EG-VRC - 
InstallShield Wizard] window appears automatically.
If you are using Windows 7, the [User Account Control] dialog appears, so click [OK] in 
the dialog.

3. Follow the on-screen instructions. 
4. When the setup is completed, MotoSim EG-VRC is registered under the 

{MotoSim EG-VRC} folder that appears by clicking the [Start] button in the task bar and 
selecting {Program} and then {Motoman}. 

5. Connect the hardware key to the printer port or USB port.  
For details, refer to section 1.4 "Hardware Key" in this chapter.

Be sure to login in administrator mode when installing the MotoSim EG-VRC in Windows 
7, or else the system related DLL files in Windows might not be updated.

NOTE
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1.6 Definition of Terms 

Cell (*.vcl)

A file in which MotoSim EG-VRC simulation environmental data 
are recorded.
Folder information to store the operation contents, model file 
information such as robots, workpieces or tools, data of 
operational environment layout, etc. is recorded.

Model file (*.mdl)
A file in which geometric data of robots, workpieces or tools are 
recorded.

Parent model

Each model requires a coordinate that refers to something in the 
layout.  Model to which the coordinate of a model refers to is 
called “parent model”.
The most basic reference model in the MotoSim EG-VRC is 
“world”.  Normally, world becomes parent for workpiece models or 
robot models.
However, since tool models or positioners move along with 
external axis or robot axes, they refer to different parent models 
than fixed model. Since tool models must move with the robot, 
the robot model flange is normally set as the parent model of the 
tool model.
1-9
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1.7 Folder Configuration 

The above diagram is based on the assumption that the cell "TEST" is the file in which the simulation 
environmental data is stored, and that there is one controller named "NX100" with 2 robots defined 
under the folders “RB1” and “RB2”.
The model files other than the robot model files are stored in the folder "TEST\MODELS".

 

 

 

 

 

  

MotoSimEG-VRC 

CELLS 

TEST 

MODELS 

RB1 

TEST.VCL 

Simulation environment used for the cell 

“TEST” is constructed in this directory. 

Stores model files of floor, tool, 

workpiece, etc. 

Stores the robot data: robot 

model files, etc. 

Cell file 

DX100 

Stores the controller related 

data files. 

RB2 

Stores the robot data: robot 

model files, etc. 

STORAGE CARD 

Stores the controller files 

accessible by the VPP 

SAVE/LOAD function. 

¥ 
Users 

MOTOMAN 

Public 

Documents 

EXAMPLE Stores sample cell files

TEMPLATE 

CELLS 

Stores template cell files created by the 

template function of MotoSim EG-VRC. 

Program Files 

MOTOMAN 

MotoSimEG-VRC 

CONTROLLER 

Stores the VRC (Virtual Robot Controller) 
application files and default data of each 
controller. 

DEVICE 

Stores the files about devices.

DOC 

Stores the help files.

MODELS 

Stores standard models such as controller, 

tools, welder, etc. 

ROBOTS 
Stores files related to robot models by 

controller type. 

Files required to run MotoSimEG-VRC such as 

executable, initialization files, etc. 

3DPDF 

Stores template PDF files for 3DPDF 

output function. 

ModelLibrary Stores sample cell files
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2 MotoSim EG-VRC Quick Tour

This chapter describes the basic operation of MotoSim EG-VRC by giving practical examples to first 
time users of this system. 
Read this chapter thoroughly in order to quickly take advantage of the excellent operability and various 
functions of MotoSim EG-VRC.

2.1 Overview

This chapter describes the procedures from cell construction to job creation.  An arc welding application 
is used as an example to illustrate the creation of workpieces for fillet-welding and a welding torch for 
tool, and then to teach a welding path.  
The following sections aim to create a robot, a workpiece and a stand like the ones prepared in 
"Arc_samp_NX" sample cell shown in the figure below.
2-1
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2.2 Cell Construction

1. Click on [START] in the task bar menu, then click {PROGRAM} - {Motoman} - {MotoSim EG-
VRC} - {MotoSim EG-VRC} to run MotoSim EG-VRC. 

2. When the main window appears, Click the MotoSim EG-VRC button (  ), and select the 

[New] - [New] menu. 

3. When the New Cel dialog box appears, enter any cell name: a folder where cells, parameter 
data, model data, job data, etc. are stored can also be set.  (The new folder name is the same 
as the cell name.)  In this example, the "TestCell" cell is created in the "CELLS" folder in the 
"Cells" folder.  
Enter "CelTest" in the File name edit box and click the [OK] button.  

 

Select here 
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4. The new cell with only a floor model appears.
Register a controller in the cell by selecting the [Controller] tab, in the [Setup] group, click the 
[New] button.  

5. The “Create Controller with” will display.
Select “No CMOS.BIN file” and press the [OK] button.

6. Select the controller system version, then press the [OK] button.

 

 

Select here 
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7. Controller Initialization.
The virtual controller will boot with the selected system version.  This may take a few moments.  
Once the boot up is completed, the virtual pendant will display in maintenance mode along with 
the “Controller Maintenance Mode Instructions” guide.  
When adding a controller with “No CMOS.BIN”, the controller needs to be initialized.  Follow the 
steps displayed by the instruction guide dialog to initialize the controller.  
When asked for the “Control Group”, select the robot “HP6-A0*” for the R1 group (press the 
spacebar to display the list of available robots.) 
When all the initialization steps are completed, press the [Finish] button of the instruction guide 
dialog to reboot the controller in normal operation mode.

8. Once the virtual controller has rebooted, the virtual programming pendant will display in normal 
mode. 
In the “Robot Settings” dialog that will also appear, enter a name for the robot (for this example, 
the default name “NX100-RB1” is used.)  Select the model file corresponding to the robot type 
(for the HP6-A0* select the “HP6-a00.mdl” file).
Press the [OK] button.

 

2-4
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9. When the controller registration has been completed normally, the robot model appears in the 
cell screen as shown in the figure below. 

However, as shown in the following figure, the robot may be displayed as if it is sank in the floor.  
This is because the offset value of the robot operational origin and the floor center coordinate 
has been set to 0 (initial value).  In this case, correct the robot position by following steps 10 
and 11. 
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10. On the [Home] tab, in the [Model] group, click the [CadTree] button, display the Cad Tree 
selection box.
Select “NX100-RB1” and click on [Pos] button. 
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11. In the Position dialog box below, the robot model can be moved to any arbitrary place. 
In the case of NX100-RB1, the height from the floor to the robot operational origin is 450 mm, 

enter "450" for "Z" and click the [OK] button.  

The height from the floor to the robot operational origin (here the height is 450 mm) can be 
obtained by measuring the distance between the floor and the robot bottom by clicking the  
on the [Home] tab, in the [Measurement] group, click the [Distance] button.  Refer to 
section 5.1 "MotoSim EG-VRC Display" for the details of measuring tools, and section 
15.7 "List of Manipulator Models and Offset Values Supported by MotoSim EG-VRC" for 
each robot offset values.

When initialized the robot controller, MotoSim EG-VRC set the absolute data 
automatically. So absolute setting is not needed in MotoSim EG-VRC. 
Refer to section 7.1.4 "Initializing the Controller (FS100)" for details.

NOTE

 

Distance between the 
robot frame and the floor. 

NOTE
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2.3 Creation of Models

This section explains how to create workpiece models and tool models using the CAD functions.

2.3.1 Creating a Workpiece and a Workpiece Stand

Follow the flowchart below to create a workpiece and its stand.
  

 

 

Create workpiece stand model
file in Cad Tree. 

 

 

 

 

 

Start

Add BOX model in file data 
editing dialog box.

Set model size and position
in BOX Edit dialog box.

Create workpiece model file  
in Cad Tree.

Add parts in the file data 
editing dialog box.

Set sizes and positions of 
parts in BOX Edit dialog box.

End
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1. The dimensions of the workpiece model and workpiece stand model are shown in the following 
figure:  

2. On the [Home] tab, in the [Model] group, click the [CadTree] button, the [CadTree] dialog 
appears.

3. When the Cad Tree appears, select "world" from the model tree; select {New Model} in the 
right-click menu, or click the [Add] button.   

To create a new model in the model selection screen, verify that the cursor is pointed to 
"world" so that it will be the parent model.

25

30

200

200

500

400

600

600

Units: mm

Workpiece Stand Model

Workpiece Model

Click the [Add] button 

NOTE
2-42

HW0485348
42 of 671



  
2.3  Creation of Models

156225-1CD
4. Enter "STAND" (a word for “stand” in Japanese) in the Add Model Dialog box and click the [OK] 
button.  

A confirmation dialog box appears, to create the new model: click on [OK].  

5. The "STAND" model appears in the Cad Tree: point the cursor to "STAND" and double-click it.  

6. The model editing dialog box appears: select “BOX” from the "Add Parts" combo box, and click 
[Add].  

The “STAND” model is 
added here. 

The “STAND” model is 
added here.
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7. The BOX Edit dialog box appears: input the dimensions of the workpiece stand.  

Select 400 for width, 600 for depth and 400 for height by using the spin button  at the side of 
the edit box or by entering the values directly.  The incremental values of the spin box can be 
changed from 0.1 to 100 in the incremental value list box.  Select desired colors, and check if 
the stand is displayed properly.  
When satisfied, click the [OK] button to return to the file data editing box.  Click the [Close] 
button in the file data editing dialog box to complete the creation of workpiece stand model.

8. The workpiece stand model is located at the center of the floor under the current conditions: 
therefore, click the [Pos] button in the Cad Tree to display the position dialog box, and input 800 
for X, 0 for Y and 200 for Z to modify the model location.  

When a part is added with the [Add] button, the parts editing dialog box appears 
automatically.  However, to reedit a part that has already been added, use the [Edit] button 
to display the part editing dialog box after selecting the subject part name.

NOTE
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9. To create a workpiece, set "STAND" as the parent model by pointing the cursor to "STAND" in 
the Cad Tree.  Create a new model named "WORK" as shown in the figures below.  

10. Display the BOX Edit dialog box by selecting "BOX" from the "Add Parts" combo box in the 
model editing dialog box, then click [Add].  

11. Set the workpiece size and position as shown in the table below in the BOX Edit dialog box: this 
model will be the bottom part of the fillet-welding workpiece.  

Width (W) 200 Depth (D) 500 Height (H) 30

X (mm) 0 Y (mm) 0 Z (mm) 0

Rx (degree) 0 Ry (degree) 0 Rz (degree) 0
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12. The model is currently displayed in the center of STAND model: to modify its position, first close 
the BOX Edit dialog box by clicking [OK] and the file data editing dialog box by clicking [Close]; 
after closing those dialog boxes, click the [Pos] button in Cad Tree to display the Position dialog 
box, and enter 0 for X, 0 for Y, and 215 for Z to display WORK model on top of STAND model.  

13. Create the upper part of the workpiece: the upper workpiece is composed of a second BOX 
part.  Double-click "WORK" in Cad Tree to call up the file data editing dialog box, and add 
another BOX model (note that this operation should not be done by clicking the [Add] button in 
the Cad Tree).

14. Set the workpiece size and position as shown in the table below in the BOX Edit dialog box.  

Width (W) 25 Depth (D) 500 Height (H) 200

X (mm) 0 Y (mm) 0 Z (mm) 115

Rx (degree) 0 Ry (degree) 0 Rz (degree) 0

Place the “WORK” 
model on top of the 
“STAND” model 
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15. Check if the workpiece model has been created according to the dimensions specified in the 
step 1.  
If the model has different dimensions or to change the color of the model, proceed to the step 
16 and 17 to make modifications.

16. Display the BOX Edit dialog box by pointing the cursor to BOX model to be edited among the 
models added to the Cad Tree, then double-click it.

17. Reedit the workpiece size, etc. in the BOX Edit dialog box.  To modify the color of the model, 
click on the [Color...] button.
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2.3.2 Editing Tool Data

This section explains on how to edit the tool data.  The tool to be created is a torch for arc-welding.  The 
tool dimensions are: 0 mm for X, 0 mm for Y, and 395 mm for Z.  

1. On the Virtual Programming Pendant, select from the main menu {ROBOT} - {TOOL}. 

 

2. The TOOL settings appear.  Move the cursor with the arrow keys to the Z field.  Press the 
[Spacebar] to select the Z field for edition and enter the value “395”.  Press [Enter] to register 
the entered value.   Repeat the same procedure for the Ry field and enter a value of -35.  (In 
this example, the tool end curves by “Ry = -35” relative to the flange axis.  
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2.3.3 Adding a Tool Model

There are two ways to add a tool model:
(1) Create a tool model with the CAD function of MotoSim EG-VRC.
(2) Read a tool model in the HSF format (*.hsf). 

First, method (1) is used to explain the creation of a tool model with the MotoSim EG-VRC CAD 
function. 

In method (2), an HSF format model is used; this is explained in section n "Reading the HSF Format 
Model" later on. 

 Creating and Adding a Tool Model with the CAD Function

Follow the flowchart below to create a tool model.  

Part A

Part C

Part B

Part D

Start

Create a tool model file in
Cad Tree.

Add parts in the file data 
editing dialog box.

Set parts size and layout in
BOX Edit dialog box.

Click on [Close] button in 
the file data editing dialog 
box after verification.

End
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1. Display the Cad Tree to create a new model names "TOOL".  In this case, point the cursor to 
"NX100-RB1_flange" and create a new model so that the parent model of the tool model is the 
flange of the robot.  
 

If the parent model is not set correctly, change the parent model by selecting 
{Model Attribute} - {Set Parent } as shown in the following figure.

 

Select the 
NX100-RB1_flange 
model and click [Add]

 

Select the parent  
model in this  
dialog box. 
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2. The dimensions of the tool model are shown in the following figure: 

3. Double-click "TOOL" in the Cad Tree to display the file data editing dialog box, and add parts in 
the file data editing dialog box.  
The tool model is composed of two BOX models and two CYLINDER models.  Assume these 
four parts as parts A, B, C and D, respectively: edit parts A and B in the BOX edit dialog box and 
parts C and D in the CYLINDER Edit dialog box.  
The following tables show the size and layout of each parts A, B, C and D. 

• Part A (BOX) 

• Part B (BOX) 

Width (W) 70 Depth (D) 70 Height (H) 80

X (mm) 0 Y (mm) 0 Z (mm) 40

Rx (degree) 0 Ry (degree) 0 Rz (degree) 0

Width (W) 150 Depth (D) 70 Height (H) 20

X (mm) 40 Y (mm) 0 Z (mm) 90

Rx (degree) 0 Ry (degree) 0 Rz (degree) 0

150 70 
70 

80 

20 

170

145

35°

30

X Y

ZZ

X

Y
Units: mm
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• Part C (CYLINDER) 

• Part D (CYLINDER) 

4. When the parts are all added, check the tool model on the screen, then click on the [Close] 
button to exit the file data editing dialog box.

5. Verify that the size and layout of the tool model, STAND model and WORK model are properly 
set, and click the [Close] button in the Cad Tree to complete creation of the models.

Lower Dia. 30
Height 
(mm)

170 Division 16 Upper Dia. 30

X (mm) 80 Y (mm) 0 Z (mm) 100

Rx 
(degree)

0
Ry 
(degree)

0
Rz 
(degree)

0

Lower Dia. 30
Height 
(mm)

145 Division 16 Upper Dia. 30

X (mm) 80 Y (mm) 0 Z (mm) 270

Rx 
(degree)

0
Ry 
(degree)

-35
Rz 
(degree)

0
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 Reading the HSF Format Model

This section describes how to add a tool model which is provided as an HSF format (*.hsf).
If the tool model has been already added in the previous section section n "Creating and Adding a Tool 
Model with the CAD Function", select "TOOL" from the Cad Tree and select "Hide" to hide it.  

1. Select "NX100-RB1_tcp" in Cad Tree and click [Add] to display the Add Model Dialog dialog 
box, then enter "TOOL2" in the Name edit box.  
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2. Click the [...] button of the file name and select "Torch.hsf" file in the folder "Models\Torch"; click 
the [OK] button.  

The HSF model files can be added by drag and drop from the Explorer.  (Refer to section 
11.11 "Reading a Model" for details.)  In this case, answer "Yes" when prompt "Select the 
parent model? and then select "NX100-RB1_tcp" as the parent.

 

Select the file type

Select the “Torch” folder

Select the “Torch.hsf” file
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2.4 Setting of Target Points (AXIS6 Model)

This section explains on how to add an AXIS6 model before starting to teach.  This procedure is not 
necessarily required, however, it makes future teaching easier.

AXIS6 is a model composed of only X, Y and Z-axis frames.  Set AXIS6 as target points for the 
following two steps which will be teach later.

• Step 3: welding start position
• Step 4: welding end position

1. On the [Home] tab, in the [Teaching] group, click the [OLP] button to display OLP dialog box as 
shown below.  Select the [Teacher] radio button in the “Operation Obj” section, check the [OLP 
Pick] check box.  

 

Select “Teacher”

Check the “Pick 
Enable” box 
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2. Set the Teacher to the welding start position of Step 3: click the welding start position with 
[Enable] checked.  

3. Set the Teacher to optimum angle for the tool welding position: in the following example, 
welding is performed at an angle of 45° to the welding position.  Press the [Display Position] 

button from the OLP panel and set Rx, Ry and Rz as shown below.  

4. Double-click the "WORK" model in the Cad Tree and add AXIS6 in the file editing dialog box.  

5. Click on [Add] and verify that the number “1” has been added to the Index list box.  Then, check 
the [Pose] check box in the Teacher group and click the [Goto] button.  With this operation, the 
teacher frame color in the cell window changes, which means that AXIS6 has been set to the 
teacher coordinate and orientation and now overlaps it. 

Rx (degree) 180 Ry (degree) 45 Rz (degree) 0

          

 Click here.
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6. Set AXIS6 to the welding end point by performing steps 1 and 2 again, however, since the 
welding end point is to be set this time, be sure to click the part shown below in the OLP 
function.  (Since the teacher angle has already been modified in the 3rd step, the angle 
modification is not necessary here.)  

7. Add frame number 2 by clicking the [Insert] button in Frame Edit dialog box for AXIS6 which has 
been previously set; verify that the [Pose] check box is checked and click on [Goto].

8. When AXIS6 is set, click on [OK] to complete the setting.

           

Click here.
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2.5 Teaching

Follow the flowchart below to create an actual job for arc-welding.
 
 

 

 

Select a job. 

 

 

 

 

 

Start

Step1: Set in the standby 
            position.

Step2: Determine the welding 
            approach posture.

Step 3: Move to welding start 
            position.

Step 4: Determine welding 
             end position.

Verify each step.

End

 
Step 5: Move to the position
            where the robot does 
            not interfere with 
            workpiece.

 
Step 6: Return to the standby
             position.
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2.5.1 Creating a New Job

Create a new job before teaching: 
1. On the virtual pendant main menu, select {JOB} - {CREATE NEW JOB}

2. With the cursor in the “JOB NAME” field, press the [Spacebar] to select the “JOB NAME” field 
and display the alphanumeric input window.  Enter a name for the job.  
For this example, enter "GUIDE" in the “Result” field and then press [ENTER].  To enter a name 
for the job, the keyboard is also available. For details, please refer to the section 5.2.5 "Input 
with keyboard".

3. Click the [EXECUTE] button or press [ENTER], to create the new job.
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2.5.2 Teaching the Standby Position

1. Press the [SERVO ON] button.  Once the servo power is activated, move the robot to its 
standby position by using the Virtual Pendant axis keys.  

To display or hide the pendant keypad, press the [/] key or click on the  icon.
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2. In the input line, select the motion type using the [MOTION TYPE] key of the pendant keypad.  
For this example, select joint motion (MOVJ)

 
3. Set the motion speed:

• Press [Select] to the focus in the input line.
• Move the cursor to the speed value with the cursor key.
• Select the speed value by using the [SHIFT] and the up and down arrow of the cursor key.

For this example, set the motion:
• Type: Joint Motion (MOVJ)
• Speed: 100%

4. Press [Enter] to register the motion instruction to the robot current position. 

2.5.3 Determining the Welding Approach Posture

Use the virtual pendant to posture the robot so that it can perform welding.
Press [Enter] to register this step (Step 2). 
 

2.5.4 Teaching the Welding Start Position

1. On the [Home] tab, in the [Teaching] group, click the [OLP] button to display the OLP dialog 
box.
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2. Select the [OLP Pick] check box and [Vertex] check box in the “Pick type” section, and click an 
arbitrary point; the TCP moves to overlap the vertex near the clicked point.  
To make the most of the AXIS6 which has been set to the welding start point in the previous 
section, the OLP settings should be made as follows: 

• OLP Active:         Checked
• Move Mode:         Position, Orientation
• Pick Mode:           Vertex
• Pick Object:          Frames
• Operation Object: Robot Name (NX100-RB1)

3. Click on AXIS6 displayed on the screen with the mouse as shown in the figure below: the tool 
angle is adjusted to the angle of the AXIS6.  
If the tool collides with the workpiece due to an improper tool angle, avoid the collision by 
manually repositioning the robot with the programming pendant dialog box.

4. With the virtual pendant, set the motion:
• Type: Joint Motion (MOVJ)
• Speed: 25%

5. Press [Enter] to register this step (Step 3).

 

Click around here.
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2.5.5 Teaching the Welding End Position

1. Enable the OLP function and click on AXIS6 which has been set to the welding end point to 
move the tool to the welding end point.

2. With the virtual pendant, set the motion:
• Type: Linear Motion (MOVL)
• Speed: 558 cm/min

3. Press [Enter] to register this step (Step 4).

           
 Click around here.
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2.5.6 Teaching the Torch Retraction

1. Use the virtual pendant axis keys to move the robot away from the weld.

2. Set the motion:
• Type: Joint Motion (MOVJ)
• Speed: 50%

3. Press [Enter]  to register this step (Step 5).
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2.5.7 Returning to the Standby Position

1. On the virtual pendant, move the cursor in the job to the first step.  
Press and hold the [FWD] key on the virtual pendant keypad to move the robot to this position.
(Use the [FAST] and [SLOW] keys to adjust the speed for manual operation.)
When the robot reaches the position for step 1, the robot will stop and the job cursor will stop 
blinking. 

2. Set the motion:
• Type: Joint Motion (MOVJ)
• Speed: 100%

3. Move the job cursor back to Step 5 (before the END command).

4. Press [Enter]  to register this step (Step 6).
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2.5.8 Verifying Each Step

On the virtual pendant, move the cursor in the job to the first step.  
Press and hold the [FWD] key on the virtual pendant keypad to move the robot to this position.
When the robot reaches the position, the robot will stop and the job cursor will stop blinking.  Release 
the [FWD] key, then press it again to move to the next step of the job.  Repeat until the end of the job is 
reached.

2.5.9 Editing a JOB

A JOB can be edited with the following procedure.

 Modifying Steps Position

1) Move the cursor to the step to be modify.
2) Move the robot to the desired position using the virtual pendant or MotoSim EG-VRC 

functions (OLP, Position panel...)
3) Press the [MODIFY] key of the pendant keypad and the [ENTER] key. 

 Adding Steps

1) Move the cursor to the step preceding the insertion point.
2) Move the robot to the desired position using the virtual pendant or MotoSim EG-VRC 

functions (OLP, Position panel...)
3) Set the motion type and motion speed.
4) Press the [ADD] key of the pendant keypad and then the [ENTER] key

 Deleting Steps or Instructions

1) Move the cursor to the instruction to delete.
2) If the instruction is a motion instruction (step), move the robot to the step position by 

pressing and holding the [FWD] key until the robot stops moving and the cursor stops 
blinking.

3) Press the [DELETE] key of the pendant keypad and then the [ENTER] key.
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2.6 Playback

1. On the virtual pendant, move the job cursor to the top of the job.
2. In MotoSim EG-VRC, click the job execution button [Start] to perform playback and check the 

movement.

3. When the playback is completed, the play time can be displayed by clicking [Trace] to show the 
Trace Manager dialog.

• To modify the job after playback the virtual pendant next to be change back to teach 
mode by pressing the [TEACH] button.

• During the execution of job, please do not sleep or hibernate the PC.
The display of cell window may not recover.

NOTE
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3 Offline Teaching Procedure

This chapter describes the procedure for offline teaching and examination of robot application with 
MotoSim EG-VRC, and other related software.

3.1 Operation Flow

The following flowchart shows the general flow of the offline teaching using MotoSim EG.  

Solid lines indicate operation by MotoSim EG-VRC and dotted lines indicate operations by other 
software.

Construct MotoSim EG-VRC operational 
environment (cell) on the computer.

Register created controller and layout the robots 
in the cell. 

Create models to represent the workpiece, tool, 
etc. using MotoSim EG-VRC.  Set target points 
to simplify teaching.

Layout the model on the cell.

Perform teaching and playback by using 
MotoSim EG-VRC to examine the motion.

From the virtual pendant menu, select {FD/CF} - 
{SAVE} ans save the job and data.

Correct the layout error between MotoSim EG-
VRC and the actual manipulator.

Send/receive job and data to the actual 
controller using CompactFlash or transmission 
software.

Reduce the error between MotoSim EG-VRC 
data and actual robot using calibration software, 
and verify and correct the motion. 

Work cell construction 

Start 

Registration of controller and  
arrangement of robots  

Creation of work model and  
teaching target points 

Model arrangement 

Teaching of robot motion 

Review of robot motion, time and 
interference 

Correction 
(work calibration) 

JOB data transfer to the 
actual controller 

Verification/correction of the motion  
using the actual robot. 

End 

Saving of jobs, parameters and  
tool data. 
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4 Creating and Editing a Cell

This chapter explains on how to create and edit a cell.  Before starting to program robot motion with 
MotoSim EG-VRC, first create a cell and then register the controllers with the type and number of the 
robots to be used. 
For controller and robot registration, refer to section 7.1 "Adding a New Controller".

4.1 Creating a New Cell

Procedure

1. Click the MotoSim EG-VRC button (  ), and select the [New] - [New] menu. 

2. Enter a file name in the File name edit box, and click on [Open] to create a basic cell.  

4.1.1 Template Function

If the template cells are registered, the new cell is created from the template, so creation time is 
shortened. And the template cells can be renamed and deleted.

 Registration of Template

The cell are currently open is registered as the template. When many cells with same robot 
configuration are created, creating the cell can be easily through the use of the template.

Procedure

1. Open the cell to register as template.

2. Click the MotoSim EG-VRC button (  ), and select the [New] - [Template] menu. 

 

Enter a file name here.
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3. Select the [Template] radio button, and click the [Add] button.

4. Set the name of template, and click the [OK] button.

5. The registered template is displayed in the template list.
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 Rename the Template

The registered template is renamed.

Procedure

1. Click the MotoSim EG-VRC button (  ), and select the [New] - [Template] menu.

2. Select the name of template to rename in the template list.

3. Select the [Template] radio button, and click the [Rename] button.
4. Set the new name of template, and click the [OK] button.
4-3

HW0485348
71 of 671



4  Creating and Editing a Cell
4.1  Creating a New Cell

156225-1CD
5. The renamed template is displayed in the template list.

 Delete the template

The registered template is deleted.

Procedure

1. Click the MotoSim EG-VRC button (  ), and select the [New] - [Template] menu.

2. Select the name of template to delete in the template list.

3. Select the [Template] radio button, and click the [Delete] button.
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4. A confirmation dialog box is displayed. Click the [OK] button.

5. The deleted template disappears in the template list.

 Create the new cell from the template

The new cell is created from the registered template.

Procedure

1. Click the MotoSim EG-VRC button (  ), and select the [New] - [Template] menu.

2. Select the name of template to delete in the template list.
3. Select the [Create cell from template] radio button, and set the name of new cell.
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4. Click the [Create cell] button.

5. The new cell is created. If the [Open the created cell] is checked, the new cell is opened.
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4.2 Opening a Cell

Procedure

1. Click the MotoSim EG-VRC button (  ), and select the [Open] - [Open] menu.

When the sample cell is opened, click the MotoSim EG-VRC button (  ), and select the 

[Open] - [Open Sample Cell] menu.

2. Select a cell file, and click on [Open]: the cell appears.  

When opening a cell with LINE data (wire frame), it is recommended to use LINE data in 
the HMF format: opening a cell with LINE data in other format may take some time. 
If the LINE data is in the format other than HMF, convert the LINE data with “MDL2HMF.EXE” 
(located in a folder where MotoSim EG has been installed).

NOTE
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4.3 Storing a Cell

A cell file can be stored either under it current name “Save” or under a new name “Save As”.

4.3.1 Save

To store a file under its current name, click the MotoSim EG-VRC button (  ), and select the [Save] 

menu.
If the cell file was loaded from an older MotoSim EG-VRC version, the following message will display to 
confirm if the cell should be saved in the cell original format or in the MotoSim EG-VRC current version.

Click [Yes] to save the file in MotoSim EG-VRC current version.  Click [No] to save the file in its original 
version.  Click [Cancel] to abort saving the cell file.

Newer cell files containing HSF files may not display properly on older MotoSim EG-VRC versions.  
If a cell file need to be used with an older MotoSim EG-VRC version, it is recommended to save it in 
the corresponding version with the "Save As" dialog box.

NOTE
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4.3.2 Save As

To store a file under a new name, click the MotoSim EG-VRC button (  ), and select the [Save As] 

menu. Then store the file with the desired cell name.  By changing the "Save as type" selection, the cell 
file may also be saved in a previous MotoSim EG-VRC format.

4.4 Exiting a Cell and MotoSim EG-VRC

To exit MotoSim EG-VRC, click the MotoSim EG-VRC button (  ), and select the [Exit] menu.

They can also be terminated by clicking  button in the control menu box on each window.
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5 Displays

MotoSim EG-VRC has various displays.  The main MotoSim EG-VRC display shows the cell layout and 
the robot motion in a 3D environment.  Also, for every VRC controller in the cell there is a Virtual 
Pendant that allows to operate the VRC controller in the same manner than the real controller.

5.1 MotoSim EG-VRC Display

For improvement of operability, the basic operations of MotoSim EG-VRC are common with those of 
other Windows applications. 

The following figure shows the MotoSim EG-VRC main window.

The appearance of MotoSim EG-VRC Ver 5.00 differs greatly from Ver 4.10 or 
before. For more detail, please refer to the section 1.1.1 "Difference of the 
operation from 5.00" section.

NOTENOTE
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5.1.1 Ribbon

The ribbon is a command bar that organizes the features of an application into a series of tabs at the 
top of the main window. The ribbon replaces the traditional menu bar and toolbars.

 MotoSim EG-VRC button

Creates a new cell.
For details, refer to section 4.1 "Creating a New Cell" .

Create the new cell form the template.
For details, refer to section 4.1.1 "Template Function"

Reads an existing cell.
For details, refer to section 4.2 "Opening a Cell".

Reads an existing sample cell.
For details, refer to section 4.2 "Opening a Cell".
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 Home

Saves the edited cell information of a cell file. 
For details, refer to section 4.3.1 "Save".

Save the active cell file with a new name.
For details, refer to section 4.3.2 "Save As".

The help of MotoSim EG-VRC is displayed. 

The help of a MotoSim EG-VRC CAM function is displayed. 

Displays the Option dialog box.
For details, refer to chapter 12 "Configuration Settings".

To close the active cell. 
For details, refer to section 4.4 "Exiting a Cell and MotoSim EG-
VRC".

Edit

Undoes the last operation.
Click the down arrows beside the icon to display the last 9 operations.  
Selecting an operation from the list will undo this operation and all the 
operations performed after.

Redoes the last undone operation.
Click the down arrows beside the icon to display the last 9 undone 
operations.  Selecting an operation from the list will redo this operation and 
all the undone operations performed before.

Open the cell folder.

• Undo and Redo function supports the robot position change, model edition, Cad Tree 
operations and camera viewpoint operations.  Any operation generated by the virtual 
pendant or the playback of a JOB is not supported by the Undo and Redo function.

• Undo and Redo function may generate temporary files (mseg????.tmp) located in the 
Temp folder under the MotoSimEG installation folder.  Deleting these files while 
MotoSimEG-VRC is running may prevent undoing some operations.  Normal termination 
of the MotoSimEG-VRC application will automatically remove all temporary files in this 
folder.

NOTE
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Teaching

Displays the Position Panel.
Position Panel displays the robot position, pulse data, etc.  
For details, refer to section 8.1 "Position Panel".

Displays OLP dialog box and enables OLP function.  Moves the end of the robot tool or 
a model to a target point with one-click operation.
For details, refer to section 8.9 "Teaching".

Displays the Job Browser.
For details, refer to section 8.15 "Job Browser".

For detail on the CAM function please refer to CAM help (click  and 

select [CAM Help] menu).

View

Displays the View Manager panel, which offers a wider selection of 
standard view and allows to save and load up to 10 user defined views.
For details, refer to section 6.1.2 "Preset Viewpoint Operation".

Displays all the models in the cell to fit in the view.

Change the viewpoint to display the default isometric view.

Changes the viewpoint to display the default top view.

Change the viewpoint to display the default side view.

Changes the viewpoint to display the default front view.

• This function is available MotoSim EG-VRC ver4.00 or later.
• To use this function (CadPack option), the MotoSim EG-VRC-

CadPack is required. (The MotoSim EG-VRC-CadPack is 
separate product from MotoSim EG-VRC.)

• For Laser-welding use and Laser-cutting use, the additional 
options sold separately are needed.

NOTE
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Model

Selects a model: click any point of the desired model for selection.

Displays the model “Cad Tree” (tree structure organization of the models), indicating  
models display status and relationship.  Can be used to add and edit models.
For details, refer to section section  "".

Displays the model library dialog.
For details, refer to section 8.15 "Job Browser".

Pick

The Pick Mode sets conditions determining the selected point in the clicked area.
For details, refer to section "Pick Mode Setting".

Pick object set filters on the type of objects that can be selected by the mouse pick.
For details, refer to section "Pick Object Setting".

Screen

Toggles display of the AXIS6 in frame indicators in the view.

Displays cross-section X/Y/Z.
For details, refer to section 6.7 "Cutting Planes".

Creates a memo (text).
For details, refer to section 6.6 "Memo".
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Creates a dimension line. 
For details, refer to section section 6.10 "Measure Line".

Draws a free-form line/circle/rectangle or adds a note (text).
For details, refer to section 6.5 "Markup".

The display mode can be change.
For details, refer to section 6.11 "Changing the Rendering Mode".

Changes the frame line to display the width.
For details, refer to section 6.12.1 "Changing Frame Width".

Displays the Light Manager panel, which allows to add or remove lights, and to 
modify each light's properties.
For details, refer to section 6.2 "Light Manager Operation".

Shadows can be displayed for the models on the screen.
For details, refer to section 6.3 "Displaying Shadows".

Displays the axis triad.
For details, refer to the section 12.1.3 "Display".

Changes the perspective.
For details, refer to the section 12.1.3 "Display".

Mesurement

Measures the distance between two clicked points.
For details, refer to section 6.8 "Measure Distance".

Measures the angle between three clicked points.
For details, refer to section 6.9 "Measure Angle".
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Tools

Copy the static image of the cell window.
For details, refer to section 6.12.2 "Copying the Image".

Drawing performance is measured. 

External software is executed. 
For details, refer to section 8.14 "Running an External Software".

Settings

The re-drawing interval at the playback is set every second (s).
For details, refer to section 7.5.4 "Refresh Interval".

Sets the language.
For details, refer to section 12.4 "Language and Unit Settings".

Operation Handle For details, refer to section section 8.9.2 "Operation Handle".

Display/Hide the operation handle.

When operate the Operation handle, the selected robot only moves.

When operate the Operation handle, the selected robot and another robot 
move to keep their TCP the same relative position.

Select the coordinate of the Operation handle.
The following coordinates are available.

Display the control group of the current job.

Display/Hide the tool names at the tip of tool (TCP).

Display/Hide the guide line.
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 Controller

Setup

Create a new controller and define a system in MotoSim EG-VRC.
For details, refer to section 7.1 "Adding a New Controller".

A controller already define in a MotoSimEG-VRC cell can be copied over to another 
cell.
For details, refer to section 7.2 "Copying a Controller from another Cell".

To delete the controller and its associated robots from a cell.
For details, refer to section 7.3 "Deleting a Controller".

Boot

Reboot the controller to update parameter changes.
For details, refer to section 7.5.3 "Reboot Controller".

The controller is rebooted in the maintenance mode.
For details, refer to section 7.10 "VRC Maintenance Mode".

VPP

Displays the Virtual Pendant.
Virtual Pendant can be operated same as Teaching Pendant of each controller.
For details, refer to section 5.2 "Virtual Pendant".

Open the Storage Card folder

Displays all Virtual Pendants. 

Hides all Virtual Pendants.
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Job

Displays the Simple Pendant dialog.
For details, refer to the section 8.17 "Simple PP".

Displays the JobPad dialog.
For details, refer to the section 8.18 "JobPad".

File Settings

Modify the tool data file.
For details, refer to section 7.5.1 "Tool Editor".

Modify the user frame data.
For details, refer to section 7.5.2 "User Frame".

Modify robot calibration data file.
For details, refer to section 7.6.3 "Robot Calibration Setting".

Set the welding machine for spot welding.
For details, refer to section 13.8.3 "Setting of welding machine".

Display/delete the cube interference area.
For details, refer to section 7.5.6 "Cube Interference Area".

Display and modify the safety function.
For details, refer to section 7.10 "VRC Maintenance Mode".

Robot

Set the robot model.
For details, refer to section 7.6.1 "Robot Property".

Draw TCP Reach View.
For details, refer to section 7.6.2 "Reach View".
5-9

HW0485348
86 of 671



5  Displays
5.1  MotoSim EG-VRC Display

156225-1CD
External Device

Creates a new external device.
For details, refer to section 7.7 "Peripheral Equipment".

Set the soft limit.
For details, refer to section 7.7.4 "Modifying the Soft Limit of a 
Device".

Displays the Job Panel.
For details, refer to section 7.7.6 "Programming a Device".

Edit conveyor specification.
For details, refer to section "Conveyor Setting".

Set the conveyor condition file.
For details, refer to section 7.7.9 "Conveyor Synchronization".

Display conveyor operation panel.
For details, refer to section 7.7.8 "Conveyor Operation Panel".
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 Simulation

Playback

Moves the cursor in the job to the first step on the virtual pendant, and sets the 
robot position to the position of starting the job.

Executes the job currently selected of all the controllers in the cell.  
Use the virtual pendant to change the selected job.

Interrupts the job under execution.

Enables a job to skip backward step by step.

Enables a job to skip forward step by step.

Display the Stage master.
For details, refer to section 8.7 "Stage Master".

To playback without considering the lag of servo.

Display the Cycle time.
For details, refer to section 7.8 "Cycle Time".

This function can not use depending on the system 
version of controller. Please refer to section 15.6 "List of 
Function depending on the system version of controller".

NOTE

During the execution of job, please do not sleep or 
hibernate the PC.
The display of cell window may not recover..

NOTE
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Monitor

Display the Variable Monitor.
For details, refer to section 8.5 "Variable Monitor".

Displays a window which enables monitoring of the [Virtual I/O] signals.
The I/O signals are link to the job I/O instructions execution.
For details, refer to section 8.2 "I/O Monitor".

Display the Speed Graph.
For details, refer to section 8.12 "Spray Model for Paint".

Display the Pulse Record.
For details, refer to section 8.8 "Pulse Recorder".

Display the Lap Time Panel.
For details, refer to section 8.6 "Lap Time Panel".

Display the Trace Manager.
For details, refer to section 7.9 "Trace".

Display the Working Trace Manager.
For details, refer to section 7.12 "Working Trace".

Collision

Display the Collision Detection.
For details, refer to section 8.10 "Collision Detection".
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I/O Settings

Display the I/O Events.
For details, refer to section 8.3 "I/O Events".

Display the I/O connection.
For details, refer to section 8.4 "I/O connection".

Model Simulation

Display the Model Script Editor.
For details, refer to section 11.12 "Model Script".

Settings

Display the Sensing Option Setting.
For details, refer to section 8.11 "Sensing Option Setting".

Display the Paint Panel.
For details, refer to section 8.12 "Spray Model for Paint".

OutPut

Outputs the 3DPDF file.
For details, refer to the section 13.14 "3DPDF Output Function".

Outputs the AVI file.
For details, refer to the section 13.15 "AVI Output Function".
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 Option Function

Estimate

Displays the Motor Load Estimate.
For details, refer to section 14.1 "Motor Load Estimate".

Displays the Life Estimate.
For details, refer to section 14.2 "Life Estimate".
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5.1.2 Mouse Operation Switching Bar

 Viewpoint Operation Switching Bar

Click the button, the icon is surrounded with yellow frame and viewpoint operation by right button is 
changed.

To show the viewpoint operation switching bar, refer to the section 12.6 "Mouse Customization".

Zoom in and out the image by dragging the mouse upward (to zoom in) or 
downward (to zoom out) over the screen; rotate the image centering on the 
Z-axis of "world" coordinates by dragging the mouse from side to side.

Drag the mouse over the desired range to be enlarged.

For vertical rotation, drag the mouse up and down; for horizontal rotation, drag 
the mouse from side to side.

Drag the mouse from side to side and up and down to synchronize the 
viewpoint with the mouse motion. 

Zoom in and out the image by dragging the mouse upward (to zoom in) or 
downward (to zoom out) over the screen; rotate the image horizontally by 
dragging the mouse from side to side.

Zoom in and out the image by dragging the mouse upward (to zoom in) or 
downward (to zoom out) over the screen.

Click any desirable point so that the image is displayed with the clicked point 
located in the center of the screen.
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5.2 Virtual Pendant

When a Virtual Robot Controller (VRC) is registered in a cell, the associated Virtual Pendant is 
displayed.  The Virtual Pendant can be use to operate the VRC controller is the same manner as with 
the programming pendant of each controller.  The Virtual Pendant is composed of two separated 
windows: the pendant screen and the pendant keypad.  The display of the pendant keypad can be 

toggled from the pendant screen by pressing the [/] key or by clicking on the  icon.

When the mouse right button is clicked on the pendant keypad, "Fit" menu is displayed. When "Fit" 
menu is clicked, the pendant keypad moves to the center of the bottom of the pendant screen window.

When the   icon is clicked with the [Ctrl] key of the keyboard, the pendant keypad moves similarly.

• For operation on the Virtual Pendant, please refer to each controller “Operator Manual”.
• When two keys are to be pressed simultaneously, the keys are shown with a “+” sign 

between them, such as [SHIFT]+[COORD].  Press and hold the first key and then press 
the 2nd key.

• Multiple axis keys cannot be used simultaneously.
• When resizing the pendant screen, if necessary, the display font size can be adjusted by 

selecting {DISPLAY SETUP} - {CHANGE FONT} from the Virtual Pendant main menu.

NOTE
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5.2.1 DX200 Virtual Pendant

 

Pendant 
Screen 

Pendant 
Keypad 
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 Virtual Pendant Button

Button
Keyboard 
Equivalent

Description

Home
Selects TEACH Mode
The axis operation and edition from the programming 
pendant are enabled.

Teach Selects PLAY Mode
The playback of taught job is enabled.

Delete

Starts the manipulator motion in playback 
operation.
The lamp on this button is lit during the playback operation.
The lamp turns OFF when playback operation is stopped by 
alarm occurrence, HOLD signal, or mode change.

End

Holds the manipulator motion.
When lamp is turned OFF, the manipulator stays stopped 
until a START command is input.
The start and axis operations are disabled while lamp is lit.

Page Up
Turns ON the servo power.
Press this button to enable servo power to be turned ON.
The SERVO ON lamp is lit while the servo power is ON.

Turns OFF the servo power.
When the servo power is turned OFF, the SERVO ON LED 
on the programing pendant will extinguish.
An emergency stop message is displayed on the screen.

Activates the job synchronization mode.
When the SYNC button is blue, the robot position is 
instantly change to match selected step of displayed job.

Open the Storage Card folder
When this button is clicked, the storage card folder of this 
controller is opened.

/
Displays the Virtual Pendant keypad
When the button is down, the Virtual Pendant keypad is 
displayed.
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 Virtual Pendant Keypad

When resizing the pendant screen to a smaller size, the displayed text maybe shorten to 
fit in the smaller size buttons. 

Keypad key
Keyboard 
Equivalent

Description

[SELECT]

Space

Works as described below.  
• Selects menu items in the main menu area and the pull-down 

menu area.  

• Makes the selected item ready to be set in the general-purpose 

display area.  

• Displays multiple messages in the message area.  

Cursor ↑
←→
↓

Moves the Cursor in the direction of the arrow.  
• The size of the Cursor and the range/place where the Cursor 

can move will vary depending on the window.  

• If the UP Cursor button is pressed when the Cursor is on the 

first line, the Cursor will move to the last line of the job.  

Conversely, if the Cursor is on the last line of the job and the 

DOWN Cursor button is pressed, the Cursor will jump to the first 

line of the job.  

SHIFT key + UP 
Scrolls the screen upward.  

SHIFT key + DOWN 
Scrolls the screen downward.  

SHIFT key  + RIGHT 
Scrolls the screen to the right.  

SHIFT key + LEFT 
Scrolls the screen to the left.  

[MAIN MENU]

F1

Displays the main menu.  
If this button is pressed while the main menu is displayed, the main menu 
disappears.  

MAIN MENU key  + UP 
Increases the brightness of the screen.  

MAIN MENU key   + DOWN 
Decreases the brightness of the screen.  

[SIMPLE MENU]

F2

Displays the simple menu.  
If this button is pressed while the simple menu is displayed, the simple 
menu disappears.  

NOTE

SELECT

SHIFT

SHIFT

SHIFT

SHIFT

MAIN
MENU

MAIN
MENU

MAIN
MENU

ENTRY

SIMPLE
MENU
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Keypad key
Keyboard 
Equivalent

Description

[SERVO ON 
READY]

Page 
Down

Enables the servo power supply to be turned ON.  
Press this button to enable the servo power supply to be turned ON if the 
servo power supply is shut OFF by the emergency stop or overrun 
signal.  
When this button is pressed:  
• In the play mode, the servo power supply is turned ON if the 

safeguarding is securely closed.  

• In the teach mode, the SERVO ON lamp flashes and the servo 

power supply is turned ON when the Enable switch is ON.  

• The SERVO ON lamp is lit while the servo power is ON.  

[ASSIST]

F3

Displays the menu to assist the operation for the currently 
displayed window.  

Pressing this button with SHIFT key  or INTERLOCK key  
displays the help guidance for the operation.  

• SHIFT key + ASSIST key  

The function list of key combinations with SHIFT key  

appears.  

• INTERLOCK key  + ASSIST key 

The function list of key combinations with INTERLOCK key  

appears.  

[CANCEL]

Esc

Cancels the current status.  
• Deletes the sub menu in the main menu area and the pull-down 

menu area.  

• Cancels the input data or the input status in the general-purpose 

display area.  

• Cancels the multiple views in the message area.  

• Cancels the occurred error.  

[MULTI]

F5

Works for the multi mode.  
If this button is pressed when the multi mode is ON, the active window 
switches.  

SHIFT key  + MULTI Key  
Switches between the multi-window display and the single-window 
display when the multi mode is ON.  

SERVO
ON

READY

ASSIST
!?

SHIFT
INTER
LOCK

SHIFT ASSIST
!?

SHIFT

INTER
LOCK ASSIST

!?

INTER
LOCK

CANCEL

MULTI

LAYOUT
SHIFT

MULTI

LAYOUT
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[COORD]

K

Select the operation coordinate system when the manipulator is 
operated manually.  
• Five coordinate systems (joint, cartesian, cylindrical, tool and 

user) can be used.  Each time this key is pressed, the coordi-

nate system is switched in the following order: "JOINT""WLD/

CYL""TOOL""USER" 

• The selected coordinate system is displayed on the status dis-

play area.  

SHIFT key + COORD Key 
The coordinate number can be changed when the "TOOL" or "USER" 
coordinate system is selected.  

[DIRECT OPEN]

L

Displays the content related to the current line.  

• To display the content of a CALL job or condition file, move the 

Cursor to the next line and press DIRECT OPEN key .  The 

file will be displayed for the selected line.  Display content will 

vary depending on the type of instruction used in the job.  

Example: 
For a CALL instruction, the content of the called job will be displayed.  
For a work instruction, the content of the condition file will be displayed.  
For Input/output instructions, the input/output condition will be displayed.  
• The lamp on this button is lit while the direct open is ON.  Press 

this button while the lamp is lit to return to the previous window.  

[PAGE]

F4

Displays the next page.
The page can be switched only when the lamp on this button is lit.  

SHIFT key  + PAGE key  
Switches to the previous page.  

[AREA]

TAB

Moves the Cursor in the following order : “Menu Area”“General-
Purpose Display Area”“Message Area”“Main Menu Area”.  If no 
item is displayed, the Cursor does not move.  

SHIFT key + AREA key  
The language can be switched when the bilingual function is valid.  
(Bilingual function is optional.)  

AREA key  + DOWN 
Moves the Cursor  from the general-purpose display area to the 
operation button when the operation button is displayed.  

AREA key   + UP 
Moves the Cursor to the general-purpose display area when the Cursor 
is on the operation button.  

[SHIFT]

Shift

Changes the functions of other keys by pressing this key together.  

Can be used with ASSIST key , COORD key , AREA key , 
[MOTION TYPE], [ROBOT], [EX. AXIS], Cursor key or Numeric key to 
access alternate functions.  
Refer to the description of each key for the alternate SHIFT functions.  

Keypad key
Keyboard 
Equivalent

Description

TOOL SEL

COORD

SHIFT
TOOL SEL

COORD

DIRECT
OPEN

DIRECT
OPEN

GO BACK

PAGE
SHIFT

GO BACK

PAGE

AREA

SHIFT AREA

AREA

AREA

SHIFT

ASSIST
!?

TOOL SEL

COORD AREA
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[INTERLOCK]

Ctrl

Changes the functions of other keys by pressing together.  

Can be used with ASSIST key , MULTI key , [TEST START], 
[FWD], or Numeric key (Numeric key customize function), [ROBOT].  
Refer to the description of each key for the alternate INTERLOCK 
functions.  

[INFORM LIST]

O

Displays instruction lists of commands available for job editing.  

[ROBOT]

I

Enables the robot axis operation.  

[ROBOT] is active for the system where multiple manipulators are 
controlled by one DX200 or the system with external axes.  

SHIFT key + [ROBOT] 
The robot under axis operation can be switched to a robot axis which is 
not registered to the currently selected job.

INTERLOCK key  + [ROBOT]
Switches the application when several applications are set to a robot.

[EX.AXIS]

F11

Enables the external axis (base axis or station axis) operation.  

[EX.AXIS] is active for the system with external axes.  

SHIFT key + [EX. AXIS]
The external axis under axis operation can be switched to an external 
axis which is not registered to the currently selected job.

[MOTION TYPE]

F7

Selects the interpolation type for playback operation.  
The selected interpolation type is shown in the status display area on the 
screen.  

• Each time this key is pressed, the interpolation type changes in 

the following order: 

"MOVJ"" MOVL""MOVC"

SHIFT key  + [MOTION TYPE]
The interpolation mode changes in the following order:
"STANDARD"" EXTERNAL REFERENCE POINT"*" CONVEYOR"* 

Interpolation type can be changed in any mode.  

*: These modes are purchased options.  

Keypad key
Keyboard 
Equivalent

Description

INTER
LOCK

ASSIST
!?

MULTI

LAYOUT

INFORM
LIST

ROBOT SHIFT

INTER
LOCK

EX.AXIS
SHIFT

MOTION
TYPE

SHIFT
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[TEST START]

N

Moves the manipulator through taught steps in a continuous 

motion when [TEST START] and INTERLOCK key  are 
simultaneously pressed.  
The manipulator can be moved to check the path of taught steps.  
Operation stops immediately when this key is released.  
• The manipulator operates according to the currently selected 

operation cycle: "AUTO", "1CYCLE" or "STEP". 

• The manipulator operates at the taught speed.   However, if the 

taught speed exceeds the maximum teaching speed, the opera-

tion proceeds at the maximum teaching speed.  

[FWD]

F12

Moves the manipulator through the taught steps while this key is 
pressed.  
• Only move instructions are executed (one instruction at a time, 

no welding instructions).  

INTERLOCK key  + [FWD]
All instructions are executed.  
[0] + [FWD]  
Moves to the reference point of the cursor line.  
The manipulator operates at the selected manual speed.  Make sure that 
the selected manual speed is the desired one before starting operation.  

[BWD]

M

Moves the manipulator through the taught steps in the reverse 
direction while this key is pressed.  
• Only move instructions are executed (no weld commands).  

The manipulator operates at the selected manual speed.  Make sure that 
the selected manual speed is the desired one before starting operation.  

[DELETE]

F9

Deletes the registered instruction.  
• Deletion completes when [ENTER] is pressed while this key 

lamp is lit.  

[INSERT]

F8

Inserts a new instruction.  
• Insertion completes when [ENTER] is pressed while this key 

lamp is lit.  

[MODIFY]

F6

Modifies the taught position data or instruction.  
• Modification completes when [ENTER] is pressed while this key 

lamp is lit.  

[ENTER]

Enter

Registers instructions, data, current position of the manipulator, 
etc. 
• When [ENTER] is pressed, the instruction or data displayed in 

the input buffer line moves to the Cursor position to complete a 

registration, insertion, or modification.  

Keypad key
Keyboard 
Equivalent

Description

TEST
START

INTER
LOCK

FWD INTER
LOCK

BWD

DELETE

INSERT

MODIFY

ENTER
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MANUAL SPEED 
keys

D

C

Sets the speed for manual operation.  This speed is also valid for 
operations with [FWD] and [BWD].  
• There are four speed levels (slow, medium, fast, and inching).  

The speed changes as described below.  The selected speed is 

displayed on the status area.  

Each time [FAST] is pressed, manual speed changes in the following 
order: 
"INCH"" SLOW""MED""FST".  
Each time [SLOW] is pressed, manual speed changes in the following 
order: 
"FST""MED""SLOW""INCH"

[HIGH SPEED]

E

Makes the manipulator move at high speed while this button and 
one of the axis keys are pressed simultaneously during manual 
operation.  No need to change the setting of speed.  
• The speed for [HIGH SPEED] is specified in advance.  

Axis Key
Q W   R T
A S   F G
Z X   V B

Y U   H J

Moves specified axes on manipulator.  
• The manipulator axes only move while the key is pressed.  

• Multiple axes can be operated simultaneously by pressing two 

or more keys at the same time.  

The manipulator operates in the selected coordinate system at the 
selected manual speed.  Make sure that the selected coordinate system 
and the manual speed are the desired ones before starting the axis 
operation. 

It is possible to allocate any external axes to [E-] + [E+], [8-] + [8+] keys 
to operate them.   
 

Numeric Key

0-9
-
.

Enters the number or symbol when the ">" prompt appears on the 
input line.  
• “.” is the decimal point.  “-” is a minus sign or hyphen. 

The Numeric keys are also used as function keys.   Refer to the 
explanation of each function for details.  

Keypad key
Keyboard 
Equivalent

Description

MANUAL SPEED

FAST

SLOW

FAST
MANUAL SPEED

X+
R+

Y+
B+

Z+
T+

X-
R-

Y-
B-

Z -
T -

8+8-

X+
S+

Y+
L+

Z+
U+

X-
S-

Y-
L -

Z-
U-

E+E-

TOOL OF
0

1
TOOL ON
2

TOOL ON
JOB

3

SMOV
4 5 6

SYNCRO
SINGLE

7 8 9

TOOL OF
JOB
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 Keyboard Layout

The Virtual Pendant keypad key all have a corresponding key on the computer keyboard.  When the 
Virtual Pendant Screen has the input focus, the those keyboard key can be pressed instead of clicking 
the keys on the pendant keypad.

ESC   F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11 F12           

CANCEL   MAIN 
MENU 

SIMPLE 
MENU 

ASSIST PAGE MULTI MODIFY MOTION
TYPE INSERT DELETE ＡＰＰＬＩＣ

ＡＴＩＯＮ 
EX.AXIS FWD           

                                      

` 1 2 3 4 5 6 7 8 9 0 - = Backspace   Insert Home Page
Up 

 1 2 3 4 5 6 7 8 9 0 -  Backspace   Teach Play  

TAB Q W E R T Y U I O P [ ] ¥   Delete End Page
Down

AREA X- 
S- 

X+ 
S+ 

HIGH 
SPEED 

X- 
R- 

X+ 
R+ 

E- E+ ROBOT 
INFORM 

LIST 
AUX      Start Hold Servo On

Ready 

CapsLock A S D F G H J K L ; ‘ Enter         

 Y- 
L- 

Y+ 
L+ 

FAST Y- 
B- 

Y+ 
B+ 

8- 8+ COORD 
DIRECT 
OPEN 

  ENTER         

Shift Z X C V B N M , . / Shift     ↑   

SHIFT Z- 
U- 

Z+ 
U+ 

SLOW Z- 
T- 

Z+ 
T+ 

TEST 
START 

BWD  . Keypad
Display

SHIFT     ↑   

Ctrl Win Alt Space Alt  Ctrl   ← ↓ → 

INTERLOCK   SELECT   INTERLOCK   ← ↓ → 
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5.2.2 DX100 Virtual Pendant

 Virtual Pendant Button

The pendant buttons are the same as those for DX100 virtual pendant.
For details, please refer to the section "Virtual Pendant Button" of the section 5.2.1 "DX200 Virtual 
Pendant" section.

 Virtual Pendant Keypad

Keypad key
Keyboard 
Equivalent

Description

[SELECT]

Space

Works as described below.
• Selects menu items in the main menu area and the pull-down 

menu area.
• Makes the selected item ready to be set in the general-purpose 

display area.
• Displays multiple messages in the message area. 

 

Pendant 
Screen 

Pendant 
Keypad 
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Cursor ↑
←→
↓

Moves the cursor in the direction of the arrow.
• The size of the cursor and the range/place where the cursor can 

move will vary depending on the window.
• If the UP cursor button is pressed when the cursor is on the first 

line, the cursor will move to the last line of the job.  Conversely, 
if the cursor is on the last line of the job and the DOWN cursor 
button is pressed, the cursor will jump to the first line of the job.  

[SHIFT] + UP
Scrolls the screen upward.
[SHIFT] + DOWN
Scrolls the screen downward.
[SHIFT] + RIGHT
Scrolls the screen to the right.
[SHIFT] + LEFT
Scrolls the screen to the left.  

[MAIN MENU]

F1

Displays the main menu.
If this button is pressed while the main menu is displayed, the main menu 
disappears.

[MAIN MENU] + UP
Increases the brightness of the screen.
[MAIN MENU] + DOWN
Decreases the brightness of the screen.  

[SIMPLE MENU]

F2

Displays the simple menu.
If this button is pressed while the simple menu is displayed, the simple 
menu disappears. 

[SERVO ON 
READY]

Page 
Down

Enables the servo power supply to be turned ON.
Press this button to enable the servo power supply to be turned ON if the 
servo power supply is shut OFF by the emergency stop or overrun 
signal.  When this button is pressed:
• In the play mode, the servo power supply is turned ON if the 

safeguarding is securely closed.
• In the teach mode, the SERVO ON lamp flashes and the servo 

power supply is turned ON when the Enable switch is ON.
• The SERVO ON lamp is lit while the servo power is ON. 

[ASSIST]

F3

Displays the menu to assist the operation for the 
currently displayed window.
Pressing this button with [SHIFT] or [INTERLOCK] displays the help 
guidance for the operation. 
• [SHIFT] + [ASSIST]

The function list of key combinations with [SHIFT] appears.  
• [INTERLOCK] + [ASSIST]

 The function list of key combinations with [INTERLOCK] 
appears.

[CANCEL]

Esc

Cancels the current status.
• Deletes the sub menu in the main menu area and the pull-down 

menu area.
• Cancels the input data or the input status in the general-purpose 

display area.
• Cancels the multiple views in the message area.
• Cancels the occurred error.  

Keypad key
Keyboard 
Equivalent

Description
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[MULTI]

F5

Works for the multi mode.
If this button is pressed when the multi mode is ON, the active window 
switches.

[SHIFT] + [MULTI]
Switches between the multi-window display and the single-window 
display when the multi mode is ON.

[COORD]

K

Select the operation coordinate system when the 
manipulator is operated manually.
• Five coordinate systems (joint, cartesian, cylindrical, tool and 

user) can be used.  Each time this key is pressed, the 
coordinate system is switched in the following order:
 "JOINT"→"WLD/CYL"→"TOOL"→"USER"

• The selected coordinate system is displayed on the status 
display area.

[SHIFT] + [COORD]
The coordinate number can be changed when the "TOOL" or "USER" 
coordinate system is selected. 

[DIRECT OPEN]

L

Displays the content related to the current line.
• To display the content of a CALL job or condition file, move the 

cursor to the next line and press [DIRECT OPEN].  The file will 
be displayed for the selected line.  Display content will vary 
depending on the type of instruction used in the job.

Example:
For a CALL instruction, the content of the called job will be displayed.
For a work instruction, the content of the condition file will be displayed.
For Input/output instructions, the input/output condition will be displayed.
• The lamp on this button is lit while the direct open is ON.  Press 

this button while the lamp is lit to return to the previous window.  

[PAGE]

F4

Displays the next page.
The page can be switched only when the lamp on this button is lit. 
 [SHIFT] + [PAGE]
Switches to the previous page. 

[AREA]

TAB

Moves the cursor in the following order : "Menu 
Area"→"General-Purpose Display Area"→"Message 
Area"→"Main Menu Area".  If no item is displayed, the 
cursor does not move.

[SHIFT] + [AREA] 
The language can be switched when the bilingual function is valid.  
(Bilingual function is optional.)
[AREA] + DOWN
Moves the cursor from the general-purpose display area to the operation 
button when the operation button is displayed. 
[AREA] + UP
Moves the cursor to the general-purpose display area when the cursor is 
on the operation button. 

[SHIFT]

Shift

Changes the functions of other keys by pressing together.
Can be used with [MAIN MENU], [ASSIST], [COORD], [AREA], 
[MOTION TYPE], cursor key or Numeric key to access alternate 
functions.  Refer to the description of each key for the alternate [SHIFT] 
functions. 

Keypad key
Keyboard 
Equivalent

Description
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[INTERLOCK]

Ctrl

Changes the functions of other keys by pressing together.
Can be used with [ASSIST], [MULTI], [TEST START], [FWD], or Numeric 
key (Numeric key customize function).
Refer to the description of each key for the alternate [INTERLOCK] 
functions.

[INFORM LIST]

O
Displays instruction lists of commands available for job 
editing.

[ROBOT]

I

Enables the robot axis operation.

[ROBOT] is active for the system where multiple manipulators are 
controlled by one DX100 or the system with external axes.

[EX.AXIS]

F11

Enables the external axis (base axis or station axis) 
operation.

[EX.AXIS] is active for the system with external axes.

[MOTION TYPE]

F7

Selects the interpolation type for playback operation.
The selected interpolation type is shown in the status display area on the 
screen.

• Each time this key is pressed, the interpolation type changes in 
the following order:
"MOVJ"" MOVL""MOVC""MOVS"

[SHIFT] + [MOTION TYPE]
The interpolation mode changes in the following order:
"STANDARD"" EXTERNAL REFERENCE POINT"*" CONVEYOR"* 

Interpolation type can be changed in any mode.

*: These modes are purchased options.

[TEST START]

N

Moves the manipulator through taught steps in a 
continuous motion when [TEST START] and [INTERLOCK] 
are simultaneously pressed.
The manipulator can be moved to check the path of taught steps.  
Operation stops immediately when this key is released.
• The manipulator operates according to the currently selected 

operation cycle: "AUTO," "1CYCLE," or "STEP."
• The manipulator operates at the taught speed.   However, if the 

taught speed exceeds the maximum teaching speed, the 
operation proceeds at the maximum teaching speed.

Keypad key
Keyboard 
Equivalent

Description
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[FWD]

F12

Moves the manipulator through the taught steps while this 
key is pressed.
• Only move instructions are executed (one instruction at a time, 

no welding instructions).  

[INTERLOCK] + [FWD]
All instructions are executed.  
[REFP] + [FWD]  
Moves to the reference point of the cursor line.  
The manipulator operates at the selected manual speed.  Make sure that 
the selected manual speed is the desired one before starting operation.  

[BWD]

M

Moves the manipulator through the taught steps in the 
reverse direction while this key is pressed.
• Only move instructions are executed (no weld commands).  
The manipulator operates at the selected manual speed.  Make sure that 
the selected manual speed is the desired one before starting operation. 

[DELETE]

F9
Deletes the registered instruction.
• Deletion completes when [ENTER] is pressed while this key 

lamp is lit.

[INSERT]

F8
Inserts a new instruction. 
• Insertion completes when [ENTER] is pressed while this key 

lamp is lit.

[MODIFY]

F6
Modifies the taught position data or instruction.
• Modification completes when [ENTER] is pressed while this key 

lamp is lit.

[ENTER]

Enter

Registers instructions, data, current position of the 
manipulator, etc.
• When [ENTER] is pressed, the instruction or data displayed in 

the input buffer line moves to the cursor position to complete a 
registration, insertion, or modification.

MANUAL SPEED 
keys

D

C

Sets the speed for manual operation.  This speed is also 
valid for operations with [FWD] and [BWD].
• There are four speed levels (slow, medium, fast, and inching).  

The speed changes as described below.  The selected speed is 
displayed on the status area.

Each time [FAST] is pressed, manual speed changes in the following 
order:
"INCH"" SLOW""MED""FST"
Each time [SLOW] is pressed, manual speed changes in the following 
order: 
"FST"" MED""SLOW""INCH"

Keypad key
Keyboard 
Equivalent

Description
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[HIGH SPEED]

E

Makes the manipulator move at high speed while this 
button and one of the axis keys are pressed 
simultaneously during manual operation.  No need to 
change the setting of speed. 
• The speed for [HIGH SPEED] is specified in advance.

Axis Key
Q W   R T
A S   F G
Z X   V B

Y U   H J

Moves specified axes on manipulator.
• The manipulator axes only move while the key is pressed.
• Multiple axes can be operated simultaneously by pressing two 

or more keys at the same time.

The manipulator operates in the selected coordinate system at the 
selected manual speed.  Make sure that the selected coordinate system 
and the manual speed are the desired ones before starting the axis 
operation.

Numeric Key

0-9
-
.

Enters the number or symbol when the ">" prompt appears 
on the input line.
• "." is the decimal point.  "-" is a minus sign or hyphen. The 

Numeric keys are also used as function keys.   Refer to the 
explanation of each function for details. 

Keypad key
Keyboard 
Equivalent

Description
5-31

HW0485348
108 of 671



5  Displays
5.2  Virtual Pendant

156225-1CD
 Keyboard Layout

The Virtual Pendant keypad key all have a corresponding key on the computer keyboard.  When the 
Virtual Pendant Screen has the input focus, the those keyboard key can be pressed instead of clicking 
the keys on the pendant keypad.

ESC   F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11 F12           

CANCEL   MAIN 
MENU 

SIMPLE
MENU 

ASSIST PAGE MULTI MODIFY MOTION
TYPE INSERT DELETE ＡＰＰＬＩＣ

ＡＴＩＯＮ 
EX.AXIS FWD           

                                      

` 1 2 3 4 5 6 7 8 9 0 - = Backspace   Insert Home Page
Up 

 1 2 3 4 5 6 7 8 9 0 -  Backspace   Teach Play  

TAB Q W E R T Y U I O P [ ] ¥   Delete End Page
Down

AREA X- 
S- 

X+ 
S+ 

HIGH 
SPEED 

X- 
R- 

X+ 
R+ 

E- E+ ROBOT 
INFORM 

LIST 
AUX      Start Hold Servo On

Ready 

CapsLock A S D F G H J K L ; ‘ Enter         

 Y- 
L- 

Y+ 
L+ 

FAST Y- 
B- 

Y+ 
B+ 

8- 8+ COORD 
DIRECT 
OPEN 

  ENTER         

Shift Z X C V B N M , . / Shift     ↑   

SHIFT Z- 
U- 

Z+ 
U+ 

SLOW Z- 
T- 

Z+ 
T+ 

TEST 
START 

BWD  . Keypad
Display

SHIFT     ↑   

Ctrl Win Alt Space Alt  Ctrl   ← ↓ → 

INTERLOCK   SELECT   INTERLOCK   ← ↓ → 
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5.2.3 FS100 Virtual Pendant

 Virtual Pendant Button

The pendant buttons are the same as those for DX100 virtual pendant.
For details, please refer to the section "Virtual Pendant Button" of the section 5.2.1 "DX200 Virtual 
Pendant" section.

 

Pendant 
Screen 

Pendant 
Keypad 
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 Virtual Pendant Keypad

Keypad key
Keyboard 
Equivalent

Description

[SELECT]

Space

Works as described below.  
• Selects menu items in the main menu area and the pull-down 

menu area.  

• Makes the selected item ready to be set in the general-purpose 

display area.  

• Displays multiple messages in the message area.  

Cursor ↑
←→
↓

Moves the Cursor in the direction of the arrow.  
• The size of the Cursor and the range/place where the Cursor 

can move will vary depending on the window.  

• If the UP Cursor button is pressed when the Cursor is on the 

first line, the Cursor will move to the last line of the job.  

Conversely, if the Cursor is on the last line of the job and the 

DOWN Cursor button is pressed, the Cursor will jump to the first 

line of the job.  

SHIFT key + UP 
Scrolls the screen upward.  

SHIFT key + DOWN 
Scrolls the screen downward.  

SHIFT key  + RIGHT 
Scrolls the screen to the right.  

SHIFT key + LEFT 
Scrolls the screen to the left.  

[MAIN MENU]

F1

Displays the main menu.  
If this button is pressed while the main menu is displayed, the main menu 
disappears.  

MAIN MENU key  + UP 
Increases the brightness of the screen.  

MAIN MENU key   + DOWN 
Decreases the brightness of the screen.  

[SIMPLE MENU]

F2

Displays the simple menu.  
If this button is pressed while the simple menu is displayed, the simple 
menu disappears.  

[SERVO ON 
READY]

Page 
Down

Enables the servo power supply to be turned ON.  
Press this button to enable the servo power supply to be turned ON if the 
servo power supply is shut OFF by the emergency stop or overrun 
signal.  
When this button is pressed:  
• In the play mode, the servo power supply is turned ON if the 

safeguarding is securely closed.  

• In the teach mode, the SERVO ON lamp flashes and the servo 

power supply is turned ON when the Enable switch is ON.  

• The SERVO ON lamp is lit while the servo power is ON.  

SELECT

SHIFT

SHIFT

SHIFT

SHIFT

MAIN
MENU

MAIN
MENU

MAIN
MENU

ENTRY

SIMPLE
MENU

SERVO
ON

READY
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[ASSIST]

F3

Displays the menu to assist the operation for the currently 
displayed window.  

Pressing this button with SHIFT key  or INTERLOCK key  
displays the help guidance for the operation.  

• SHIFT key + ASSIST key  

The function list of key combinations with SHIFT key  

appears.  

• INTERLOCK key  + ASSIST key 

The function list of key combinations with INTERLOCK key  

appears.  

[CANCEL]

Esc

Cancels the current status.  
• Deletes the sub menu in the main menu area and the pull-down 

menu area.  

• Cancels the input data or the input status in the general-purpose 

display area.  

• Cancels the multiple views in the message area.  

• Cancels the occurred error.  

[MULTI]

F5

Works for the multi mode.  
If this button is pressed when the multi mode is ON, the active window 
switches.  

SHIFT key  + MULTI Key  
Switches between the multi-window display and the single-window 
display when the multi mode is ON.  

[COORD]

K

Select the operation coordinate system when the manipulator is 
operated manually.  
• Five coordinate systems (joint, cartesian, cylindrical, tool and 

user) can be used.  Each time this key is pressed, the coordi-

nate system is switched in the following order: "JOINT""WLD/

CYL""TOOL""USER" 

• The selected coordinate system is displayed on the status dis-

play area.  

SHIFT key + COORD Key 
The coordinate number can be changed when the "TOOL" or "USER" 
coordinate system is selected.  

Keypad key
Keyboard 
Equivalent

Description

ASSIST
!?

SHIFT
INTER
LOCK

SHIFT ASSIST
!?

SHIFT

INTER
LOCK ASSIST

!?

INTER
LOCK

CANCEL

MULTI

LAYOUT
SHIFT

MULTI

LAYOUT

TOOL SEL

COORD

SHIFT
TOOL SEL

COORD
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[DIRECT OPEN]

L

Displays the content related to the current line.  

• To display the content of a CALL job or condition file, move the 

Cursor to the next line and press DIRECT OPEN key .  The 

file will be displayed for the selected line.  Display content will 

vary depending on the type of instruction used in the job.  

Example: 
For a CALL instruction, the content of the called job will be displayed.  
For a work instruction, the content of the condition file will be displayed.  
For Input/output instructions, the input/output condition will be displayed.  
• The lamp on this button is lit while the direct open is ON.  Press 

this button while the lamp is lit to return to the previous window.  

[PAGE]

F4

Displays the next page.
The page can be switched only when the lamp on this button is lit.  

SHIFT key  + PAGE key  
Switches to the previous page.  

[AREA]

TAB

Moves the Cursor in the following order : “Menu Area”“General-
Purpose Display Area”“Message Area”“Main Menu Area”.  If no 
item is displayed, the Cursor does not move.  

SHIFT key + AREA key  
The language can be switched when the bilingual function is valid.  
(Bilingual function is optional.)  

AREA key  + DOWN 
Moves the Cursor  from the general-purpose display area to the 
operation button when the operation button is displayed.  

AREA key   + UP 
Moves the Cursor to the general-purpose display area when the Cursor 
is on the operation button.  

[SHIFT]

Shift

Changes the functions of other keys by pressing this key together.  

Can be used with ASSIST key , COORD key , AREA key , 
[MOTION TYPE], [ROBOT], [EX. AXIS], Cursor key or Numeric key to 
access alternate functions.  
Refer to the description of each key for the alternate SHIFt functions.  

[INTERLOCK]

Ctrl

Changes the functions of other keys by pressing together.  

Can be used with ASSIST key , MULTI key , [TEST START], 
[FWD], or Numeric key (Numeric key customize function), [ROBOT].  
Refer to the description of each key for the alternate NTERLOCK 
functions.  

[INFORM LIST]

O

Displays instruction lists of commands available for job editing.  

Keypad key
Keyboard 
Equivalent

Description

DIRECT
OPEN

DIRECT
OPEN

GO BACK

PAGE
SHIFT

GO BACK

PAGE

AREA

SHIFT AREA

AREA

AREA

SHIFT

ASSIST
!?

TOOL SEL

COORD AREA

INTER
LOCK

ASSIST
!?

MULTI

LAYOUT

INFORM
LIST
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[ROBOT]

I

Enables the robot axis operation.  

[ROBOT] is active for the system where multiple manipulators are 
controlled by one FS100 or the system with external axes.  

SHIFT key + [ROBOT] 
The robot under axis operation can be switched to a robot axis which is 
not registered to the currently selected job.

INTERLOCK key  + [ROBOT]
Switchs the application when several applications are set to a robot.

[EX.AXIS]

F11

Enables the external axis (base axis or station axis) operation.  

[EX.AXIS] is active for the system with external axes.  

SHIFTkey + [EX. AXIS]
The external axis under axis operation can be switched to an external 
axis which is not registered to the currently selected job.

[MOTION TYPE]

F7

Selects the interpolation type for playback operation.  
The selected interpolation type is shown in the status display area on the 
screen.  

• Each time this key is pressed, the interpolation type changes in 

the following order: 

"MOVJ"" MOVL""MOVC"

SHIFT key  + [MOTION TYPE]
The interpolation mode changes in the following order:
"STANDARD"" EXTERNAL REFERENCE POINT"*" CONVEYOR"* 

Interpolation type can be changed in any mode.  

*: These modes are purchased options.  

[TEST START]

N

Moves the manipulator through taught steps in a continuous 

motion when [TEST START] and INTERLOCK key  are 
simultaneously pressed.  
The manipulator can be moved to check the path of taught steps.  
Operation stops immediately when this key is released.  
• The manipulator operates according to the currently selected 

operation cycle: "AUTO", "1CYCLE" or "STEP". 

• The manipulator operates at the taught speed.   However, if the 

taught speed exceeds the maximum teaching speed, the opera-

tion proceeds at the maximum teaching speed.  

Keypad key
Keyboard 
Equivalent

Description

ROBOT SHIFT

INTER
LOCK

EX.AXIS
SHIFT

MOTION
TYPE

SHIFT

TEST
START

INTER
LOCK
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[FWD]

F12

Moves the manipulator through the taught steps while this key is 
pressed.  
• Only move instructions are executed (one instruction at a time, 

no welding instructions).  

INTERLOCK key  + [FWD]
All instructions are executed.  
[0] + [FWD]  
Moves to the reference point of the cursor line.  
The manipulator operates at the selected manual speed.  Make sure that 
the selected manual speed is the desired one before starting operation.  

[BWD]

M

Moves the manipulator through the taught steps in the reverse 
direction while this key is pressed.  
• Only move instructions are executed (no weld commands).  

The manipulator operates at the selected manual speed.  Make sure that 
the selected manual speed is the desired one before starting operation.  

[DELETE]

F9

Deletes the registered instruction.  
• Deletion completes when [ENTER] is pressed while this key 

lamp is lit.  

[INSERT]

F8

Inserts a new instruction.  
• Insertion completes when [ENTER] is pressed while this key 

lamp is lit.  

[MODIFY]

F6

Modifies the taught position data or instruction.  
• Modification completes when [ENTER] is pressed while this key 

lamp is lit.  

[ENTER]

Enter

Registers instructions, data, current position of the manipulator, 
etc. 
• When [ENTER] is pressed, the instruction or data displayed in 

the input buffer line moves to the Cursor position to complete a 

registration, insertion, or modification.  

MANUAL SPEED 
keys

D

C

Sets the speed for manual operation.  This speed is also valid for 
operations with [FWD] and [BWD].  
• There are four speed levels (slow, medium, fast, and inching).  

The speed changes as described below.  The selected speed is 

displayed on the status area.  

Each time [FAST] is pressed, manual speed changes in the following 
order: 
"INCH"" SLOW""MED""FST".  
Each time [SLOW] is pressed, manual speed changes in the following 
order: 
"FST""MED""SLOW""INCH"

Keypad key
Keyboard 
Equivalent

Description

FWD INTER
LOCK

BWD

DELETE

INSERT

MODIFY

ENTER

MANUAL SPEED

FAST

SLOW
5-38

HW0485348
115 of 671



5  Displays
5.2  Virtual Pendant

156225-1CD
[HIGH SPEED]

E

Makes the manipulator move at high speed while this button and 
one of the axis keys are pressed simultaneously during manual 
operation.  No need to change the setting of speed.  
• The speed for [HIGH SPEED] is specified in advance.  

Axis Key
Q W   R T
A S   F G
Z X   V B

Y U   H J

Moves specified axes on manipulator.  
• The manipulator axes only move while the key is pressed.  

• Multiple axes can be operated simultaneously by pressing two 

or more keys at the same time.  

The manipulator operates in the selected coordinate system at the 
selected manual speed.  Make sure that the selected coordinate system 
and the manual speed are the desired ones before starting the axis 
operation. 

It is possible to allocate any external axes to [E-] + [E+], [8-] + [8+] keys 
to operate them.   
 

Numeric Key

0-9
-
.

Enters the number or symbol when the ">" prompt appears on the 
input line.  
• “.” is the decimal point.  “-” is a minus sign or hyphen. 

The Numeric keys are also used as function keys.   Refer to the 
explanation of each function for details.  

Keypad key
Keyboard 
Equivalent

Description

FAST
MANUAL SPEED

X+
R+

Y+
B+

Z+
T+

X-
R-

Y-
B-

Z -
T -

8+8-

X+
S+

Y+
L+

Z+
U+

X-
S-

Y-
L -

Z-
U-

E+E-

TOOL OF
0

1
TOOL ON
2

TOOL ON
JOB

3

SMOV
4 5 6

SYNCRO
SINGLE

7 8 9

TOOL OF
JOB
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 Keyboard Layout

The Virtual Pendant keypad key all have a corresponding key on the computer keyboard.  When the 
Virtual Pendant Screen has the input focus, the those keyboard key can be pressed instead of clicking 
the keys on the pendant keypad.

ESC   F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11 F12           

CANCEL   MAIN 
MENU 

SIMPLE
MENU 

ASSIST PAGE MULTI MODIFY MOTION
TYPE INSERT DELETE ＡＰＰＬＩＣ

ＡＴＩＯＮ 
EX.AXIS FWD           

                                      

` 1 2 3 4 5 6 7 8 9 0 - = Backspace   Insert Home Page
Up 

 1 2 3 4 5 6 7 8 9 0 -  Backspace   Teach Play  

TAB Q W E R T Y U I O P [ ] ¥   Delete End Page
Down

AREA X- 
S- 

X+ 
S+ 

HIGH 
SPEED 

X- 
R- 

X+ 
R+ 

E- E+ ROBOT 
INFORM 

LIST 
AUX      Start Hold Servo On

Ready 

CapsLock A S D F G H J K L ; ‘ Enter         

 Y- 
L- 

Y+ 
L+ 

FAST Y- 
B- 

Y+ 
B+ 

8- 8+ COORD 
DIRECT 
OPEN 

  ENTER         

Shift Z X C V B N M , . / Shift     ↑   

SHIFT Z- 
U- 

Z+ 
U+ 

SLOW Z- 
T- 

Z+ 
T+ 

TEST 
START 

BWD  . Keypad
Display

SHIFT     ↑   

Ctrl Win Alt Space Alt  Ctrl   ← ↓ → 

INTERLOCK   SELECT   INTERLOCK   ← ↓ → 
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5.2.4 NX100 Virtual Pendant

 Virtual Pendant Button

The pendant buttons are the same as those for DX100 virtual pendant.
For details, please refer to the section "Virtual Pendant Button" of the section 5.2.1 "DX200 Virtual 
Pendant" section.

 

Pendant 
Screen 

Pendant 
Keypad 
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 Virtual Pendant Keypad

Keypad key
Keyboard 
Equivalent

Description

Cursor ↑
←→
↓

Moves the cursor in the direction of the arrow.
The size of the cursor and the range/place where the cursor can move 
will vary depending on the window.
If the UP cursor button is pressed when the cursor is on the first line, the 
cursor will move to the last line of the job.  Conversely, if the cursor is on 
the last line of the job and the DOWN cursor button is pressed, the cursor 
will jump to the first line of the job.

• [SHIFT] + UP
Goes back to the previous page.

• [SHIFT] + DOWN
Goes to the next page.

• [SHIFT] + RIGHT
Scrolls the instruction area of the job content or play back 
display to the right.

• [SHIFT] + LEFT
Scrolls the instruction area of the job content or playback 
display to the left.

[SELECT]

Space
Selects menu items such as main menu, pull-down menu, 
etc.

[MAIN MENU]

F1

Displays the main menu.
If this button is pressed while the main menu is displayed, the main menu 
disappears.

[SHIFT] + [MAIN MENU]
While a window opens, the window is switched in the following order:
Window → Sub-menu → Main menu

[SERVO ON 
READY]

Page 
Down

Enables the servo power supply to be turned ON.
Press this button to enable the servo power supply to be turned ON if the 
servo power supply is shut OFF by the emergency stop or overrun 
signal.
When this button is pressed:
• In the play mode, the servo power supply is turned ON if the 

safeguarding is securely closed.
• In the teach mode, the SERVO ON lamp flashes and the servo 

power supply is turned ON when the Enable switch is ON.
• The SERVO ON lamp is lit while the servo power is ON.
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[AREA]

Ctrl

Moves the cursor between “Menu Area” and "General 
Purpose Display Area."
When [SHIFT] is pressed simultaneously:

• [SHIFT] + [AREA]
The language can be switched when the bilingual function is 
valid.  (Bilingual function is optional.)

• DOWN cursor button + [AREA]
Moves the cursor to the operation button on the screen if 
displayed.

• UP cursor button + [AREA]
Moves the cursor to the general-purpose display area when the 
cursor is on the operation button.

[PAGE]

F4

Displays the next page.

[SHIFT] + [PAGE]
The previous page is displayed.

The page can be changed when  appears in the status area on the 

screen.

[DIRECT OPEN]

F7

Displays the content related to the current line.

To display the content of a CALL job or condition file, move the cursor to 
the next line and press [DIRECT OPEN].  The file will be displayed for 
the selected line.  Display content will vary depending on the type of 
instruction used in the job.

Example:
For a CALL instruction, the content of the called job will be displayed.
For a work instruction, the content of the condition file will be displayed.
For Input/output instructions, the input/output condition will be displayed.

[COORD]

F6

Select the operation coordinate system when the 
manipulator is operated manually.
Five coordinate systems (joint, cartesian, cylindrical, tool and user) can 
be used.  Each time this key is pressed, the coordinate system is 
switched in the following order: "JOINT""WLD/
CYL""TOOL""USER"
The selected coordinate system is displayed on the status display area.

[SHIFT] + [COORD]
The coordinate number can be changed when the "TOOL" or "USER" 
coordinate system is selected.

MANUAL SPEED 
keys

D

C

Sets the speed for manual operation.
This speed is also valid for operations with [FWD] and [BWD].
There are four speed levels (slow, medium, fast, and inching).
Each time [FAST] is pressed, manual speed changes in the following 
order: "INCH"" SLOW""MED""FST"
Each time [SLOW] is pressed, manual speed changes in the following 
order: "FST"" MED""SLOW""INCH"
The selected speed is displayed on the status area.

[HIGH SPEED]

E

Changes the speed of axis operation when the axis button 
is pressed. 
The speed of the manipulator will change to high regardless of the 
programmed speed while this key is pressed.
The speed for [HIGH SPEED] is specified in advance.

Keypad key
Keyboard 
Equivalent

Description
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[MOTION TYPE]

P

Selects the interpolation type for playback operation.
The selected interpolation type is shown in the status display area on the 
screen.

Each time this key is pressed, the interpolation type changes in the 
following order:
"MOVJ"" MOVL""MOVC""MOVS"

[SHIFT] + [MOTION TYPE]
The interpolation mode changes in the following order:
"STANDARD"" EXTERNAL REFERENCE POINT"*" CONVEYOR"* 

Interpolation type can be changed in any mode.

*: These modes are purchased options.

[ROBOT]

I

Enables the robot axis operation.

[ROBOT] is active for the system where multiple manipulators are 
controlled by one NX100 or the system with external axes.

[EX.AXIS]

K

Enables the external axis (base axis or station axis) 
operation.

[EX.AXIS] is active for the system with external axes.

Axis Key
Q W   R T
A S   F G
Z X   V B

Moves specified axes on manipulator.
The manipulator axes only move while the key is held down.
Multiple axes can be operated simultaneously by pressing two or more 
keys at the same time.

The manipulator operates in the selected coordinate system at the 
selected manual speed.  Make sure that the selected coordinate system 
and the manual speed are the desired ones before starting the axis 
operation.

[TEST START]

M

Moves the manipulator through taught steps in a 
continuous motion when [TEST START] and [INTERLOCK] 
are simultaneously pressed.
The manipulator can be moved to check the path of taught steps.
The manipulator operates according to the currently selected operation 
cycle: "AUTO," "1CYCLE," or "STEP."
The manipulator operates at the taught speed.  However, if the taught 
speed exceeds the maximum teaching speed, the operation proceeds at 
the maximum teaching speed.
Operation stops immediately when this key is released.

Keypad key
Keyboard 
Equivalent

Description
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[FWD]

U

Moves the manipulator through the taught steps while this 
key is pressed.
Only move instructions are executed (one instruction at a time, no 
welding instructions).

[INTERLOCK] + [FWD]
All instructions except move instructions are executed.

[SHIFT] + [FWD]
Move instructions are executed in succession.

As for the operation of pressing [REFP]  simultaneously, refer to the 
“NX100 Operator Manual”.  
The manipulator operates at the selected manual speed.  Make sure that 
the selected manual speed is the desired one before starting operation.

[BWD]

Y
Moves the manipulator through the taught steps in the 
reverse direction while this key is pressed.
Only move instructions are executed (no weld commands).

[INFORM LIST]

O
Displays instruction lists of commands available for job 
editing.

[CANCEL]

Esc Cancels data input and resets errors.

[DELETE]

H
Deletes registered instructions and data.
Deletion completes when [ENTER] is pressed while this key lamp is lit.

[INSERT]

J
Inserts new instructions or data.
Insertion completes when [ENTER] is pressed while this key lamp is lit.

[MODIFY]

N
Modifies taught position data, instructions, and data.
Modification completes when [ENTER] is pressed while this key lamp is 
lit.

[ENTER]

Enter

Registers instructions, data, current position of the 
manipulator, etc.
When [ENTER]  is pressed, the instruction or data displayed in the input 
buffer line moves to the cursor position to complete a registration, 
insertion, or modification.

Keypad key
Keyboard 
Equivalent

Description
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[SHIFT]

Shift

Changes the functions of other keys by pressing together.
Can be used with [MAIN MENU], [COORD], [MOTION TYPE], cursor 

key, Numeric key, page key  to access alternate functions.
Refer to the description of each key for the alternate [SHIFT] functions.

[INTERLOCK]

F11

Changes the functions of other keys by pressing together.
Can be used with [TEST START], [FWD], Numeric key (Numeric key 
customize function).
Refer to the description of each key for the alternate [INTERLOCK] 
functions.

Numeric Key
0-9

-
.

Enters the number or symbol when the ">" prompt appears 
on the input line.
“.” is the decimal point. “-” is a minus sign or hyphen.
The Numeric keys are also used as function keys.  Refer to the 
explanation of each function for details.

[BACK SPACE]

Back 
space

Deletes the last character while typing characters.

[Multi]

F5

Displays multiple windows.
This function is for future use. (Cannot be used with the NX100 of 
the current version.)

[SHORTCUT]

F2

Displays the shortcut selection dialog box.
This function is for future use. (Cannot be used with the NX100 of 
the current version.)

[ASSIST]

F3

Displays the menu to assist the operation for the 
currently displayed window.
This function is for future use. (Cannot be used with the NX100 of 
the current version.)

Keypad key
Keyboard 
Equivalent

Description
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 Keyboard Layout

The Virtual Pendant keypad key all have a corresponding key on the computer keyboard.  When the 
Virtual Pendant Screen has the input focus, the those keyboard key can be pressed instead of clicking 
the keys on the pendant keypad.

5.2.5 Input with keyboard

In MotoSim EG-VRC, To enter the string, the keyboard is also available.

Procedure

1. Click the [KB] button in the software keypad.

Enter

Enter

Shift

'

→AltSpace

Select →← ↓Area

Ctrl ←Alt

↑

Ctrl Win

.
Keypad
D isplay

↓

Shift

↑

Shift
Z-
U -

Z+
U + SLOW

Z-
T-

Z+
T+ Modify

Test
Start

. /Shift Z X C V B N

Insert

,

Ex.Axis W eld
O N /O FF

M

Servo O n
ReadyHold

Y-
L-

Y+
L+ FAST

Y-
B -

Y+
B + Delete

CapsLock A S D F

StartRobot
Inform
List

M otion
Type

L ;

X-
R-

X+
R+ Bwd Fwd

G H J K

X-
S-

X+
S+

H igh
Speed

\ Delete End
Page
D ow nO P [ ]TAB Q W E R T Y U I

Teach PlayBackspace9 0 -

Page
U p

1 2 3 4 5 6 7 8

Insert HomeBackspace9 0 - =` 1 2 3 4 5 6 7 8

Inter
lock

F11 F12

Cancel
M ain
M enu

Short
C ut

Assist Page Multi Coord
D irect
O pen

F7 F8 F9 F10ESC F1 F2 F3 F4 F5 F6
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2. Enter the string, and click the [OK] button, the inputted string is fixed and the previous screen 
appears. Press the [Cancel button, the inputted string is canceled and the previous screen 

appears.

  Input the job name or folder name

If the gray-out characters as bellow are inputted, the characters are deleted from the inputted string, 
when the inputted string is fixed (when the previous screen appears)

 Input the label name

If the gray-out characters as bellow are inputted, the characters are deleted from the inputted string, 
when the inputted string is fixed (when the previous screen appears).

• The inputted string is not checked. Please make sure not to use the character which can 
not be inputted by the software keyboard.

• The other operation can not used on the input mode. When use the other operation, 
Press the [OK] button or the [Cancel] button to close the input window.

NOTE
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6 Display Operation

The display tool functions help to achieve better visualization enabling text input on the cell window, 
sectional display of models, display mode change, etc.  

6.1 Viewpoint Operation Tools

MotoSim EG-VRC can control the display with the viewpoint operation tool as follows:

6.1.1 Viewpoint Operation with the Mouse

Each viewpoint operation mode is assigned to the button of the mouse.
Drag with the mouse to the up to down or side to side, a viewpoint will change by the viewpoint 
operation mode currently assigned to the button.

The assignment of the viewpoint operation mode is as follows.

Viewpoint Operation Mode Mouse Operation Viewpoint Movement

Parallel
Press-and-hold the scroll 
wheel and drag

Drag the mouse from side to side and 
up and down to synchronize the 
viewpoint with the mouse motion.

Rotate
Press-and-hold the scroll 
wheel and the right button, and 
drag

For vertical rotation, drag the mouse 
up and down; for horizontal rotation, 
drag the mouse from side to side.

Zoom Rotate the scroll wheel

Zoom in and out the image by dragging 
the mouse upward (to zoom in) or 
downward (to zoom out) over the 
screen.

Zoom And Rotate
Press-and-hold the right button 
and drag

Zoom in and out the image by dragging 
the mouse upward (to zoom in) or 
downward (to zoom out) over the 
screen; rotate the image centering on 
the Z-axis of "world" coordinates by 
dragging the mouse from side to side.

Change the viewpoint Press the scroll wheel

Click any desirable point so that the 
image is displayed with the clicked 
point located in the center of the 
screen.

Free Zoom
Press [CTRL] key + Press-
and-hold the right button and 
drag

Drag the mouse over the desired 
range to be enlarged.
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 Right Mouse Button Operation

A pop-up menu for viewpoint operation appears by clicking the right mouse button on the cell window.

6.1.2 Preset Viewpoint Operation 

The camera viewpoint can also be changed to a preset viewpoint.

The most communly used viewpoint are available by clicking on the [Home] tab, in the [View] group 

.
For detail on the preset viewpoint choices please refer to section 5.1.1 "Ribbon". 

Further preset viewpoint choices are available with the View Manager.

 Viewpoint Operation with the View Manager

The View Manager panel allows to quickly change the view point of the scene by selecting one of the 
standard views or user views.  And, +90 degree or -90 degree rotation from the current viewpoint can 
be executed.
The View Manager panel can be displayed by clicking the [Home] tab, in the [View] group, the [View 
Manager] button.
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View Manager

Item Description

[Standard View] buttons Changes the viewpoint to display associated the standard view.

+90 deg. or -90 deg. rotation 
button

Rotates the viewpoint + 90 degree or -90 degree from the current viewpoint.

[Fit view to extends] button Displays all the models in the cell to fit in the view.

[User View] listbox
Double clicking one of the views will display the associated user defined 
view.Clicking the selected view name will enable the edition mode to allow 
renaming the selected view.

[Load] button
Changes the viewpoint displayed on the screen to the user view selected in 
the "User View" listbox.

[Save] button
Saves the current viewpoint displayed on the screen to the user view selected 
in the “User View” listbox.

[Close] button Closes the View Manager panel.

User views definitions are only saved to the file when the cell is saved.

 

Standard View 
buttons 

Enables/disables the 
zoom to extents function 
when a standard view 
button is pressed 

User Views 
listbox 

+90 deg. or -90 
deg. rotation 
button 

NOTE
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 Using Shortcuts

Each view has an associated shortcut key that can be used to recall one of the defined views when the 
input focus is on either the cell display or on the View Manager panel.  Pressing one of the numeric 
keys (1... 9, 0) will load the corresponding user view; the "0" key is used for the 10th user view.  The first 
letter of the standard view name is used (.e.i. "T" for the Top view, "F" for the Front view...), the letters 
are indicated on the buttons of the View Manager panel.  The keys "I", "O", "J" and "K" are used for the 
four isometric views.

 Smooth Transition

The viewpoint can be changed with or without smooth transition function by setting the display as 
follows:

Smooth transition ON (smooth transition checked in the menu):
• The viewpoint changes as the image continuously moves.

• For the duration setting, click the MotoSim EG-VRC button (  ), and select the 

[Options] menu.

Smooth transition OFF (smooth transition unchecked in the menu):
• The viewpoint changes instantaneously.
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6.2 Light Manager Operation

The Light Manager panel allows to add or remove lights and to modify the settings or each light.  In 
addition to the default light, up to 4 additional lights can be added.
On the [Home] tab, in the [Screen] group, click the [Light Manager] button, the [Light Manager] dialog 
appears.

Light Manager

Intensity

Adjusts the intensity of the lights.
Sliding the control toward the left will reduce the general lighting of the scene.  
Sliding the control toward the right will increase it.
(The standard intensity is 100)
All the lights are affected by this control.

Light No.
Selects a light for operations.
The properties of the currently selected light are displayed in the Light 
Property section.

Add

Adds a new light.
To complete the operation, click on the main view to position the light.  A light 
object will be displayed to indicate the location of the light.  Up to 4 lights can 
be added.  For more details please refer to the section "Adding and Modifying 
Lights" and section "Light Sources" sections.

 

Pressing the [Shift] key 
enables or disables the 
Pick Light Position with 
Mouse function. 

Selects the light to be 
modified. 

Set the properties of the 
selected light.  Note that only 
the color can be changed for 
the “Default” light. 

Light intensity adjustment. 
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Remove
Deletes the currently selected light.
Note that the "Default" light cannot be deleted.

Pick Light Position with Mouse

When checked, clicking on the main view will move the position of the light to 
the clicked position.  (When unchecked, clicking the main view doesn't 
change the light position and allows view point change operation.)
Pressing the [Shift] key toggles the Pick Light Position with Mouse check 
mark.

Light Property

[On / Off]
  [Off] : The selected light is turned off.  But, the light is not erased, the 
           settings remains valid.
  [On] : The selected light is turned on.
[Type]
  Distant Light  : Light rays are all parallel (coming from an infinite distance)
  Local Light    : Omni directional rays coming from the light source 
                        point (light marker). 
  Spot Light     : Cone shaped directional rays coming from the light   
                        source point (light marker).
  For more detail, please refer to the section "Light Sources" section.
[Color]
  The color of the light is displayed in the rectangle.
[Change]
  Displays the Color Dialog to change the color of the light.

OK

Closes the Light Manager panel.The lights information will be save to the cell 
file when the cell is saved.
The light markers in the main view will disappear when Light Manager is 
closed.  To display the light markers again, reopen the Light Manager panel.

Cancel
Cancels the light setting modifications and closes the Light Manager panel. 
The light markers in the main view will be deleted.

• To preserve the light settings for next time the cell is opened, the cell needs to be saved 
after the light settings are changed.

• When exporting files (i.e. html format), changing the light settings don't affect the 
resulting exported file.

Light Manager

NOTE
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 Adding and Modifying Lights

Operation Procedure

1. Press the [Add] button.  The properties of the newly added light will display in the Light Property 
section. (At this stage, the light source still isn't created.)

2. Click on the main view to position the light.  The light will be created and a light marker will be dis-
played to indicate the location of the light.
The light location and type can be confirmed by looking at the light marker in the main view.

 

 

Light Marker 
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The lighting of the cell will change to reflect the new light influence.

As long as the [Pick Light Position with Mouse] is checked, clicking on the main view will move the light to the 

clicked position.  Other items can be changed in the Light Property section.

Note that a maximum of 4 lights can be added to the cell.

3. To modify existing light, first select the "Light No." and then change the settings in the "Light 
Property" section.

4. Press [OK] or [Cancel] to close the Light Manager panel.
When the Light Manager is closed the light markers in the main view will disappear.  To display the 
light markers again, reopen the Light Manager panel.

 Deleting Lights

Select the light number.  Press the [Remove] button to remove the light.
Note that the "Default" light cannot be deleted. 

To preserve the light settings for next time the cell is opened, the cell needs to be saved 
after the light settings are changed.

  

NOTE
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 Light Sources

Default

Directional light constantly attached to the viewpoint.  The initial light color is white.

 

 

 

 

Result after changing the 
light color 

The FLOOR model is not affected
by light change and will always
display the same way. 
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The light reflection and intensity of the whole scene can be modified by adjusting the "Intensity" value.

Distant Light

Light is emitted from a infinite distance so that all the 
rays are parallel.Light type for general use.
The light direction is from the clicked position toward 
the viewpoint center.

Intensity:       100     75      50 

    

 

 
 

 

Distant Light Marker 
(Located at the clicked position)
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Local Light

Spot Light

Light is emitted in all direction from the light position.
Useful for generating light from a given point.

Light is emitted in a specific direction forming a cone from the light position in a cone 
shape. Useful to illuminate a specific face of a part.
The light direction is from the clicked position toward the viewpoint center.  
For proper illumination of a model or a face, it may be necessary to relocate the 
viewpoint center on the intended target before setting the light position.
Viewpoint center can be moved with click on the mouse wheel.

 

Local Light Marker 
(Located at the clicked position) 

 

 
Spot Light Marker 
(Located at the clicked position) 
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6.3 Displaying Shadows

Shadows can be displayed for the models on the screen.
Since the shadows are not easily visible when the floor is displayed, use the shadow with the opacity of 
floor image decreased (approx. to 0.5 or less), or hide the floor image. 
For the detailed setting of shadow, refer to section 12.1.4 "Shadow".
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6.4 Pick Settings

The Pick settings influence the selection of objects when picking object in the cell view with the mouse.

 Pick Mode Setting

The Pick Mode sets conditions determining the selected point in the clicked area.

Procedure

On the [Home] tab, in the [Pick] group, click the [Pick Mode] button, and select one of the following 

items.   

• Free: Selects the point of the model corresponding to the clicked position.

• Vertex: Selects the model vertex nearest to the clicked position.

• Center: Selects the face or edge center nearest to the clicked position.  Note that in order 
to select the center of the cylindrical model, select the model using [Vertex] 
instead of [Center].

• Edge Selects the edge point nearest to the clicked position.

That these settings are also linked to the same settings available in the OLP dialog.NOTE
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 Pick Object Setting

Pick object set filters on the type of objects that can be selected by the mouse pick. 

Procedure

On the [Home] tab, in the [Pick] group, click the [Selectable Object] button, and select one of the 
following items.   

• Models: Solid models.

• Frames: Model frame or AXIS6 models. (Note: The model frame needs to be visible to be 
selected.)

• Lines &  
lnters:

Lines such as LINE part, WORK line and wireframe model, and intersection lines 
generated by the intersection of parts or models.  
(Note the intersection lines are displayed during the pick operation when the left 
mouse button is pressed down.  In cells with many detailed models, the 
intersection generation may slow down the pick function response.  In such case, 
you may uncheck this item to improve performance.) 

• Points: Points such as TRACE points.

• Floor: FLOOR parts. (Note: FLOOR parts tend to interfere selection depending on the 
viewpoint, therefore their selection is managed independently from other models.)

That these settings are also linked to the same settings available in the OLP dialog.NOTE
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 Pick method and screen display

When the mouse pointer is over the cell view, press down the left mouse button.  The model considered 
for selection will display in yellow with a red dot to indicate the specific point location.  The display will 
update to represent change of selection as the mouse pointer is moved over different models.  The 
actual selection is made only when the mouse button is released.

 

   

Picked point
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6.5 Markup

Graphic forms (such as circles, rectangles) and text can be temporarily drawn on the cell window.

6.5.1 Freehand

This section explains on how to draw a free-form line.  

Procedure

1. Set the viewpoint of the window.  (This step must be done first since the line will be deleted 
when the viewpoint is changed.)

2. On the [Home] tab, in the [Screen] group, click the [Make-up] button, and select [Free Hand].

Position the mouse pointer at a desired point, and drag the mouse freely so that the mouse 
pointer on screen draws a line with the mouse movement. 

Click the MotoSim EG-VRC button (  ), and select the [Options] menu to set the color and 

thickness of the line.  Refer to section 12.2 "Markup Settings" for details.   

The line drawn on the cell is deleted by changing the viewpoint of the window.NOTE
6-64

HW0485348
141 of 671



6  Display Operation
6.5  Markup

156225-1CD
6.5.2 Circle

This section explains on how to draw a circle.  

Procedure

1. Set the viewpoint of the window.  (This step must be done first since the circle will be deleted 
when the viewpoint is changed.)

2. On the [Home] tab, in the [Screen] group, click the [Make-up] button, and  select [Circle].

Position the mouse pointer at a desired point, and drag the mouse: a circle is drawn centering 
around the point where the mouse started dragging. 

Click the MotoSim EG-VRC button (  ), and select the [Options] menu to set the color and 

line thickness of the circle.  Refer to section 12.2 "Markup Settings" for details.   

The circle drawn on the cell is deleted by changing the viewpoint of the window.NOTE
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6.5.3 Rectangle

This section explains on how to draw a rectangle.  

Procedure

1. Set the viewpoint of the window.  (This step must be done first since the rectangle will be 
deleted when the viewpoint is changed.)

2. On the [Home] tab, in the [Screen] group, click the [Make-up] button, and  select [Rectangle].

Position the mouse pointer at a desired point, and drag the mouse: a rectangle is drawn from 
the point where the mouse started dragging. 

Click the MotoSim EG-VRC button (  ), and select the [Options] menu to set the color and 

line thickness of the rectangle.  Refer to section 12.2 "Markup Settings" for details.   

The rectangle drawn on the cell is deleted by changing the viewpoint of the window.NOTE
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6.5.4 Notes

This section explains on how to add a note.  

 Adding a Note

Procedure

1. Set the viewpoint of the window.  (This step must be done first since the note will be deleted 
when the viewpoint is changed.)

2. On the [Home] tab, in the [Screen] group, click the [Make-up] button, and  select [Notes].

Click any point on the window where to add notes; a "Note" indication appears at the clicked 
point.  Right-click the “Note” to open a pop-up menu, and select {Edit} to enter texts.   

The note added on the cell is deleted by changing the viewpoint of the window.NOTE
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3. Click on [OK] after entering the texts.  
Click the MotoSim EG-VRC button (  ), and select the [Options] menu to set the font and 
color of the text.  Refer to section 12.2 "Markup Settings" for details.  

 Deleting a Note

Select the note to be deleted, and right-click it.  Select {Delete} from the pop-up menu to delete the text.

 Relocating a Note

Drag a note to a different location with on the [Home] tab, in the [Screen] group, click the [Make-up] 
button, and  selected [Notes].
Note that the arrow remains at the same point.

• The note added on the cell is deleted by changing the viewpoint of the window.
• When adding two-byte characters, use a font that properly displays two-byte characters.

NOTE
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6.6 Memo

This section explains on how to create a memo (text).  

 Creating a Memo

Procedure

1. On the [Home] tab, in the [Screen] group, click the [Memo] button.

Click the desired model and drag the mouse to the desired memo location; a "Memo" indication 
with an arrowed line appears at the position where the mouse button is released after dragging.    

2. Right-click “Memo” to open a pop-up menu, and select {Edit} to enter texts.   

Non-displayed model or the point where there is no model cannot be selected as a subject 
for the memo indication whereas any point of the model displayed on the window can be 
selected for the memo indication.

Memo

NOTE
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3. Enter texts, and click on [OK].  
Click the MotoSim EG-VRC button (  ), and select the [Options] menu to set the font and 
color of the texts.  Refer to section 12.2 "Markup Settings" for details.  

 Deleting a Memo

Select a memo to be deleted, and right-click it.  Select {Delete} from the pop-up menu to delete the 
memo with the arrowed line.

 Relocating a Memo

Drag a note to a different location with on the [Home] tab, in the [Screen] group, click the [Make-up] 
button, and  selected [Memo].
Note that the arrow remains at the same point.

When adding two-byte characters, use a font that properly displays two-byte characters.NOTE
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6.7 Cutting Planes

This section explains on how to display cross sections that are perpendicular to the X-, Y-, Z-axes 
directions in the cell window.  

6.7.1 X-Cutting Planes

With this command, the X-cutting plane (a cutting plane which is perpendicular to the X-axis direction in 
the window) can be displayed as shown in the following figure:

 Displaying the X-Cutting Plane

When the X-cutting plane is not displayed.On the [Home] tab, in the [Screen] group, click the [Cutting 
Plane] button, and select [X]  

 Deleting the X-Cutting Plane

When the X-cutting plane is displayed.On the [Home] tab, in the [Screen] group, click the [Cutting 
Plane] button, and select [X]  

 

 

Shifted in parallel in the X-axis 
direction.

Rotated centering on the Z-axis

Rotated centering on the Y-axis
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 Changing Display of the X-Cutting Plane

Drag the tools  to on the figure above to rotate the X-cutting plane centering on the Y- or Z-axis, or 
shift it in a direction parallel to the X-axis.  

6.7.2 Y-Cutting Planes

With this command, the Y-cutting plane (a cutting plane which is perpendicular to the Y-axis direction in 
the window) can be displayed as shown in the following figure:

 Displaying the Y-Cutting Plane

When the Y-cutting plane is not displayed.On the [Home] tab, in the [Screen] group, click the [Cutting 
Plane] button, and  select [Y]  

 Deleting the Y-Cutting Plane

When the Y-cutting plane is displayed.On the [Home] tab, in the [Screen] group, click the [Cutting 
Plane] button, and  select [Y]  

 Shift the X-cutting planes in a direction parallel to the X-axis.

 Rotate the X-cutting planes centering on the Y-axis.

 Rotate the X-cutting planes centering on the Z-axis.

 

 Shifted in parallel in the Y-axis 
direction.

Rotated centering on the Z-axis

Rotated centering on the X-axis
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 Changing Display of the Y-Cutting Plane

Drag the tools  to  on the figure above to rotate the Y-cutting plane centering on the X- or Z-axis, 
or shift it in a direction parallel to the Y-axis.  

6.7.3 Z-Cutting Planes

With this command, the Y-cutting plane (a cutting plane which is perpendicular to the Z-axis direction in 
the window) can be displayed as shown in the following figure:

 Displaying the Z-Cutting Plane

When the Z-cutting plane is not displayed.On the [Home] tab, in the [Screen] group, click the [Cutting 
Plane] button, and  select [Z]  

 Deleting the Z-Cutting Plane

When the Z-cutting plane is displayed.On the [Home] tab, in the [Screen] group, click the [Cutting 
Plane] button, and  select [Z]  

 Shift the Y-cutting plane in a direction parallel to the Y-axis.

 Rotate the Y-cutting plane centering on the X-axis.

 Rotate the Y-cutting plane centering on the Z-axis.

Shifted in parallel in the Z-axis 
direction.
Rotated centering on the Y-axis

Rotated centering on the X-axis
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 Changing the Z-Cutting Plane

Drag the tools  to  on the figure above to rotate the Z-cutting plane centering on the X- or Y-axis, 
or shift it in a direction parallel to the Z-axis.  

 Shift the Z-cutting plane in a direction parallel to the Z-axis.

 Rotate the Z-cutting plane centering on the X-axis.

 Rotate the Z-cutting plane centering on the Y-axis.
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6.8 Measure Distance

Click 2 points to measure the distance between them.  

Procedure

1. On the [Home] tab, in the [Measurement] group, click the [Distance] button.

2. Click with the mouse any 2 points on models. (Blue dots on the clicked positions and a blue line 
joining the points will appear.)  The Measure Distance dialog will display with the measurement 

results.

Measure Distance dialog

Copy Copies the measurement result to the clipboard.

Close Closes the Measure Distance dialog.

When clicking in an area the selected point depends on the current "Pick Mode" and "Pick 
Object" settings.  Please refer to section 6.4 "Pick Settings" for details.

Coordinate of the 1st point

Coordinate of the 2nd point

Difference between 
the 2 points  

NOTE
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6.9 Measure Angle

Click 3 points to measure the angle between them.  

Procedure

1. On the [Home] tab, in the [Measurement] group, click the [Angle] button.

2. Click with the mouse any 3 points on models. (Blue dots on the clicked positions and blue lines join-

ing the points will appear.)  The Measure Angle dialog will display with the measurement results.

Measure Distance dialog

Copy Copies the measurement result to the clipboard.

Close Closes the Measure Angle dialog.

When clicking in an area the selected point depends on the current "Pick Mode" and "Pick 
Object" settings.  Please refer to section 6.4 "Pick Settings" for details.

Coordinates of the 3 points

Angle between the 2 lines 
linking the 3 points  

NOTE

 

This angle.
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6.10 Measure Line

With this command, a dimension line can be created as shown in the figure below.  

 Creating a Dimension Line

Procedure

1. On the [Home] tab, in the [Mesurement] group, click the [Measure Line] button.

2. Click a model and drag; a dimension line with two-headed arrow appears where the mouse is 
dragged across, displaying the dimension between the both ends.  

 Deleting a Dimension Line

Select a dimension to be deleted, and right-click it.  Select {Delete} from the pop-up menu to delete the 
dimension with the dimension line.

 Relocating a Dimension Line

Drag a note to a different location with on the [Home] tab, in the [Measurement] group, click the 
[Measure Line] button.
Note that the arrow remains at the same point.

• Non-displayed model or the point where there is no model cannot be selected as a 
subject for the dimension line indication whereas any point of the model displayed on the 
window can be selected for the dimension indication.

• When clicking in an area the selected point depends on the current "Pick Mode" and 
"Pick Object" settings.  Please refer to section 6.4 "Pick Settings" for details.

NOTE
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6.11 Changing the Rendering Mode

On the [Home] tab, in the [Screen] group, click the [Rendering Mode] button, the display mode can be 

change..  

Flat Shading

The image displayed in flat shaded rendering mode:  

Gourand Shading

The image displayed in Gourand shaded rendering mode:  

Wire Frame

The image displayed in wire frame:  

• The cell is displayed in "GourandShading" mode when it is opened.
• For edition, select desired mode from "FlatShading", "GourandShading", or "Wireframe".

SUPPLE
-MENT
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6.12 Other Display Operations

6.12.1 Changing Frame Width

Modify the frame line width for better visualization on the display. 
Refer to section 12.1.5 "Frame & AXIS6" to set the frame length.

Procedure

On the [Home] tab, in the [Screen] group, click the [Line Size] button, and select the frame width from 
{Small}, {Medium}, or {Large}.

6.12.2 Copying the Image

Copy the static image of the cell window: the copied data can be used in other application software by 
pasting it.

Procedure

Display the cell to be copied.  On the [Home] tab, in the [Tools] group, click the [Copy] button, or hold 
down the Ctrl key and press the C key.

6.12.3 Dividing a Cell Window

A cell window can be divided up to four views by dragging a separator of the vertical or horizontal scroll 
bar in the cell window.  This function provides users with different viewpoint angles, enabling teaching 
or playback operations viewed from several directions.

         

Drag here.
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6.12.4 Printing the Image

MotoSim EG-VRC does not have any printing function.  
On the [Home] tab, in the [Tools] group, click the [Copy] button, or hard-copy the screen (Alt + Print 
Screen), and paste it to another application.
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7 Controller and Robot Settings

MotoSim EG-VRC allows many robot and controller operations, such as adding, deleting, etc. 
This chapter describes operation related to setting controllers and robots

7.1 Adding a New Controller

A single controller may have one or more control group representing robot, base station or external 
stations. Then, there are 2 ways to create the environment. One is to recreate the system configuration 
in the MotoSim EG-VRC with the "CMOS.BIN" file saved from a real controller. The "CMOS.BIN" file 
contains all the information defining a controller and its robots. The other is to create the "CMOS.BIN" 
file in the MotoSim EG-VRC.

On the [Controller] tab, in the [Setup] group, click the [New] button, the new controller can be created.

There are 2 ways to proceed depending on the presence or absence of the "CMOS.BIN" file.
• If there is not the "CMOS.BIN" file (the "CMOS.BIN" file is created in the MotoSim EG-

VRC), proceed to section 7.1.1 "Create a New VRC Controller (no file)".
• If there is the "CMOS.BIN" file (the "CMOS.BIN" file is taken from a real controller), 

proceed to section 7.1.2 "Create VRC Controller (using CMOS.BIN file or ALL.PRM file)".

Note that a controller that has already been created by MotoSim EG-VRC cell can be simply copied into 
the cell.  To do so, please refer to section 7.2 "Copying a Controller from another Cell".

In regard to the FS100 controller, the "CMOS.BIN" file saved from a real controller can not 
be used with MotoSim EG-VRC to create the environment.

NOTE
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7.1.1 Create a New VRC Controller (no file)

Create a new controller and define a system in MotoSim EG-VRC.

Procedure

1. On the [Controller] tab, in the [Setup] group, click the [New] button.  To display the “Create 
Controller” dialog. Select “New VRC Controller (no file)” and press the [OK] button. 

2. The "New Controller" dialog box appears.  Select the controller type and then the system 
version from the list below.  If desired you may change the default name for the controller.  Click 

the "OK" button.

• When ECD80D-A00 (NX100) is registered, select the following controller certainly. That 
robot model is only used with the following controller system version.

[Controller Type] NX100
[System Version] NS 4.69-A5

• The expanded memory option is not supported for the FS100 controller.

Check the Expanded Memory check 
box, construct the controller with the 
expanded memory.  
Uncheck this check box, construct the 
controller with the standard memory. 
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3. New controller dialog for the selected controller version is displayed.
When executes standard setting, set the "Language", "Control Group" and "Application" and 
press the [Standard Setting Execute] button. Proceed the step 5 next.When executes setup on 
maintenance mode of controller, press the [Maintenance Mode Execute] button. Proceed the 

step 4 next.

4. The controller will launch with the selected system version and display the Virtual Pendant in 
maintenance mode.  (This may take a few moments.)  At the same time, the “Controller 
Maintenance Mode”  Instruction Guide will appear.
Since there is no CMOS.BIN file, it is necessary to initialize the controller with the Virtual 
Pendant in order to define the system (language, robot, application...).  
To do so:

• Initialize the controller
• Once the controller initialization is completed, click on the “Finish” button of the Instruction 

Guide to reboot.
For details how to proceed to set initialize the controller, follow the procedure described in the 
“Instruction Guide” or refer to the section 7.1.3 "Initializing the Controller (DX200, DX100, 
NX100)" sections that follow later in this chapter.

• When the controller is "FS100", "Application" of Standard Setting cannot be set.
• When the controller system version is "NS4.69-A5", Standard Setting is not supported.
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5. The Virtual Pendant will close and reboot in normal mode.  (This may take a few moments.)  
The “Robot Setting” dialog will display.  A default robot name and model file should be pre-
entered.  If required, enter a name for the robot and select a robot model file corresponding to 
the robot type.  (In the example below, the robot model is “VA01400-A00” the corresponding 
model is “VA01400-A00.mdl”.)  Robot models are found in the “Robot” folder under 
MotoSimEG-VRC install folder.  Click the [OK] button.  

6. The robot will display with the selected model file.

When initialized the robot controller, MotoSim EG-VRC set the absolute data 
automatically. So absolute setting is not needed in MotoSim EG-VRC. 
Refer to section 7.1.4 "Initializing the Controller (FS100)" for details.
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7.1.2 Create VRC Controller (using CMOS.BIN file or 
ALL.PRM file)

Reproduce an existing system composition in MotoSim EG-VRC using the "CMOS.BIN" file or 

"ALL.PRM" file saved from a real system.

Procedure

1. On the [Controller] tab, in the [Setup] group, click the [New] button.  To display the “Create 
Controller” dialog. Select “VRC Controller (using file)” and press the [OK] button. 

2. The “Open” dialog box appears.  Select the CMOS.BIN file  or “ALL.PRM” file to be used to 
create the controller, and click [Open].

• In regard to the FS100 controller, the "CMOS.BIN" file saved from a real controller can 
not be used with MotoSim EG-VRC to create the environment.

• In regard to the NX100 controller, the "ALL.PRM" file saved from a real controller cannot 
be used with MotoSim EG-VRC to create the environment.
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3. The "New Controller" dialog box appears. If desired you may change the default name for the 
controller. Select the system version from the list below that corresponds to the version of 
system from which came the "CMOS.BIN" or “ALL.PRM” selected in step 2, and click the 
"OK" button. When the kind of controller corresponding to "CMOS.BIN" or “ALL.PRM” 
cannot be detected automatically, the controller type can be selected. Please select the 
controller type.

4. The Virtual Pendant will close and reboot in normal mode.  (This may take a few moments.)  
The “Robot Setting” dialog will display.  A default robot name and model file should be pre-
entered.  If required, enter a name for the robot and select a robot model file corresponding to 
the robot type.  (In the example below, the robot model is “VA01400-A00” the corresponding 
model is “VA01400-A00.mdl”.)  Robot models are found in the “Robot” folder under 
MotoSimEG-VRC install folder.  Click the [OK] button.  

When ECD80D-A00 (NX100) is registered, select the following controller certainly. That 
robot model is only used with the following controller system version.

[Controller Type] NX100
[System Version] NS 4.69-A5
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5. The robot will display with the selected model file.
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7.1.3 Initializing the Controller (DX200, DX100, NX100)

Using the virtual pendant in maintenance mode, the system of controller (language, robot, 
application…) can be set.

Procedure

1. Select {SYSTEM} - {INITIALIZE} from the main menu.

  

2. In the “LANGUAGE” screen, select a language for LANGUAGE1 and LANGUAGE2. 

A series of configuration screen will display to configure the controller.  Press [ENTER] to 
go to the next screen.  Press the [Esc] key on the keyboard or [CANCEL] on the pendant 
keypad to go back to the previous screen. 

To change a field, move the cursor over that field with the arrow keys and then select it by 
pressing the [Space] key on the keyboard or by clicking the [Select] button on the pendant 
keypad.  Depending on the field, either select a value from the list of choices; or enter the 
required value and press [ENTER]  to register the value.

The Virtual Pendant interface can change between the set languages by pressing the 
[SHIFT] key on the keyboard and clicking the [AREA] key on the pendant keypad.  

NOTE

NOTE
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3. In the “CONTROL GROUP” screen, define the control groups by selecting the manipulator 
connector to the each group.  “R” groups are for robot, “B” groups are for robot base station and 
“S” groups are for external axis devices.  When the selection is complete, press [ENTER] to go 
to the next screen.

4. The “CONNECT” screen doesn’t need any change.  Press [ENTER] to go to the next screen.

• The robot models supported by MotoSim EG-VRC are those displayed on the virtual 
pendant for the controller version selected at the time of creation.  Please refer to section 
section 15.7 "List of Manipulator Models and Offset Values Supported by MotoSim EG-
VRC" for the list of available model. However, for similar robot model that only have 
differences in the details of their shape, it maybe possible to do simulation using the 
standard robot model (model ending with A0*).

• When ECD80D-A00 (NX100) is registered, select the following controller certainly. That 
robot model is only used with the following controller system version.

[Controller Type] NX100
[System Version] NS 4.69-A5
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5. In the “APPLICATION” screen, select the application that correspond best to what the robot will 
be doing.

6. The “OPTION BOARD” screen doesn’t need any change.  Press [ENTER] to go to the next 
screen.

7. The “I/O MODULE” screen is only for confirmation and I/O modules selection cannot be 
changed at this step.  Press [ENTER] twice to go to the next screen.  To add I/O modules 
please refer to section 13.4 "Adding I/O Board Module".
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8. The “CMOS MEMORY” screen cannot be modified.  Press [ENTER] to go to the next screen.

9. The “DATE/TIME SET” screen cannot be modified.  Press [ENTER] to go to the next screen.

10. A confirmation dialog box will appear, select [YES] to start initializing the CMOS data. Then, the 
message "Initializing system data. Don't turn the power off." is displayed at the bottom of the 
virtual pendant. Don't operate anything while that message is displayed. If the initialization is 
finished, the message is changed to "Maintenance Mode".
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7.1.4 Initializing the Controller (FS100)

Using the virtual pendant in maintenance mode, the system of controller (language, robot, 
application…) can be set.

Procedure

1. Select {SYSTEM} - {INITIALIZE} from the main menu.

2. In the "LANGUAGE" screen, select a language for LANGUAGE1 and LANGUAGE2. When the 

selection is completed, press [ENTER] to go to the next screen.

A series of configuration screen will display to configure the controller.  Press [ENTER] to 
go to the next screen.  Press the [Esc] key on the keyboard or [CANCEL] on the pendant 
keypad to go back to the previous screen. 

To change a field, move the cursor over that field with the arrow keys and then select it by 
pressing the [Space] key on the keyboard or by clicking the [Select] button on the pendant 
keypad.  Depending on the field, either select a value from the list of choices; or enter the 
required value and press [ENTER]  to register the value.

The Virtual Pendant interface can change between the set languages by pressing the 
[SHIFT] key on the keyboard and clicking the [AREA] key on the pendant keypad.  

NOTE

NOTE

NOTE
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3. In the "CONTROL GROUP" screen, define the control groups by selecting the manipulator 
connector to the each group. "R" groups are for robot, "B" groups are for robot base station and 
"S" groups are for external axis devices. When the selection is completed, press [ENTER] to go 

to the next screen.

4. The "CONNECT" screen doesn't need any change. Press [ENTER] to go to the next screen.

5. The "IO MODULE" screen doesn't need any change. Press [ENTER] to go to the next screen.

The robot models supported by MotoSim EG-VRC are those displayed on the virtual 
pendant for the controller version selected at the time of creation.  Please refer to section 
15.7 "List of Manipulator Models and Offset Values Supported by MotoSim EG-VRC" for 
the list of available model. However, for similar robot model that only have differences in 
the details of their shape, it maybe possible to do simulation using the standard robot 
model (model ending with A0*).

NOTE
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6. The "SENSOR FUNCTION ALLOCATION" screen doesn't need any change. Press [ENTER] to 
go to the next screen.

7. The "EXTERNAL IO ALLOCATION(INPUT)" screen doesn't need any change. Press [ENTER] 
to go to the next screen.

8. The "EXTERNAL IO ALLOCATION(OUTPUT)" screen doesn't need any change. Press 
[ENTER] to go to the next screen.

9. The "CMOS MEMORY" screen doesn't need any change. Press [ENTER] to go to the next 
screen.
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10. The "DATE/TIME SET" screen doesn't need any change. Press [ENTER] to go to the next 
screen.

11. A confirmation dialog box will appear, select [YES] to start initializing the CMOS data. Then, the 
message "Initializing system data. Don't turn the power off." is displayed at the bottom of the 
virtual pendant. Don't operate anything while that message is displayed. If the initialization is 
finished, the message is changed to "Maintenance Mode"

7.1.5 Defining the Robot Home Position

When initialized the robot controller, MotoSim EG-VRC set the absolute data automatically. So absolute 
setting is not needed in MotoSim EG-VRC. (This setting should be needed in real robot.)
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7.2 Copying a Controller from another Cell

A controller already define in a MotoSimEG-VRC cell can be copied over to another cell.

Procedure

1. On the [Controller] tab, in the [Setup] group, click the [Copy] button.

2. The “Open” dialog box appears.  Select the VRC.BIN file located in the controller folder (folder 
bearing the name of the controller) of a MotoSimEG-VRC cell, and click [Open].

3. The “Add Controller” dialog box appears.  Enter a name for the controller.  The “File Name” field 
already contains the path to the VRC.BIN selected in step 2 above.  Click [OK].  The controller 
and robot files will be copied over to the current cell folder and the controller will boot in normal 
mode.  This may take a few moments.
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4. When the controller has completed its boot up, the “Robot Setting” dialog will display.  Default 
robot name and model file should be pre-entered.  If required, they may be modified.  Click the 
[OK] button.  

5. The robot will display with the selected model file.
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7.3 Deleting a Controller

To delete the controller and its associated robots from a cell, follow the procedure below. 

Procedure

1. On the [Controller] tab, in the [Setup] group, click the [Delete] button.

2. The “Select Controller/Robot” dialog box appears.  Select the controller to be deleted, then click 
on [OK].

  

3. The confirmation message below will appear.  Select [Yes] to remove the controller from the 

cell.

The controller is removed from the cell but its corresponding folder and files are 
not deleted from the cell folder.
A delete controller may be added later on by using the “Copy Controller...” menu.  
(For details refer to section 7.2 "Copying a Controller from another Cell") 

NOTE
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7.4 Select Controller

A cell always have an active controller .  
Simply click on the down arrow to display the list of controllers  and select the desired controller. (See 
figure below)
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7.5 Controller Setting

7.5.1 Tool Editor

The Tool Editor is used to select the active tool and to modify the tool data.
On the [Controller] tab, in the [File Settings] group, click the [Tool Data] button, the [Tool Editor] dialog 
appear.

Select the tool number, and then, if required, modify the tool data by using the spin button  at the side 
of each edit box or entering a value directly.  The tool data can also be changed by checking the [Pick 
Enable] check box and clicking in the cell window.

• In a cell with multiple controllers, it is necessary to select the controller to edit with the 

ribbon   before opening the Tool Editor dialog box.

• In order to change the Tool No., the controller must be set to operate with multiple tools.  
Use the following parameter to activate the multiple tool function on the controller:

DX200, DX100, FS100
             S2C431:  Tool number change (0: Single tool, 1: Multiple tool)
NX100  S2C333:  Tool number change (0: Single tool, 1: Multiple tool)

For more detail please refer to the "Tool Coordinates" section of the controller 
"Operator's Manual".

• To change the tool selection and tool data using the virtual pendant, please refer to the 
"Tool Coordinates" section of the controller "Operator's Manual".

NOTE

 

 

Robot name 

Incremental value of the  

Tool Number 

Selected controller
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 Setting the Tool Load Information

Tool Editor dialog box extends to show the tool load information as follows when [Exp. >>] button is 
selected.

Tool Editor Dialog Box

Item Description

[OK] button Closes the dialog box after modifying the tool data.

[Cancel] button Closes the dialog box without modifying the data to the new values.

[Apply] button Modifies the tool data; does not close the dialog box.

[Pick Enable]
     check box

Enables mouse picking operation to move the tool center point to the clicked 
position.
When clicking in an area the selected point depends on the current "Pick 
Mode" and "Pick Object" settings. Please refer to section 6.4 "Pick Settings" 
for details.
Pressing the [Shift] key enables or disables the [Active] checkbox.

[Exp >>] button Displays tool load information, enabling data setting.
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7.5.2 User Frame

The Set User Frame dialog box is used define user coordinate system or delete existing ones.
On the [Controller] tab, in the [File Settings] group, click the [User Frame] button, the [Set User Frame] 

dialog appear.

• In a cell with multiple controllers, it is necessary to select the controller to edit with the 

ribbon  before opening the Set User Frame dialog box.

• To change the user coordinate selection and the coordinate system definition using the 
virtual pendant, please refer to the "User Coordinates" section of the controller 
"Operator's Manual".

• Master tool user coordinate can be edited the values only. New master tool user 
coordinate can not be created in this dialog. When select the existing master tool user 
coordinate, robot name is gray out.

Set User Frame Dialog Box

Item Description

[Add] button Create a coordinate system for the selected user frame number.

[Delete] button Delete the coordinate system of the selected user frame number.

[Pick Enable]
     check box

Enables mouse picking operation to move the user frame.
When clicking in an area the selected point depends on the current "Pick 
Mode" and "Pick Object" settings. Please refer to section 6.4 "Pick Settings" 
for details.
Pressing the [Shift] key disables, enables, and 3 point the [Active] checkbox.

[Pick 3 Points]
check box

Enables 3 points picking operation to move the user frame.
When clicking in an area the selected point depends on the current "Pick 
Mode" and "Pick Object" settings. Please refer to section 6.4 "Pick Settings" 
for details. Pressing the [Shift] key disables, [Pick Enable] checkbox, enables 
and [Pick 3 points] checkbox.

NOTE

 
 

 

User Frame Number 

Selected Controller

Incremental value of the  

Robot Name 
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Procedure

1. Select the user frame number to be edited with the top left combobox.
2. If the selected UF#2 doesn't already exist, press to the [Add] button.
3. Check the [Pick Enable] or [Pick 3 points] check box, and then left-click with the mouse on the 

cell window to move the user frame.
• [Pick Enable]

Check the [Pick Enable] checkbox, and then left-click with the mouse on the cell window to 
move the user frame to the clicked position.

• [Pick 3 points]
Check the [Pick 3 points] checkbox, and then left-click with the mouse on the cell window to 
move the user frame to the clicked position. Next, left-click with the mouse on the cell win-
dow to define the X-axis direction. Finally, left-click with the mouse on the cell window to 
define the XY-plane. Then the user frame is shown.

4. If necessary, set the axis values to move the user frame.
5. Press [OK] to save the user frame settings.

7.5.3 Reboot Controller

Some operation perform in the Virtual Pendant such as parameter changes may require to reboot the 
controller in order for the change to be affective.  
On the [Controller] tab, in the [Boot] group, click the [Reboot] button, the controller can be rebooted.

[OK] button Closes the dialog box after confirming the overwrite of user frame.

[Cancel] button Closes the dialog box without modifying the data to the new values.

Set User Frame Dialog Box

Item Description
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7.5.4 Refresh Interval

The re-drawing interval at the playback is set every second (s).
During playback, the drawing time interval can be set in the “Refresh Interval” dialog box.
On the [Home] tab, in the [Settings] group, click the [Heart Beat] button, the [Refresh Interval] dialog 
appears.
The VRC sends position data to MotoSimEG-VRC for every segment (usually between 10 and 20 
milliseconds).  For animation purpose, the screen doesn’t need to be refreshed so quickly.  The refresh 
interval can be adjusted to optimize the playback visualization according to a specific computer 
capability. 

 Setting of high-speed playback function

When [More >>] button is pushed, the high-speed playback set up information is displayed. 

The playback can be done at high speed by setting the high-speed playback function.

• The high-speed playback function is a function sped up by omitting the segment data.
The effect might not become visible according to a set value at drawing intervals and 
computers that use it.

• Please do not use this function when you want to check the movement of every one 
segment on the pulse record.

NOTE
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7.5.5 Servo Emulation

To playback without considering the lag of servo, On the [Simulation] tab, in the [Playback] group, click 
the [Servo Emulation] button.

Item Description

[Enable Fast Playback] 
check box

The high-speed playback function is made effective.

[Subject Pass]

The section where the high-speed playback function is made effective is set.
  All                  : The function is made effective in all sections.
  Welding Pass : The function is made effective while welding
                          (ARCON-ARCOF section).

[Speed]
The degree at the speed of the high-speed playback function is set by five 
stages.
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7.5.6 Cube Interference Area

Interference area can be define on the controller to determine if a robot is in a given cube or prevent the 
robot  to enter the defined area. 

 Displaying the Cube Interference Area

On the [Controller] tab, in the [File Settings] group, click the [Cube Interference Area] button and select 
[Draw Cube Area Model] , the defined interference cubes display.  

 Deleting the Cube Interference Area

On the [Controller] tab, in the [File Settings] group, click the [Cube Interference Area] button and select 
[Delete Cube Area Model] , the defined interference cubes display.
This will only delete the models, the cube area definition in the controller will not be affected.

 Setting the Cube Interference Area

The cube interference areas can be defined by using the Virtual Pendant.  Please refer to the 
“INSTRUCTIONS”  of the controller for the procedure.

If the cube areas are already displayed and the cube definitions are changed, the cube 
model in MotoSimEG-VRC will not automatically be updated.
After modifying the cubes with the Virtual Pendant, the {Cube Area Update & Display} 
menu need to be selected in order to update the MotoSimEG-VRC display. 

       

NOTE
7-26

HW0485348
183 of 671



  
7.6  Robot Settings

156225-1CD
7.6 Robot Settings

7.6.1 Robot Property

The “Robot Property” dialog can be used to change the robots name and their model files.  On the 
[Controller] tab, in the [Robot] group, click the [Model Setting] button, the [Robot Settings] dialog 
appears.

Procedure

1. Select a robot from the robot list.  Its name and model file will display in the corresponding field 
in the section below the robot list.

2. Edit the robot name or select a new model file.
3. If multiple changes are required, repeat the above steps.  As new selections are made the data 

in the robot list will be updated.
4. When all the changes have been entered, press the “OK” button to apply those changes and 

close the “Robot Settings” dialog.  Or, press “Cancel” to discard the changes. 
7-27

HW0485348
184 of 671



  
7.6  Robot Settings

156225-1CD
7.6.2 Reach View

The motion range of the robot P-point (wrist rotation center) can be displayed in 2D or 3D.
To create or delete Reach View models, 
On the [Controller] tab, in the [Robot] group, click the [TCP Reach] button, the [Reach Area] dialog 
appears. 

Reach Area Dialog Box

Item Description

“Disp” section

Specifies display style for range of motion.  (For some robot models, 3D 
display is not available.)

• [2D] radio button: displays range of motion in 2D style.
• [3D] radio button: displays range of motion in 3D style.

“Level” section Selects display level (rough/standard/fine) of range of motion.

[Color] button Displays Color dialog box to specify colors.

[Delete] button Deletes the previously created Reach View models.

[Create] button
Creates a Reach View model of the specified style representing the range of 
motion of the cell active robot.

[Close] button Closes Reach Area dialog box.

Motion Range can be displayed in both 2D and 3D style 
simultaneously:  Select 2D and press the [Create] 
button; then select 3D, change color (optional) and press 
[Create] again.
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7.6.3 Robot Calibration Setting

The robot calibration data define the relative position between robots and stations of a same controller.  
This information is necessary to use the “Coordination Motion” function of the controller.  In order for 
MotoSimEG-VRC to properly display the coordinated motion between robots/stations, the controller 
calibration data and robot/station model layout must correspond to each other.  

To adjust the controller calibration and robot/station model layout to correspond to each other, display 
the “Coordinated Motion Calibration” dialog by selecting: on the [Controller] tab, in the [File Setting] 
group, click the [Robot Calibration] button.

“Coordinated Motion Calibration” Dialog Box

Item Description

Layout robot models to 
match calibration data

Adjusts the relative position between the robot/station models to match the 
calibration data of the controller. 

Set calibration data base on 
robot model layout

Sets the calibration data of the controller based on the relative position 
between the robot/station models in the MotoSimEG-VRC layout.

[Close] button Closes the “Coordinated Motion Calibration” dialog box.

The “Calibration” menu item is only available for controller with the “Coordinated 
Motion” option activated.  In order to activate this function, please refer to the steps 
to set {OPTION FUNCTION} for each controller in section 13.6 "Dual-Arm robot Setting". 

The calibration data must be define in the controller 
before using this function.

NOTE

NOTE
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7.7 Peripheral Equipment

Peripheral Equipment or Device are considered as a RCS controllers.  Their name appears in the 
Controller lists with the other controllers.  They can be programmed to move in the same manner as a 
robot controller by creating jobs and then playing them back.   
Three types of device are available: conveyor, press and gantry.

7.7.1 Adding a Conveyor

 Adding a Conveyor

Conveyors are device that can be setup with 1 to 3 linear axis (X, Y, Z).
To add a conveyor to the cell. On the [Controller] tab, in the [External Device] group, click the [New] 
button, and select [Conveyor] the [Conveyor Installation] dialog appears.

Up to 6 conveyors can be added to a cell.  The conveyor is registered as a controller with 
the name displayed in the "Name" edit box of the Conveyor Install dialog box.  This name 
is determine by the selection of the conveyor number and cannot be changed.

Conveyor Installation dialog box

Item Description

"No" section Specifies the conveyor number.

"Joint Num" section Specifies the number of axis by selecting one of the radio buttons.  

NOTE

 
The conveyor name is automatically completed 
when the conveyor No. is selected. 
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 Conveyor Setting

Specify the dimensions, speed, and operating range of the conveyor to be registered in the Edit 
Conveyor Information dialog box.
This dialog is automatically displayed when a new conveyor is installed.  It can also be displayed 
afterward to modify the conveyor settings by selecting:
On the [Controller] tab, in the [External Device] group, click the [Conveyor Setting] button.  

[OK] button
Adds the conveyor to the cell and then displays the “Conveyor Setting” dialog 
box.
Refer to section 7.7.1 "Adding a Conveyor" for details.

Conveyor Setting dialog box

Item Description

"No" section Specifies the conveyor number to set the condition.

Conveyor Installation dialog box

Item Description
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"Model info" section

Specifies the dimensions of the conveyor to be registered.  

"Motion info" section

Specifies the dimensions of the conveyor to be registered.  

[make model] check box Creates a default conveyor model. 

• When the default conveyor model is modified, clear the [make model] check box unless  
the default conveyor model is to be used.  If the [make model] check box is not cleared, 
the modification for the model becomes invalid, and the model is restored to the default 
model.

Conveyor Setting dialog box

Item Description

"L(mm)" edit box Entire length of the conveyor.

"D(mm)" edit box Width of the conveyor.

"H(mm)" edit box
Thickness of the conveyor. (Distance from the 
floor to the conveyor top.)

"Org(mm)" edit box
Limit switch position for the conveyor home 
position. (Distance from the conveyor end.)

"Speed(mm/s)" 
 edit box

Operation speed of the conveyor.

"Start(mm)" 
 edit box

Start position of the conveyor operation. (Specify 
the distance from the home position
 of the conveyor.)

"End(mm)" 
 edit box

End position of the conveyor operation. (Specify 
the distance from the home position
 of the conveyor.)

NOTE
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7.7.2 Adding a Press

Presses are device that have 3 linear axis (X, Y, Z).  By default, only the Z-axis is enabled to move 
because the X and Y axes motion have been restrained by soft limits.  To change the soft limit 
restriction please refer to the section 7.7.4 "Modifying the Soft Limit of a Device" section.

To add a press to the cell. On the [Controller] tab, in the [External Device] group, click the [New] button, 
and select [Press] .

Procedure

1. On the [Controller] tab, in the [External Device] group, click the [New] button, and select [Press]  
the [Press] dialog appears.
Select if the default press model is to be used or not by checking or unchecking the [Make 
Model] check box.  (The [Make Model] check box is selected by default.)
Press the [OK] button.

2. Enter the name of the press in the “Device Install” dialog, as shown in the figure below.
Press the [OK] button.
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3. The press is added to the cell and a model is automatically generated if the [Make Model] 
option was checked in the “Press” dialog.
 

7.7.3 Adding a Gantry

A gantry device is composed of a “robot” model (RB1) with three linear axes (X, Y, Z) for the base and a 
“station” model (ST1) with three external rotation axes for the head (Rx, Ry, Rz).  The control point 
(TCP) is thoroughly determined by the three rectangular linear axes, and is independent of the external 
axes.

To add a gantry to the cell. On the [Controller] tab, in the [External Device] group, click the [New] button, 
and select [Gantry] .

Procedure

1. On the [Controller] tab, in the [External Device] group, click the [New] button, and select 
[Gantry]  the [Gantry] dialog appears.
Select the check box to specify if the following items in “Gantry” dialog box are required.
[Series List] check box: Configuration of external rotation axis.
                                      (Checked: serial configuration; cleared: parallel configuration.)
[Make Model] check box: Creation of a model.  (Check the box if model creation is
                                         desired.)
Note that both check boxes are selected by default. 
Press the [OK] button.
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2. Enter the name of the gantry in the “Device Install” dialog, as shown in the figure below.
Press the [OK] button.

3. The gantry is added to the cell and a model is automatically generated if the [Make Model] 
option was checked in the “Gantry” dialog. 

7.7.4 Modifying the Soft Limit of a Device

The motion range of device can be modified with the “Soft Limit Setting” dialog.

Procedure

1. On the [Controller] tab, in the [External Device] group, click the [Soft Limit] button, the [Soft Limit 
Setting] dialog appears. 

2. Select the device to be edited from the “Name” combobox.
Note that when a gantry device is selected, the dialog expand to also display settings for the 
Rx, Ry, Rz axes.   
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3. Modify the values as required and press the [Apply] button to make the modification.
4. Press “Close” to close the dialog.

5. For the modification to take affect, close the cell file and then open it again.  

7.7.5 Moving a Device

Devices can be moved by using the Position Panel.  
On the [Home] tab, in the [Teaching] group, click the [Position Panel] button, the [Position Panel] dialog 
appears.

Unlike other robots, they can only be moved using the “Pulse” or “Joint” frame coordinate system.  
Using the “Joint” frame is the equivalent of a rectangular coordinate system (coordinate X, Y, Z in 
millimeters).  

To enable the modifications, reload the cell.NOTE
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Gantry also have a station (external axes) mounted at the end of the robot TCP (X, Y, Z axes) that 
allows Rx, Ry and Rz rotations.  To move this axis, change the selection in the robot combobox to the 
robot name ending by “-ST1”.

For further detail on the Position Panel operation, please refer to section 8.1 "Position Panel" .

7.7.6 Programming a Device

Devices can be programmed to move in the same manner as a robot controller by creating jobs and 
then playing them back. 
The Job panel is used to display the job and allow teaching.  On the [Controller] tab, in the [External 
Device] group, click the [Job Panel] button, the [Job Panel] dialog appears.

If the cell contains multiple devices and the "Multiple Controller Dialog" mode is enable, a 
separate Job panel can be displayed for each device in the cell.  Select the device to be 
displayed in the controller combobox of the toolbar before displaying the Job panel.

 

Select the [Enter] button 
processing mode. 

Adds, modifies or deletes 
instructions. 

Adds multiple lines of 
instructions at a time by 
entering coordinate 
values. 

- Updates the job if it has been edited with other software. 
- Moves the cursor to the step of the current robot position. 

Job display box 

Selected job 

Synchronizes the robot 
position with the current 
position in the display box. 

Displays the “Select Job” 
dialog 
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Job Panel

Item Description

Job selection 
combobox

Select the current job from the dropdown list or click on the [...] button to its 
right to display the “Select Job” dialog. (Refer to the section "Select Job" 
section for details.

Job display box

The device moves to the step selected in the job display panel if the [Sync] 
step synchronization check box is selected.
JOB Edit dialog box for job editing appears by double-clicking the selected 
line.  

JOB Edit Dialog Box:
Modify the instruction in the edit box.  Select either the [Add Line] or [Replace 
Line] button. 

[Enter] button Executes the command selected among [Del], [Add], [Mod] radio buttons.

[MOVE...] button

Displays the Interpolation dialog box.
Specify motion type, speed and position level for the playback operation, and 
click [OK].  

[Close] button Closes the Job Panel

To enable the modification of the motion type and speed 
when a teaching position is modified, select the [Allow 
Modif.] check box.
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 Select Job

The Select Job dialog box (see the figure below) allows to select, copy, delete the jobs.  It can also 
import jobs registered in other cells. 

Selecting a Job

Select a job from the job list, then click on [OK]. 

Creating a Job

Type the name of the new job in the “Selected Job” field.  The job name may not exceed 8 
characters and cannot contain any spaces.

Importing a Job

Procedure
1) Click on [Import].
2) Select a job, and click [Open].
3) Click [OK] to import the job.

 

List of the jobs in the controller folder. 

Displays the content 
of the selected job. 

Selected controller 

Selected job 

Controller folder 
7-39

HW0485348
196 of 671



  
7.7  Peripheral Equipment

156225-1CD
Copying a Job

Procedure
1) Select a job to be copied, and click on [Copy...]: the Job Copy dialog box as 

shown below appears.  

2) Enter a job name in the Destination of Copy edit box, and click on [Copy>>].
3) The job to be copied is displayed on the right; check the item, then click on [OK] to copy 

the job.

Deleting a Job

Select a job to be deleted from the job list in the Select dialog box, then click on [Delete].

 Input of Coordinates (AxisInput)

Press [AxisInput] in the Job Panel to display Axis Data Input dialog box shown below, and create a list 
by entering coordinate values (either pulse or rectangle).  Instructions are added to the job for each 
point of the list.
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Axis Data Input Dialog Box

Item Description

[Pulse] radio button Coordinate values are entered in pulse value.

[Rectangle] radio button Coordinate values are entered in rectangle value.

[CSV File Load] button
Loads the coordinate values from a CSV file, and inserts the coordinate 
values right after the selected line in the list.

[Line Insert] button
Inserts the coordinate entered in the Axis Input dialog box right after the 
selected line in the list.

[Line Edit] button Edits the selected line in the Axis Input dialog box.

[Line Delete] button Deletes the selected line from the list.  (Multiple selection is allowed.)

[OK] button Closes the Axis Data Input dialog box; the list is added as instructions.

[Cancel] button Closes the Axis Data Input dialog box without modifying the job.
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Procedure

1. Select either the [Pulse] or [Rectangle] radio button in Axis Data Input dialog box. 
2. Edit coordinate values with [Line Insert], [Line Edit], or [Line Delete], and create a list.  If a CSV 

file already exists, load coordinate values by selecting [CSV File Load].
3. When the list is completed, press [OK] to add the created list as instructions after the selected 

line in the job.  

Axis Input Dialog Box

Item Description

Pulse/Rectangle

[OK] button Applies the modification, and closes the Axis Input dialog box.

[Cancel] button Closes the Axis Input dialog box without executing the modification.

The motion type and speed of MOVE instructions which have been added with the input of 
coordinates are the set values specified in Interpolation dialog box displayed by clicking 
[MOVE...] in the Job Panel.

Coordinate

Radio Button selected in 
the Axis Data Input Dialog Box

Pulse Rectangle

S/X S-axis X-axis

L/Y L-axis Y-axis

U/Z U-axis Z-axis

R/Rx R-axis Rx-axis

B/Ry B-axis Ry-axis

T/RZ T-axis Rz-axis

NOTE
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7.7.7 Other Operations with devices

 Deleting a Device

Device and their model can be deleted by using the same procedure as other controllers. 
On the [Controller] tab, in the [Setup] group, click the [Delete] button, the [Select Controller/Robot] 
dialog appears..

 I/O Signals for Devices

Devices also have I/O signals that can be use to interact with other controllers in the cell.  They can be 
used in a similar way than those of a VRC controller.

Device I/O Monitor 

The I/O Monitor for device is displayed in the same way as other controller but the displayed dialog is 
different.
On the [Simulation] tab, in the [Monitor] group, click the [I/O Monitor] button, the [I/O Monitor] dialog 
appears 

I/O Monitor can display signals change from an instruction and also give signals to the robot by 
selecting an IN signal before or during playback.  
The I/O data specified in I/O Monitor can be saved as well.

If the cell contains multiple device and the "Multiple Controller Dialog" mode is enable, a 
separate I/O Monitor can be displayed for each device in the cell.  Select the device to be 
displayed in the controller combobox of the toolbar before displaying the I/O Monitor.

NOTE
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I/O Monitor Dialog Box

Item Description

[Group No] Specifies the I/O group number to display.

[Set all IN-Signal] check box
Turns ON all the IN signals of all registered robots.  Uncheck the box to 
turn OFF all the IN signals.

[Set all OT-Signal] check box
Turns ON all the OUT signals of all registered robots.  Uncheck the 
box to turn OFF all the OUT signals.

[Clear I/O] button Clears all the signals of the selected robot.

[Close] button Closes I/O Monitor dialog box.
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7.7.8 Conveyor Operation Panel

This panel is used to operate the conveyor with 1 axis.
To operate the conveyor with multi-axis, refer to section 7.7.5 "Moving a Device".

Conveyor Operation Panel

Item Description

Position

To set the conveyor position for teaching the robot, input the number 

or set the number by the  button.

Conveyor Power On
When this is turned off during playback, the review on stopping the 
conveyor is enabled.

Robot Moving with Conveyor

If this is turned on, the selected robot moves with conveyor on 
operating the conveyor.
When [Robot Moving with Conveyor] is used, set the conveyor 
synchronization of the selected robot in advance.

 

Setting the conveyor 

The position of conveyor in [Position] is 
reflected LS offset value of the each robot. 
When the other robot is selected, the position of 
conveyor in [Position] is changed, without the 
displayed conveyor is not operating.

NOTE
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7.7.9 Conveyor Synchronization

This panel is used to set the synchronization condition between the robot and the conveyor.
If the conveyor synchronization option is available, this panel is displayed automatically when the 
conveyor is added. Refer to section 13.8 "Setting of spot welding simulation" about conveyor 
synchronization option.
To change the synchronization condition of registered conveyor. On the [Controller] tab, in the [External 
Device] group, click the [Conveyor Condition File] button, the [Conveyor Synchronization] dialog 
appears.

Conveyor Synchronization Setting

Item Description

Robot
The list of the controller which can use the conveyor synchronized 
function is displayed. Select the controller by the list.

Conveyor No
Select the conveyor synchronized with the controller selected by 
[Robot].

Conveyor Info
The name and speed of the conveyor selected by [Conveyor No] is 
displayed.
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Condition

[Condition File No]          : Select the conveyor condition file of the 
selected conveyor and controller. the file 
is registered by the virtual pendant.

[Tracking]                        : Specify whether to carry out the 
synchronization with the robot-axis or the 
base-axis.

[Base Axis]                      : When the [Base Axis] is selected by 
[Tracking], the selected axis is dis played.

[Direction Rev]                : When the [Base Axis] is selected by 
[Tracking], the item is displayed. When 
the conveyor traveling direction is 
opposite of the forward direction of base 
axis, this item is "ON".

[Average Time (msec)]   : The averaged travel time of conveyor is 
displayed.

[User Frame No]             : The user frame number of the conveyor 
direction is displayed. The user frame 
number corresponding to the conveyor 
number is selected automatically.

[LS offset (mm)]               : Set the distance of the conveyor origin 
position. When this item is set to 
1000 mm, the conveyor origin position of 
the selected robot is located 1000 mm 
before the origin position on the display.

Conveyor Synchronization Setting

Item Description
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7.8 Cycle Time

On the [Controller] tab, in the [Playback] group, click the [Cycle time] button.

The latest cycle time of playback is displayed on the following display.

This function can not use depending on the system version of controller. Please refer to 
section 15.6 "List of Function depending on the system version of controller".

NOTE

Displays the maximum of playback 

Copys the displayed data to the clipboard
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7.9 Trace

Trace is a function to display update points of the robot position when the robot playback is performed. 
Larger dots in the traces mean the separation of the command data (step end). Traces can be set with 

the "Trace Manager" dialog box. On the [Simulation] tab, in the [Monitor] group, click the [Trace] button.

7.9.1 Trace Manager

Multiple traces can be set.
When a controller is registered to the cell a trace is automatically added for Tool Center Point (TCP) of 
each robot. 

This function can not use depending on the system version of controller. Please refer to 
section section 15.6 "List of Function depending on the system version of controller".

“Trace Manager” Dialog Box

Item Description

Trace list

Displays the information of the defined traces.
Trace Model: Name of the trace model (used in the CadTree)
Enable: Enable/Disable the trace generation during playback.

Length: Approximate travel distance of the traced point during playback.

Time: Playback Time
Keep TraceLine: In the case of Disable, the trace lines is deleted 

automatically before the playback is started.
The “Trace Property” of a trace can be displayed by double-cycling on a trace 
from the list.

[Edit] button
Edits a trace with the “Trace Property” dialog.
For details refer to section 7.9.2 "Trace Properties".

[Add] button
Defines a new trace with the “Trace Property” dialog.
For details refer to section 7.9.2 "Trace Properties".

[Delete] button Deletes the trace definition currently selected in the trace list.

NOTE
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7.9.2 Trace Properties

The “Trace Property” dialog box is displayed by pressing the [Edit] or [Add] button of the “Trace 
Manager” dialog box.
It allows to set the trace properties such as the color, number of points, traced model, etc.

 

“Trace Property” Dialog Box

[Clipboard] button
Opens the “Trace Copy” dialogs with the data of the trace currently selected in 
the list.
For details refer to section 7.9.3 "Trace Copy". 

[Clear Model] button
Deletes all the trace models.
Note that before playback, all the previously generated trace models are 
automatically deleted.

[Clear TraceLine] 
button

Delete all the trace lines.

[Save TraceLine] 
button

Save the trace lines as the model file.

[Close] button Closes the “Trace Manager” dialog box.

Item Description

[Enable] Indicates that the trace will be generated during playback when checked.

[Robot]

Selects the robot associated with the trace.
A trace point is generated everytime the robot position is updated during 
playback.  
This field cannot be modified when editing an existing trace.

[Model] 

Displays the name of the model that will be traced.  
The default model is the robot TCP.  
To change model, press the [...] button beside the “Model” field to display the 
“Select Model” dialog box.  Select a model and press [OK].

“Trace Manager” Dialog Box

Item Description

The trace is not saved on the cell. When it needs that the 
trace is saved, the trace is saved by [Save TraceLine], 
and save the cell.

NOTE
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[Parent] 

Displays the name of the model that is used as the parent of the trace and as 
a coordinated system for the trace point.  
The default model is the “world” model.  
To change model, press the [...] button beside the “Parent” field to display the 
“Select Model” dialog box.  Select a model and press [OK].

[Keep TraceLine]
When this item is checked, the trace lines before playback is not deleted and 
the playback is started.

[Max Points] 
Defines the maximum number of data points that are generates in the trace 
model.  The value may be increase up to 20 000 points.  When the maximum 
value is reached, the oldest points are erased as new points are generates.

[Color]
Displays the color of the trace model.  
To change the color, press the [...] button beside the “Color” field to display the 
“Color” dialog box.  Select a color and press [OK].

[Line Type] Selects the line type: dotted, normal, thick.

[OK] button
If in [Add] mode: adds a new trace definition. 
If in [Edit] mode: updates the selected trace definition.
Closes the “Trace Property” dialog box.

[Cancel] button Closes the “Trace Property” dialog box.

Item Description
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7.9.3 Trace Copy

The “Trace Copy” dialog box is displayed by pressing the [Clipboard] button of the “Trace Manager” 
dialog box.
It allows to copy the last playback data points of the selected trace to the clipboard or a text file.
The displayed trace data are "Controller Name", "Robot Name", "Model Traced", "Trace Model", and 
"Reference". Then, the values of position and speed at each trace points are displayed.

“Trace Copy” Dialog Box

Item Description

[File] button Saves the displayed trace information to a text file.

[Clipboard] button Copies the displayed trace information to the clipboard.

[Close] button Closes the “Trace Copy” dialog box.
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7.10 VRC Maintenance Mode

The VRC controller can be started up in maintenance mode to perform various maintenance task such 
as initializing data, setting, etc.  When there are no opened cell, the “VRC Maintenance Mode” dialog 
can be displayed by selecting from MotoSim EG-VRC : on the [Controller] tab, in the [Boot] group, click 
the [Maintenance Mode] button. 

VRC Maintenance Mode

The VRC Maintenance mode can only be started when there are no opened cell in 
MotoSim EG-VRC.  Before proceeding, save and close all opened cells.

VRC.BINPath Select the VRC.BIN file to be maintenance by pressing the [...]
button.

Start Start up the controller (VRC.BIN) and displays the Virtual Pendant in
maintenance mode.

End Closes the Virtual Pendant and shuts down the controller. 

Some operations in the Virtual Pendant may take a few moments.  Do not press the “End” 
button until the Virtual Pendant has completed its current operation.
Closing the “Virtual Pendant” in the middle of an operation may cause the lost of VRC.BIN 
data.

NOTE

NOTE
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7.11 Displaying model / Editing Data of Safety Function

Display the model from Safety Function File. And the file can be edited.
Following function is available in MotoSim EG-VRC.

• Display the robot range limit data
• Edit the safety function data
• Display the tool interference model

• Display the robot approximate model

7.11.1 Displaying Robot Range Limit

Display the model from the Robot Range Limit.
On the [Controller] tab, in the [File Settings] group, click the [Function Safety] button, and select [Safety 
Function File]. And. choose the [Robot Range Limit] tab.

• This function is available only when the controller is DX200 and the parameter of safety 
function is available.

• Function safety in which a simulation is possible on MotoSim EG-VRC is as follows.
Robot Range Limit
Axis Range Limit
Speed Limit
Tool Angle Monitor

Following function safety can not be simulated on MotoSim EG-VRC.
Axis Speed Monitor
Tool Change Monitor
Safety Signal

• When the edited files are loaded to DX200, it is necessary to put in "SAFETY MODE", 
and to disable "SAVE DATA CRC CHECK FUNC.(FSU)". After loading, please make sure 
to enable "SAVE DATA CRC CHECK FUNC.(FSU)".
And, please make sure to check the settings on DX200.

NOTE
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[Robot Range Limit]

Item Description

File No.

Select the file number. When selecting the file number, the parameter is 
displayed.
[Add Model]

The model of selected file number is displayed. Click the vertex list when 
the model is displayed, teacher model is moved to that position.

[Delete Model]
The model of selected file number is cleared.

Parameter
For those details or Editing them, please refer to "DX200 OPTIONS 
INSTRUCTIONS FOR FUNCTIONAL SAFETY BOARD OPERATION".

Range Combination Range combination dialog appears, and combine the ranges.

Parameter 
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 Area Combination

Creates a new area by combining two already-specified areas.
Click the [Area Combination] button, the [Range Combination] dialog is displayed.
For details, please refer to "DX200 OPTIONS INSTRUCTIONS FOR FUNCTIONAL SAFETY BOARD 

OPERATION".

Model Settings

Set the contents of Inside model or Outside/Plane model.
[Color]

Displays the Color Dialog to change the color of model.
[Opacity]

Specifies the opacity of model. The value can be set between 1.00 and 
0.00, which corresponds respectively to fully opaque and completely 
transparent.

[Add All Model]
The models of all file number are displayed.

[Delete All Model]
The models of all file number are cleared.

Close Close the dialog.

[Range Combination]

Item Description

Input File1 Select the input file1.

Logic Select "AND" or "OR".

Input File2 Select the input file2.

Output File Select the output file.

Combine Execute Combination.

Close Close the dialog.

[Robot Range Limit]

Item Description
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When combination is finished, the following dialog is displayed. Click the [OK] button, a new area is 
written to output file. Click the [Cancel] button, a new area is not written.

 
When overwriting is finished, the following dialog is displayed. Click the [OK] button, a new area model 
is displayed. Click the [Cancel] button, a new area model is not displayed.

7.11.2 Editing the Safety Function Data

Edit the safety function file. Following files are available. To edit the files, it is necessary to put them into 
the robot folder. On the [Controller] tab, in the [File Settings] group, click the [Function Safety] button, 
and select [Safety Function File] the [Safety Function File Settings] dialog appears.

• Robot Range Limit
• Axis Range Limit
• Axis Speed Monitor
• Speed Limit
• Tool Angle Monitor
• Tool Change Monitor

 Robot Range Limit Data

Edit the Robot Range Limit Data. Choose the {Robot Range Limit} tab. For details, please refer to 
section 7.11.1 "Displaying Robot Range Limit".
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 Axis Range Limit Data

Edit the Axis Range Limit Data. Choose the {Axis Range Limit} tab.

[Axis Range Limit]

Item Description

File No.
Select the file number. When selecting the file number, the parameter is 
displayed.

Parameter
For those details or Editing them, please refer to "DX200 OPTIONS 
INSTRUCTIONS FOR FUNCTIONAL SAFETY BOARD OPERATION".

Close Close the dialog.

Parameter 
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 Axis Speed Monitor Data

Edit the Axis Speed Monitor Data. Choose the {Axis Speed Monitor} tab.

[Axis Speed Monitor]

Item Description

File No.
Select the file number. When selecting the file number, the parameter is 
displayed.

Parameter
For those details or Editing them, please refer to "DX200 OPTIONS 
INSTRUCTIONS FOR FUNCTIONAL SAFETY BOARD OPERATION".

Close Close the dialog.

Parameter 
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 Speed Limit Data

Edit the Speed Limit Data. Choose the {Speed Limit} tab.

[Speed Limit]

Item Description

File No.
Select the file number. When selecting the file number, the parameter is 
displayed.
Select the Speed Limit in Teach Mode, the setting of it is available.

Parameter
For those details or Editing them, please refer to "DX200 OPTIONS 
INSTRUCTIONS FOR FUNCTIONAL SAFETY BOARD OPERATION".

Close Close the dialog.

Parameter 
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 Tool Angle Monitor Data

Edit the Tool Angle Monitor Data. Choose the {Tool Angle Monitor} tab.

[Tool Angle Monitor]

Item Description

File No.
Select the file number. When selecting the file number, the parameter is 
displayed.

Parameter
For those details or Editing them, please refer to "DX200 OPTIONS 
INSTRUCTIONS FOR FUNCTIONAL SAFETY BOARD OPERATION".

Close Close the dialog.

Parameter 
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 Tool Change Monitor Data

Edit the Tool Change Monitor Data. Choose the {Tool Change Monitor} tab.

[Tool Change Monitor]

Item Description

File No.
Select the file number. When selecting the file number, the parameter is 
displayed.

Parameter
For those details or Editing them, please refer to "DX200 OPTIONS 
INSTRUCTIONS FOR FUNCTIONAL SAFETY BOARD OPERATION".

Close Close the dialog.

Parameter 
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7.11.3 Displaying the Tool Interference Model

Display the tool interference model from the Tool Interference Data.
On the [Controller] tab, in the [File Settings] group, click the [Function Safety] button, and select [Tool 

Interference Model]  the [Tool Interference] dialog appears.

Item Description

File No.
Select the file number. When selecting the file number, the parameter is 
displayed.

Data No.

Select the data number. 
[Points]

Specify the X, Y, and Z of two points.
[Radius]

Specify the radius of sphere and cylinder.
For those details or Editing them, please refer to "DX200 OPTIONS 
INSTRUCTIONS FOR FUNCTIONAL SAFETY BOARD OPERATION".
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7.11.4 Displaying the Robot Approximate Model

Display the robot approximate model from robot parameter. 
On the [Controller] tab, in the [File Settings] group, click the [Function Safety] button, and select [Robot 
Approximate Model]  the [Robot Approximate] dialog appears.

Model Settings

Display/Clear the tool interference model.
[Color]

Displays the Color Dialog to change the color of model.
[Opacity]

Specifies the opacity of model. The value can be set between 1.00 and 
0.00, which corresponds respectively to fully opaque and completely 
transparent.

[Add Model]
The model of the file number is displayed.

[Delete Model]
The model of the file number is cleared.

Close Close the dialog.

Item Description

    

 

 

 
 

Selected controller 

Value of  

Robot Name 
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[Robot Approximate Model]

Item Description

Show Model

Display the approximate model.
[Color]

Displays the Color Dialog to change the color of model.
[Opacity]

Specifies the opacity of model. The value can be set between 1.00 and 
0.00, which corresponds respectively to fully opaque and completely 
transparent.

Delete Model Clear the approximate model.

Close Close the dialog.

When the parameter does not have approximate 
model, the model is not displayed.

NOTE
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7.12 Working Trace

 When the lines where drawing starting and where drawing end are inserted a job, the continuous 
cylinder, line and seat is drawn on the TCP position of the robot at the time of a playback.

 
Working trace can be set with the "Working Trace Manager" dialog box. On the [Simulation] tab, in the 
[Monitor] group, click the [Working Trace] button.

 
To draw the working trace, it is necessary to execute the following two procedure.
1. Adds/Edits the setting of working trace
2. Inserts the lines where drawing starting and where drawing ending to the job

For details about above step1, refer to the section 7.12.1 "Working Trace Manager" and section 7.12.2 
"Working Trace Property". For details about above step 2, refer to the section 7.12.3 "Specify the Start 
Point and End Point".

• This function can use virtual robot controller only.
• The working trace is not saved on the cell. When it needs that the working trace is saved, 

the working trace is saved by [Save WorkingTrace], and save the cell.
• When working trace has many points, the playback may become slowly.
• When the 3DPDF file is output, that working trace is that when playback is finished. 

Working trace is not moved on the animation of 3DPDF.
• When the type of working trace is "Line" and the 3DPDF file is output, the width of the line 

is not reflected. When the tick line is needed on 3DPDF file, the type is needed to set 
"Cylinder" or "Sheet".

• Drawing start and end by the ARCON/ARCOF instruction can be used only the following 
system version of controller.

• DX200: DN1.61-00
• DX100: DS3.93-00
• NX100: NS4.75-00

• NS4.69-A5 Controller is not supported.

NOTE
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7.12.1 Working Trace Manager

Multiple working traces can be set.
When a controller is registered to the cell a trace is automatically added for Tool Center Point (TCP) of 

each robot. The [Enable] setting is set to "Disable".

Working Trace Manager

Working Trace list

Displays the information of the defined traces.
    Display: Show/Hide the working trace
    Enable: Enable/Disable the working trace generation during playback
    Working Trace Name: Name of the working trace model
    Length: Approximate travel distance of the working trace
    Time: Time during working trace generation
The "Working Trace Property" of a trace can be displayed by double-
clicking on a working trace from the list.

[Edit] button
Edits a trace with the "Working Trace Property" dialog.
For details refer to section 7.12.2 "Working Trace Property".

[Add] button
Defines a new working trace with the "Working Trace Property" dialog.
For details refer to section 7.12.2 "Working Trace Property".

[Delete] button
Deletes the working trace definition currently selected in the working trace 
list.

[Clear WorkingTrace] 
button

Deletes all working traces.

[Save WorkingTrace] 
button

Save the working trace as a model file.

[Close] button Closes the "Working Trace Manager" dialog box.

The working trace is deleted automatically when the following operation is done.
• Start playback
• Click the [Reset] button
• Close the cell
• Click the [Clear WorkingTrace] button
• Add/Edit/Delete the setting of working trace

The working trace is not saved on the cell. When it 
needs that the working trace is saved, the working 
trace is saved by [Save WorkingTrace], and save the 
cell. 

NOTE

NOTE
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7.12.2 Working Trace Property

The "Working Trace Property" dialog box is displayed by pressing the [Edit] or [Add] button of the 
"Working Trace Manager" dialog box.
It allows to set the trace properties such as the color, type, opacity, diameter, traced model, etc.

Working Trace Property

[Enable]
Indicates that the working trace will be generated during playback when 
checked.

[Name]
Input the name of working trace. (Up to 8 one-byte characters) When 
adding the working manager, WT [serial number] is set automatically.

[Robot] Selects the robot associated with the working trace.

[Parent]

Displays the name of the model that is used as the parent of the working 
trace and as a coordinated system for the working trace.
The default model is the "world" model.
To change model, press the [...] button beside the "Parent" field to display 
the "Select Object" dialog box. Select a model and press [OK].

[Color]
Displays the color of the working trace model.
To change the color, press the [...] button beside the "Color" field to display 
the "Color" dialog box. Select a color and press [OK].

[Opacity]
Specifies the opacity of model. The value can be set between 1.00 and 
0.00, which corresponds respectively to fully opaque and completely 
transparent.

[Type] Specifies the type of working trace. (Cylinder, Line or Sheet).

[Diameter] Specifies the diameter of working trace.
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[Display Accuracy]

Specifies the minimum distance to add the point to working trace.

[Step] Specifies the increment value of the spin control.

[Width Direction]

Specifies the direction of TCP as the width direction of sheet.
 
  (e.g. Width Direction is set to "X")

Draw back plane

If this is disable, the back plane of sheet is not drawn.

Offset
Specifies the offset values of working trace point. These values are the 
value of the tool coordinates.

Working Trace Property

When display accuracy becomes smaller, the working 
trace becomes finer. When display accuracy becomes 
larger, the working trace becomes rougher.

NOTE

 

 

Sheet Width

Working Trace (Sheet) 

X-axis of TCP 

This item is available only when type is "Sheet".NOTE

This item is available only when type is "Sheet".NOTE
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7.12.3 Specify the Start Point and End Point

Inserts the lines where drawing starting and where drawing ending to the job.

To insert the lines, there are two methods as follows.
• ARCON/ARCOF instruction

When ARCON and ARCOF instructions are inserted in the job, working trace is created 
between ARCON and ARCOF.

Examples are given below.
Working trace is created between ARCON and ARCOF. Working trace property of R1 of 
this controller is reflected.

When the job is for multiple robots, working traces of all robots are created between 
ARCON and ARCOF.

When the job has many ARCON/ARCOF pairs as follows, working traces of each pair are 

created between ARCON and ARCOF.

Drawing start and end by the ARCON/ARCOF instruction can be used only the following system 
version of controller.

• DX200: DN1.61-00
• DX100: DS3.93-00
• NX100: NS4.75-00

 

Start

End

NOTE
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• Comment instruction
When the following two comment instructions are inserted in the job, working trace is 
created during two comment instructions.

'DRW:[Name]=ON (Where drawing starts)
'DRW:[Name]=OFF (Where drawing ends)

Examples are given below.
Working trace is created during two comment instructions. Working trace property of 
"WT2" is reflected.

When the job has many comments pairs as follows, working traces of each pair are 

created between comments.

NS4.69-A5 Controller is not supported.

 

Start

End

NOTE
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8 Tool Functions

MotoSim EG-VRC has tools to operate and teach a robot, including functions to display the current 
position and pulses of the robot; it also has functions that simplifies teaching operations such as OLP 
(on-screen teaching function to teach target point) and interference check function.
This chapter explains each function and its application.

8.1 Position Panel

The Position panel displays position data of a robot, and enables robot operation by entering numerical 
values in pulses or coordinate units.
On the [Home] tab, in the [Teaching] group, click the [Position Panel] button, the [Position Panel] dialog 

appears.

.

If the cell contains multiple controllers and the "Multiple Controller Dialog" mode is enable, 
a separate Position panel can be displayed for each robot in the cell.  Select the robot to 
be displayed in the robot combobox of the toolbar before displaying the Position panel.

NOTE

Controller Name  

Selected Robot 

Values units  

Coordinate system
reference frame  

Specify each axes 
value  

Set the step value 
for the spin buttons 

Change the value 
with these buttons
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Keyboard entry

The value of an axis can be entered directly with the numeric keys.  Select the desired axis edit box, 
enter the new value, and then press the [Enter] key to update the robot position or the [Tab] key to 
move to the next axis.

 Pulse

Displays the pulse values of the S, L, U, R, B, T axis of the robot.

 Joint

Displays the angular values of the S, L, U, R, B, T axis in angular units (degrees or radians).

Position Data Panel

Item Description

[Frame] combobox
The coordinate system reference frame can be selected with the 
"Frame" combobox.  The choice of frame available in the list may change 
depending on the robot configuration.  

[Fix TCP] checkbox
When checked, the [Fix TCP] function is enabled.  The robot TCP position 
remains fixed relative to another model in the cell.  Refer to section section 
8.1.2 "Fix TCP" for details.

[Set Fix TCP...] button
Displays the "Select Model" dialog to change the model reference used by the 
Fix TCP function.

[Configuration] button
Displays the robot "Configuration" dialog to select a different robot 
configuration to reach the current position.  (Refer to section 8.1.3 "Robot 
Position Configuration" for details)

[Move Slave] checkbox

When checked, the [Move Slave] function is enabled.  When a robot or station 
is moved, other slave robots from the same controller are moved with it so 
that their TCP maintain the same relative position to the moved robot or 
station. 
By default all robots are set as slave.  The individually setting of each robot 
can be changed by pressing the [...] button to display the “Set Slave Robot” 
dialog.
Note that when the function is enable, if one of the robot cannot reach the 
proper position, all the robots are prevented from moving.

[Close] button Closes the position data panel.

The Fix TCP section is not available when the Frame is set to "Work Angle". NOTE
8-2

HW0485348
230 of 671



8  Tool Functions
8.1  Position Panel

156225-1CD
 Robot

Displays the position (X, Y, Z, Rx, Ry, Rz) of the robot current Tool frame (TCP) relative to the Robot 
frame.

 Base

Displays the position (X, Y, Z, Rx, Ry, Rz) of the robot current Tool frame (TCP) relative to the Base 
frame.  If the robot doesn't have any base axis, the Base frame and Robot frame overlaps each other.

 Tool

This frame is useful to move the robot in the Tool coordinate system (X, Y, Z, Rx, Ry, Rz) but the 
displayed values are always "0" even though the robot moves since the reference system and the Tool 
coordinate frame are the same. 

  

  
8-3

HW0485348
231 of 671



8  Tool Functions
8.1  Position Panel

156225-1CD
 User

Displays the position (X, Y, Z, Rx, Ry, Rz) of the robot current Tool frame (TCP) relative to the selected 
user frame.  When selected, a 2nd combobox will appear next to the "Frame" combobox to allow the 
selection of the user frame number.  Only the defined user frame will appear in the list.  At least one 
user frame need to be define in order to select the User Frame reference system. 

 Work

Displays the position (X, Y, Z, W, T, C) of the robot current Tool frame (TCP) relative to the set Work 
frame.  When this coordinate system is selected, the "Set Frame..." button and the "Reverse Work 
Side" checkbox will appear under the axis values.

The Work frame is defined by three components: the frame position (or origin), the travel direction, and 
the work surface.  The normal of the work surface is set as the Z-axis (red arrow) and the tool travel 
direction is set as the X-axis (blue arrow). The Y-axis (green arrow) will be set perpendicular to the 
other two axes.  

  

  

Work Frame 
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The Work angle (W) is defined by the angle between the tool and the work surface in the YZ plane.  
Changing the value of "W" will rotate the tool around the Work frame X-axis.  The "W" angle is define 
between -90.0 and 90.0 degrees.  The Reverse Work Side checkbox indicates if the Work Angle is on 
the same side then the Y-axis (unchecked) or on the opposite side (checked).  If a work angle is moved 
over the 90.0 degree limit, the work angle side will change and the work angle will be set back within its 
allowable limit.

The Travel angle (T), also called the Push/Pull angle, is defined as the angle between the torch and the 
YZ plane.  When set to 0 degree, the tool is in perpendicular to the travel direction.  If "T" is positive, the 
tool is pushing; and if it is negative, the tool is pulling.  The "C" angle is the rotation angle around the 
Tool Z axis.

 

8-5

HW0485348
233 of 671



8  Tool Functions
8.1  Position Panel

156225-1CD
8.1.1 Work Frame Setting

The Work frame can be set manually or automatically.  Press the "Set Frame..." button to display the 
Work Frame Set dialog and set your preferences.

Set Work Frame

Item Description

"Auto Search" section
Determine which components of the Work frame are to be 
automatically updated as the robot moves.  Settings during teaching 
[Teach] and during playback [Play] are independently set.

[Screen Pick Active] check box
Enables the mouse picking operation.Pressing the [Shift] key enables 
or disables the "Screen Pick Active" mode.

[Close] button Closes the dialog box.

[More] or [Less] button Displays or hides the pick mode setting section.

"Set Value For:" section
Determine which values of the Work Frame will be changed when the 
screen is clicked.

"Use Face:" section

Determines which information for a click surface is used to set the 
Travel Direction or the Work Surface.

[Normal] radio button:
The normal of the face is used.

[Edge] radio button:
The edge direction closes to the picked point is used.  Note if 
both the X-axis and the Z-axis are checked, the Z-axis is set in 
the Edge direction.

[Point] radio button:
The direction defined by the Work frame origin and the picked 
face point is used.

The [Reverse Direction] checkbox can be used to select the opposite 
direction.

"Pick Object" section
Sets the type of objects that can be selected when clicking on the 
screen.  Please refer to section 6.4 "Pick Settings".
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Auto Search

MotoSimEG can automatically set the Work frame by searching from the work surface.  The tool Z-axis 
positive direction is searched to find the first intersecting face.  The found face intersection point and 
normal can be used to calculate the frame position and Z-axis.  The travel direction (or Work frame X-
axis) can automatically be determined by using the robot previous position and new position.

Each component of the Work frame can be set to automatically updated as the robot moves or not.  The 
settings are independently set for "Teach" and "Play" mode.  By default the "Auto Search" is active 
(checked) for all the components except for the "Travel Direction" in "Teach" which tends make jogging 
operation of the robot difficult because the Work frame changes after each position change.

Manually setting the Work Frame

The Work frame components can be set manually by clicking on the screen.  To control the pick result, 
press the "More" button to display the Pick Setting section of the dialog.  Select the value to be set and 
click on the screen to change those values to those of the clicked geometry.

Note that the "Auto Search" - "Teach" check boxes and the "Pick" - "Set Value for" check boxes are 
exclusive of one another.  By default, only the "Travel Direction" is checked to be manually set by using 
the face point information ("Use Face: point").  Therefore, clicking on the screen will cause travel 
direction (X-axis) to turn in the work surface plane to point toward the clicked point.

"Pick Mode" section
Sets conditions determining the selected point in the clicked area.  
Please refer to section 6.4 "Pick Settings".

• The Work surface search and calculation can become fairly intensive in cells with large 
models made of thousand of faces and will slow down the playback animation.  For 
such cases, it may necessary to turn off (uncheck) the Work Surface auto search and 
manually set the Z-direction. 

• When the tool is close to an edge formed by multiple faces, the face with the normal 
pointing upward will be selected over the other ones. 

• If no surface can be found, the position is set as the tool position and the previously 
found normal (Z-axis) is reused.

Set Work Frame

Item Description

NOTE
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8.1.2 Fix TCP

The Fix TCP function allows fixing (or attaching) the robot TCP position relative to another model in the 
cell.  If the robot base or the attached model is moved, the robot changes position so that it TCP 
remains in the same position relative to the specified model.

The Fix TCP function is enabled by the robot Position panel.  Check the "Fix TCP" check box to enable 
the function.  The default model to which the TCP is attached is the world.  To change the model, press 
the "Set Fix TCP..." button to display the "Select Model" dialog.  

This function is useful to determine the layout of a cell.  For example the robot TCP can be attached to 
a work piece.  As the robot base or work piece are moved around during the layout procedure, the robot 
automatically adjust itself to keep its TCP in the same position on the work piece.  It then becomes 
obvious if the work piece become out of reach, because robot will no longer maintain its position on the 
work piece.

Its can also be used when teaching a robot with external axis.  After the tool has been set in position, if 
the robot external axis need to be changed, with the Fix TCP function enabled the robot tool will 
remains in position.  This avoids having to adjust the robot tool after moving the external axis.

The function is automatically disabled if the Position panel is closed or if a job is played back.  The 
Fix TCP section is not available when the Frame is set to "Work Angle".

 

NOTE
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8.1.3 Robot Position Configuration

The robot position "Configuration" dialog displays a list of different ways the robot can reach its current 
position.  To display the "Configuration" dialog, select {Tool} - {Teaching} - {Robot Configuration} or from 
the robot "Position" panel click the "Configuration" button.

A robot can often reach the same position in different ways.  The robot resulting pulse position will be 
different but the tool will be at same position (XYZ position).  The robot configuration is used to 
differentiate between those possibilities.

The configuration is define by six parameters:

Configuration Dialog Box

Item Description

Configuration List

Displays the list of all available robot configurations in which the robot can 
reach the current position. Changing the selected configuration will move 
the robot into the specified configuration. The asterisk next to the index 
number indicates the initial configuration of the robot.

[OK] button
Closes the Configuration dialog and changes the robot configuration to the 
select one.

[Cancel] button
Closes the Configuration dialog and returns the robot to its initial 
configuration.

FRONT or REAR
Specifies if the B-axis rotation center is in the FRONT or the 
REAR of the S-axis rotation center.

UP or DOWN
Specifies if the elbow of the robot (angle between the lower 
and upper arm) is UP or DOWN.
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Example:

FLIP or NO FLIP

DX200, DX100, FS100
            : B-axis position

Specifies if the angle of the B-axis is to be positive or 
negative.

FLIP: B-axis angle is greater or equal to 0°
NO FLIP: B-axis angle is small than 0°

NX100 : R-axis position
Specifies if the R axis is FLIP or NOFLIP.  FLIP 
position indicates an angle from -90° to 90°, 270° to 
360°, or -360° to -270°. 

S<180 or S>=180
Specifies if the S-axis absolute angle is smaller then 180° 
(within one turn) or greater (over one turn).

R<180 or R>=180
Specifies if the R-axis absolute angle is smaller then 180° 
(within one turn range) or greater (over one turn range).

T<180 or T>=180
Specifies if the S-axis absolute angle is smaller then 180° 
(within one turn range) or greater (over one turn range).

FRONT,UP,FLIP,S<180,R<180,T<180 REAR,DOWN,FLIP,S<180,R<180,T>=180
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8.2 I/O Monitor

The I/O Monitor allows the simulation of the input and output signals of the YIU0x unit (DX100) or the 
NIO0x board of the NIF0x unit and other I/O expansion boards.  It displays the current I/O states of the 
controller.  Input signals can be changed manually before or during playback.  Output signals maybe 
changed by the execution of I/O instructions during job playback or by the virtual pendant.

On the [Simulator] tab, in the [Monitor] group, click the [I/O Monitor] button, the [Virtual I/O] dialog 

appears.  

If the cell contains multiple controllers and the "Multiple Controller Dialog" mode is enable, 
a separate I/O Monitor can be displayed for each controller in the cell.  Select the 
controller to be displayed in the controller combobox of the toolbar before displaying the I/
O Monitor.

The I/O Monitor support the following I/O expansion boards:
DX200, DX100:

• JARCR-XOI01
• JARCR-XOI02
• JARCR-XOI03
The analog EW boards are not supported for the DX200/DX100.

FS100:
• LIO-08R (JAPMC-IO2308-E)
• LIO-09R (JAPMC-IO2309-E)

NX100:
• JARCR-XOI01
• JARCR-XOI02
• JARCR-XOI03
• JANCD-XEW01-1
• JANCD-XEW01-2
• JANCD-XEW02

To add or remove I/O expansion board refer to section 13.4 "Adding I/O Board Module".

NOTE

NOTE
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8.2.1 Dedicated and General I/O

This function emulated the I/O of the YIU0x unit (DX100) or the NIO0x board of the NIF0x unit.
These I/O are found under the “Standard I/O” tab.

Virtual I/O

IN section

External input signals #20010 to #20057 ON/OFF status display.
The ON/OFF status can be toggled by left clicking on a signal status icon.
    ● (Green)  : ON
    ● (Black)   : OFF 

OUT section

External output signals #30010 to #30057 ON/OFF status display.
The ON/OFF status of the signals cannot be change by clicking on them.
    ● (Green)  : ON
    ● (Black)   : OFF 

[Set all IN-Signal] 
check box

All general-purpose input (IN#0001 - IN#1024) is put into the state of the 
compulsion input.

[Set all OUT-Signal] 
check box

All general-purpose outputs (OUT#0001 - OUT#1024) are made an output 
status.

[Close] button Closes the “Virtual I/O” window. 

For the relationship between the External Input/Ouput signals and the Universal Input/
Output signal please refer to the section 8.2.4 "Inputs and Outputs".

  

  

External Input can be turned ON/OFF 
by clicking on them with the mouse. 

Comment identifying the usage of the 
I/O signal pointed by the mouse. 

NOTE
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8.2.2 Expanded Digital I/O

This function emulated the expanded digital I/O of the XIO0x board.  These I/O are found under the 

“Expanded I/O” tab.

Virtual I/O

The expanded digital I/O board [JANCR-XOI0x] need to be added to the CMOS in order to 
be displayed.  Please refer to section 13.4 "Adding I/O Board Module".

IN section

External input signals #20060 to #20107 ON/OFF status display.
The ON/OFF status can be toggled by left clicking on a signal status icon.
    ● (Green)  : ON
    ● (Black)   : OFF 

OUT section

External output signals #30060 to #30107 ON/OFF status display.
The ON/OFF status of the signals cannot be change by clicking on them.
    ● (Green)  : ON
    ● (Black)   : OFF 

[Set all IN-Signal] 
check box

All general-purpose input (IN#0001 - IN#1024) is put into the state of the 
compulsion input.

[Set all OUT-Signal] 
check box

All general-purpose outputs (OUT#0001 - OUT#1024) are made an output 
status.

Close Closes the “Virtual I/O” window. 

NOTE

 

  

External Input can be turned ON/OFF 
by clicking on them with the mouse. 

Comment identifying the usage of the 
I/O signal pointed by the mouse. 
8-13

HW0485348
241 of 671



8  Tool Functions
8.2  I/O Monitor

156225-1CD
8.2.3 Analog I/O (EW Board)

This function emulated the analog and digital I/O of the XEWxx board.  These I/O are found under the 

“EW Board” tab.

 JANCD-XEW01-1

Virtual I/O

For the relationship between the External Input/Ouput signals and the Universal Input/
Output signal please refer to the section 8.2.4 "Inputs and Outputs".

• This function cannot be use in the case of DX100 controller.
• This function is enabled when the CMOS loaded from a real system contains an analog I/

O board [JANCR-XEWxx].
For details, please refer to section 13.4 "Adding I/O Board Module".

Wire Sticking Signals to the controller that the wire is sticking.  (#21274)

Arc Occurence Signals to the controller  that the arc is on.  (#21273)

Arc Shortage Signals to the controller that the arc was extinguished.  (#21272)

Wire Shortage Signals to  the controller that there is a shortage of wire.  (#21271)

Gaz Shortage Signals to the controller that there is a shortage of gaz.  (#21270)

Search Signals to enable the search function. (#31275)

Gaz Flow Signals to enable the gaz flow.  (#31274)

NOTE

NOTE

 

Check this box to automatically generate 
proper response to the ARCON command.

Buttons to turn ON/OFF signals 
going to the controller. 
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 JANCD-XEW01-2

Virtual I/O

Wire Retract Signals to retract the wire.  (#31273)

Wire Inching Signals to feed the wire.  (#31272)

ArcOn Signals to enable the welding arc.  (#31271)

CH1 Display the analog output value of channel 1. (AOUT1)

CH2 Display the analog output value of channel 2. (AOUT2)

CH3 Display the analog output value of channel 3. (AOUT3)

Simulate welding 
machine automatic 
response

Enables the automatic simulation of the normal response from a welding 
machine to the controller “Arc On” command.

Close Closes the “Virtual I/O” window.

CH1 Display the analog output value of channel 1. (AOUT1)

CH2 Display the analog output value of channel 2. (AOUT2)

CH3 Display the analog output value of channel 3. (AOUT3)

Close Closes the “Virtual I/O” window.
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 JANCD-XEW02

Virtual I/O

Wire Sticking Signals to the controller that the wire is sticking.  (#21274)

Arc Occurence Signals to the controller  that the arc is on.  (#21273)

Arc Shortage Signals to the controller that the arc was extinguished.  (#21272)

Wire Shortage Signals to  the controller that there is a shortage of wire.  (#21271)

Gaz Shortage Signals to the controller that there is a shortage of gaz.  (#21270)

CH1 Slider Set the analog value send to the controller on channel 1. (AIN01)

CH2 Slider Set the analog value send to the controller on channel 2. (AIN02)

Search Signals to enable the search function. (#31275)

Gaz Flow Signals to enable the gaz flow.  (#31274)

Wire Retract Signals to retract the wire.  (#31273)

Wire Inching Signals to feed the wire.  (#31272)

ArcOn Signals to enable the welding arc.  (#31271)

CH1 Display the analog output value of channel 1. (AOUT01)

CH2 Display the analog output value of channel 2. (AOUT02)

Simulate welding 
machine automatic 
response

Enables the automatic simulation of the normal response from a welding 
machine to the controller “Arc On” command.

Close Closes the “Virtual I/O” window.

 

Check this box to automatically generate 
proper response to the ARCON command.

Buttons to turn ON/OFF signals 
going to the controller. 

Move the sliding bars 
to send analog signals 
(-14V to +14V) to the 
controller. 
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8.2.4 Inputs and Outputs

 DX200, DX100, NX100

DX200

Classification of I/O signals

Logic Name Classification Description Range

0xxxx General Input
Reference with input instruction of the 
job.

00010 - 05127
(4096 signals)

1xxxx General Output
Reference with input instruction of the 
job.

10010 - 15127
(4096 signals)

2xxxx External Input
Signal No. corresponding to the input 
terminal.

20010 - 25127
(4096 signals)

3xxxx External Output
Signal No. corresponding to the output 
terminal.

30010 -35127
(4096 signals)

4xxxx Specific Input
Signal to change the operating 
condition of the robot.

40010 - 41607
(1280 signals)

5xxxx Specific Output
Signal notifying the operating condition 
of the robot.

50010 - 53007
(2400 signals)

6xxxx
Interface Panel 
Input

Signal notifying the operating condition 
of the interface panel.

60010 - 60647
(512 signals)

7xxxx Auxiliary Relay Auxiliary relay in the concurrent I/O
70010 - 79997
(7992 signals)

80xxxx Control Status
Monitoring of the hardware signal 
status of the robot control section.

80010 - 80647
(512 signals)

82xxxx Pseudo Input
Pseudo input relay reading from the 
system parameter.

82010 - 82207
(160 signals)

27xxxx Network Input Input signal from the network device.
27010 - 29567
(2048 signals)

37xxxx Network Output Output signal to the network device.
37010 - 39567
(2048 signals)

Mxxxx Register

1 word data (16 bits)
General Register

M000 - M559
Analog output register

M560 - M599
Analog input register

M600 - M639
System Register

M650 - M999

M00 - M999
(1000 signals)
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DX100

Classification of I/O signals

Logic Name Classification Description Range

0xxxx General Input
Reference with input instruction of the 
job.

00010 - 02567
(2048 signals)

1xxxx General Output
Reference with input instruction of the 
job.

10010 - 12567
(2048 signals)

2xxxx External Input
Signal No. corresponding to the input 
terminal.

20010 - 22567
(2048 signals)

3xxxx External Output
Signal No. corresponding to the output 
terminal.

30010 -32567
(2048 signals)

4xxxx Specific Input
Signal to change the operating 
condition of the robot.

40010 - 41607
(1280 signals)

5xxxx Specific Output
Signal notifying the operating condition 
of the robot.

50010 - 52007
(1600 signals)

6xxxx
Interface Panel 
Input

Signal notifying the operating condition 
of the interface panel.

60010 - 60647
(512 signals)

7xxxx Auxiliary Relay Auxiliary relay in the concurrent I/O
70010 - 79997
(7992 signals)

80xxxx Control Status
Monitoring of the hardware signal 
status of the robot control section.

80010 - 80647
(512 signals)

82xxxx Pseudo Input
Pseudo input relay reading from the 
system parameter.

82010 - 82207
(160 signals)

25xxxx Network Input Input signal from the network device.
25010 - 27567
(2048 signals)

35xxxx Network Output Output signal to the network device.
35010 - 37567
(2048 signals)

Mxxxx Register

1 word data (16 bits)
General Register

M000 - M559
Analog output register

M560 - M599
Analog input register

M600 - M639
System Register

M650 - M999

M00 - M999
(1000 signals)
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NX100

Classification of I/O signals

An External Input signal (#20010 - #25127(DX200), #22567(DX100), #21287(NX100)) or External 
Output signal (#30010 - #35127(DX200), #32567(DX100), #31287(NX100)) is allocated for each I/O 
data of the board.

The standard NIO0x board  can transmit to the controller 40 input points (5 bytes) and 40 output points 
(5 bytes).  The first 16 I/O points are normally configured has dedicated I/O.  The dedicated I/O 
assignment depends on the controller selected application.  The remaining I/O points are assigned to 
the General I/O which corresponds to the I/O with the I/O instruction of a job.

Logic Name Classification Description Range

0xxxx General Input
Reference with input instruction of the 
job.

00010 - 01287
(1024 signals)

1xxxx General Output
Reference with input instruction of the 
job.

10010 - 11287
(1024 signals)

2xxxx External Input
Signal No. corresponding to the input 
terminal.

20010 - 21287
(1024 signals)

3xxxx External Output
Signal No. corresponding to the output 
terminal.

30010 -31287
(1024 signals)

4xxxx Specific Input
Signal to change the operating 
condition of the robot.

40010 - 40807
(640 signals)

5xxxx Specific Output
Signal notifying the operating condition 
of the robot.

50010 - 51007
(800 signals)

6xxxx
Interface Panel 
Input

Signal notifying the operating condition 
of the interface panel.

60010 - 60647
(512 signals)

7xxxx Auxiliary Relay Auxiliary relay in the concurrent I/O
70010 - 79997
(79921 signals)

80xxxx Control Status
Monitoring of the hardware signal 
status of the robot control section.

80010 - 80647
(512 signals)

82xxxx Pseudo Input
Pseudo input relay reading from the 
system parameter.

82010 - 82127
(96 signals)

22xxxx Network Input Input signal from the network device.
22010 - 23287
(1024 signals)

32xxxx Network Output Output signal to the network device.
32010 - 33287
(1024 signals)

Mxxxx Register 1 word data (16 bits)
M00 - M499
(500 signals)
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In the case of a Digital I/O expansion board (JARCR-XOI01, JARCR-XOI02 or JARCR-XOI03), the 
board can transmit to the controller 40 input points (5 bytes) and 40 output points (5 bytes).

There external signals normally follows those of the NIOxx board and are assigned to General I/O.

To help identify the correspondance between the I/O board signal and the controller signal, comments 
for each I/O point can be added in the VRCNXMAIN.INI file under the [IO_ALLOC] section.  The 
comment corresponding to an I/O point is displayed in the Virtual I/O dialog comment section when the 
mouse pointer is over a I/O point.

The information is entered in the following format:
LG<External I/O No.>=Comment     

For example:
File:VRCNXMAIN.INI

[IO_ALLOC]
LG20030=IN0001   
LG20031=IN0002   
LG20032=IN0003  
...

Input Output

20010 - 20017: Dedicated Input
20020 - 20027: Dedicated Input

30010 - 30017: Dedicated Output
30020 - 30027: Dedicated Output

20030 - 20037 : General I/O (IN#001-008)
20040 - 20047 : General I/O (IN#009-016)
20050 - 20057 : General I/O (IN#017-024)

30030 - 30037 : General I/O (OUT#001-008)
30040 - 30047 : General I/O (OUT#009-016)
30050 - 30057 : General I/O (OUT#017-024)

Input Output

20060 - 20067 : General I/O (IN#025-032)
20070 - 20077 : General I/O (IN#033-040)
20080 - 20087 : General I/O (IN#041-048)
20090 - 20097 : General I/O (IN#049-056)
20100 - 20107 : General I/O (IN#057-064)

30060 - 30067 : General I/O (OUT#025-032)
30070 - 30077 : General I/O (OUT#033-040)
30080 - 30087 : General I/O (OUT#041-048)
30090 - 30097 : General I/O (OUT#049-056)
30100 - 30107 : General I/O (OUT#057-064)
8-20

HW0485348
248 of 671



8  Tool Functions
8.2  I/O Monitor

156225-1CD
 FS100

FS100

Classification of I/O signals

Logic Name Classification Description Range

0xxxx General Input
Reference with input instruction of the 
job.

00010 - 01287
(1024 signals)

1xxxx General Output
Reference with input instruction of the 
job.

10010 - 11287
(1024 signals)

2xxxx External Input
Signal No. corresponding to the input 
terminal.

20010 - 21287
(1024 signals)

3xxxx External Output
Signal No. corresponding to the output 
terminal.

30010 -31287
(1024 signals)

4xxxx Specific Input
Signal to change the operating 
condition of the robot.

40010 - 41607
(1280 signals)

5xxxx Specific Output
Signal notifying the operating condition 
of the robot.

50010 - 52007
(1600 signals)

6xxxx
Interface Panel 
Input

Signal notifying the operating condition 
of the interface panel.

60010 - 60647
(512 signals)

7xxxx Auxiliary Relay Auxiliary relay in the concurrent I/O
70010 - 79997
(7992 signals)

80xxxx Control Status
Monitoring of the hardware signal 
status of the robot control section.

80010 - 80647
(512 signals)

82xxxx Pseudo Input
Pseudo input relay reading from the 
system parameter.

82010 - 82207
(160 signals)

25xxxx Network Input Input signal from thenetwork device.
25010 - 26287
(1024 signals)

35xxxx Network Output Output signal to the network device.
35010 - 36287
(1024 signals)

Mxxxx Register

1 word data (16 bits)
General Register

M000 - M559
Analog output register

M560 - M599
Analog input register

M600 - M639
System Register

M650 - M999

M00 - M999
(1000 signals)
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An External Input signal (#20010 - #21287) or External Output signal (#30010 - #31287) is allocated for 
each I/O data of the board.

In the case of a Digital I/O expansion board (LIO-08R, LIO-09R), the board can transmit to the 
controller 32 input points (4 bytes) and 32 output points (4 bytes).
In regard to the first board, the configuration of the first 16 I/O points (2 bytes) is dedicated by system. 
The dedicated I/O assignment depends on the controller selected application. The remaining 16 I/O 
points (2 bytes) are assigned to the General I/O which corresponds to the I/O instruction of a job.
In regard to the subsequent board, 32 input points and 32 output points are assigned to the General I/
O.
When the board is set, the area for 48 input points and 48 output points (6 bytes) is reserved. The first 
32 points (4 bytes) are usable area, and the remaining 16 points (2 byte) are unusable area (they are 
assigned to the area of the board status).

When two I/O expansion boards are set, I/O signals are as follows.

.

To help identify the correspondence between the I/O board signal and the controller signal, comments 
for each I/O point can be added under the [IO_ALLOC] section in the "VRCNXMAIN.INI" file. The 
comment corresponding to an I/O point is displayed on the comment section in the Virtual I/O dialog 
when the mouse pointer is over a I/O point.

The information is entered in the following format:
LG<External I/O No.>=Comment     

For example:
File:VRCNXMAIN.INI

[IO_ALLOC]
LG20030=IN0001   
LG20031=IN0002   
LG20032=IN0003  
...

Input Output

20010 - 20017 : Assigned by system
20020 - 20027 : Assigned by system
20030 - 20037 : General I/O (IN#001-008)
20040 - 20047 : General I/O (IN#009-016)
20050 - 20057 : Unusable Area
20060 - 20067 : Unusable Area

30010 - 30017 : Assigned by system
30020 - 30027 : Assigned by system
30030 - 30037 : General I/O (OUT#001-008)
30040 - 30047 : General I/O (OUT#009-016)
30050 - 30057 : Unusable Area
30060 - 30067 : Unusable Area

20070 - 20077 : General I/O (IN#033-040)
20080 - 20087 : General I/O (IN#041-048)
20090 - 20097 : General I/O (IN#049-056)
20100 - 20107 : General I/O (IN#057-064)
20110 - 20117 : Unusable Area
20120 - 20127 : Unusable Area

30070 - 30077 : General I/O (OUT#033-040)
30080 - 30087 : General I/O (OUT#041-048)
30090 - 30097 : General I/O (OUT#049-056)
30100 - 30107 : General I/O (OUT#057-064)
30110 - 30117 : Unusable Area
30120 - 30127 : Unusable Area
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8.3 I/O Events

An I/O Event allows to monitor a specific I/O state during playback.  When the I/O state changes to a 
set condition, it triggers an event, which executes a model script. 
 For example, in a handling application, if the output #1 is used to open and close the gripper,  an event 
can be linked to this I/O signal in MotoSim EG-VRC to execute a model script to change the gripper 
appearance to an open or close state.
On the [Simulator] tab, in the [I/O Setting] group, click the [I/O Events Manager] button, the [I/O Events] 
dialog appears.

8.3.1 I/O Event Manager
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I/O Events Dialog Box

Item Description

I/O Event list

List of all the I/O Events registered in the cell.
• Controller: Name of the controller.

The checkbox on the left of the controller name, 
indicates if the I/O Event is enables or not.  The 
enable state can be changed by clicking on the 
checkbox.

• I/O Signal: Displays the I/O number or I/O name of the I/O 
signal being monitors.  
Displayed information is changed by checking or 
unchecking the “Display I/O Signal Name” 
checkbox.

• Condition: The event will execute when the I/O signal 
changes to this condition (ON or OFF).

• Event: Description of the event that will be executed 
when the I/O signal changes to the set condition.

Double-clicking on an I/O Events will display its I/O Event Property dialog 
for edition.  

[Display I/O Signal Name] 
checkbox

When checked the I/O Signal column in the list displays the I/O name 
instead of the I/O number.

[Add] button Displays the “I/O Event Property” dialog to create a new I/O event. 

[Edit] button
Displays the “I/O Event Property” dialog of the currently selected 
I/O Event for edition.

[Delete] button Deletes the currently selected I/O Event.

[Enable All] button Enables all of the I/O Events

[Disable All]button Disables all of the I/O events.

[Script Editor]button
Displays the “Model Script Editor” dialog to add or edit the model scripts.  
(For details, refer to section 11.12 "Model Script")

[Close]button Closes the I/O Events dialog.

The I/O names displayed for a I/O signals correspond to those defined in the 
VRCNXMAIN.INI file (For detail, refer to section 8.2.4 "Inputs and Outputs")

NOTE
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8.3.2 I/O Event Property

The “I/O Event Property” dialog box is displayed by pressing the [Edit] or [Add] button of the 
“I/O Events” dialog box.
It allows setting the I/O Event properties such as the I/O signal, condition and event.

“I/O Event Property” Dialog Box

Item Description

[Enable] Indicates that the I/O Event will be monitored during playback when checked.

[Controller]
Selects the controller associated with the I/O Event.
This field cannot be modified when editing an existing I/O Event.

[I/O Signal] 

Selects the controller I/O signal that will be monitored during playback.
The combobox list contains both the I/O number and I/O name, but only one 
of the information will display in the box.
Displayed information is changed by checking or unchecking the “Display I/O 
Name” checkbox.

The combobox list only contains the I/O signals available on the selected 
controller.  Changing controller selection changes the list content. 

[Condition] 
Selects if the event will execute when the I/O signal changes to the ON or 
OFF condition.

[Event] 
Enter or select the script name to be executed when the I/O signal changes to 
the set condition.

[OK] button
If in [Add] mode: adds a new I/O Event definition. 
If in [Edit] mode: updates the selected I/O Event definition.
Closes the “I/O Event Property” dialog box.

[Cancel] button Closes the “I/O Event Property” dialog box.

The I/O names displayed for the I/O signals correspond to those defined in the 
VRCNXMAIN.INI file (For detail, refer to section 8.2.4 "Inputs and Outputs")NOTE
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8.4 I/O connection

The I/O connect allows to exchange I/O signals between robot controllers.
It is possible to interlock the motion of robot to set this function.
On the [Simulator] tab, in the [I/O Setting] group, click the [I/O Connection Manager] button, the [I/O 
Connections] dialog appears.

8.4.1 Management of I/O connection

I/O Connection

Item Description

Controller
The robot controller can be selected.
When selected the "ALL Controller", all setting can be displayed in current 
cell.

 

 

Select a controller.

I/O connection list. 
8-26

HW0485348
254 of 671



8  Tool Functions
8.4  I/O connection

156225-1CD
I/O connection list

List of all the I/O connections registered in the cell.
• Controller: Name of the controller.

The checkbox on the left of the controller name, 
indicates if the I/O Event is enables or not.  
The enable state can be changed by clicking on 
the checkbox.

• I/O Name: Displays the I/O number or I/O name of the I/O 
signal being input. 
Displayed information is changed by checking or 
unchecking the “Display I/O Signal Name” 
checkbox.

• Connection: The value of connection will be output to I/O 
name signal.  

Double-clicking on an I/O Connections will display its I/O Connection 
Property dialog for edition.

[Display I/O Signal Name] 
checkbox

When checked the I/O Name column in the list displays the I/O name 
instead of the I/O number.

[Add] button Displays the I/O Connection Setting dialog to create a new I/O Connection. 

[Edit] button
Displays the I/O Connection Setting dialog of the currently selected I/O 
Connection for edition.

[Delete] button Deletes the currently selected I/O Connection.

[Enable All] button Enables all of the I/O Connection.

[Disable All]button Disables all of the I/O Connection.

[Close]button Closes the I/O Connection dialog.

I/O Connection

Item Description
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8.4.2 I/O Connection setting

The I/O Connect setting dialog box is displayed by pressing the [Edit] or [Add] button of the 
I/O Connection dialog box. It allows setting the I/O Connection properties such as the I/O Name and 

connection.

I/O Connection setting

Controller The robot controller can be selected to edit the I/O connection.

Input

Select the controller I/O name that will be connected.
Displayed information is changed by checking or un-checking the [Display 
I/O Name check] box.
The combo-box list only contains the I/O Names available on the selected 
controller.  Changing controller selection changes the list content.

Delay Timer
The time can be set to delay to substitute connection for input. (Unit of time 
is second)

[Display I/O Signal Name] 
checkbox

When checked the I/O Name column in the list displays the I/O name 
instead of the I/O number

Connection

Displayed contents of connection by selecting the Input.
• [Oper.]: “+”,”*”, “ “  can be selected.
• [ (! ]: “!”, “(“, “!(“, “(!“, “ “ can be selected.
• [Controller]: The robot controller can be selected that will 

have the   output signals.
• [I/O Signal]: Displayed I/O signals as output by un-checking 

the [Display I/O Signal Name] checkbox.
• [I/O Name]: Displayed I/O names as output.
• [ ) ]: “)“, “ “ can be selected. Should be set to be equal 

to the number of pre brackets.

[OK] button
If in [Add] mode: adds a new I/O Connection definition. 
If in [Edit] mode : updates the selected I/O Connection definition. Closes 
the I/O Connection Property dialog.

[Cancel] button Closes the I/O Connection Property dialog.

 

 

Displayed contents of connection.
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Procedure

1. When pushed [Add] button, displays the I/O Connection Setting dialog to create a new I/O 
Connection. When pushed [Edit] button , Displays the I/O Connection Setting dialog of the 
currently selected I/O Connection for edition.

2.  After setting each items, and pushed [OK] button, connection will be updated.
Below is example setting, the [OUT001] of [NX100-2] will be set to the [IN001] of [NX100-1] 
after 1.0 second.

 PLC setting

The PLC device can be used to set the complicated connection
“X“, “Y“, “M“ means,

- “X“ : Input signal 
- “Y“ : Output signal
- “M“ : Internal register

The maximum number of each signal is 128.

Logical expression

+ Mean OR (∪ ).

* Mean AND (∩ ).

! Mean NOT. This will be used to set "make-before-break contact".

(  ) Mean bracket.

 

 
(1) Select controller 

example：NX100 

(2) Input signal 

example：IN0001 

(3) Connection expression 

example：Controller：NX100-2

I/O Name：OUT0001

(4)Delay timer(second) 

example：1.00 
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Below is example diagram to set,

1. Set to substitute OUT001 of NX100 for X001 of PLC device.

Also, “OUT0002”, “OUT0005” and “OUT0006”set to substitute “X0002”, “X0003” and “X0004” of 
PLC device.

①

NX100 NX100-2

O UT0001

O UT0006

O UT0002

O UT0005

IN0001

PLC

X0001

X0004

X0002

X0003

Y0001

X0001

X0002

X0003 X0004

M 0001

M 0001

Y0001

②

③

④

8-30

HW0485348
258 of 671



8  Tool Functions
8.4  I/O connection

156225-1CD
2. Set to substitute the internal register [PLCX:0001+PLC:X0002] for [PLC:M0001].

3. Set to substitute the internal register [(PLC:X0003*PLC:X0004) + PLC:M0001] for PLC:Y0001.
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4. Finally, set to substitute PLC:Y001 for NX100-2:IN001.

The setting of example diagram is finished,
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8.5 Variable Monitor

Displaying and editing the robots are enabled by setting the Variable Monitor.
On the [Simulator] tab, in the [Monitor] group, click the [Variable Monitor] button, the [Variable Monitor] 

dialog appears.

Variable Monitor

Item Description

[Add(A)] button

Displays the Variable Property dialog box to set the variables to be 
displayed and edited.
When setting a position variable (such as P, BP, EX variables), be sure to 
specify the frame (coordinate) in the FRAME combo box.

Setting of FRAME:
Variable P:   When "USER" has been selected, set the user
                     coordinate number in the [UF#] box.
Variable BP: Enabled only when "PULSE" or "BASE" is 
                     selected.
Variable EX: Enabled only when "PULSE" is selected.
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8.6 Lap Time Panel

The Lap Time Panel dialog box shows playback time of a specified section or the number of stroke per 
minute (spm).
On the [Simulator] tab, in the [Monitor] group, click the [Lap Time Panel] button, the [Lap Time Panel] 

dialog appears.

[Mod(M)] button

Displays the Variable Property dialog box to modify the variables.
If "PULSE" is selected in the FRAME combo box when a position variable
(such as P, BP, EX variables) is selected in the Name combo box,
no selection can be made in the .TYPE. section.

[Del(D)] button Deletes the selected variables.

[Clear(L)] button Deletes all the variables displayed in the Variable Monitor window.

[Close(C)] button Closes the Variable Monitor window.

This function can not be used with high-speed playback function. Refer to section 7.5.4 
"Refresh Interval" about high-speed playback function.

Variable Monitor

Item Description

NOTE
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Procedure

1. Enter the following comment at the point where the lap time count is to be started.
(Note that the comment has to be entered before the start point as shown in the figure below at 
"(a)".)
        'RPT:LAP=START

2. Enter the following comment at the point where the lap time count is to be stopped. (Note that 
the comment has to be entered after the end point as shown in the figure below at "(b)".)
        'RPT:LAP=STOP

3. On the [Simulator] tab, in the [Monitor] group, click the [Lap Time Panel] button, the [Lap Time 
Panel] dialog appears.

4. Play back the job.

5. After the playback, the Lap Time Panel dialog box shows the playback time between two points 
specified in step 1 and 2 above, or the number of stroke per minute (spm) of the currently 
selected controller.
To display the lap time of each controllers, change the robot selection in the controller list.

6. Press   to reset the value to zero in the Lap Time Panel dialog box.

Controllers can not be selected during the playback.

 

(a) Comment to start the 
Lap Time count. 

(b) Comment to stop the 
Lap Time count. 

 

Playback time of specified  
interval, 

OR 
The number of stroke per  
minute (spm.) 

Controller 
li
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8.7 Stage Master

The Stage Master dialog allows selecting which controller will be affected by the  playback start 

command. 
On the [Simulator] tab, in the [Playback] group, click the [Stage Master] button, the [Stage Master] 
dialog appears.
In the Stage Master dialog, put a check mark next to the controller that will be affected by the playback 
start command then press [OK] to close the dialog.
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8.8 Pulse Recorder

When playback is performed with [Pulse Recorder] dialog box displayed on the screen, the pulse 
position of the specified robot or the model information are displayed in the dialog box at every screen 
refresh. When it needs that the model information are displayed, Check the [Output Model Script].
When moving the cursor in the displayed list of data, if the selected data line contains pulse information, 
the robots are moved to the specified pulse positions. If the selected data line contains model 
information, the model script is executed.

On the [Simulator] tab, in the [Monitor] group, click the [Pulse Recorder] button, the [Pulse Recorder] 
dialog appears. 

Pulse Recorder Dialog Box

Item Description

Moves the cursor to the first data line and executes it.

Move the cursor to the previous data line and executes the line.

Continuously executes the data line in the pulse record from the cursor 
current position to the end of the list or until stopped.

Stops the continuous execution of the data lines started by pressing the 

 button.

Moves the cursor to the next data line and executes the line.

Moves the cursor to the last data line and executes it.
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Output Model Script Model information is displayed in the list of pulse record.

Update VRC
When the pulse record is played, the robot position is set to the controller. 
If this item is "OFF", the playback gets faster because the robot position is 
not reflected.

[Copy] button Copies all the data lines to the clipboard. 

[Delete] button Deletes the data line where the cursor is located.

[Reset] button Deletes the all the data lines. 

[Load] button Retrieves the previously saved data lines from a text file (.txt). 

[Save]button Stores all the data lines in a text file (.txt).

[Close]button Closes the Pulse Recorder.

• Buttons in the Pulse Recorder dialog box can only be used after a job has been played 
back.

• When the pulse record is played, the robot position is updated at refresh intervals. Refer 
to section 7.5.4 "Refresh Interval"" for refresh interval.

Pulse Recorder Dialog Box

Item Description

NOTE
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8.9 Teaching

8.9.1 OLP

OLP is a teaching tool that simplifies the robot teaching by moving the robot to an target position. 
On the [Home] tab, in the [Teaching group, click the [OLP] button, the [OLP] dialog appears.
For the details on how to use OLP, refer to section 13.1 "Teaching Using OLP Function".

                                                      

Use the [Shift] key 
to toggle the “Pick 
Enable” checkbox 

Name of the 
operation object 
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OLP dialog box

Item Description

[OLP Pick] check box
To be selected whenever OLP is used.
The check box is automatically cleared when another function is selected to 
operate the robot.

“Move Mode” section

Determines the method to move to the target point.
[Position] check box:

The Operation Object is moved to the position (XYZ) of the target point. 
[Orientation] check box:

The Operation Object is turned to match the orientation (Rx, Ry, Rz) of 
the target point frame.

[Z-Axis] check box:
The Operation Object is turned so that its Z-axis matches the Z-axis of 
the target point frame.

[Use Face] section:
This setting is enable with  [Orientation] or [Z-Axis] mode.  It can be use 
to change the direction of the Z-Axis when selecting a face.
[Normal] radio button:

The Z-axis is in the same direction as the face normal. 
[Reverse] radio button:

The Z-axis is in the opposite direction of the face normal.

“Pick Mode” section

Sets conditions determining the selected point in the clicked area. 
[Free] check box:

Point of the model at the clicked position. 
[Vertex] check box:

Nearest vertex from the clicked position.
[Center] check box:

Center of the nearest face or edge from the clicked position. 
[Edge] check box:

Nearest edge point from the clicked position.

“Pick Object” section

Sets the type of the object to be selected when clicking on the cell view.  
(Multiple items can be selected) 

[Model] check box:
Solid models. 

[Frame] check box:
Model frame or AXIS6 models. 

[Lines & Inters] check box:
Lines such as LINE part, WORK line and wireframe model, and 
intersection lines generated by the intersection of parts or models. 

[Point] check box:
Points such as TRACE points. 

[Floor] check box:
FLOOR parts.

If only the orientation is to be changed without 
changing the position, uncheck the [Position] 
checkbox before clicking any point.

NOTE
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“Operation Obj” section

Selects an object to be moved to the target point.
[Robot TCP] radio button:

-Sets the robot TCP as the object to move.To select the robot, please 
refer to section section 7.3 "Deleting a Controller".
[Move Slave] checkbox:

- When checked, the [Move Slave] function is enabled.  When a robot 
or station is moved, other slave robots from the same controller are 
moved with it so that their TCP maintain the same relative position to 
the moved robot or station. 
By default all robots are set as slave.  The individually setting of each 
robot can be changed by pressing the [...] button to display the “Set 
Slave Robot” dialog.

[Teacher] radio button:
-Sets the “Teacher” coordinate axis as the object to move.

[Model] radio button:
-Sets the selected model as the object to move.

Model can be selected with  or {Screen} - {Model} - {SelectModel} or 

the [CADTree].
[XYZ] button:

-Displays the position data panel as shown below to manually modify the 
position or orientation of the operation object.  

        Position dialog                              Teacher dialog

OLP dialog box

Item Description

Refer to the dialog title bar to confirm the operation 
object name.

NOTE
8-41

HW0485348
269 of 671



  
8.9  Teaching

156225-1CD
 OLP Function Pick Method and Display

When the mouse pointer is over the cell view, press down the left mouse button.  The model considered 
for selection will display in yellow with a red dot to indicate the specific point location.  In the case of a 
solid model, the border (edges) of the pick face will be highlighted in green.  The display will update to 
represent change of selection as the mouse pointer is moved over different models.  The actual 
selection is made only when the mouse button is released.

“Move to External Ref. 
Point” section

TUse to move the part held by the robot to a specific point (External Reference 
Point).

[Active] check box:
- When check the robot will move the point clicked on the model it is 
holding to the defined external reference. 

[Select Reference] button:
Displays the Select Model dialog to select a model (frame) as the 
external reference point. 

"Synchronous Move of 
Base Axis" section

Use to move the base axis (servotrack) at the same time as the robot when 
moving to a target point.

[Active] check box:
- When check the base axis will move according the set method to enable 
the robot to reach the target point.

[Method...] button
-Specifies the method to move the base axis. 

OLP dialog box

Item Description

 

   

Pick Point
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The pick point display will change depending on the selected move mode.

 Selecting [Position] in the "Move Mode" section: (Other items set at 
default)

The robot moves so that the robot TCP overlaps with any clicked point.
Note that this motion does not involve any change in the wrist posture.

  

Position

Displays a point.

Orientation

Displays a frame (Z-axis is in red).

Z-axis

Display an arrow (Z-Axis).

 

               

Click
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 Selecting [Position] and [Orientation] in the "Move Mode" section: 
(Other items set at default)

The robot moves changing its wrist's posture so that the frame of the robot TCP overlaps the frame of 
the clicked point.  

 Selecting "Move to External Reference Point"

Click a point on a model carried by the robot and the robot will move to bring that point to the reference 
point.  (The reference point needs to have been set before this operation can be used.)   

                

Click

              
Click 

Reference Model
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 Selecting [CurModel] in the "Operation Object" section

Click a point and the currently selected model will be move to the click location.  The name of the 
current model is displayed in the OLP dialog title bar.

8.9.2 Operation Handle

The operation handle is to perform robot jog operation or model allocating by intuitive operation.
Drag the operation handle on the cell screen, the position of the robot is changed. So, unskilled 
engineers can perform robot operation easily.
And, drag the operation handle of the model, model allocating can be performed easily.

 Grid Settings

Sets the distance or angle of grid. This grid setting is available by following functions.
• Each Axis Operation
• TCP Handle
• Model Handle

For more details on the OLP operation, please refer to section 13.1 "Teaching Using OLP 
Function".

               

Click

Current Model

NOTE
8-45

HW0485348
273 of 671



  
8.9  Teaching

156225-1CD
On the [Home] tab, in the [Operation Handle] group, click the [Grid Settings] button. Grid Setting dialog 
box is displayed.

 Display Settings

Display/Hide the additional information of operation handle.

Tool Name Display Display/Hide the tool names at the tip of tool (TCP).

Guide Display
Display/Hide the guide line. For details, please refer to the "Guide 
Line" section of "TCP Handle".

       

 

       

Sets the travel distance. This setting 
is available by following functions. 
･Each Axis Operation 
･TCP Handle (axis, face) 
･Model Handle (axis, face) 

Sets the rotation angle. This setting is 
available by following functions. 
 ･Axis Operation 
･TCP Handle (rotation) 

 ･Model Handle (rotation) 
･Elbow Handle 

 

8-46

HW0485348
274 of 671



  
8.9  Teaching

156225-1CD
 Handle Display

On the [Home] tab, in the [Operation Handle] group, click the [Handle Display] button, the operation 

handle bar is displayed on the upper center of the view.

  Each Axis Operation

When drag the robot model, each robot axis is rotated. And, station and base axis can be operated. 
The base axis moves to the movable direction.
The distance while dragging, that is set by grid setting. For details, refer to the "Grid Setting".

Procedure

1. Click the icon  .

2. Move the mouse cursor to the robot model.

When enabled, each axis can be operated. When drag the robot 
model, that axis can be operated.

When enabled, TCP handle (axis) is displayed. 

 When enabled, TCP handle (face) is displayed. 

When enabled, TCP handle (rotation) is displayed. 

When enabled, OLP drag function is enabled.
When drag to the model, the TCP of the robot is moved to the position 
of mouse cursor. 

When enabled, model handle (axis) is displayed. 

When enabled, model handle (face) is displayed. 

When enabled, model handle (rotation) is displayed.

• A yellow frame is shown to an icon of the function performed.
• When the TCP handle is displayed in the cell with a double arm robot included in a 

current controller, the elbow angle handle to operate an elbow corner is displayed.

SUPPLE
-MENT
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3. When a mouse cursor comes to the robot model, robot model is highlighted.

4. Drag the highlighted robot model. During dragging, the angle of axis is displayed.

Base axis/Station

Because drag the model, base model or station model need be added to operate the base axis or 
station. It provides the following example of base (BASE-XT).

• The operable robot is only a robot of a current controller. To operate the robot besides 
the current controller, it is necessary to change the current controller.

• The operable robot is only a robot of a VRC controller.

 

Drag 

 

Angle of axis 

NOTE

     

Travel axis

Cad Tree dialog 

Rotate axis
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 TCP Handle

This handle is to operate the position of TCP, it displayed on the TCP frame.
The distance while dragging, that is set by grid setting. For details, refer to the "Grid Setting".

TCP handle is displayed at the position of all robots of the current controller, but all except for a robot 
included in a control group of a current job will be semi-transparent displayed. But, the operation of the 

semi-transparent handle is also possible.

Procedure

• Display the operation handle
To display the TCP handle, click the icon of the operation handle bar.

TCP handle (axis) …  

TCP handle (face) …  

TCP handle (rotation) …  
• Operate the operation handle

• The operable robot is only a robot of a current controller. To operate the robot besides 
the current controller, it is necessary to change the current controller.

• The operable robot is only a robot of a VRC controller.

     

X axis rotation

TCP handle (axis) 

Y axis rotation

TCP handle (face) TCP handle (rotation) 

Z axis rotationX axis 

Y axis 

Z axis 

XY face 

YZ face 

XZ face 

    

Robot not included a  
control group 

Robot included in a control group 

Semi-transparent display 

NOTE
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To operate the handle, drag the handle to move. When a mouse cursor comes to the 
handle, the handle is highlighted. And, during dragging, the traveling distance (or rotating 
amount) is displayed. When the coordinate system is "Tool", traveling distance is the 
relative value from drug start position. Otherwise, traveling distance is absolute value.

For example, to move as follows, drug the green handle to the following direction.

When drag the handle (face), TCP moves on the same plane as the dragged face.

     

Semi-transparent 
display Highlighted handle 

Traveling distance

   
Drag 

   

Drag 
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When drag the handle (rotation), TCP rotates on the same direction as the dragged ring.

• Select the Coordinate
The following coordinates are available to operating TCP handle. On the [Home] tab, in 
the [Operation Handle] group, select the coordinate by the combo box.

• Base coordinate and Robot coordinate
Robot always moves by the same posture as a base coordinate and a robot 
coordinate.

When operating the handle (rotation) by a base coordinate, a robot coordinate and the 
user coordinate, the handle doesn't rotate together, but a robot moves.

    
Drag 

NOTE
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• Tool coordinate
Robot always moves by the same position and posture as TCP.

• User coordinate
Robot always moves by the same posture as a selected user coordinate.

When selects USER AXIS, the following dialog box is displayed.

  

   
User 
coordinate 
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• Synchronized operation
When operate the Operation handle, the selected robot and another robot can move to 
keep their TCP the same relative position.
On the [Home] tab, in the [Operation Handle] group, click the [Synchronized] button, 
and operate the operation handle.

A double arm robot moves as follows.

The above is an example of the TCP handle (axis), but TCP handle (face) and TCP 
handle (rotation) can also do synchronized operation.

   

Drag the green handle to the right

R1 and R2 move 
to the right

   

Drag the red 
handle down 

R1 and R2 
move down
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• Guide Line
The guide line helps to recognize the TCP position at the XY-plane. A vertical broken 
line is displayed to the XY-plane from the TCP handle.
When some operation handle is displayed, on the [Home] tab, in the [Operation 
Handle] group, click the [Display Settings] button and the [Guide Display] button, the 
guide line is displayed.

When the [Guide Display] button is enabled, a vertical broken line is displayed to the 
XY-plane from the TCP handle

.

The guide line of the current controller (VRC controller) is displayed only.

 

 
Guide Line

NOTE
8-54

HW0485348
282 of 671



  
8.9  Teaching

156225-1CD
 Elbow Handle

When a double arm robot is included in a current controller and one of TCP handles (axis, face, or 
rotation) are displayed, the elbow handle is also displayed at the same time. When drags the elbow 
handle, the elbow angle can be changed. When a mouse cursor comes to the handle, the handle is 
highlighted. And, during dragging, the rotating amount is displayed.
The angle while dragging, that is set by grid setting. For details, refer to the "Grid Setting".
When drags like a left figure, robot moves as a right figure. 

 OLP Drag

When drag to the model, the TCP of the robot is moved to the position of mouse cursor. A pink marker 
is shown to a point on the model at the mouse cursor location.

Procedure

1. Click the icon  .

2. Click the robot model to operate.

 

Click 
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3. Drag on the model. TCP of the robot is moved to the position of mouse cursor
To operate another robot, proceed the step 2. But, only a robot in the current controller can be 

selected..

• The operable robot is only a robot of a current controller. To operate the robot besides 
the current controller, it is necessary to change the current controller.

• The operable robot is only a robot of a VRC controller.
• When drag at the location outside the reach of TCP, robot does not move. When mouse 

is outside the reach of TCP, robot stops at that position.

 

 

 

 
 

 

 

Side view 

Side view 

Side view 

Start dragging 

Dragging 

Finish dragging

TCP moves on 
the model 

NOTE
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 Model Handle

Model handle appears at the origin position of the model. When operates the model handle, Model is 
moved.

The distance while dragging, that is set by grid setting. For details, refer to the "Grid Setting".

Procedure

• Display the Model handle
1) To display the Model handle, click the icon of the operation handle bar.

Model handle (axis)… 

Model handle (face)… 

Model handle (rotation)… 

2) Select the model to operate
Click the model to operate. Model handle appears as follows.

• FLOOR model cannot be operated.
• When click the robot model, robot position is moved.

     

X axis rotation 

Model handle (axis) 

Y axis rotation

Model handle (face) Model handle (face) 

Z axis rotation

X axis 

Y axis 

Z axis 

XY face

XZ face
YZ face

NOTE

   

Click the model 
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3) Release of handle
To finish operating the model, click a FLOOR model or the space where model doesn't 
exist on the cell screen (light-blue space of the following figure). 

And, to operate another model, proceed the step 2. Then, Model handle is appears at the 

selected model and it is the target model.

• Operate the handle
To operate the handle, drag the handle to move. When a mouse cursor comes to the 
handle, the handle is highlighted. And, during dragging, the traveling distance or rotating 
amount is displayed.

When hide the operation handle bar or change to another operation handle, the operation 
is finished.

 

The space where 
model doesn't exist 

   

Click 

Target model 

SUPPLE
-MENT

   

Highlighted handle

Semi-transparent display 

Traveling distance 
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• Model handle (axis)
When drag the colored model handle (axis), the model is moved to the handle direction.
For example, the model is moved to the Y axial direction of model coordinates.First, drag the 
green handle to the following direction.

The following dialog is displayed and input the traveling distance manually.

When the [OK] button is clicked, the operation is fixed. When the [Cancel] button is clicked, the 
operation is canceled and the model returns to the original position.

Drag 
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• Model handle (face)
When drag the handle (face), the model moves on the same plane as the dragged face.
For example, the model is moved on the XY plane of the model coordinates.First, drag the red 
handle to the following direction.

The following dialog is displayed and input the traveling distance manually.

When the [OK] button is clicked, the operation is fixed. When the [Cancel] button is clicked, the 
operation is canceled and the model returns to the original position.

Drag 
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• Model handle (rotation)
When drag the handle (rotation), the model rotates on the same direction as the dragged ring.
For example, the model is rotated around X axis of the model coordinates.First, drag the blue 
handle to the following direction.

The following dialog is displayed and input the rotating amount manually.

When the [OK] button is clicked, the operation is fixed. When the [Cancel] button is clicked, the 
operation is canceled and the model returns to the original position.

Drag 
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• Model Copy
When the [Ctrl] key of a keyboard is pressed during handle operating, a model returns to the 
original location and only the handle moves.

When drag operation is ended, the following dialog is displayed and input the traveling distance 
manually.

When the [OK] button is clicked, the model is copied and copied model is displayed at the posi-
tion of handle.

 

Only the handle 
moves

     

Copied model
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The parent of the copied model is the same as an original model. A serial number is added to the model 
name.

When the [Ctrl] key is released in the state with the [Ctrl] key was pressed in the dragging, a model 
moves to the location of the handle again. Then, the model is not copied and drug operation is the 
usual model handle.

8.9.3 Visual Path Edit Function

Each step position is displayed and is connected with a line. And, drag the marker, the job is edited 
intuitively.

 RESTRICTION

• Visual path edit function is available only the current job of the current controller.
• Each step position is displayed and is connected with a line or a curve simply. So, visual 

path is different from the trace of playback. And, visual path is not supported the position 
level.

• Visual path edit function is available only the controller of 1 or 2 robots. But, the job whose 
control group is "R1+R2" is not supported.

• External axis is not supported.
• Only following move instruction is supported.

• MOVJ
• MOVL
• MOVC
• MOVS
• SYMOVJ
• SYMOVL
• SYMOVC
• SVSPOTMOV

• f the curve of MOVC or SYMOVC cannot calculated (ex. Lack of teaching point), the path 
is connected with a line.

• The line is drawn in order of step number. Visual path is not supported when the 
sequence is changed by the control instruction.

• When the CTP is set by variable, visual path is not supported.
• When job has any error (ex. Robot cannot reach the teaching point), visual path is not 

displayed.

Copied model

Target model
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• The following function cannot be used in PLAY mode. Change to the TEACH mode.
• Step move by clicking the move instruction marker
• Modify/Add the teaching point by TCP handle 
• Modify the anticipation value by dragging the SPYON/SPYOF marker
• Modify the PAINTSET tags by double-click
• Modify the instruction, add the instruction or delete the instruction by the right-button menu

 Setting

On the [Controller] tab, in the [Job] group, click the [Visual Path Edit] button and select the [Settings] 
menu, the visual path edit setting dialog is displayed.

Items of paint instruction can be set only the use of controller is paint.
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Move Instruction

Enable Shows/Hides the move instruction marker.

Cone height (mm) Sets the height of move instruction marker.

Cone diameter (mm) Sets the diameter of move instruction marker.

Color Sets the color of move instruction.

Opacity Sets the opacity of move instruction.

Path

Line weight (mm) Sets the line weight of path.

Enable work area only Selects whether the path of work area is displayed only or not.

Color

Movement section Sets the color of movement section.

Paint section

Auto
The color of paint section is selected automatically.
The color is selected by the paint condition file number. The color 
setting is loaded from the "vpecolor.ini" in the controller folder.

Manual The color of paint section is the selected color.

Opacity Sets the opacity of path.

Aux Instruction

Enable Shows/Hides the aux instruction marker.

Marker size (mm) Sets the size of aux instruction marker.

Opacity Sets the opacity of aux instruction marker.

Max display number

Sets the max number of aux marker between steps. When the 
number of aux instruction is over the max number, the display is 
skipped.

User Definition

Instruction Inputs the instruction.

Color Sets the color of the aux instruction marker.

Add Register the instruction name and color.

Upd Updates the selected line of the list to the instruction and color.
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 Show/Hide the Visual Path

On the [Controller] tab, in the [Job] group, click the [Visual Path Edit] button, the visual path is 
displayed.

Visual path of the current job of current controller is displayed. Click this button again, visual path is 
hidden. 

Del Delete the selected line in the list.

Paint Instruction

Enable
Shows/Hides the paint instruction marker.
Target instruction are SPYON, SPYOF,   PAINTSET, and 
PAINTEND.

SPYON/SPYOF

Marker size (mm) Sets the size of SPYON/SPYOF instruction marker.

Opacity Sets the opacity of SPYON/SPYOF instruction marker.

Color
Sets the color of SPYON/SPYOF instruction marker. It can be set 
every gun number.

PAINTSET/PAINTEND

Marker size (mm) Sets the size of PAINTSET/PAINTEND instruction marker.

Opacity Sets the opacity of PAINTSET/PAINTEND instruction marker.

Color
Sets the color of PAINTSET/PAINTEND instruction marker. It can be 
set every gun number.

Step Sets the step of spin box.

OK The setting is saved and this dialog is closed.

Cancel The setting is not saved and this dialog is closed.
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Step position is displayed as cone. Each step position is connected with a line or a curve simply. The 
color of move instruction is changed into the work area between SPYON and SPYOF.

This marker means move instruction position. Step number is displayed.

This marker means SPYON/SPYOF instruction.

This marker means PAINTSET/PAINTEND instruction. Selected instruction 
can be displayed.

 

Move Instruction

SPYON – SPYOF area
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Show/Hide setting of marker is can be changed in the ribbon menu. When the marker is displayed, the 

menu is highlighted.

Click the move instruction marker, robot moves to the step position.

Display Visual Path Shows/Hides the visual path.

Display Move Instructions hows/Hides the move instruction marker.

Display Aux Instructions Shows/Hides the aux instruction marker.

Display Work Instructions
Shows/Hides the paint instruction marker.
Target instruction are SPYON, SPYOF,   PAINTSET, and PAINTEND. This item 
is paint use only.

Display Work Area Only
Selects whether the path of work area is displayed only or not. This item is 
paint use only.

This operation cannot be used in PLAY mode.

Click 

NOTE
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When the mouse cursor is on the move instruction marker, the instruction is displayed. 

When the job is conveyor synchronization job, the visual path is displayed with CTP value. Click the 

move instruction marker, robot moves to the step position and conveyor moves to the CTP position.

When the SPYON/SPYOF instruction has "ANT=" tag or "ANTDIS=" tag and last move instruction has 
"NWAIT" tag, the SPYON/SPYOF marker is positioned defined time or defined distance away. 

[Example]
Anticipation is not set

Anticipation is set (Positive)

When the CTP is set by variable, visual path is not supported.NOTE

 

Click

CTP position 

 
Marker is not displayed 

beyond the next step.
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Anticipation is set (Negative)

 Edit the Teaching Position

Uses the visual path edit function and Operation handle, the job can be edited easily.

Procedure

1. On the [Controller] tab, in the [Job] group, click the [Visual Path Edit] button, the visual path is 
displayed.

2. On the [Home] tab, in the [Operation Handle] group, click the [Handle Display] button, the 
operation handle bar is displayed. Select the Handle.

3. Click the move instruction marker. Robot moves to the step.

When multi step is registered the same position, Select dialog is displayed

• This operation cannot be used in PLAY mode.
• MOVJ and SYMOVJ is not supported.
• Acceleration and deceleration of a robot aren't considered.

 
Marker is not displayed beyond 

the previous step.

NOTE

       

Click 

Robot moves to 
the step 
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4. Drag the operation handle while the keyboard key is pressed. When release the mouse button, 
the job is edited. When drag the operation handle without pressing the key, Robot moves but 
the job is not edited. To edit the job, click the move instruction marker again.

Following the keyboard assignment is available.

The operating coordinates of Operation handle is selected coordinates in the combo box in the 
[Operation Handle] group on the [Home] tab.

When the robot cannot moves to the handle position, the teaching point is changed.

[Alt] key Modify the teaching point

[Ctrl] key Add the move instruction after the step.

[Alt] + [Ctrl] key Add the move instruction before the step.

This operation cannot be used in PLAY mode.

      

[Alt] key + Drag
Teaching point 
is edited. 

Path before editing

 

NOTE
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 Edit the contents of instruction

Click the right button on the move instruction marker and select the [Edit this Instruction] in the right-
button menu, Edit function of the simple pendant is executed.

Double-click the PAINTSET marker, Paint Condition Setting dialog is displayed. When click the [OK] 
button, the setting is saved. When click the [Cancel] button, the setting is not saved.

                         

Click the right button
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When the SPYON/SPYOF instruction has "ANT=" tag or "ANTDIS=" tag and last move instruction has 
"NWAIT" tag and drag the SPYON/SPYOF marker, the anticipation setting can be edited. When release 
the button, the setting dialog is displayed. When click the [OK] button, the setting is saved. When click 

the [Cancel] button, the setting is not saved.

 Right-button menu

Click the right button on the move instruction marker, right-button menu is displayed. Following 

operation is available.

This operation cannot be used in PLAY mode.

Edit this Instruction
Edit this move instruction
(Execute the edit function of simple pendant.) 

Insert Teaching Point at 
previous

Insert teaching point at previous

Insert Teaching Point at 
next

Insert teaching point at next

Insert Paint Instruction 
here

Insert SPYON/SPYOF instruction

Remove this Instruction Delete the move instruction or SPYON/SPYOF instruction

 

Drag 

NOTE
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When delete the instruction, the following dialog is displayed. When click the [OK] button, the 

instruction is deleted. When click the [Cancel] button, the instruction is not deleted.

This operation cannot be used in PLAY mode.NOTE
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8.10 Collision Detection

This function displays the collision between some models.
When the collision is detected, the model is displayed in red, and the robot pulse data and the 
executing job name is displayed in the collision log.

To use the Collision detection, the following settings are needed.
1. The model (work, robot, etc.) group is registered as "Collision model group".
2. To detect collision, the model group pairing is registered as "Collision pair".
3. Select the Collision pair, and start the Collision Detection.

For details, please refer to section 13.3 "Collision Detection Setting".

8.10.1 Collision Detection Dialog

In this dialog, set up to detect collision, and operate the start/end the collision detection.
On the [Simulation] tab, in the [Collisions] group, click the [Collision Detection] button, the [Collision 
Detection] dialog appears.

   

1.Register the collision  
model group. 

Reset the collision log, or 
copy the collision log to  
clipboard. 
When the data need be 
outputted in the form of 
tab delimited, select the 
[ExcelOption] on the 
copy dialog. 

Collision log list 
When the collision log is 
clicked, the robot moves 
the interfering position. 

2.Register the collision 
pair. 

4.Start/End the collision 
detection. 

3.Select the collision 
pair to be used. 
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8.10.2 Collision Model Group Setting

 Collision Model Group Display

The model (work, robot, etc.) group is registered as "Collision model group".
To display the Collision Model Group dialog box, click the [ModelGroup] button on the Collision setting 

dialog box.

Collision Detection dialog option

Item Description

Collision Color (RED) The interfering model is displayed in red.

Playback without Redraw To reduce the time to check collision, Redraw is skipped on playback.

Move Collision Step

When the collision log is clicked, the robot moves the interfering position, and 
the cursor location in the virtual pendant moves to the step number position 
recorded in that log.
When this operation is used, set the teach mode.

Near miss check
When the models approach with in the selected distance, the models are 
considered interfering.

• The function is not available for hidden model.
• Near miss check option may need time to process.
• [Playback without Redraw] and [Move Collision Step] can not use depending on the 

system version of controller. Please refer to section 15.6 "List of Function depending on 
the system version of controller".

Collision Model Group 

Item Description

Collision Model Group List
The registered collision model group is displayed.
When the collision model group is selected, the models of the collision model 
group are highlighted.

Add The new collision model group is created.

NOTE

  

Collision Model Group 
List 
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 Auto-registration of the collision model group

The collision model group of robot is registered automatically in following case. Edit it if needed.
• When the new controller is created

• When the old cell (before MotoSim EG-VRC ver 2.60) is opened.

 Collision Model Group Detail Display

The models (work, robot, etc.) are registered/deleted to the collision model group.
To display the Collision Model Group Detail dialog box, click the [Add] button, the [Edit] button, or the 
[Copy] button on the Collision Model Group dialog box

Edit
The collision model group selected in the list is edited.
When the collision model group in the list is double-clicked, that can be edited.

Copy
The new collision model group is created based on the collision model group 
selected in the list.

Del The collision model group selected in the list is deleted.

Del All All collision model group selected in the list are deleted.

• The tool model is not added. Click the [Edit] button, and add the tool model if needed.
• The time to check collision depends on the number of model and the complexity of 

model.
All robot models are registered by Auto-registration. If some robot models need not be 
checked, narrow down the models of the collision model group at the Collision Model 
Group Detail Dialog Box.

Collision Model Group 

Item Description

NOTE
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.

Collision Model Group Detail

Item Description

Pick Enable

On the [Home] tab, in the [Model] group, click the [Select Model] button. Select 
the model in the MotoSim EG-VRC, that model is added to the [Model List].

Add from CadTree
Select the model on the CadTree, and click the [Add from CadTree] button, 
that model is added to the [Model List].

A child model is also 
registered simultaneously

When the model is added, the child model of that is also registered 
simultaneously.
For example, If the "SAKU" is selected in the CadTree and the [Add from 
CadTree] button is clicked, the child models "SAKU1", "SAKU2", "SAKU3", 
"SAKU4", "SAKU5", and "SAKU6" are also added.
("SAKU" is dummy model, so it is not added.)

Del The selected model in the [Model List] is deleted.

Del All All models in the [Model List] are deleted.
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8.10.3 Collision Definition Setting

 Collision Definition Dialog

To detect collision, the model group pairing is registered as "Collision pair".
To display the Collision Definition dialog box, click the [Add] button, and the [Edit] button on the 
Collision Detection dialog box.
Collision Detection function check if master interfere slaves. So, select one model group as Master, and 

Select one or more model group(s) as Slave.

Collision Definition

Item Description

Collision model group list

The registered collision model group is displayed in the list.
When the collision model group is selected, the models of the collision model 
group are highlighted.
To check the collision model group, set the Attribute items "Master" or "Slave".

Playback stop by collision 
detection

Set the robot action when collision occurs. If this is checked, playback is 
stopped when collision is detected in playback. When the playback is 
continued without interruption, do not check this, and register the collision 
definition.

   

Collision model group 
list 

Select the model group to 
check collision. 
Master is only one model 
groups. 
8-79

HW0485348
307 of 671



  
8.11  Sensing Option Setting

156225-1CD
8.11 Sensing Option Setting

When the Sensing option is used, to detect the point where the wire of robot has contact with the work, 
the searching operation (Starting Point Detection function) is available.
Please refer to "INSTRUCTIONS FOR BASIC OPERATION OF STARTING POINT DETECTION 

FUNCTION" of each the controller for details.

• This function can not be used for the FS100 controller.
• When this function is used, "Starting point detecting function" of option function in 

maintenance mode need be checked "use".
• When this function is used, turn off the servo simulation.On the [Simulation] tab, in the 

[Playback] group, click the [Servo Emulation] button. 

• Sensing function (SRCH tag of MOV* instruction) can be simulated, but sensing result is 
not the real one.

• The master model of sensing gets deeply into the slave one depending on the moving 
speed of sensing.

NOTE
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Procedure

It explains the procedure for setting the sensing option between the wire of robot (Model name: wire) 
and the work (Model name: work).

1. The wire (Model name: wire) is added at the torch head of robot.
In this case, the "CYLINDER" is used for the parts of wire.

2. On the [Simulation] tab, in the [Settings] group, click the [Sensing Setting] button, the [Sensing 
Option Setting] dialog appears.

3. Select [Master] in the [Model List] group.
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4. On the [Home] tab, in the [Model] group, click the [Select Model] button. Click the "wire" model, 
"wire" is displayed at [Model].

5. Click the [Add] button, the "wire" is set to the [Master] in the [Model List] group.

6. Select [Slave] in the [Model List] group, and set the "work" to the [Slave] as Step 4 and 5.

7. Click the [OK] button.
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8.12 Spray Model for Paint

The Spray Model for Paint function allows creating the spray model easily. The spray model is 

displayed and hidden automatically, when the SPYON or SPYOF instruction is executed.

Paint Panel

Item Description

[Gun No.] spin box 
(1 to 3)

Paint gun number.

[Tool No.] spin box Specifies the tool number to set the paint gun number.

"(a)TCP distance" 
edit box

Distance from the paint spray outlet (nozzle).

"(b)Valid distance" 
edit box

Effective range to apply paint from the nozzle.

"(c)Max Diameter" 
edit box

Maximum width of the paint spray face.

"(d)Mini Diameter" 
edit box

Minimum width of the paint spray face.

"(e)Nozzle Position" 
edit boxes

Nozzle position viewed from the flange.
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Procedure

1. Select the controller for the spray model setting.
2. On the [Simulation] tab, in the [Settings] group, click the [Paint Setting] button, the [Paint Panel] 

dialog appears. 
Set the Gun No. and Tool No. to according to the job.

3. Click the [OK] button or the [Apply] button, and then the spray model is created.
4. When the playback is executed, the spray model related to the Gun No. of SPYON or SPYOF 

instruction is displayed and hidden automatically.

"(e)Nozzle Posture" 
edit boxes

Nozzle posture viewed from the flange.

[TCP calculation] 
check box

Automatically calculates tool dimensions according to the input information.

[Transparent] check box Displays paint model in translucent color.

"Model division" 
combo box

Number of divided paint spray faces.

[TCP distance] button Paint color from nozzle to TCP.

[Valid distance] button Paint color from nozzle to the end of the valid painting distance.

[Display model] 
check box

Displays the created spray model.

This function can not used with two or more robot system.

Paint Panel

Item Description

NOTE
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8.13 Speed Graph Function

This function displays on a graph the robot TCP speed during playback.

8.13.1 Basic usage

The procedure for using the Speed Graph function is as follows.

• This function cannot be used in conjunction with the High-Speed Playback function.  For 
details on the High-Speed Playback function, please refer to section 7.5.4 "Refresh 
Interval" of the MotoSimEG-VRC Operation Manual.

• This function doesn't support multiple controllers or a controller with multiple robots.
• The speed displayed in this function is the speed of the TCP of the R1 robot of the 

current controller selected at the time the Speed Graph dialog was displayed.

NOTE

Trace Settings

Graph Settings

Playback

Graph Operations
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8.13.2 Trace Settings

To display the speed in the graph, this function uses the data from the robot TCP trace.  Therefore, the 
Trace function must be enabled and set to the robot TCP in order to use this function.For more details 
about the Trace function, please refer to section 13.2 "Trace Function" of the MotoSimEG-VRC 
Operation Manual.

Procedure

1. On the [Simulation] tab, in the [Monitor] group, click the [Trace] button, the [Trace Manager] 
dialog appears. To use the speed graph, you will need to set the trace to the TCP model: 
<ControllerName>-R01_tcp (example: DX100-R01_tcp). By default, the trace 
<ControllerName>-trace1 is already set to the TCP of the controller's R1 robot.

If it does not exist or was changed, please create a trace for the model "[controller name]-
R01_tcp".

2. To verify the settings, double-click on the trace "<ControllerName>-trace1" or select it and press 
the [Edit] button.  In the "Trace Property" dialog, if it not already set, select the 
"<Controller_Name>-R01_tcp" model in the "Model" field.
To display the speed relative to a moving work piece, change the "Parent" field from "world" to 
the model representing the work piece.
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8.13.3 Graph Settings

Set the graph settings before displaying the graph.
On the [Simulation] tab, in the [Monitor] group, click the [Speed Graph] button, the [Speed Graph] dialog 
appears.

Press the [Settings] button to display the "Graph Settings" dialog.

If the following message displays, the settings for the current controller are not set 
properly.  Please verify the graph settings.

 

NOTE
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 Graph Settings Dialog

In this dialog, display parameters such as I/O signals, line color, line thickness, scale, etc. can be set. 

Up to 5 I/O signals can be displayed.  The same I/O signal cannot be set multiple times.

 I/O Signal Setting Dialog

The "I/O Signal Setting" dialog is used to select the I/O signal to plot on the speed graph.

Graph Settings [Graph Settings]

Item Description

Refresh Interval
Sets the rate at which the Speed Graph is updated. 
(0.004 to 0.4 sec)

Speed Units Sets the speed units for the Y-axis.

Gradations Sets the number of gradation lines along the X and Y axes.

Y-axis auto-scaling 
during playback

When checked, the Y-axis scaling is automatically adjusted during playback 
to display the full range of the speed.

 

Check to display 
this data Open the dialog to 

select the I/O signal 

Set the line thickness 
Set the line color 

Check to adjust the 
Y-axis scaling during 
playback 

                             

Select between Input or 
Output signals 

Select the signal 
number 
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8.13.4 Playback

During playback, the speed is plotted on the speed graph.  The graph can display up to 200.0 seconds 
of data.  Playback data beyond 200.0 seconds will not be displayed.  Also note that graph operations 
cannot be done during playback. 

8.13.5 Graph Operations

After playback is complete, various operations can be done with the speed graph.

Mouse Operations

Keyboard Operations

Click on the graph
Move the cursor position (yellow line) to the clicked position.  
The robot in the MotoSim EG-VRC window will also move to the 
position corresponding to the cursor position.

Mouse Wheel Roll the mouse wheel to change the X-axis scaling factor.

[Ctrl] key + Mouse Wheel Roll the mouse wheel to change the Y-axis scaling factor.

Drag the scrollbar
Drag the bottom scrollbar to horizontally pan (X-axis) the graph in 
the display area.

[←] [→] keys Move the cursor position by one segment.  

[Ctrl] + [←] [→] keys Move the cursor position rapidly.  

[Home] key Move the cursor and the display area to X=0.0

[End] key Move the cursor and the display area to X=Max.

 

Display of robot 
speed and step 
number change 

Fit the whole playback 
within the display area 

Copy the graph data 

Display the graph 
settings dialog

Display of the data at 
the cursor position 

Display of the I/O 
signals 

Cursor (yellow line) 
position 
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 Graph Data Copy

When the [Copy] button from the "Speed Graph" dialog is pressed, the "Copy Data" dialog displays.  
Press the [File] button to save the data to a text file.  Press the [Clipboard] button to copy the data to the 
Windows clipboard so that the data can be paste in another application.
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8.14 Running an External Software

To run an external software with MotoSim EG. On the [Home] tab, in the [Tools] group, click the 
[External Software] button, the [Launcher] dialog appears and perform the settings explained in the list 
below.  

Launcher Dialog Box

Item Description

[Add] button

Select [Add] to register the software to run; the Launcher Setting dialog box appears.
Press the [Browse] button on the right of the Path edit box.  Select the desired program 
(executable file), and press [OK].  (The file name will be automatically entered in the 
Name edit box.)  

[Edit] button Edits the settings of the registered software. 

[Delete] button Deletes the registered software.

 

Path name of 
the external 
program to run.

File name opened by the software specified 
in the Path edit box. (Directly editable.)

Executable file name 
of the path: ".EXE" 
(directly editable.)
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8.15 Job Browser

Job Browser supported the selection the job. Job Browser is available for the NX100, DX100 and 
FS100. 
On the [Home] tab, in the [Teaching] group, click the [Job Browser] button, the [Job Browser] dialog 

appears.

 When starting Job Browser for the first time

When starting Job Browser for the first time, the bellow dialog appears. Open the Search tab in the Job 
Browser, search the job, and set the job to the root of the job tree.

“Keyword”
column

Double-click the desired software in the “Keyword” column to run the external software.  

This function can not use depending on the system version of controller. Please refer to  
section 15.6 "List of Function depending on the system version of controller".

Launcher Dialog Box

Item Description

Double-click to run the software.

NOTE
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 Main Window

Job Browser

Item Description

Controller Select the controller.

Job Tree tab Job Tree tab shows the job hierarchy as a tree.

Search tab Search the job in the controller on the Search tab.

Bookmark tab Bookmark tab shows the registered jobs as bookmark.

Select Job Set the selected job in the tree or list to the virtual pendant.

Close Close the Job Browser.
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 Sub Window

Job information and contents are displayed at the sub window. Job Browser enables the user to 
selectively hide and display the sub window.

Sub window

Item Description

Contents

Display the contents of the selected job. The line of the Contents list can be selected. 
When set the job to the virtual pendant, the cursor is set to the selected line.
Double-click the line, the job can be set to the virtual pendant. (The cursor is set to the 
selected line.)

Job Info The job header of the selected job is displayed.

Name The name of selected job is displayed.

Comment The comment of selected job is displayed.

Date The date of selected job is displayed.

Group The control group of selected job is displayed.

StepNo The steps number of selected job is displayed.
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 Right-click menu

Right-click menu

Item Description

Set Selected Job to Root
The selected job is set to the root of Job tree.
The current job tree is cleared.

Add to Bookmark / Remove from 
Bookmark

The selected job is added to (removed from) the Bookmark.

Job Data Update The selected job data is updated. The node is closed.

Contents Display/Hide the Contents window.

Job Info Display/Hide the Job Info window.

Expand

The Job tree is expanded from the selected 
node.

Set Master Job to Root
Set the master job set in the virtual pendant to the root of Job tree. If 
the master job is not set, The root of Job tree is not set.

During the expansion, the follow dialog box 
is displayed. Do not execute the playback.

NOTE
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 Job Tree Tab

Display the hierarchy structure of jobs as tree structure. The target instructions are CALL JOB, JUMP 
JOB and PSTART JOB. The tree is displayed until eight-level. And the tree can be expanded. The root 
of tree is set the follow jobs.

• The selected job on the Job tree
• The selected job in the list (Search tab/Bookmark tab)
• Master job in the virtual pendant
• Current job in the virtual pendant

Set Current Job to Root
Set the current job set in the virtual pendant to the root of Job tree. If 
the current job is not set, The root of Job tree is not set.

Right-click menu

Item Description
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 Search Tab

Press the [Search] button, jobs in the virtual controller is searched and the appropriate jobs are 
displayed in the list. A keyboard search is available. When the text box is empty, All jobs are displayed.

 Bookmark Tab

The selected job in the tree/list can be registered as bookmark.
It is useful for registering jobs with much reference number of times.
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8.16 Model Library

Model Library supports the model importing. Model Library dialog shows the preview of model 
registered with a library.
On the [Home] tab, in the [Model] group, click the [Model Library] button, the [Model Library] dialog 
appears.

8.16.1 Introduction

To import the model, drag and drop the model icon, or double-click the model icon. The type of model 
are "Work" and "Tool". It is different in the behavior when importing the model.

And, it's possible to add a model of a cell to the model library from the [CadTree] dialog.

Model Library

Category Changes the category of the models.

Edit
Edits the information of model (e.g. arrangement information) 
registered with the model library.
For details, refer to section 8.16.5 "Edit Model of Model Library".

Del
Deletes the model from the model library.
For details, refer to section 8.16.6 "Delete Model of Model Library".

When the model icon is dragged to the cell screen, the model in the mouse location is 
highlighted. For highlighting object, refer to section 6.4 "Pick Settings".

SUPPLE
-MENT
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8.16.2 Model Import (Work Type)

The model of peripheral equipment (e.g. Work, work table, controller and etc.) becomes "Work Type". 
When the model icon is dragged and dropped, the model is added at the highlighted position in the 
mouse location. And, the highlighted model becomes the parent model (in an exceptional case, when 
the FLOOR is highlighted, "world" becomes the parent model).?When the model icon is double-clicked, 
the model is added at the origin of world coordinates.

Procedure

1. Drag and drop the model.

2. When the FLOOR is highlighted, the parent model is "world".

3. Drag and drop the new model on the added model.
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4. The new model is added and the selected becomes the parent model. 

8.16.3 Model Import (Tool Type)

The model of tool (e.g. torch, servo gun and etc.) becomes "Tool Type". When the "Tool Type" model is 
dragged and dropped to the robot, the model is added at flange or TCP automatically. When the model 
icon is double-clicked, the tool model is added to the first robot of the cell.
And, when the "Tool Type" model is imported, the tool setting dialog is displayed. When the tool number 
is selected, the tool data registered with the model library is reflected to the controller.

Procedure

1. Drag and drop the model icon at the robot.
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2. Tool setting dialog appears. When select the tool number and press the [OK] button, the tool 

data is reflected to the controller. When press the [Cancel] button, the tool data is not reflected.

3. The tool model is displayed. When the tool data is set, TCP flame moves to the tip of tool.

Tool data setting dialog

Tool Selects the tool number.

ToolData The tool data of model is displayed.

OK The tool data is reflected to the selected number.

Cancel The tool data is not reflected.
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8.16.4 Add the model to the model library

The model of cell can be added to the model library.?Select the model in the [CadTree] dialog, display 

the right-click menu and select the [Add ModelLibrary...].

The model icon needs to be added manually. Refer to the following procedure.

Add Model Library

Category
Selects the model category.
When the category does not exist, the new model category can be 
made by inputting directly.

Name Selects the model name displayed on the model library.

Layout

Sets the model layout data. When there is the origin point of the 
model in a center, please input the data. (e.g. BOX model)
Layout data is used as the value of the offset. The model is located 
at the offset position from the mouse pick position.

Type

Chooses the type, "WORK" or "TOOL".
It is different in the behavior when importing the model. For details, 
refer to section 8.16.2 "Model Import (Work Type)" and section 
8.16.3 "Model Import (Tool Type)".

FLANGE / TCP
Selects which is the parent model, a flange of a robot or TCP.
When the model origin point is on the foundation side of the tool, 
choose "FLANGE". When it is on the tip of tool, choose "TCP".

ToolData

Sets the tool data. This values are reflected to the controller when 
the model is imported. When the parent of the model is a flange of a 
robot or TCP, MotoSim EG-VRC judges as the "TOOL" type and the 
No.0 tool data of the controller is displayed.

NOTE
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Procedure

1. Selects the target model from [CadTree] dialog.
• One Model

Selects the target model in the state "open".

• Multi Models

Get ToolData

When the parent of the model is a flange of a robot or TCP, this 
button is enable.
When the button is pressed, tool number select dialog is displayed. 
When select the tool number, the tool data of selected number is set 
to the ToolData.

Tool Number Select Dialog

Tool Selects the tool number of the controller.

ToolData The tool data of selected number is displayed.

OK Tool data is reflected to the Add Model Library dialog.

Cancel Tool data is not reflected and this dialog is closed.

Add Model Library

Target model：WORK only 
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Selects the target model in the state "close". All child models are included.

2.  Displays the right-click menu on the [CadTree] dialog and select the [Add ModelLibrary...]. 
3. Sets the Category, Name, Layout and Type on the [Add ModelLibrary] dialog and presses the 

[OK] button.

4. Added model is displayed on the Model Library. The model icon is "NO IMAGE".

Target model：DAI and all child models 
WORK and AXIS 
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5. Adds the model icon image. Saves an icon picture of the bitmap file format in a <Model Name> 
folder of ModelLibrary. The file name is made ITEM.bmp. For location of ModelLibrary folder, 
refer to the section 1.7 "Folder Configuration".

6. When Model Library dialog is refreshed, the new model icon is displayed.

 MotoSim EG-VRC 

ModelLibrary 

<Category> Folder 

<Model Name> Folder 

ITEM.ini 

ITEM.bmp 

Model File 
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8.16.5 Edit Model of Model Library

Selects the model icon and press the [Edit] button, the model data can be edited.
For detail of the edit dialog, refer to section 8.16.4 "Add the model to the model library".

8.16.6 Delete Model of Model Library

Selects the model icon and press the [Del] button, the model data can be deleted.

This operation cannot be undone.
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8.16.7 Export the Model of Model Library to Other PC

The model of model library can be used on other PC.
The model of model library is managed the following <Model Name> Folder. 

When <Model Name> folder of one PC is copied to <Category> folder of other PC, the model can be 
used on the other PC. For the location of [ModelLibrary] folder, refer to section 1.7 "Folder 
Configuration".

 MotoSim EG-VRC 

ModelLibrary 

<Category> Folder 

<Model Name> Folder 
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8.17 Simple PP

Simple PP dialog is the simple version of virtual pendant for teaching and playback.

On the [Controller] tab, in the [Job] group, click the [SimplePP] button, the [Simple PP] dialog appears.

 Main Display

In a cell with multiple controllers, it is necessary to select the controller to edit with the 
ribbon   before operating the Simple PP dialog box.

TEACH/PLAY button Changes the mode (TEACH / PLAY) of the controller.

START button
Starts the playback. This button is highlighted during 
playback.

NOTE

 

 

Refresh button 

Job Select button 

Displays selected motion 
type and speed to be  
added or modified. 

Controller name 

Job name and Control 
Group 

Tool number of the 
cursor line. 

Set the book mark 
or break point. 

SYNC check box 

Job Contents panel 
When click the right 
button, right-button 
menu is displayed. 
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HOLD button Interrupts the playback.

SERVO button
Turns the servo ON. This button is highlighted while servo 
power is ON.

Alarm button Resets the alarms. This button is highlighted while alarms 
occur.

Job Stack
Display the Call Stack display.
For details, please refer to the section 10.4 "Job Stack".

Job Select button
When click this button or press the [ALT] + [W] key, displays 
the Job Select dialog.
For details, refer to the section 8.17.1 "Job Select".

Refresh button When the job is edited on the virtual pendant, click this button 
to refresh the job contents.

New button
Displays the Job Create dialog.
For details, refer to the section 8.17.2 "Job Create".

Copy button
Displays the Job Copy dialog.
For details, refer to the section 8.17.3 "Job Copy".

Delete button Displays the Job Delete dialog.
For details, refer to the section 8.17.4 "Job Delete".

Job Contents panel

The robot moves to the step selected in the job contents 
panel if the [SYNC] check box (  ) is selected. When 
the cursor is on the CALL JOB: or JOMP JOB: instruction, 
and press the [Alt] + [Down] key, the called job is 
displayed.?When press the [Alt] + [Up] key, the previous job is 
displayed.Job Edit dialog box appears by double-clicking the 
selected job.

[Job Edit]
Modify the instruction in the edit box. Select either the [Add 
Line] or [Replace Line] button.

Add Line: Adds the new instruction under the cursor line.
Replace Line: Replaces the instruction of the cursor line.

Move button
Displays the Interpolation dialog box. Specify motion type, 
speed and position level.

Add button

Adds the new move instruction under the cursor line.
And, same operation is available with operation handle. 
Please refer to the section 8.17.8 "Teaching with Operation 
Handle". 

Mod button Replaces the teaching position of the cursor line to current 
position.
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 Right-button menu

Del button Deletes the cursor line.

VPP button
Displays the virtual pendant if the virtual pendant is not 
shown.

Search Display the Search dialog. (Short cut key: [Ctrl] + [F])

Cut Selected area is cut. (Short cut key: [Ctrl] + [X])

Copy Selected area is copied. (Short cut key: [Ctrl] + [C])

Paste Cut area or copied area is pasted. (Short cut key: [Ctrl] + [V])

Reverse Paste
Cut area or copied area is pasted in reverse.
(Short cut key: [Ctrl] + [Shift] + [V])

Delete Selected area is deleted. (Short cut key: [Delete])

Replace Inform
Informs of the selected area are replaced.
For details, please refer to the section 8.17.7 "Replace 
Inform".

Setting BreakPoint
Set/Delete the break point to the selected line. (Short cut key: 
[F9])
For details, please refer to the chapter 10 "Debug Function".

Del All BreakPoint
Delete all break point of the target controller.
For details, please refer to the chapter 10 "Debug Function".

Disable All BreakPoint
Disable all break point of the target controller.
For details, please refer to the chapter 10 "Debug Function".

Enable All BreakPoint
Enable all break point of the target controller.
For details, please refer to the chapter 10 "Debug Function".

Shortcut List Display the shortcut list dialog.
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8.17.1 Job Select

Selects a job from job list, the job is displayed on the Simple PP dialog box.

8.17.2 Job Create

Creates a new job and displays on the simple PP dialog.

Search

A keyword search is available.
In the above dialog, input the "SE" on the edit box and click 
the [Search] button, "RESET-R1" and "H_CLOSE" is 
displayed on the job list. When the edit box is empty, All jobs 
are displayed.

Job list Select a job in this list to set to the simple PP dialog.

OK button Sets the selected job to the simple PP dialog.

Cancel button Closes this dialog without job selection.

Job Name Inputs the job name.

Comment Inputs the comment of the job.

Control Group Select the control group from drop down list box.

 

Job list 
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8.17.3 Job Copy

Copies the selected job and displays the new job on the simple PP dialog.

OK button Creates the new job and displays on the simple PP dialog.

Cancel button Closes this dialog without creating a job.

Search

A keyword search is available.
In the above dialog, input the "SE" on the edit box and click 
the [Search] button, "RESET-R1" and "H_CLOSE" is 
displayed on the job list. When the edit box is empty, All jobs 
are displayed.

Job list Select a job in this list to be copied.

New Name Inputs the new job name.

OK button Copies the selected job and displays the new job on the 
simple PP dialog.

Cancel button Closes this dialog without copying a job.

Job list 
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8.17.4 Job Delete

Deletes the selected job.

Search

A keyword search is available.
In the above dialog, input the "SE" on the edit box and click 
the [Search] button, "RESET-R1" and "H_CLOSE" is 
displayed on the job list. When the edit box is empty, All jobs 
are displayed.

Job list Select a job in this list to be deleted.

OK button Deletes the selected job.

Cancel button Closes this dialog without deleting a job.
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8.17.5 Search

Search the keyword in the job.
When the cursor in the job contents panel, select the "Search" in the right-button menu or press the 
[Ctrl] key and [F] key, Search dialog is displayed.
When the cursor in the job contents panel and press the [F3] key, forward search is available. And 

press the [Shift] + [F3] key, back search is available.

8.17.6 Job Edit

When the line is selected and double-click or press the [Space] button, Job Edit dialog box is displayed. 

Modify the instruction in the edit box and select either the [Add Line] button or [Replace Line] button

Find what Inputs a keyword.

[Match case] check box
When this is enabled, the large character is separated from 
the small character.

[Find Next] button The keyword is searched from current cursor position.

[Cancel] button This dialog is closed.

[Add Line] button
Adds the new instruction under the cursor line. (Short cut key: 
[Shift] + [Enter] key)

[Replace Line] button

Replaces the instruction of the cursor line. When the 
instruction of the cursor line is move instruction, teaching 
point is not changed.
(Short cut key: [Enter] key)

[Cancel] button Close this display.
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8.17.7 Replace Inform

Informs of the selected area are replaced to the [Move] instruction.
When the lines are selected, select the "Replace Inform" in the right-button menu.

8.17.8 Teaching with Operation Handle

When the Simple PP and TCP handle of operation handle are displayed and double-click the TCP 
handle with pressing [Ctrl] key, teaching point is added. The instruction of Simple PP is reflected.

8.17.9 Book Mark

Sets the book mark to the selected line. And, Jump to the book mark in the book mark dialog.
When the line is selected and press the [Ctrl] + [M] key, set/delete the book mark.
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Press the [Ctrl] + [Shift] + [M] key, the book mark dialog is displayed.

Controller Select the controller to display the book mark.

Bookmark List

When double-click the bookmark, the job and current line of 
simple PP and virtual pendant are changed to the book mark.
When double-click the Comment area, Set the Comment to 
the bookmark.

[Delete] button Delete the selected book mark.

[Delete All] button Delete all book marks.
8-116

HW0485348
344 of 671



  
8.18  JobPad

156225-1CD
8.18 JobPad

JobPad shows the saved jobs from VRC and these job can be edited. the edited job can be loaded to 
VRC.

On the [Controller] tab, in the [Job] group, click the [JobPad] button. The [JobPad] dialog appears.

 Main Window

The displayed format is the text data saved in ex. memory. So, this format is different from 
that of virtual pendant and real pendant.

[New] button To create a new job, the [Job Crate] dialog is displayed.

[Open] button To select a job, the [Select Job] dialog is displayed.

[Check] button The displayed job is checked to load to VRC.

[Setting] button The [JobPad Setting] setting dialog is displayed.

[Save] button The displayed job is loaded to VRC.

[Full Mode] check box To show the area before "NOP", turns this check box enabled.

NOTE
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 Job Create

When the [Create] button is clicked, the [Job Crate] dialog is displayed.

[Show Log] check box
To display the result of checking or loading, turns this check 
box enabled. The log area is displayed automatically when 
click the [Check] button or [Save] button.

Controller Selects the VRC controller from drop down list.

Job Name

Inputs the new job name.

Comment Inputs the comment of job.

Control Group Select the control group from drop down list.

[OK] button Create the new job and this dialog is closed.

[Cancel] button This dialog is closed.

Use only the character which can be input by a 
software keyboard for job name.

NOTE
8-118

HW0485348
346 of 671



  
8.18  JobPad

156225-1CD
 Select Job

When the [Open] button is clicked, the [Select Job] dialog is displayed.

Controller Selects the VRC controller from drop down list.

Search
Click the [Search] button after inputting the keyword, The job 
names including the keyword are displayed on the list.
When the edit box is empty, all job names are displayed.

[OK] button
Open the selected jobs and this dialog is closed. Multiple jobs 
can be opened.

[Cancel] button This dialog is closed.
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 Find

Press the [Ctrl] + [F] key of the keyboard when the cursor is in the job contents area of main window, 

the [Find] dialog is displayed. Keyword search is available.

 Replace

Press the [Ctrl] + [H] key of the keyboard when the cursor is in the job contents area of main window, 

the [Replace] dialog is displayed. Keyword replacing is available.

Find what Inputs a keyword.

[Match case] check box When this is enabled, the large character is separated from 
the small character.

[Find Next] button The keyword is searched from current cursor position.

[Cancel] button This dialog is closed.

Find what Inputs a target keyword.

Replace with Input a replacing keyword.

[Find Next] button The keyword is searched from current cursor position.

Replace The selected keyword is replaced and next keyword is 
searched from current cursor position.

Replace All All target keyword are replaced.

[Match case] check box When this is enabled, the large character is separated from 
the small character.

[Cancel] button This dialog is closed.
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 Error String

When double-click the line of the log window, string around the error occurrence part is reversed.
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 Input Support

To use the input support, job can be created easier. When input the initial character of instruction, the 

candidates are displayed on the popup list.

• Input support is case-sensitive.
• The candidates display depends on the language level of the virtual controller.
• About the structured language, the candidates (AND or OR) after the conditional 

statement is not available.
• About the structured language, the candidates of the conditional statement is not 

available.
• The displayed format is the text data saved in ex. memory. So, WHILE, IFTHEN, AND 

and OR are displayed as WHILEEXP, IFTHENEXP, ANDEXP and OREXP by DX200 
controller.

• The candidates after the EXPRESS of SET instruction is not available.
• ON/OFF and CONSTANT is not displayed.

NOTE

 
 
 

When input the “C”, the instruction 
started “C” is displayed. 

When input “CALL” and press the 
[Space] key, The candidates 
after “CALL” is displayed. 
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 Setting

To make it easy for an analysis of a job, it's possible to change the font and change the color of the 

instruction.

To pick a keyword out by a space end, coloring is as follows.
    MOVJ C0001 EC0001 VJ=5.00  
    MOVJ C0001 EC0001 VJ=5.00  
A comment line is one color.
String of the log window is not colored.

Color Definition
Defines the color. Sets the standard setting and detail setting 
use this definition.

Standard Setting
Defines the font, back color and comment color used in 
standard.
Keyword not defined in the detail setting is used this setting.

Detail Setting Defines the color each keyword.

 

NOTE
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9 Online Function

When PC is connected to a real controller by Ethernet, the following operation becomes possible.
• Reconstructs a system configuration of a real controller in VRC
• Monitor the condition of a real controller
• Receive the files from a real controller and load to the VRC

• Save the files of VRC and send them to a real controller.

9.1 Automatic Construction

A system configuration of a real controller is reconstructed in VRC.

9.1.1 Create a New VRC Controller (Network)

When PC is connected to a real controller by Ethernet, a system configuration of a real controller is 
reconstructed in VRC.

• The "High-speed Ethernet Server Function" option of a real controller is required.
• This function is not available by NX100.
• For details on how to setup the network, refer to the following manuals.

     "DX200 Options: Instructions for High-speed Ethernet Server Function"
     "DX100 Options: Instructions for High-speed Ethernet Server Function"
     "FS100 Options: Instructions for High-speed Ethernet Server Function"

In Order to transmit with the host control function, the command remote must be set to valid. Using 
the programming pendant, under [IN/OUT] a [PSEUDO INPUT] menu set the [CMD REMOTE SEL] 
to enable. And, the mode of the programming pendant needs to be "REMOTE".

NOTE

NOTE
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Procedure

1. On the [Controller] tab, in the [Setup] group, click the [New] button. To display the "Create 
Controller" dialog. Select "New VRC Controller (Network)" and press the [OK] button.

2. The "Connection Setting" dialog box appears. Select the controller kind and input the IP 
address of a real controller connected with PC. If desired you may change the default 
name for the controller.
Click the [OK] button, the files needed to construction are downloaded from a real 

controller.

In Order to transmit with the host control function, the command remote must be set to valid. Using 
the programming pendant, under [IN/OUT] a [PSEUDO INPUT] menu set the [CMD REMOTE SEL] 
to enable. And, the mode of the programming pendant needs to be "REMOTE".

NOTE
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3. The "New Controller" dialog box appears. Select the system version from the list and click 

the "OK" button. Then the configuration will be executed automatically.

4. The Virtual Pendant will close and reboot in normal mode.  (This may take a few 
moments.)  The “Robot Setting” dialog will display.  A default robot name and model file 
should be pre-entered.  If required, enter a name for the robot and select a robot model file 
corresponding to the robot type.  (In the example below, the robot model is “VA01400-A00” 
the corresponding model is “VA01400-A00.mdl”.)  Robot models are found in the “Robot” 
folder under MotoSimEG-VRC install folder.  Click the [OK] button.  

When there are no system versions corresponded with that of a real controller in a list, 
please choose the close system version.

NOTE
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5. The robot will display with the selected model file.

When initialized the robot controller, MotoSim EG-VRC set the absolute data 
automatically. So absolute setting is not needed in MotoSim EG-VRC. 
Refer to section 7.1.4 "Initializing the Controller (FS100)" for details.
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9.2 Network Function

To connect PC to a real controller by Ethernet, execute the setting with this function.

Procedure

1. On the [Online] tab, in the [Connect] group, click the [Network] button.

2. Select the controller from the list, click the [Setting] button.

3. The "Connection Setting" dialog box appears. Input the IP address and click the [OK] 
button.

4. The IP address is displayed on the list.
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9.3 Monitor Function

The condition of a real controller is monitored. The mode, status, positions of the robots of the controller 
are displayed. During monitoring, the dialog beside [Simple PP], [Position Panel], [View Manager] and 
[Light Manager] cannot be displayed.

9.3.1 Connect

Connects PC to a real controller.

Procedure

1. On the [Online] tab, in the [Connect] group, click the [Network] button.

2. Select the controller from the list, click the [Connect] button.

3. MotoSim EG-VRC starts to connect to IP address. When the icon turns to green, 

connection is completed.

Item Description

ControllerName The controller name of VRC is displayed.

IP Address The IP address of a real controller is displayed.

Mode The mode of a real controller is displayed. ([TEACH] or [PLAY])

Status
The status of a real controller are displayed. (Auto operation, Alarm occurred, 
etc.)
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4. When jog operation or playback is executed on a real controller, the robot position on the 
MotoSim EG-VRC is updated.

During the playback on a real controller, the current line is displayed on a [Simple PP] 
dialog. When changed task, the displayed job is changed.

 
 

 

 

S-axis Jog Operation 
on a real controller
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9.3.2 Disconnect

Disconnects PC to a real controller.

Procedure

1. On the [Online] tab, in the [Connect] group, click the [Network] button.

2. Select the controller from the list, click the [Disconnect] button.

3. MotoSim EG-VRC starts to disconnect to IP address. When the icon turns to red, 
disconnection is completed.
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9.4 File Manager

The jobs and condition files of VRC and a real controller are displayed on the File Manager. The 
following operation becomes possible on File Manager.

• Opens the file by a text editor.
• Compares the files of VRC and a real controller
• Receive the files from a real controller and load to the VRC

• Save the files of VRC and send them to a real controller

9.4.1 File Manager Dialog

On the [Online] tab, in the [Connect] group, click the [File Manager] button. The [File Manager] dialog 
appears.

In Order to transmit with the host control function, the command remote must be 
set to valid. Using the programming pendant, under [IN/OUT] a [PSEUDO INPUT] 
menu set the [CMD REMOTE SEL] to enable. And, the mode of the programming 
pendant needs to be "REMOTE".

NOTE

 

 

 

Selects the controller  
name to connect. 

The IP address of a real 
controller is displayed. 

Selects the file type 
to display. 

When right-clicks on the list, 
the right click menu appears. 

The number of the file in the list 
or the selected files is displayed.

The file names in VRC 
are displayed. 

The blue frame is shown 
around the selected list.

The file names in a real 
controller are displayed. 
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 Menu

 Tool Button

  Right-button Click Menu

File

Copy
The file selected by a list is copied to the other. When multiple file name are 
selected, batch-copying is executed. For details, refer to the section 9.4.6 
"File Copy".

Close The file manager dialog is closed.

Edit

File open
The selected file is opened by an external application. For details, refer to 
the section 9.4.4 "File Open".

Select all The all files on the list are selected.

View

Refresh

The list of VRC and a real controller are refreshed.
When a new job is created, a job is copied or a job is deleted on a real 
controller after the file manager dialog is opened, click this menu to refresh 
the list.

Tool

File comparison
The selected file is opened by an external application to file comparison. For 
details, refer to the section 9.4.5 "File Compare"".

Option The option dialog is displayed. For details, refer to the section 9.4.2 "Option".

The file selected by a list is copied to the other.
Menu: {File} - {Copy}

The all files on the list are selected.
Menu: {Edit} - {Select all}

The list of VRC and a real controller are refreshed.
Menu: {View} - {Refresh}

Copy
The file selected by a list is copied to the other.
Menu: {File} - {Copy}

File open
The selected file is opened by an external application.
Menu: {Edit} - {File open}

File comparison
The selected file is opened by an external application to file comparison.
Menu: {Tool} - {File comparison}

Select all
The all files on the list are selected.
Menu: {Edit} - {Select all}

Refresh
The list of VRC and a real controller are refreshed.
Menu: {View} - {Refresh}
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9.4.2  Option

Sets the option setting of the file manager.

File Manager Option

File Open Application

Sets the external application to open the file. NotoPad.exe is default 
setting. To set other application, set the full path of the external 
application and arguments of starting. A full path of a displayed file is 
substituted for "%1".

File Comparison Application

Sets the external application to compare the files. If the setting is not 
set, file comparison cannot be executed. Sets the full path of the 
external application and arguments of starting. A full path of a 
compared file of VRC is substituted for "%1". A full path of a 
compared file of a real controller is substituted for "%2".

Communication method

Sets the method of communication to a real controller.
High-Speed Ethernet server is default.
The "FTP Function" option of a real controller is required. For 
Details, please refer to the following manuals.
"Instructions for FTP Function".
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9.4.3 Connect to a Real Controller

Connects to a real controller and displays the file list.

Procedure

1. Network setting is completed on the network connection dialog beforehand.
For details, refer to the section 9.2 "Network Function".

2. On the [Online] tab, in the [Connect] group, click the [File Manager] button,  the 
[File Manager] dialog appears. Selects the target controller from the [Select VRC].

3. The file list is displayed.

4. The file category can be changed.
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9.4.4 File Open

The selected file is opened by an external application.

Procedure

1. Select a file from the file list of VRC or a real controller, click the right-button and select 
{File open} menu of the right-button click menu, or select the {Edit} - {File open} menu.

2. The selected file is opened by an external application. The executed application can be 
changed by option setting.

The selected file is downloaded to the temporary folder and opened. So, when the 
opened file is edited, that file is not loaded to VRC or a real controller.

NOTE
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9.4.5 File Compare

The selected file is opened by an external application to file comparison.

Procedure

1. Selects the file from the file list of VRC or a real controller, click the right-button and select 
{File comparison} menu of the right-button click menu, or select the {Tool} - {File open} 
menu.

2. The selected file of VRC and a real controller are saved, and these files are opened by an 
external application to compare.

To use this function, sets the setting of the external application to compare. For 
details, refer to the section 9.4.2 "Option".

NOTE
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9.4.6 File Copy

The file selected by a list is copied to the other. When multiple file name are selected, batch-copying is 

executed.

Procedure

1. Selects the file from the file list of VRC or a real controller.

• When click the file name with [Ctrl] key of the keyboard, multiple files are selected.

• When click the file name with [Shift] key of the keyboard, multiple files from first cursor to 
second cursor are selected.

• click the right-button and select {Select all} menu of the right-button click menu, or select 

the {Edit} - {Select all} menu, or click the   button, all files of the list are selected.

When the file is copied, the file is overwritten. The file cannot be restored.NOTE
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2. Click the right-button and select {Copy} menu of the right-button click menu, or select the 

{File} - {Copy} menu, or click the   button.

(1) When the file is copied from a real controller to VRC, the following dialog is 
displayed.

(2) When the file is copied from VRC to a real controller, the following dialog is 
displayed.

3. Click the [OK] button, file copy is executed. The progress dialog appears. When click the 
[Cancel] button, file copy is canceled.

(1) Copy the file from a real controller to VRC

(2) Copy the file from VRC to a real controller
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4. When the selected file cannot be saved or loaded, the following error dialog is displayed. 
When click the [Yes] button, the error file is ignored and the copy process is continued. 
When click the [No] button, the copy process is canceled.
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10 Debug Function

Sets a break point to the job, it's possible to suspend job execution by the optional line and confirm the 

state of variable or IO.

10.1 Change to Debug Mode

To change to debug mode, on the [Simulation] tab, in the [Debug] group, click the [Enable] button. 

The button is changed to "Disable".
To change to usual mode, on the [Simulation] tab, in the [Debug] group, click the [Disable] button.

• When use the debug function, the cycle time and trajectory is different from those in 
usual mode.

• Debug function is available only with VRC controller.
• Debug function is not available with external device.
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10.2 Set/Release the break point

To set/release the break point, the simple pendant is used. 

To set/release the break point, select the line to set the break point and press the [F9] key or "Setting 
BreakPoint" of the right-button menu.
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10.3 BreakPoint List

On the [Simulation] tab, in the [Debug] group, click the [Enable] button, break point list dialog is 
displayed.

Controller
Selects the controller. The break point of the selected 
controller is displayed in the list.

JobName Job name is displayed.

Line Line number set the break point is displayed.

Instruction Instruction of the line number is displayed.

Enable The condition of break point is displayed. (Enable or Disable)

[Delete] button Deletes the selected breakpoint.

[Delete All] button Deletes all break points of the selected controller.
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When right-button click on the list, changes the condition of break point in the right-button menu.

The condition of break point can be checked by the icon in the simple pendant.

                  

Enable 

Disable 
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10.4 Job Stack

On the [Simulation] tab, in the [Debug] group, click the [Job Stack] button, break point list dialog is 
displayed.

Only when the playback is stopped by break point, the caller job is displayed in the job stack dialog.
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10.5 Debug Monitor

On the [Simulation] tab, in the [Debug] group, click the [Debug Monitor] button, debug monitor dialog is 
displayed.

 

The status of variables or IO can be checked in the debug monitor dialog.
To add the monitored data, click the [Add] button.

To change the monitored data, double-click or press the [F2] key.

[Add] button Displays the insert monitoring data dialog.

[Del] button Deletes the selected line.
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10.5.1 Insert Monitoring Data

Click the [Add] button, the insert monitoring data dialog is displayed. Set the data to monitor.

Following variable and IO can be monitored.

Variable: B, I, D, R, P, BP, EX

IO: IN, OT
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10.6 Operation in Break

Following operation on the simple pendant is available in break.

10.6.1 Execution

Press the [F5] key, the job is executed to next break point. If next break point is not set, the job is 
executed to the end.

And, when the job is executed by PSTART, the suspended task is restarted.
When the multi task is suspended, all suspended task are restarted.

     

Suspend by break point.

F5 

The break point is set at 
line 8, so job is executed to 
line 8. 
10-8

HW0485348
376 of 671



10  Debug Function
10.6  Operation in Break

156225-1CD
10.6.2 Step Over

Press the [F8] key, the job is executed to next line. When the stopped line is "CALL JOB", the called job 
is executed to the end. If the called job has break point, the execution is suspended by break point.

10.6.3 Step In

Press the [F11] key, the playback is executed to the top of the called job.

     

Suspend by break point.
Called job is executed 
to the end and execution 
is suspended. 

F8 

     

Suspend by break point.
The execution is suspended 
at the top of called job 
“SUB1”.

F11 
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10.6.4 Step Out

Press the [SHIFT] + [F11] key, the playback is executed to the end of the called job.
If the called job has break point, the execution is suspended by break point.

      

Suspend by break point 
in the called job. 

SUB1 is called by line 3, 
so execution is 
suspended at line 4. 

SHIFT+F11
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11 Model Editing

This chapter explains the operations for creating and editing the workpiece and tool models using the 
CAD functions.
A model is generally created by combining basic figures, such as cubes and cylinders; in addition to the 
general method, MotoSim EG-VRC supports the model creation by reading HSF and HMF data.  

11.1 Cad Tree

11.1.1 Outline of the Cad Tree

On the [Home] tab, in the [Model] group, click the [CadTree] button, the [Cad Tree] dialog appears.

 

 

  
            

 Model
(MDL) dummy Robot 

Model
(HMF,
HSF)

Display
  

Hide 
  

 Select display style of a model from the combo 
box. 
SeeAll : Displays the model and its frame. 
Model Only : Displays only the model. 
Frame Only : Displays only the frame. 
Hide All : Hides everything. 
Show Name : Add the model name to the  

current display setting. 
Wireframe : Changes the model display mode 

to wireframe 
*Note that in this dialog box, "frame" represents 
a coordinate axis of a model. 

Press to create
a new model. 

Model selection display 
Note: Right-click the mouse on 

this display to open the 
menu for operation and 
edition of the model. 

Button to set 
model opacity. 

Select display/nondisplay the child model in the Cad Tree. 
：Displays the child model in the Cad Tree. 
：Hides the child model in the Cad Tree. 

*1) If a display style of a model (See, Hide, etc.) is selected in " " status,  
the model and their child models in lower layers will be displayed in the same style. 

*2) If a model is deleted in " " status, the model and their child models in lower layers  
will be deleted, except for "world", "Teacher", and the robot models.

Button to layout 
the model. 

Button to 
change position.

Sets the Position of the 
selected model in the tree. 
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11.1.2 Tree Structure

The Cad Tree displays a column of models in a tree structure.
As shown in the following diagram, a model in the level immediately above the subject model is the 
parent model of the subject model.

11.1.3 Opacity Settings

To set the model opacity, select the model in the Cad Tree and set the value using the spin button 
indicated in the following figure.
The maximum value of opacity is “1.00”.  Decreasing the value below the maximum value reduces the 
opacity, the model becomes translucent enabling to see other models through it.  If the value is set to 
“0”, the model becomes completely transparent and can no longer be seen.  

world

Parent model of "dai", "FLOOR", 
"worldframe", and "H6".

dai

work

FLOOR

worldframe

H6

Parent model of "work".

Spin button to specify opacity.
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11.1.4 Teacher

"Teacher" is a tool to create a target point (coordinate) at an arbitrary position, and is displayed as an 
AXIS6 frame on the screen.  It simplifies the use of OLP-related function and the relocation of parts.
To enable the Teacher, point the cursor to "Teacher" in the Cad Tree, and click on [Pos] to display the 
“Position Teacher” dialog box.  Specify the values in this dialog box. (For further detail on the "Position" 
dialog box, please refer to section 11.5 "Positioning a Model"). 

11.1.5 Mouse-Driven Model Editing

 Right Mouse Button Operation

A pop-up menu for model editing operation appears by clicking the right mouse button at a location 
where a model is displayed.
However, note that the viewpoint operation menu appears when clicking the right mouse button where 
there is no model displayed or when the Cad Tree is not on the screen.  

 

 

(1) Select "Teacher". 

(2) Select [Pos]. 

Set the incremental value

of the spin button

Menu for model editing. 
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11.1.6 Position Input Area

Select the model in the tree, the position of model is displayed in the Position Input Area. When input 

the value, it is set to the position of model.

11.1.7 Layout function

The layout function is to arrange a model.
To use the layout function, click the [Layout] button of the [CadTree] dialog.

When the model whose position cannot be set is selected, the input area cannot be set 
the value.

 
Set the incremental value 

of the spin button  

NOTE

    

Click 
11-4

HW0485348
382 of 671



11  Model Editing
11.1  Cad Tree

156225-1CD
The layout dialog is displayed.

When each button of the layout panel is clicked, its function becomes effective. Its function is released 

by clicking again. But, the button   (Remove all reference coordinates) is executed only when 

clicking the button.

Layout function is two modes as follows.
• Pick mode … The model is moved as fitting between the chosen points or faces.
• Ref coord mode … The model is moved or rotated depending on the reference 

coordinate.

Each mode has the function as follows.

• Pick mode

This function cannot be operated during the playback

Mate the two points

The model is moved so that the selected 
two points become same position.

Mate the two faces

The model is moved so that the selected 
two faces become same position.

Mate the point and the center of circle 
(passing through 3 points)

The model is moved so that the selected the 
point and the center of circle (passing 
through the selected three points) become 
same position.

Mate the center of two circle (each 
circle passing through 3 points)

The model is moved so that the center of 
two circle (each circle passing through the 
selected three points) become same 
position.

• The model to which the point or face selected first is the target model.
• To specify the center of the circle, select the three point on the circumference of circle.
• When clicking in an area the selected point depends on the current "Pick Mode" settings. 

Please refer to section 6.4 "Pick Settings" for details.

NOTE

NOTE
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• Ref coord mode

Create a reference coordinates
The reference coordinates is created.

Remove the reference coordinates
The reference coordinates is removed.

Remove all reference coordinates
All reference coordinates are removed.

Move model in the selected axial 
direction

The model is moved to the selected axial 
direction of the reference coordinates.

Rotate model about the selected axis

The model is rotated about the selected axis 
of the reference coordinates.

Mate the two faces by selected axis

The model is rotated about the selected axis 
of the reference coordinates so that the 
selected two faces become same position.

• The reference coordinate is temporary and is not saved to the cell. When the cell is 
closed, all reference coordinates are removed.

• On the [Home] tab, in the [Screen] group, click the [Frame Display] button to show/hide 
the reference coordinates.

NOTE
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Procedure

• Mate the two points
The model is moved so that the selected two points become same position. For example, 
the two corner of two cuboid are matched as follows.

1) Click the button   (When the button has been clicked, it isn't necessary to 

click.).
2) Click the first point. The model to which the point clicked first is the target model. A red 

marker is shown to the location of the selected point.

3) Click the second point.

Click

Click
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4) The model moves at the same time as a mouse button is released.

 
• Mate the two faces

The model is moved so that the selected two faces become same position. For example, 
the two faces of two model are matched as follows.

1) Click the button   (When the button has been clicked, it isn't necessary to 

click.).
2) Click the first point of the face. The model to which the point clicked first is the target 

model. A red marker is shown to the location of the selected point.

The picked point is shown the red point like OLP function and the point is fixed at the same 
time as a mouse button is released. And, when moves the mouse during a mouse click, 
the pick target is moved.

SUPPLE
-MENT

Click
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3) Click the second point.

The model moves at the same time as a mouse button is released and the following 
dialog is displayed.

              
4) When click the [Yes] button, the model is reversed and the operation is finished.

When click the [No] button, the model is not reversed and the operation is finished.

The picked face is surrounded by the yellow-green frame like OLP function and the face is 
fixed at the same time as a mouse button is released. And, when moves the mouse during 
a mouse click, the pick target is moved.

Click

SUPPLE
-MENT
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• Mate the point and the center of circle (passing through 3 points)

The model is moved so that the selected the point and the center of circle (passing 
through the selected three points) become same position. For example, the corner of the 
cuboid and the center of the upper face of the cylinder are matched as follows.

1) Click the button   (When the button has been clicked, it isn't necessary to 

click.).
2) Click the first point. The model to which the point clicked first is the target model. A red 

marker is shown to the location of the selected point.

Click
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3) To specify the center of the circle, click the first point on the circumference of circle. A 
blue marker is shown to the location of the selected point.

4) Click the second point on the circumference of circle. A blue marker is shown to the 
location of the selected point.

5) Click the third point on the circumference of circle.

Click

Click

Click
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The model moves at the same time as a mouse button is released.

• Mate the center of two circle (each circle passing through 3 points)
The model is moved so that the center of two circle (each circle passing through the 
selected three points) become same position. For example, the center of the bottom face 
of the cone and the center of the upper face of the cylinder are matched as follows.

1) Click the button   (When the button has been clicked, it isn't necessary to 

click.).
2) To specify the center of the first circle (target of operation), click the first point on the 

circumference of circle. A red marker is shown to the location of the selected point.

The picked point is shown the red point like OLP function and the point is fixed at the same 
time as a mouse button is released. And, when moves the mouse during a mouse click, 
the pick target is moved.

SUPPLE
-MENT

 

Click
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3) Click the second point on the circumference of circle. A red marker is shown to the 
location of the selected point.

4) Click the third point on the circumference of circle. A red marker is shown to the location 
of the selected point.

5) To specify the center of the second circle, click the first point on the circumference of 
circle. A blue marker is shown to the location of the selected point.

6) Click the second point on the circumference of circle. A blue marker is shown to the 
location of the selected point.

Click

Click
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7) Click the third point on the circumference of circle.

The model moves at the same time as a mouse button is released.

                
8) When click the [Yes] button, the model is reversed and the operation is finished.

When click the [No] button, the model is not reversed and the operation is finished.

 

The picked point is shown the red point like OLP function and the point is fixed at the same 
time as a mouse button is released. And, when moves the mouse during a mouse click, 
the pick target is moved.

Click

SUPPLE
-MENT
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• Create a reference coordinates
The reference coordinates is created.

1) Click the   button (When the button has been clicked, it isn't necessary to 

click.).
2) Click the first point. This point becomes the origin of the reference coordinates. A yellow 

marker is shown to the location of the selected point.

3) Click the second point. This point means the X-axis direction of the reference 
coordinates. A blue marker is shown to the location of the selected point. 

4) Click the third point. This point means the XY-plane of the reference coordinates.

 

Click

Click

Click
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The reference coordinates is created.

 
• Remove the reference coordinates

The reference coordinates is removed.

1) Click the button   (When the button has been clicked, it isn't necessary to 

click.).

2) Click the reference coordinates to delete.
3) The reference coordinates is removed.

• Remove all reference coordinates
All reference coordinates are removed.

1) Click the button  .

2) All reference coordinates are removed.

The picked point is shown the red point like OLP function and the point is fixed at the same 
time as a mouse button is released. And, when moves the mouse during a mouse click, 
the pick target is moved.

SUPPLE
-MENT

Click
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• Move model in the selected axial direction
The model is moved to the selected axial direction of the reference coordinates. For 
example, the model is moved to the X-axis direction of the reference coordinates as 
follows.

1) Click the button   (When the button has been clicked, it isn't necessary to 

click.).
2) Click the blue arrow of the reference coordinates. The selected arrow is highlighted.

3) Click the model to move.

The following dialog is displayed and input the traveling distance manually.

 

 

Click 

 

Click 
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4) When the [OK] button is clicked, the model is moved to the X-axis direction of the 
reference coordinates as the inputted travel distance.

When the [Cancel] button is clicked, the operation is canceled.

• Rotate model about the selected axis
The model is rotated about the selected axis of the reference coordinates. For example, 
the model is rotated about the Z-axis of the reference coordinates as follows. 

1) Click the button   (When the button has been clicked, it isn't necessary to 

click.).
2) Click the red arrow of the reference coordinates. The selected arrow is highlighted.

 

Click 
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3) Click the model to rotate.

The following dialog is displayed and input the rotation angle manually.

4) When the [OK] button is clicked, the model is rotated about the Z-axis of the reference 
coordinates as the inputted rotation angle.

When the [Cancel] button is clicked, the operation is canceled.

The plane perpendicular to the selected axis of the reference coordinates cannot be selected.

 

Click 

NOTE
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• Mate the two faces by selected axis
The model is rotated about the selected axis of the reference coordinates so that the 
selected two faces become same position. The two normal vector is projected on the 
plane made by the selected axis of the reference coordinates and the model is rotated so 
that the direction of two projected vectors is matched.

For example, The model is rotated so that two faces of two model is matched about the 
Z-axis of the reference coordinates as follows.

1) Click the button   (When the button has been clicked, it isn't necessary to 

click.)
2) Click the red arrow of the reference coordinates. The selected arrow is highlighted.

3) Click the first face. The model which this face belongs is the target.

Click 

 

Click 
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4) Click the second face.

The model is rotated so that two faces of two model is matched about the Z-axis of the 

reference coordinates.

 

The plane perpendicular to the selected axis of the reference coordinates cannot be selected.

 

Click 

NOTE
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11.2 Creating a New Model

To start creating a new model, click on [Add] of the Cad Tree menu to display the Add Model dialog box.  

Procedure

1. Enter a name of the new model to be created in the Name edit box of the Add Model dialog box.  
(By default, the model name and the model file name are the same: the model file is
 created with the model name.) 

2. Click [OK] in the Add Model dialog box.  
A newly created model is displayed in the Cad Tree.  (Note that new model file does not contain 
any data at this point.)  

3. Double-click the new model name in the Cad Tree to edit the model. 
The file data editing dialog box (as shown below) appears; refer to section 11.3 "Editing a Part" to 
edit the file data.  

4. When the creation of the model is completed, click [Close] to complete the file data editing.
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 Creating a Model from an Existing Model

A new model creation can be achieved not only by creating parts with the CAD function, but also with 
an existing model file.  In addition to those methods, a new model can also be added with the method 
explained in section 11.11 "Reading a Model".

Procedure

1. Click [Add] of the Cad Tree, or select {File} - {New Model} from the right-click menu of the Cad 
Tree.

2. The Add Model dialog box appears.  Press the [...] button on the left of the File Name edit box to 
select a file. 
 

3. Enter a new model name in the Name edit box of the Add Model dialog box.

4. Click [OK].  

5. If the model file path doesn't correspond to the "models" folder under the cell folder, the 
following dialog box will display and offer to copied model file to the "models" folder of the cell.

If the "Yes" button is clicked and a file with the same name already exists in the cell "models" 
folder.  The following dialog will display to ask for overwrite confirmation.

When adding LINE data (wire frame), it is recommended to use LINE data in the HMF 
format: adding LINE data in other format may take some time. 
If the LINE data is in a format other than HMF, convert the LINE data with “MDL2HMF.EXE” 
before adding the model.  (The MDL2HMF.EXE is located in a folder where MotoSim EG-VRC 
was installed).

 

 

NOTE
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 Creating a Dummy Model

Dummy model is a model with only the position and direction data and no modeling data (model file).  
Normally, external servo track or rotation axis have a reference position that is fixed and unchangeable 
(even if it is changed, it returns to the original position when opening the cell next time).  
To avoid such problem, use a dummy model: create a dummy model, then register the external axis as 
a child model of the dummy model.  This way, the reference position of the external axis or rotating axis 
can be moved by changing the reference position of the dummy model.

Procedure

1. Click [Add] on the Cad Tree dialog box, or select {File} - {New Model} from the right-click menu 
of the Cad Tree.

2. The Add Model dialog box appears; enter a new model name in the Name edit box.  

3. Check the [Dummy Model] check box.

4. Click [OK].
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11.3 Editing a Part

MotoSim creates a model data file by combining basic figures such as cubes and cylinders: such 
figures are called "parts" in this manual.
The following sections explain on how to edit the parts using the file data editing dialog box of the Cad 
Tree.

11.3.1 Displaying the File Data Editing Dialog Box

In the Cad Tree, double-click the model to be edited, or select {Attribute} - {Edit File Data} to display the 
file data editing dialog box as follows:

File data editing dialog box

Item Description

[Add] button
Displays a dialog box to edit the part selected in [Add Parts] combo box.  Also 
displays the added part on the cell window.

[Edit] button
Displays a dialog box to edit the part selected in the parts list.  
(Multiple selection is not possible.)

[Delete] button
Deletes the part selected in the parts list. 
(Multiple selection is not possible.)

[Move Org] button
Changes the parent of the part selected in the parts list.
Refer to section 11.9.1 "Changing the Parent Model" for details.

 

Select a part type.

Parts list.
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11.3.2 Registering a Part

Procedure

1. Select a type of parts to be added in [Add Parts] combo box in the file data editing dialog box.  

2. Click [Add] to display the part on the cell window; the parts editing dialog box appears.

[ClipBoard...] button

Stores/Retrieves the data of the part selected in the parts list on the clipboard.  

[Close] button Closes the file data editing dialog box.

File data editing dialog box

Item Description
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3. See descriptions below to edit the part in the parts editing dialog box:

• Enter the values for model size, position, etc. with the spin buttons  or keystrokes. (The 
incremental value of the spin buttons is specified in the Step combo box.)

• Click [Color...] to display the Color dialog box, and specify the color.
• To move the part to an arbitrary point with the Teacher, set the Teacher to the target position; 

click [Goto] in the "Teacher" section to move the part to the teacher coordinate.  To move the 
part including the posture to the teacher, check the [POSE] check box and then click [Goto].  
(For the details of the Teacher, refer to section 11.1.4 "Teacher".)

4. When all the settings for the model are completed in the parts editing dialog box, click [OK] to 
add the part to the model data file.

5. Create a model by repeating the steps 1 to 4 to register additional parts.

11.3.3 Part Types

This section explains on how to edit the parts according to the part type.

 BOX

The BOX is a rectangular parallelepiped part, which can be edited in the BOX Edit dialog box.

• The origin of the part is the center of the BOX part model.  

   

 

Origin of the part
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 BOX2

The BOX2 is a rectangular parallelepiped part, which can be edited in the BOX2 Edit dialog box.

• The origin of the part is the vertex of the BOX2 part model.  

 CYLINDER

The CYLINDER is a cylindrical part, which can be edited in the CYLINDER Edit dialog box.

• Selecting the [Straight] check box links the values of the upper and lower diameters 
("U. Diameter" and "L. Diameter", respectively).  

• The value in "Number" edit box represents the number of sides to form a cylinder: the 
larger the number becomes, the more perfect the cylinder becomes. Therefore, when "3" 
is input, the number of side faces becomes three, forming a triangular cylinder.  

• The origin of the part is the center of the CYLINDER bottom.

   

 

Origin of the part

 

 

Origin of the part
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 CONE2

The CONE2 is a conic part, which can be edited in the CONE2 Edit dialog box.

• The origin of the part is the center of the CONE2 bottom.

 SPHERE

The SPHERE is a spherical part, which can be edited with the "SPHERE Edit" dialog box.

• The origin of the part is the center of the sphere.

     

Origin of the part

 Origin of the part
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 PIPE2

The PIPE2 is a pipe part, which can be edited in the PIPE2 Edit dialog box.

• The values in "U. Thickness" and "L. Thickness" edit boxes respectively represent the 
thickness of upper and bottom faces of the pipe.

• Selecting the [Straight Cylinder] check box links the upper and lower diameters ("U. 
Diameter" and "L. Diameter", respectively), and the upper and bottom face thickness.

• The origin of the part is the center of the PIPE2 bottom.

     

Origin of the part
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 AXIS6

The AXIS6 is a part that may contain multiple frames (position and orientation data).  The frames can 
be used as a target point or for external axis setting.  It can be edited in the Frame Edit dialog box.

• To add a frames, press [Insert].  The frames are added to the "Index" list box. 
• To delete a frame, select the frame number in the "Index" list box, and press [Delete].
• To edit a frame, select the frame number in the "Index" list box and modify the values in 

the "Position" section.  The position can be displayed and modified relative to various 
coordinated system depending on the "Operation" mode.

"Operation" combo box settings

"Absolute" Displays the position with reference to the model frame.

"Relative"
Displays the position with reference to the frame original 
position when initially selected in the "Index" list box.

"SelModel"
Displays the position with reference to a selected model.  
When this mode is first selected the "Select Model" dialog 
will display to allow selection of the reference model.

The frame corresponding to the selected "Index" of the list box is highlighted in red in the 
main view.

NOTE

 

 

AXIS6 model

Model name Coordinate system (Changes 
according to the operation mode)
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 LINE

The LINE is a part that contains multiple points.  The points are links together by straight-line segments 
to form a continuous line.  It can be edited with the "LINE Edit" dialog box.  A minimum of 2 points must 
be defined for the line to display.  Points can be inserted, edited or deleted in the same manner as the 
"FRAME Edit" dialog box.  (Please refer to the section "AXIS6" section for details).

 LINE2

The LINE2 is a part that may contains multiple lines each made of 2 points.  It can be edited with the 
"LINE2 Edit" dialog box.  The points with an odd index number are the starting points and those with an 
even index number are the end points.    The total number of defined points must be even to display all 
the segments.  Points can be inserted, edited or deleted in the same manner as the "FRAME Edit" 
dialog box.  (Please refer to the section "AXIS6" section for details).

Point 1
Point 2

Point 3

Point 4

Origin of the part

Point 5

Point 1

Point 2 Point 3

Point 4

Origin of the part

Start

End

End

Start
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 CUBE

The CUBE is a polyhedron part, which can be edited in the CUBE Edit dialog box.

• When a CUBE model is added, a model with four points appears on the screen, with the 
four points already registered in the CUBE Edit dialog box as shown below. 

• The apex of the figure at the bottom is registered as a point from No. 1, the point in the 
height direction is the last registered point in the model file form.  
The points at the apex of the bottom figure are arranged as follows:  

-When the height is set to Z-axis positive (+) direction: counterclockwise to Z-axis
 positive (+) direction. 
-When the height is set to Z-axis negative (-) direction: clockwise to Z-axis positive
 (+) direction.

 FLOOR

The FLOOR is a floor part, which can be edited in the FLOOR Edit dialog box.

• The values "X Num" and "Y Num" edit boxes respectively represent the numbers of 
dividing lines that divide the face in the X-direction and Y-direction. 

• The origin of the part is the center of the FLOOR model.  

100100

100

Z-axis

Y-axis

X-axis

Point 1Point 2

Point 3

Point 4

    

Origin of the part
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 FACE

The FACE is a face part, which can be edited in the Face Edit dialog box.

• Register apexes to create faces.  
Several faces can be created in one FACE part, however, there must be three or more 
points to create each face.  If the points are not in the same plane, the face will be divided 
into some triangles.  Therefore, unless these points are clearly on the same plane, create 
the FACE with units of three points.

Procedure

1. Select the [Pickup ON] check box. 
(Clear the check box to change the viewpoint on the screen.)  

2. Click the points 1, 2 and 3 as shown in the above figure.  
The frame of the clicked point is displayed in "Vertex List" box.  Click [Add Face>>] to create the 
FACE 1 defined by three points.

3. Click the points 4 to 6, and click [Add FACE>>] to create FACE 2.

4. Click the points 7 to 9, and click [Add FACE>>] to create FACE 3.

 

Point 1

Point 2
Point 3

Point 4

Point 5

Point 6

Point 8

Point 9

FACE 1

FACE 2
FACE 3

Point 7
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 “Teacher” Section of the Parts Editing Dialog Box

The parts BOX, CYLINDER, CONE2, PIPE2, AXIS6, SPHERE, LINE, LINE2 can be relocated by using 
the "Teacher" section of each editing dialog box.
When using the Teacher, it has to be previously set: refer to section 11.1.4 "Teacher" for details.

“Teacher” section of the parts editing dialog box

Item Description

[Goto] button Moves the part to the Teacher position.

[POSE] check box Moves the part including the posture to the Teacher position.
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11.4 Editing a Model

A model can be cut, copied, pasted, etc. with commands under {Edit} of the Cad Tree.
Select a model from the Cad Tree, and edit the model with the commands described below:

 Cut

Cuts the selected model.

 Copy

Copies the selected model.

 Paste

Pastes the cut or copied model in an arbitrary place.
When selecting {Copy} - {Paste} within the same cell, enter the model name to be copied.

 Delete

Deletes the selected model.  However, the model file will not be deleted though the model is deleted 
from the Cad Tree and the cell window.
When deleting the currently selected model including its child models are to be deleted, set the display/
non-display status (  or ) on the left of the model name to  in the Cad Tree, then select [Delete].  
Note, however, that the "world", "Teacher", and robot model will not be deleted even if they are in the  
status.

 Add

Creates a new model.  
Refer to section 11.1 "Cad Tree" for details.

 Rename

Changes the model name.
Note, however, that the names of "world", "Teacher", and the robot model names cannot be changed.

+ +
+
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 Property

Specifies opacity, scale, and model type.  (The command {Property} is located under {Attribute}.)

Property dialog box

Item Description

[Opacity] edit box Specifies the opacity of the model.

[Scale] edit box Specifies the scale of the model.

[Model Type] edit box Specifies a character string in the model.

[Back Plane Culling] check 
box

Set up whether the back plane of CAD data is shown or hidden.
When the back plane is shown, the CAD data is displayed according to that 
data.
When the back plane is hidden, display speed is faster.

[OK] button Applies the modifications, and closes the Property dialog box.

[Cancel] button Closes the Property dialog box without applying the modifications.

When the back plane is hidden, some parts of the CAD 
data may be lost.
When the CAD data need be displayed collect, check off 
the Back Plane Culling.

NOTE
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11.5 Positioning a Model

Position a model by specifying the values in the Position dialog box.
To display the Position dialog box, click on [Pos] button or select {Attribute} - {Set Position} menu item 
of the Cad Tree.

Position dialog box

Item Description

"Operation" combo box

“Absolute”
Displays the position with reference to the parent model, and moves the 
model.

“Relative”
Displays the position with reference to the selected model, and moves the 
model.

“SelModel”
Displays the Select Object dialog box; displays the position with reference 
to the model specified in the Select Object dialog box, and moves the 
model.

 

 

 

Set the incremental value of 

The spin button  
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[matrix] button

Allows to store or retrieve the data of the Position dialog box in the clipboard. 

“Teacher” section

Move the model to the Teacher current position.
[Goto] button

Moves the model to the Teacher position.
[POSE] check box

When checked and the [Goto] button is used, the model also moves to 
match the Teacher orientation.

When using the Teacher, it has to be previously set: refer to section 11.1.4 
"Teacher" for details.

“Pick” section

[Enable] check box
Enables the mouse picking operation.  
Pressing the [Shift] key enables or disables the "Pick Enable" mode.

[Pick two points] check box
The chosen model is parallel-shifted so that the specified point of the 
model may unite with the pick position of the 2nd point.

[Settings >>] or [<< Settings] buttons
Displays or hides the pick setting section.

“Move Mode” section

Determines the method to move to the picked point.
[Position] check box

The model is moved to the position (XYZ) of the picked point.
[Orientation] check box

The model is turned to match the orientation (Rx, Ry, Rz) of the picked 
point frame.

[Axis] check box
The model axis specified in the combobox is turned so that it matches the 
picked face normal.

[Reverse] check box
This setting is enable with [Orientation] or [Axis] mode. It can be use to 
change the direction of the picked face normal.

“Pick Mode” section
Sets conditions determining the selected point in the clicked area.
Please refer to section "Pick Mode Setting" for details.

“Pick Object” section
Sets the type of the object to be selected when clicking on the cell view. 
(Multiple items can be selected)
Please refer to section "Pick Object Setting" for details.

[OK] button Applies the modifications, and closes the Position dialog box.

[Cancel] button Closes the Position dialog box without applying the modifications.

Position dialog box

Item Description
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The operating procedure of a two-point pick is explained concretely below.
1. With the first pick, the point to align is specified.

2. With the second pick, the movement place is specified.

3. The point specified as the first point moves to the position of the second point. 

 

First pick

 

Second pick 
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11.6 Editing Multiple Models (Model List)

Multiple models can be edited in the Model List dialog box.  To open the dialog box, select {Edit} - 
{Models List} of the Cad Tree right-click menu.

Model List dialog box

Item Description

Model selection list box
Displays the models registered in the cell.
The selected models are highlighted.  (Multiple selection is possible.)

[Delete] button
Deletes the models selected in the model selection list box.  The models on 
the cell window are also deleted, however, their model files still exist.

[Change Parent] button
Changes the parents of the models selected in the model selection list box.
Refer to section 11.9.1 "Changing the Parent Model" for details.

[Move Parent] button
Moves the parents of the models selected in the model selection list box.
Refer to section 11.9.2 "Moving the Parent Model" for details.

[Close] button Closes the Model List dialog box.

 

 

Model selection list box
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11.7 Searching a Model

Search for a desired model with the Find dialog box.  To open the dialog box, select {Edit} - {Find} from 
the Cad Tree right-click menu.  
If the entered name exists, the model is selected in the Cad Tree.

 

 

Enter the model name.
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11.8 Saving and Reading a Model Group

A model and its parent-child relevant information can be saved as a set.
This can be done by creating a folder under [cell folder name\models] and naming it with the same 
name as the subject model, then by saving the following files in the new folder:

• The parent-child relevant information of the model (ModelInfo.dat).
• Subject model and its all the child models (*.mdl, *.hsf).

 Saving a Model Group

Procedure
1. Select a model with the status symbol (on the left of the selected model name)  in the Cad Tree 

set to .  

2. Select {Edit} - {Save Model Group] from the Cad Tree right-click menu. 
Select [Yes] to create a folder with the same name as the model selected in the step 1.  The 
files of the model (selected in the step 1) and its child models are copied to the folder, and a 
parent-child relevant information file "ModelInfo.dat" is generated.

+
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 Reading a Model Group

Select {Edit} - {Load Model Group] from the Cad Tree right-click menu.  Select a “ModelInfo.dat” file to 
read the saved model including its child models.
  

 Syntax of the ModelInfo.dat

MODEL
{
NAME=Camera_Dummy     //Logical name of the model
PARENT=world             //Parent model name
FILENAME=dummy               //File name
COLOR=RGB (0,0,255)       //Color of the model
HIDESEE=1                         //Display/nondisplay information
OPACITY=0.25                        //Opacity
AXIS6=4000.000,5500.000,2000.000,-1.57,0.00,-0.35     // Position of the model
}

If there is a model with the same name in the current cell, the second one will automatically be 
numbered.  (The number will be added after the name.)

NOTE
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11.9 Changing and Moving the Parent Model

11.9.1 Changing the Parent Model

The parent model of an arbitrary model can be changed with {Parent Change} under {Attribute} of the 
Cad Tree menu.
With this function, the relation (coordinate) between the selected model and its parent model is 
automatically changed, and the model position does not change.  Use this function in case of changing 
the parent model while keeping the model in the same position.

To use this function, select the desired model in the Cad Tree, then select {Attribute} - {Parent Change} 
from the Cad Tree right-click menu.

11.9.2 Moving the Parent Model

The parent model of an arbitrary model can be moved with {Parent Move} under {Attribute} of the Cad 
Tree menu.
Since the relation (coordinate) between the selected model and its parent model does not change with 
this function, the selected model position changes when it is moved to its new parent model with 
{Parent Move}.

To use this function, select the desired model in the Cad Tree, then select {Attribute} - {Parent Move} 
from the Cad Tree right-click menu.
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11.10Changing a Model File

The model file of an existing model can be changed with {ChangeFilePath} under {Attribute} of the Cad 
Tree menu.

To use this function, select a model to be changed in the Cad Tree, then select {Attribute} - 
{ChangeFilePath} from the Cad Tree menu.  Select the desired model file in a file selection dialog box 
to change the model file.
Note that the change will only take effect the next time the cell is open.  

The model files for "world", "Teacher", and robot models cannot be changed. NOTE
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11.11Reading a Model

A model appears on the cell by dragging and dropping its model file (in the HSF, HMF, MDL, 3DS, or 
RWX format) to the cell window, and the model file is copied to the "models" folder.  
In this operation, a parent model can also be selected.

Procedure

1. Drag and drop an arbitrary model to the cell window; If the model file path doesn't correspond to 
the "models" folder under the cell folder, the following dialog box will display and offer to copied 
model file to the "models" folder of the cell.

 

Drag and drop.

Model displayed on the cell.
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If the "Yes" button is clicked and a file with the same name already exists in the cell "models" 
folder.  The following dialog will display to ask for overwrite confirmation.

2. The Select Model Parent dialog will display.  Select the model that will become the parent of the 
new model and press the [OK] button.  (By default the "world" model is selected.) 

When adding LINE data (wire frame), it is recommended to use LINE data in the HMF 
format: adding LINE data in other format may take some time. 
If the LINE data is in a format other than HMF, convert the LINE data with “MDL2HMF.EXE” 
before adding the model.  (The MDL2HMF.EXE is located in a folder where MotoSim EG-VRC 
was installed).

 

NOTE
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11.12Model Script

Model script allows manipulate models by the execution of a series of model commands.  The model 
script editor allows to write and manage the model script of the specified controller.  The model script 
can be executed from the Model Script Editor or from an I/O Event during playback. (For details on I/O 
Events refer to section 8.3 "I/O Events"). 

11.12.1 Model Script Editor

To display the Model Script Editor select {Model} - {Model Script Editor} from the main menu.

Model Script Editor Dialog Box

Item Description

Controller Select the controller for which the scripts are to be edited.

Script List
Displays the list of scripts for the selected controller.
Select a script to display/edit its content in the right section of the dialog.

Script
Displays the name of the selected script.  
The script content in displayed in edit box below where the model 
commands can be added or modified.  

[Add] button
Adds a new script to the list.  
A dialog will display to enter the script name.  Enter a name and press OK.  
The new script will be added to the list.

[Delete] button Deletes the script currently selected in the script list.
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11.12.2 Model Commands

Model commands can be used in model script to manipulate models in the cell.  Note that model names 
are case sensitive.  Make sure that the names are typed exactly like the name of the model appearing 
in the Cad Tree.

 Model Display

 Model Non-display

 Model Move 1 (Set Model Parent)

 Model Move 2

 Model Move 3

[Save]button
Save the script content to file.
Note: Scripts are saved to the “ModelScript.txt” file under each controller 
folder. 

[Run]button Execute the script selected.

[Stop] button Stop the script selected.

[Close]button Closes the Model Script Editor dialog.

Notation SEE M1

Meaning Displays the model M1.

Notation HID M1

Meaning Hides the model M1.

Notation MOV M1 M2

Meaning 
Moves the model M1 in the Cad Tree to change its parent to M2. Without 
changing the model location on the display, the model relative position 
from its new parent (M2) is changed automatically.

Notation AXIS6 M1=10,20,30,0,0,0

Meaning 
Moves the model M1.  The position from the parent is changed to 
(10,20,30,0,0,0).

Notation ADDX6 M1=10,20,30,0,0,0

Meaning 
Moves the model M1.  The position from the parent is changed by adding 
(10,20,30,0,0,0) to the current position.

Model Script Editor Dialog Box

Item Description
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 Model Copy 1

 Model Copy 2

 Model Deletion

 Model Action

 I/O signal Output

Notation DUP M1 M2

Meaning Copies (duplicates) the model M1 to create M2.

Note

If MotoSim EG-VRC is saved without deleting the copied model, the 
description (information on arrangement, etc.) is written in to the cell.  
The copied model will reference the same model data file (.mdl) as the 
original model.

Notation REF M1 M2

Meaning Copies (references) the model M1 to create M2.

Note
Even if MotoSim EG is saved without deleting the copied model, the 
description (information on arrangement, etc.) is not written in to the cell.

Notation DEL M1

Meaning Deletes the model M1.

Notation ACT M1 D S=P1 E=P2 T=T1,T2

Meaning 

Meaning?Model M1 moves from P1 to P2 in D direction between T1 and 
T2.
  D : One of the character X, Y, Z, Rx, Ry or Rz
  P1 : Movement start position (units:mm or deg.)
  P2 : Movement end position (units:mm or deg.)
  T1 : Movement starting time after this model script executed(units:msec)
  T2 : Movement ending time after this model script executed(units:msec)

  (E.G.) ACT M1 X S=0 E=1000 T=0,1000
   Model M1 moves from 0mm to 1000mm in X-axis direction between 0ms 
  and 1000ms

Note

Only while a controller is moving, ACT command is executed.
If the time of ACT command is over the playback time, ACT command also 
stops at the time of a playback finishing. And, ACT command is not 
executed by RCS controller.

Notation1 OUT C1 #(20030)=ON

Meaning IO signal 20030 (Logical Name) of controller C1 turns ON

Notation2 OUT C1 IN#(1)=ON
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 Starting Time of Each Command in Model Script

To specify the timing of executing each command, add "T=T1 ,T2" at the end of each command. 
Because commands besides ACT move momentarily, make T1 and T2 the same value.
(E.G.) MOV WORK world T=1000 ,1000

(Example for Executing Timing)

The executing timing of starting each command of above model script is as follows.

Meaning General Input IO signal IN#(1) of controller C1 turns ON

Note

 Only while a controller is moving, ACT command is executed.
If the time of ACT command is over the playback time, ACT command also 
stops at the time of a playback finishing. And, ACT command is not 
executed by RCS controller.
General Input and External Input are supported only.

 
ACT KYUBAN Z S=0.000 E=-1150.000 T=0 ,2000      ① 

MOV WORK world T=2000,2000    ② 

ACT KYUBAN Z S=-1150.000 E=0.000 T=2100 ,4100 ③ 

ACT ROT1 Rx S=0.00 E=90.00 T=4300 ,5300  ④ 

ACT ROT2 Rx S=0.00 E=90.00 T=4300 ,5300  ⑤ 

ACT ROT3 Rx S=0.00 E=90.00 T=4300 ,5300  ⑥ 

ACT ROT4 Rx S=0.00 E=90.00 T=4300 ,5300  ⑦ 

OUT DX200 IN#(1)=ON T=5300 ,5300   ⑧ 

 

 ② 

0 2000 2100 4100 5300 4300 

③ ④ 

⑤ 

⑥ 

⑦ 

⑧ 

(ms) 

 ?  
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11.12.3 Display of script input assistance

As for the script, the edit that uses the manual edit and the “Script input assistance” dialog box can be 
done.
The “Script input assistance” dialog box opens when the line edited in the “Model Script Editor” dialog 

box is double-clicked.

It explains the input item of each model instruction.

The model's display (SEE), the model's non-display (HID), and the model's deletion (DEL) 
The [model] is input. 

The [model] is input by either the selection with the direct input or Cad Tree or .

Model Script Editor Dialog Box

Item Description

Model instruction
The model instruction is selected. (The input item changes by the selected 
model instruction. )Please refer to the explanation of the following each 
model instructions for details.

Move time

Set the execution starting time and ending time of the model 
command.(units:msec)
In case of ACT command, the model moves smoothly between starting 
time and ending time.

I want to set the start time to 
end time of the previous

When enabled, the ending time of the latest line is set to the starting time 
automatically.

step Set the increment value of the spin control.

[Add] button
The edited model instruction is added to a selected line. (Former model 
instruction moves below by one line. )

[Change] button A selected line is changed by the edited model instruction.

[Cancel]button The script input assistance is closed without changing the edited content.
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The [Move time] is set by either the direct input or   . The increment value of   can be 
changed by step.

 The model's movement 1(MOV), the model's copy 1(DUP), and the model's copy 2(REF) 
[Model1] and [Model2] are input.

The [Model] is input by either the selection with the direct input or Cad Tree or .

The [Move time] is set by either the direct input or   . The increment value of   can be 
changed by step.

 The model's movement 2(AXIS6) and the model's movement 3(ADDX) 
The [Model] and the [Position] are input.

The [Model] is input by either the selection with the direct input or Cad Tree or .

The model name is 

input. 

 

Model 1 and model 2 
are input. 
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The [position] and the [Move time] are set by either the direct input or   .

The incremental value of  can be changed by step.

 

The Model is input. 

The Position is input. 

Set the incremental value of the 

spin button  
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 The model's action (ACT)
[Model], [Direction], [StartPos], [EndPos] and [Move time] are input.

The [Model] is input by either the section with the direct input or CAD Tree or  .

The [StartPos], [EndPos] and [Move time] are set by direct input or spin box   .

The increment value of spin box   can be changed by step.

 The I/O output (OUT)
The target controller of I/O output is selected by the drop down list.
The [Io kind], [ON/OFF], [Io no] and [Move time] are input.

The [Move time] is set by either the direct input or  .

The increment value of   can be changed by step.
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11.12.4 Execute Model Script while playback

To execute the model script while playback, Set one of the following.
• I/O Event

For details, refer to the section 8.3 "I/O Events"
• Comment of Job

Enter the following comment at the point where the model script is to be started.

'MDS:[Model Script Name]
(E.G.)

And, when enter the following comment in a job, the model script execution after this 
comment waits for the previous model script completion. But job execution keeps.

'MDSWAIT
(E.G.)

  

Model script “SC4UNSET” execution waits 

for the previous model script “SC1UNSET” 

and “SC2UNSET” completion. 
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11.13Reduce HSF File

The number of polygons of the HSF file can be reduced.
On the [CadTree] dialog, select a model to reduce the polygon number. And, right-click on the model 
and select the [HSF Reduce] menu, the [Reduce HSF File] dialog is displayed. Input the Accuracy and 
click the [OK] button, the number of polygons of the HSF file is reduced.
When the accuracy is set to 100%, a model will be an original model. The number of polygons is 

reduced so that the accuracy is set as the small value.

This function is available only with the HSF data. When a file size is big, it takes time for 
reducing process.

    

NOTE
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11.14CAD Data Import <CadPack Option>

Loads the following CAD data format to the cell directly.

This function is accessible by:
a)The Add Model dialog of the [Cad Tree]

(For details, please refer to section section "Creating a Model from an Existing Model".)
b)Dragging and dropping the file over the cell display area.

(For details, please refer to section 11.11 "Reading a Model".)

 CAD Data Import

Before importing CAD data, the "CAD Import" dialog will display. The healing settings in the dialog can 
be changed if required. (This dialog doesn't display when importing SAT file.)

To change the default settings related to the CAD Import, please refer to section 12.7 "CAD Import/
Export <CadPack Option>". 

To use this function (CadPack option), the MotoSim EG-VRC-CadPack is required.  (The 
MotoSim EG-VRC-CadPack is separate product from MotoSim EG-VRC.)

Format Extension Version
Availability of CAM 

function

IGES igs,iges -5.3 

STEP stp,step 203,214 

Inventor ipt V11-2015 

ProE / Creo prt,asm 16-Creo 3.0 

Solidworks sldprt,sldasm 2003-2014 

CATIA V5 CATPart,CATProduct R8-R24(V5-6R2014) 

SAT sat R1-R25 

Parasolid x_t,x_b 9.0.* -27.0.* 

DXF dxf 2.5 -2014 

HSF hsf -20.20 

HMF hmf -20.20 

VRML wrl 2.0 

STL stl ― 

3DS 3ds ― 

RWX rwx ― 

PLY ply ― 

When adding a model with method a) Add Model dialog, it is necessary to select "All (*.*)" 
in the "File Type" section, in order to display all the file types and be able to select the 
IGES or SAT files.

NOTE

NOTE
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The figure below shows, the "CAD Import" 
dialog when the IGES data healing is 
disabled.  
This is the default setting.

The "CAD Import" dialog with the IGES 
data healing enabled.

CAD Import

“Enable Healing” 
section

When enabled, a healing algorithm is applied to the imported CAD data.
[Recreate surface] check box

The [Recreate surface] option is normally selected.
The [Recreate surface] is part of the normal healing process.  If it is 
unselected, this step will be skipped in the healing process.
If the surface regeneration doesn't give the intended results, unselect the 
"Recreate Surface" may improve the healing results. 

[Disable on error] check box
The [Disable on error] option is normally selected.
When the [Disable on error] is selected, the healing will be disabled if an error 
occurs during the healing process. 

Imports the work 
file for CAM 
teaching

Select this type when the model applies a CAM function. Do not select this type 
when the model is tool or peripheral equipment.

General CAD data are displayed  in the CadTree dialog, and the model for 

CAM teaching are displayed    .

[High-Speed 
Mode] check box

When enabled, MotoSim EG-VRC reads only data necessary to drawing from CAD 
data, so it may takes higher. But, When "Imports the work file for CAM teaching" is 
enabled, this is disabled.
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[Don't show this 
dialog next time] 
check box

If checked, the "IGES Import" dialog will no longer be displayed when an IGES file 
is imported. The "IGES Import" dialog display can be re-enable in the "Option 
Setting" dialog under the "CAD Import/Export" tab.  Please refer to section section 
12.7 "CAD Import/Export <CadPack Option>".

[OK]button The IGES file import will proceed with the options set in the dialog.

[Cancel]button Cancel the IGES file import

The healing process attempts to repair any corrupted data of the imported CAD files. 
However, the processing time to import a file may increase significantly when healing is used.  
The performance may also vary depending on the extent and nature of the errors in the 
original CAD file.  In some cases, result with healing may be worst than reading the file without 
healing.

CAD Import

NOTE
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11.15Changing the Coordinate Origin of CAD Data 
<CADPack Option>

Change the coordinate origin of external CAD data.
After [Cad Tree] is displayed, right-click on the work to change the coordinate origin and select the [set 

Originpos] menu. Then the [Origin Point] dialog is displayed, change the value of position.

It is possible to change the coordinate origin of external CAD data as follows.

This function is available only with the data which enabled [Imports the work file for CAM 
teaching] at the time of reading of the following external CAD data.
CATIA, SOLIDWORKS, Pro/E, INVENTOR, IGES, STEP, SAT

NOTE
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11.16CAD Data Export 

Exports in IGES,SAT or HSF format the data of multiple models with their relative position from a 
selected base point.

 Export

Before the CAD data of IGES or SAT format is exported, the "Export" dialog is displayed.  The export 
settings in the dialog can be changed if required.
To change the default settings related to the export, please refer to section 12.7 "CAD Import/Export 

<CadPack Option>". 

When IGES or SAT data are exported (CadPack option), the MotoSim EG-VRC-CadPack 
is required.  (The MotoSim EG-VRC-CadPack is separate product from MotoSim EG-
VRC.)

 The settings selected in the "Export" dialog will not change the settings in the "Option 
Setting" dialog under the "CAD Import/Export" tab.

Export

[Units] radio button Sets the measuring units of the exported SAT or IGES files.

“Version (SAT Only)” 
section

Sets the SAT file version used in the exported file.Recommended value: 6 
(Setting range: 4 to 16)

[Don't show this dialog 
next time] check box

If checked, the "IGES Import" dialog will no longer be displayed when an 
IGES file is imported. The "IGES Import" dialog display can be re-enable in 
the "Option Setting" dialog under the "CAD Import/Export" tab.  Please refer 
to section 12.7 "CAD Import/Export <CadPack Option>".

[OK]button The CAD export will proceed with the options set in the dialog.

[Cancel]button Cancel the CAD export.

NOTE

NOTE
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Procedure

1. Select in the Cad Tree the models to export.
• To select a single model:

Expand the model node so that there is no "+" icon on the left of the model name and select 
the model.

• To select multiple models
Collapse the node containing the desired models so that there is a "+" icon on the left of the 
model name.  All the child models in the collapsed branch will also be exported.

 Only the model referring to 
• IGES,SAT or HSF format files;
• .mdl files composed of BOX, BOX2, CYLINDER, CONE2, SPHERE, PIPE2, AXIS6, 

LINE, LINE2 parts;
can be exported.  When selecting multiple models, at least one of the selected models 
must make reference to such CAD file.

The “SAT1” model will be 
exported. 

The child “SAT1” and “SAT2” model of 
the “POS” model will be exported. 

NOTE
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2. Right click on the CadTree to display the popup menu.  Then select "Export CAD File..."

3. In "Select Base Model" dialog, select the model to be used as the base point (origin) of the 
exported model and press the [OK] button.

4. In the "Save As" dialog, select the file type (IGES, SAT or HSF).  Enter a filename and press the 
[Save] button.
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5. If the "Export" dialog is set to display, the "Export" dialog will display to confirm the IGES/SAT 
export settings.  Change the settings as required, and then press [OK].  For more details please 
refer to the section "Export" section above.

6. When the export is completed the following message will display.
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12 Configuration Settings

Various configuration settings can be made in the Option Setting dialog box.

Click the MotoSim EG-VRC button (  ), and select the [Options] menu.

12.1 Graphical Settings

For the graphical settings, select the “Graphic” tab of the Option Setting dialog box.  

Graphic tab

Item Description

[Reset] button Restores all the values to the default setting.

[OK] button Applies the modifications, and closes the dialog box.

[Cancel] button Closes the dialog box without applying the modifications.
12-1

HW0485348
445 of 671



12  Configuration Settings
12.1  Graphical Settings

156225-1CD
12.1.1 Background Color

Specify the background color of the cell window in the “Background Color” section.  

12.1.2 Smooth Transition

Specify if a smooth transition is executed when changing viewpoint in the “Smooth Transition” section.

12.1.3 Display

Configure the graphic driver in the "Display" section. 

Item Description

"Top" color 
indication box

Displays the current color of the upper part of the background.
Press [color] to display the Color dialog box, and select the desired color.

"Bottom" color 
indication box

Displays the current color of the bottom part of the background.
Press [color] to display the Color dialog box, and select the desired color.

[Same Color] 
check box

Check this check box to set the “Bottom” background color to the same color as 
the “Top” background. 

Item Description

[Execute] check box Select to execute the smooth transition function when changing the viewpoint.

"Duration" edit box
Specify the duration of the smooth transition.  (Editable when the [Execute] 
check box is selected.)

Item Description

"Driver" combo box

Select a graphic driver from the list: "OpenGL" is selected by default.
The graphic drivers currently available are "OpenGL", "OpenGL2" and 
"WinGDI". 

[Axis Triad On] 
check box

Displays the coordinate axis below on the lower left of the cell window. 

[Perspective] 
check box

Check this check box to display the cell in perspective.

To apply the change of graphic driver, reload the cell.NOTE
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12.1.4 Shadow

Set the following items for shadow display in the “Shadow” section.

12.1.5 Frame & AXIS6

Specify the Frame and Axis6 display property.

Item Description

[Show] check box Select to display shadows on the cell window.

"Color" indication box
Displays the current color of the shadows.
Press [color] to display the Color dialog box, and select a desired color.
(The [color] button is enabled when the [Show] check box is selected.)

"Resolution" edit box
Enter the resolution value.
(Editable when the [Show] check box is selected.)

"Blurring" edit box
Enter the value for the gradation effect.
(Editable when the [Show] check box is selected.)

Item Description

“Frame Length” spin box Enter the value of the frame and Axis6 length with the spin button.

"Color" indication box
Displays the current color of the frame.
Press [color] to display the Color dialog box, and select a desired color. (The 
[color] button is enabled when the [Show] check box is selected.)

"Always Display Axis6 in 
Front" checkbox

When checked, the Axis6 are displayed in front of all the other parts.

Axis6 Displayed in FrontRegular Display
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12.1.6 Level of Detail

When changing the scene viewpoint or during playback the level of detail can be decrease in order to 
obtain a smoother animation.  This function is useful to improve display performance of cell containing 
a large amount of data such as very detailed HSF model.

Item Description

Enable

When this item is checked, the level of detail will be reduced during viewpoint 
change and playback.  The level of detail data will also be generated for the HSF 
models when required.

• When the displayed surface becomes rougher during viewpoint change or playback, 
depending on the data some model elements may not display.

• It is easier to distinguish the discrepancies between levels of detail when displaying the 
cell in "Flat Shading" (refer to section 6.11 "Changing the Rendering Mode").

• When the function is enabled, a message offers to 
generate the level of detail data for the currently 
opened cell.  If the data was previously generated for 
this cell, it is not necessary to regenerate the data and 
you may press "Cancel".

• The generation of the level of detail data may take 
some time depending on the size of the model file.

NOTE

NOTE

 

 

 

 

Displayed surface  

become rough 
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 Generating the Level of Detail Data

When the Level of Detail function is enabled, the level of detail data need to be generate for the function 
to work properly.  If an opened cell doesn't contain the level of detail data, a message will prompt the 
user to confirm that the data should be generated at this time.

While generating the level of detail data, the "Generating Level of Detail" dialog will display the 
generation progress.  To stop the data generation, click on the "Abort" button.  Note that when aborting 
the generation, the current file processing will continue until completed, and then the generation will 
stop and data for the remaining file will not be created
.

When adding HSF model and the Level of Detail is enable, the level of detail data will automatically be 
generated for the new model.  The "Generating Level of Detail" progress dialog will display but the 
process cannot be aborted.
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12.2 Markup Settings

To configure the lines and texts on the cell window, select the "Mark Up" tab of the Option Setting dialog 
box.

Mark Up tab

Item Description

"Mark up" section

"Color" indication box
Displays the current color of the markup object (line and text).
Press [color] to display the Color dialog box, and select the desired color.

"Thickness" spin box
Directly enter the value or specify the value with the spin button  to specify 
the thickness of the markup line.
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"Text" section

"Font Name" combo box
Select a desired font for the text. 

"Size (pts.)" edit box
Specify the size of the font.

"Back Color" indication box
The color indication box displays the current markup text background color.
Press [color] to display the Color dialog box.  And select the desired 
background color.

[Reset] button Restores all the values to the default setting.

[OK] button Applies the modifications, and closes the dialog box.

[Cancel] button  Closes the dialog box without applying the modifications.

Mark Up tab

Item Description

When using two-byte characters for the text, make sure 
to select a font which can be displayed properly.

NOTE
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12.3 Robot Option Settings

When a robot axis reaches its limit position, the color of the axis changes.  

Robot Option tab

Item Description

"Pulse limit warning" 
section

[Execute in Teach] check box
Select to display the axis reaching its limit in a reverse color or a limit color in a 
teaching operation. 

[Execute in Play] check box
Select to display the axis reaching its limit in a reverse color or a limit color in a 
playback operation.

First
"Limit Value (%)" edit box

Directly enter the value to specify the limit value for the first limit axis check. 

"Limit Color" indication box
Displays the current first limit color. Press [color] to display the Color dialog 
box, and select the desired color.

Second
"Limit Value (%)" edit box

Directly enter the value to specify the limit value for the second limit axis 
check. 

"Limit Color" indication box
Displays the current second  limit color. Press [color] to display the Color 
dialog box, and select the desired color.
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"Multiple Controller 
Dialog" section

When enabled MotoSim EG-VRC will display a separate copy of  controller related 
dialog or panel for each controller in the cell.  When a dialog is initially displayed, it 
is set to the currently selected controller.  Once displayed the dialog will always 
display the information for the same controller, even if the current controller is 
changed.  To display multiple copy of a same dialog, display a first copy of the 
dialog, then change the current controller and display the dialog again.

File Save

When checked, the path information stored in the cell file are relative to the cell file 
folder. If unchecked, the full path starting from the driver root is stored in the cell 
file. A cell saved with relative path is easier to transfer to another computer. (To 
store the file refer to section 4.3 "Storing a Cell".)

[Reset] button Restores all the values to the default setting.

[OK] button Applies the modifications, and closes the dialog box.

[Cancel] button  Closes the dialog box without applying the modifications.

Robot Option tab

Item Description
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12.4 Language and Unit Settings

To configure the language and unit, select the "Lang / Unit" tab of the Option Setting dialog box.  

Lang / Unit tab

Item Description

"Language" section
Select the [Japanese] or [English] radio button to configure the language.
To set from the main menu, select {View} - {English} or {Japanese}.

"Unit Settings" 
section

Select the units for each type of values.

"Length/Position" edit box
Indicates the unit of the length. 

"Angle" edit box
Indicates the unit of the angle. 

"Weight" edit box
Indicates the unit of the weight.

[Reset] button Restores all the values to the default setting.

[OK] button Applies the modifications, and closes the dialog box.

[Cancel] button  Closes the dialog box without applying the modifications.
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12.5 Performance Settings

To configure the performance, the "Performance" tab of the Option Setting dialog box.

Performance tab

Item Description

"Framerate Optimization" 
section

"None" radio button
All model data are displayed.

"Culling Threshold" radio button
Model data which displayed size is smaller than the selected pixel 
on the display are not displayed.

[Reset] button Restores all the values to the default setting.

[OK] button Applies the modifications, and closes the dialog box.

[Cancel] button Closes the dialog box without applying the modifications.

If the threshold is large, performance is improved. But, 
if the threshold is overlarge, the necessary model data 
are not displayed. Set up the threshold in accordance 
with the model data.
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12.6 Mouse Customization

The mouse button allocation of viewpoint operation can be changed.
Presses the allocable mouse button and key in the edit box, the mouse button allocation of viewpoint 
operation is changed.
The allocable mouse button and key are as follows.

• Middle button (mouse)
• Right button (mouse)
• [CTRL] key
• [SHIFT] key

Mouse Customization

Scroll ･Zoom
Presses the allocable mouse button and key in the edit box, the 
allocated key to Scroll/Zoom is displayed.

Rotate
Presses the allocable mouse button and key in the edit box, the 
allocated key to Rotate is displayed.

Pan
Presses the allocable mouse button and key in the edit box, the 
allocated key to Pan is displayed.

Free Zoom
Presses the allocable mouse button and key in the edit box, the 
allocated key to Free Zoom is displayed.
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Show Viewpoint Operation Bar

When enabled, viewpoint operation bar is displayed. 

Click the above button, viewpoint operation by right button is changed.
If unchecked, viewpoint operation bar is hidden.

[Reset] button Setting is changed into default.

[OK] button Setting is saved and this dialog is closed.

[Cancel] button Setting is canceled and this dialog is closed.

Mouse Customization
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12.7 CAD Import/Export <CadPack Option>

12.7.1  CAD Import

Option settings related to reading CAD format files.

To use this function (CadPack option), the MotoSim EG-CadPack is required.  (The 
MotoSim EG-CadPack is separate product from MotoSim EG.)

“Enable Healing” 
section

When enabled, a healing algorithm is applied to the imported CAD data.

[Recreate 
surface] check 
box

The [Recreate surface] option is normally selected.
The [Recreate surface] is part of the normal healing process.  If it is unselected, 
this step will be skipped in the healing process.
If the surface regeneration doesn't give the intended results, unselect the 
"Recreate Surface" may improve the healing results. 

[Disable on error] 
check box

The [Disable on error] option is normally selected.
When the [Disable on error] is selected, the healing will be disabled if an error 
occurs during the healing process. 

NOTE
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12.7.2  IGES/SAT Export

Imports the work file 
for CAM teaching

Select this type when the model applies a CAM function. Do not select this type 
when the model is tool or peripheral equipment.

General CAD data are displayed  in the CadTree dialog, and the model for CAM 

teaching are displayed  .

[High-Speed Mode] 
check box

When enabled, MotoSim EG-VRC reads only data necessary to drawing from CAD 
data, so it may takes higher. But, When "Imports the work file for CAM teaching" is 
enabled, this is disabled.

[Uses External 
Converter] check box

When enabled, CAD data is converted by outside CAD converter software and 
MotoSim EG-VRC imports the converted CAD data. When not enabled, MotoSim 
EG-VRC converts the CAD data.

[Don't show the [CAD 
Import] dialog] check 
box

When this option is selected, the "CAD Import" dialog will not display when an 
IGES file is read.

The healing process attempts to repair any corrupted data of the imported CAD files. However, 
the processing time to import a file may increase significantly when healing is used. The 
performance may also vary depending on the extent and nature of the errors in the original 
CAD file. In some cases, result with healing may be worst than reading the file without healing.

Units Sets the measuring units of the exported SAT or IGES files.

Version (SAT 
Only)

Sets the SAT file version used in the exported file.
Recommended value: 6 (Setting range: 4 to 16)

[Don't show the 
[Export] dialog] 
check box 

When this option is selected, the "Export" dialog will not display when the "Export 
CAD file" function is used. 

For details on the CAD data import, please refer to section 
11.13 "Reduce HSF File".

NOTE

NOTE

For details on the IGES, SAT data export, please refer to 
section 11.16 "CAD Data Export".

NOTE
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12.8 Show Teach Point <CadPack Option>

To configure the Teach Point, the "Show Teach Point" tab of the Option Setting dialog box.

To use this function (CadPack option), the MotoSim EG-VRC-CadPack is required. (The 
MotoSim EG-VRC-CadPack is separate product from MotoSim EG-VRC.)

GuideLine

[Show] check box Select displaying the guide lines or not.

NOTE
12-16

HW0485348
460 of 671



12  Configuration Settings
12.8  Show Teach Point <CadPack Option>

156225-1CD
[Modify Color] 
button

Select the color of the guide line.

Teach Point No

[Show] check box Select displaying the teach point no. or not.

[Modify Color] 
button

Select the color of the teach point no.

Show Teach Point

Style

Frame only 

Arrow Only (S)  

Arrow Only (M)  

Arrow Only (L)  

Frame and Arrow (S)  

 

 

 

A teach point and a teach point 
are connected with a dotted line, 
and are displayed. 
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Style

Frame and Arrow (M)  

Frame and Arrow (L)  

None

Length Change the frame length (Z-Axis) of teach point.

[Modify Color] 
button

Select the color of the frame length (Z-Axis)

[Show Teach 
Point Inverse 
Direction] check 
box

Select reversing the frame length (Z-Axis) or not.

[Reset] button Initialize the settings.

[OK] button The settings are saved and the dialog is closed.

[Cancel] button The settings are canceled and the dialog is closed.
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13 Applied Operation

13.1 Teaching Using OLP Function

 What is OLP Function?

Normally, teaching operation uses the programming pendant to move the robot model to the target 
position.  The OLP (Off-Line Programming) function is a quick and efficient way to move the robot to a 
target position.  When the desired destination is located on a model, by using the OLP panel, the end of 
the tool (TCP) can conveniently be moved to the target position by simply clicking on the screen (for 
example, any point of a workpiece, etc.).

• When moving the robot tool end with the OLP function, the message "Cannot reach this 
point" may appear even if the robot is not too far from the target point.  This may happen 
when the tool end cannot be moved to the target point due to the shape or current 
posture of the robot.

• A point other than the target point may be selected depending on the point clicked and 
the view position.  When this occurs, use the programming pendant to move the robot or 
change the camera scope of the screen to click on the proper model.

SUPPLE
-MENT
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13.1.1 Teaching Operation Setup

The teaching operation is explained by using “Arc_Sample.vcl” as an example.

Procedure

1. Open “Arc_Sample.vcl”.
(If it is difficult to perform the teaching operation, hide the displayed models such as  fence, 
controller, etc. by selecting the obstructing model and then setting its display property to “Hide 
All” in the combo box on the Cad Tree dialog box.)

2. On the [Home] tab, in the [Teaching] group, click the [OLP] button, the [OLP] dialog appears.
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3. Display the cell window so that the workpiece is visible as shown in the figure below.

13.1.2 Position Designation in Free Mode

In "Free" mode, the tool end (TCP) moves to the point of the model corresponding to the clicked 
position.

1. Set each item in the OLP dialog box as shown in the following figure.

2. Click on the following position of the workpiece model displayed in the cell window.

Check.

Select.

 

Click here.
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3. The tool end moves to the clicked position.
Click on another point, and the tool end moves to the clicked position.
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13.1.3 Position Designation in Vertex Mode

In "Vertex" mode, the tool end (TCP) moves to the model vertex nearest to the clicked position.

1. Set each item in the OLP dialog box as shown in the following figure.

2. Click on the following position of the workpiece model displayed in the cell window.

3. The tool end moves to the nearest vertex.
Click on a point near another vertex to check if the tool end moves to the nearest vertex. 

 

Check.

Select.

 

Click a side near
the corner.
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13.1.4 Position Designation in Center Mode

In "Center" mode, the tool end (TCP) moves to the face or edge center nearest to the clicked position.
.

1. Set each item in the OLP dialog box as shown in the following figure.

2. Click on the following position of the workpiece model displayed in the cell window.

3. The tool end moves to the center point of the designated model face or edge.  
If the tool overlaps on the model, the tool direction is improper.  Use the programming pendant 
to correct the position afterward.
Click on another face to check if the tool end moves to the center of the designated model face. 

Check. 

Select. 

 

Click the side face.
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13.1.5 Position Designation in Edge Mode

IIn "Edge" mode, the tool end (TCP) moves to the edge point nearest to the clicked position.
.

1. Set each item in the OLP dialog box as shown in the following figure.

2. Cick on the following position of the workpiece model displayed in the cell window.

3. The tool end moves to the edge point nearest to the clicked position.  Click on another face 
point to check if the tool end moves to the closest edge.

Check.

Select.

 

Click here. 
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13.1.6 Designation with Orientation Mode

Orientation Move Mode can be used by itself or in combination with the Position Mode.  Checking the 
[Orientation] checkbox rotates the tool end frame to align it with the target point frame.  If the [Position] 
mode is also check, the tool end will also move overlap the target frame.  Therefore, if you only want to 
change the orientation of the tool without moving it, make sure to uncheck the [Position] checkbox.

The target point frame appears when the left mouse button is pressed down on a model and is 
represented by 3 colored arrows.  The red arrow is the Z-axis and corresponds to the normal (or 
reversed normal) of the face where lies target point; the blue arrow is the X-axis and is defined by the 

face edge closest to the point; and the green arrow is the Y-axis and is orthogonal to the two other axis.

Procedure

1. Hide the T-shape workpiece and the stand to make it easier to create a new workpiece.
On the [Home] tab, in the [Model] group, click the [CadTree] button, the [CadTree] dialog 
appears.  To hide the lower hierarchy of the “DAI” tree. Confirm that the cursor is on the “DAI” 
model, then select “Hide All” in the Cad Tree dialog combobox to hide the model.

2. Select “world” in the Cad Tree and click on the [Add] button to add the BOX of the following 
specifications.
Model: WORK2

3. Click on the [Pos] button in the Cad Tree to set the position as shown in the table below.

• That some geometries, such as lines or points, do not have sufficient information to 
generate a frame information.  In such cases, the tool end will maintain its original 
orientation.

• The direction of the Z-axis can be changed by selecting [Normal] or [Reverse] mode in 
the "Use Face:" section.

Width (W) 500 Depth (D) 500 Height (H) 50

X (mm) 0 Y (mm) 0 Z (mm) 0

Rx (degree) 0 Ry (degree) 0 Rz (degree) 0

X (mm) 800 Y (mm) 0 Z (mm) 560

Rx (degree) 150 Ry (degree) -20 Rz (degree) 0

NOTE
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4. To see and understand the coordinate axis of “WORK2”, select “WORK2” in the Cad Tree, then 
select “SeeAll” to display the Frame of the coordinate axis on the “WORK2”.

5. Set each item in the OLP dialog box as shown in the following figure.

6. Click on the position of the “WORK2” as shown below.

7. The tool end moves to the model vertex and the tool coordinate axis is aligned in the same 
direction as the target point frame that was displayed when the point was clicked.

Check.

Select.

  

Click.
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If the [Orientation] checkbox is not checked, the direction of the tool coordinate axis will not be 
changed as shown below.

 Designation with Z-Axis Mode

Z-Axis Move Mode can be used by itself or in combination with the Position Mode.  Checking the [Z-
Axis] checkbox rotates the tool end frame to align its Z-axis with the target point Z-axis.  If the [Position] 
mode is also check, the tool end will also move overlap the target frame.  Therefore, if you only want to 
change the orientation of the tool without moving it, make sure to uncheck the [Position] checkbox.

The target point Z-Axis appears when the left mouse button is pressed down on a model and is 
represented by a red arrows.  For a solid, the Z-axis corresponds to the normal (or reversed normal) of 

the face where lies target point.  For a line, it corresponds to the line direction to the next closest point.

Procedure

The procedure is explained by using "WORK2", which has been used in "Designation with Orientation 
Mode", as an example.

1. Move the robot to its home position.  

• Points do not have sufficient information to generate Z-axis information.  In such cases, 
the tool end will maintain its original orientation. .

• The direction of the Z-axis can be changed by selecting [Normal] or [Reverse] mode in 
the "Use Face:" section.

           

NOTE
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2. Set each item in the OLP dialog box as shown in the following figure.

3. Click on the face of the "Work2", and the tool Z-axis will turn so that the tool end is 
perpendicular to the clicked face of the model.

Check.

Select.
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13.1.7 Pick Object Filter

The "Pick Object" section allows setting the type of model that can be selected with mouse.
Use this section when pick operation cannot be executed properly because the objects overlap each 
other.  This setting filters which object types can be selected and enables proper pick operation.

Procedure

The procedure is explained by using “WORK2”, which has been used in section "Designation with 
Orientation Mode", as an example.

1. Display the Cad Tree; hide the “WORK2” and display the “DAI”.

2. Select “DAI” in the Cad Tree to add the AXIS6 of the following specifications.
Model: DAI (AXIS6)     Frame No.: 0

The AXIS6 is inside the BOX. (To see AXIS6 make sure that the Axis6 are always 
displayed in front in the "Options" dialog.  Please refer to section 12.1.5 "Frame & AXIS6"

X (mm) 0 Y (mm) 0 Z (mm) -100

Rx (degree) 0 Ry (degree) 0 Rz (degree) 0

 

Newly added
AXIS6
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3. Set each item in the OLP dialog box as shown in the following figure.

4. The tool does not move even though the “AXIS6” on the cell window is clicked.  If you click 
around the vertex of the BOX, however, the tool moves to the vertex.  This is because the 
[Frame] check box in the OLP dialog box has been cleared and only models are considered for 
selection.

 

Check.

Select.

 

Clicking of the AXIS6
does not move the tool.
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5. Check the [Frame] check box for the “Pick Object” and clear the [Model] check box.

6. Click on the AXIS6, and the tool moves to the vertex of the AXIS6.

It is recommended to use this function with both [Frame] and [Parts] checked for normal 
operation.

Uncheck. 

Check 

SUPPLE
-MENT
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13.1.8 Changing of Operation Object

Setting the "Operation Object" section in the OLP dialog box allows changing the object moved by the 
pick operation.  The "Operation Object" can be changed among.

Procedure

The procedure is explained by taking “CurModel” as an example.

1. Set each item in the OLP dialog box as shown in the following figure.

2. Display the Cad Tree to select “DAI”, or click on the  button to select the “DAI” model in 

the cell window.

 

The operation object of
when "CurModel" is selected

The operation object of
when "Teacher" is selected

Check.

Select.
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3. Select a model for the operation object.
• When the current model was selected with the Cad Tree

Click on the tool end in the cell window with the mouse, and the “DAI” moves to the tool end.

• When the current mode was selected with the  button

Check the [OLP Pick] check box, then click on the tool end on the cell window, and the “DAI” 
moves to the tool end.

13.1.9 Move to External Reference Point

When the Move to External Reference Point function is active, the robot will move so that the point 
clicked on a model (carried by the robot) is brought to the external reference point.  
This is useful for applications like sealing and spot welding where the parts are handled by the robot 
and brought to a fix point (distribution nozzle, spot gun) for processing. 

Procedure

The procedure is explained by using the "SpotWeld.vcl" as an example.
1. Open the "SpotWeld.vcl" located in the "Example" folder.  The cell display should look like the 

one shown below.

Perform the same operation when the [Teacher] radio button is selected for the “Operation 
Obj” section.

           

Click here.

SUPPLE
-MENT
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2.  On the [Home] tab, in the [Teaching] group, click the [OLP] button, the [OLP] dialog appears. 
Click on the [More >>] button.

3. Set the external reference point.

With the "Select Model" mode  , select the "hite" model by clicking on it.

 

Click here 

(model:hite)
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To set the external reference point, click on the [Select Reference] button, the [Select Model] 
dialog will display, select the "hite" model and press [OK].

The name of the selected reference model is displayed in the "Move to External Ref. Point" 
section.  Confirm that the "hite" model is selected.

4. Set each item in the OLP dialog box as shown in the following figure.

Check 

Select 

Check 
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5. Click on the work piece at the shown position.

6. The robot will move the work piece target point to the external reference point.

To use the "Move to External Reference Point" mode, the "Operation Object" needs to be 
set to robot.

 

Click here.

NOTE
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13.1.10 Synchronous Base Axis Move to Target Point

When a robot with servotrack/servotracks is moved with the OLP, the synchronous base axis move 
function allows the tool end (TCP) to move to the target point with the servotrack motion.
This operation function procedure is explained separately for robots with a single servotrack and robots 
with multiple servotracks.

 Robot with Single Servotrack

Procedure

1. For the robot with a single servotrack, the move method can be selected among:
• Front movement;
• Approach little by little; and
• Middle of attainment and front.

2. Select the [Active] check box in the “Synchronous base axis move” .

  

Check. 

Displays the selected move method.
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3. Click on the [Method] in the OLP dialog box to display the “Synchronous base axis movement” 
dialog box, and set the move method.

Front Movement

The function enabled with the [Front movement] radio button allows the tool end to move to the target 
point after the servotrack moves in front of the target point.

Procedure

1. Select the [Front movement] radio button in the “Synchronous base axis movement” dialog box.

2. Click on the target point.
• If the target point exceeds the servotrack soft limit, a message is displayed and the servo-

track moves to the soft limit.
• If the tool end (TCP) does not reach the target point, an error message is displayed but the 

servotrack moves in front of the target point.

 

Select the move method.

Input only when the 
[Middle of attainment
and front] radio button 
is selected.

            

Aimed point

Moving distance

After move

 

Select.
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Approach Little by Little

The function enabled with the [Approach little by little] radio button allows the servotrack to move only 
the distance between the target point and the position of the current tool end (TCP), then the tool end 
(TCP) moves to the target point.  In short, the servotrack and the tool end (TCP) move so that the 
current robot posture is maintained as much as possible.

Procedure

1. Select the [Approach little by little] radio button in the “Synchronous base axis movement” 
dialog box.

2. Click on the target point.
• If the target point exceeds the servotrack soft limit, a message is displayed and the servo-

track moves to the soft limit.
• If the tool end (TCP) does not reach the target point, an error message is displayed but the 

servotrack moves in front of the target point.

           

 Aimed point

 Distance to
    aimed point

The robot moves
the distance 

After
move

 

Select.
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Middle of Attainment and Front

The function enabled with the [Middle of attainment and front] radio button allows the servotrack to 
move toward the target point step by step to search for the first position where the tool end (TCP) can 
attain the target point.  The servotrack then moves to the middle point between the first attainment and 
the front of the target point, and the tool end (TCP) moves to the target point.

Procedure

1. Select the [Middle of attainment and front] radio button in the “Synchronous base axis 
movement” dialog box.  In the “STEP” edit box, set the moving amount for each step taken 
toward the target point. 

2. Click on the target point.
• If the tool end (TCP) does not reach the target point even though the servotrack moves in 

front of the target point, the attainment is searched with the servotrack moving in such a 
direction that the target point will be further (up to the maximum soft limit) than the servo-
track position before moving.  

         

Target point

After
move

The first attainment Front of the
target pointMiddle

point
The robot moves in the direction
of the target point step by step.

 

Select.

Sets the interval 
to search for the 
aimed point.

Target point Searches for
    the attainment.

The original
position

 The end tool
     does not reach
     the aimed point.

In front of the
target point

 Searches
     again.
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• If the tool end (TCP) does not reach the target point, an error message is displayed and the 
servotrack returns to the original position before moving.

• If the tool end (TCP) does not reach the target point because the servotrack moves to the 
middle point between the first attainment and the front of the target point, the attainment is 
searched again with the servotrack moving in such a direction that the target point will be 
further than the middle point.

 Searches for 
    the attainment.

 Moves to the middle point.

The end tool
    does not
    reach the
    target point.

In front of the
target point

Target point

The original position

 Searches
           again.

 The first
      attainment
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 Robot with Multiple Servotracks

For the robot with multiple servotracks, each servotrack moves the distance between the current tool 
end (TCP) position and the target point, and the tool end (TCP) moves to the target point.

Procedure

1. Select the [Active] check box in the “Synchronous base axis move”.  For the multiple 
servotracks, the servotrack move methods cannot be selected since only one method is 
available.   

2. Click on the target point.
• If the target point exceeds the servotrack soft limit, a message is displayed and the 

servotrack moves to the soft limit.
• If the tool end (TCP) does not reach the target point, a message is displayed but the 

servotracks move the distance to the target point. 

           

After move

Aimed point

Moving distance of
the second servotrack

Moving distance of
the third servotrack

Moving distance of
the first servotrack

Select.
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13.1.11  Position Designation with move slave function

When the [move slave] checkbox is checked, the [Move Slave] function is enabled. When a robot or 
station is moved, other slave robots from the same controller are moved with it so that their TCP 
maintain the same relative position to the moved robot or station. For example, this section describes 
the move slave function with SDA10D-A00.

1. Display the OLP dialog box and check the [Move Slave] checkbox.

2. To display the "Set Slave Robots" dialog, click the […] button. Then set which robot are slave 
robots.

Check 
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3. Click the arbitrary points of works in the MotoSim EG-VRC.

4. Then, slave robots are moved with it so that their TCP maintain the same relative position to the 

moved robot or station.

When the function is enable, if one of the robot can not reach the proper position, all the 
robots are prevented from moving.

 

Click here 

NOTE
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13.2 Trace Function

13.2.1 Changing Trace Object

The object normally traced is the tool end, however, the trace object can be changed.  
The trace object is changed to the flange in the following explanation. 

Procedure

The procedure is explained with the  “Arc_Sample.vcl” example.

1. On the [Simulation] tab, in the [Monitor] group, click the [Trace] button, the [Trace] dialog 
appears. 
The “Trace Manager” dialog will appear.  Trace can be added, edited or deleted.  For this 
example, the default trace will be edited.  

2. Display the trace property by double clicking on the “HP6_trace1” or by pressing the “Edit” 
button.  Press the [...] next to the “Model” field to display the “Select Model” dialog and select 
the model to be traced.  For this example, select the “HP6_flange” model.  Then click on the 
[OK] button.  Make sure that the “Model” edit box shows the selected model name and click on 
the [OK] button. 

Select 
“HP6_flange”
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3. Execute an job.
On the [Simulation] tab, in the [Playback] group, click the [Start] button.

The following figure shows when the tracing point is a tool.

  

Flange tracing

  

Tool end tracing
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13.2.2 Changing Trace Parent

The tracking drawn by the trace function is normally created and drawn as a model having "world" as 
the parent.  Therefore, changing the name of the “Parent” in the Trace Configuration dialog box will 
change the parent of the tracking.  This parent changing function is useful in the following cases:

• Tracing welding point positions when the robot holds and moves a workpiece to a fixed 
welding points.

• Points to be traced are set to welding points. 

Procedure

The procedure is explained with the “Arc_Sample.vcl” example.

1. On the [Home] tab, in the [Model] group, click the [CadTree] button, the [Cad Tree] dialog 
appears.  
To hide the “WORK” which is located on “DAI”, select “WORK” to set it to “Hide”.

2. Select “world” from the Cad Tree and click on the [Add] button to create the “YOUSETU” model.

3. Add the “CONE2” model to “YOUSETU”.
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The following figures show “CONE2” and the layout setting.

4. Create the “WORK3” model that has “TCP” as the parent.
Select “HP6_tcp” from the Cad Tree, then click on the [Add] button.

5. Add the “BOX” model to “WORK3”.

 

YOUSETU

Set the layout so that the model frame 
comes to this position.

 

Create "WORK3" on TCP. 
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Set the BOX as follows.

6. On the [Simulation] tab, in the [Monitor] group, click the [Trace] button, the [Trace] dialog 
appears. 

7. Display the trace property by double clicking on the “HP6_trace1” or by pressing the “Edit” 
button.  Press the [...] next to the “Model” field to display the “Select Model” dialog and select 
the model to be traced.  For this example, select the “YOUSETU” model.  Then click on the [OK] 
button.  Make sure that the “Model” edit box shows the selected model name.

8. Press the [...] next to the “Parent” field to display the “Select Model” dialog and select the model 
that will become the parent (and the reference coordinate frame) of the trace.  For this example, 
select the “WORK3” model.  Then click on the [OK] button.  Make sure that the “Parent” edit box 
shows the selected model name.

9. The “Max. Points” field defines the maximum number of points that will be used by the trace, 
this affect the length of the trace.  (If the number of tracing points exceeds the set value, tracing 
points are deleted in order from the oldest.)
In this example, set the value to 2000.

10. The “Color” field displays the color of the trace.  Set any desired color by pressing the [...] button 
next to the color.

11. Click on the [OK] button to save the setting.

          

WORK3
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12. Using the Virtual Pendant, create a new job which welds four corners of a workpiece as shown 
in the following figure.  Teach the positions of each STEP with  MOVL instructions.  

13. Execute the job and the tracing track attached to “WORK3” will be displayed.  This helps to see 
which positions on the workpiece are to be welded.

As described above, changing the trace object and the parent with the Trace Configuration 
dialog box can leave the moving track of the target point that can be easily read.

     
  Initial State Viewed from Side Initial State Viewed from Front

           

       

STEP 1 STEP 2 STEP 3

STEP 4 STEP 5
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13.3 Collision Detection Setting

This section explains to set up the collision detection and check the collision on the playback.
Follow the flowchart below to set up the collision detection.

 Collision model group registration

Procedure

1. On the [Simulation] tab, in the [Collision] group, click the [Collision Detection] button, the 
[Collision Detection] dialog appears.

2. Click the [ModelGroup] button on the Collision Detection dialog box, the Collision Model Group 
dialog box is displayed.

3. Click the [Add] button on the Collision Model Group dialog box, the Collision Model Group 
Detail dialog box is displayed.

 Collision model group registration 

Collision definition registration 

Start collision detection 

     
13-34

HW0485348
496 of 671



13  Applied Operation
13.3  Collision Detection Setting

156225-1CD
4. Enter the collision model group name to [Model Group], display the [CadTree] dialog box, and 
select the "DAI" in the CadTee dialog box.
Check the [A child model is also registered simultaneously] and click the [Add from CadTree] 
button, "DAI" and "WORK" is added to the model list. Click the [OK] button to save. 

5. To edit the collision model group of robot, Double-click "DX100-R01" on the Collision Model 
Group dialog box. The Collision Model Group Detail dialog box is displayed.

Delete the unnecessary model from model list. Click the   button and click the tool model 

on the MotoSim EG-VRC window. "Torch" is added. Click the [OK] button to save.
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 Collision definition registration

1. Click the [Add] button on the Collision Detection dialog box, the Collision Definition dialog box is 
displayed.

2. Enter "PAIR1" to the [Pair Name], Set Attribute of "DX100-R01" as "Master" and set Attribute of 
"WORK" as "Slave".

 Start collision detection

1. Check the "PAIR1" check box on the Collision Detection dialog box, and check the [Collision 
Check] check box.

2. To execute the job, on the [Simulation] tab, in the [Playback] group, click the [Start] button. 
When the collision occurs, the models turn red, and playback is stopped.
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13.4 Adding I/O Board Module

Even if CMOS.BIN of the real robot with I/O board module or welding board module, it is possible to 
add virtually those board modules to the virtual controller.

13.4.1 Adding I/O Board Module (DX200, DX100, NX100).

Procedure

1. With a text editor software (e.i. Notepad) open the “HwEmu.ini” file located in the controller 
folder of the cell (the same folder that contains the VRC.BIN file).

2. Edit the file as follows and then save the file.

[HwEmu.ini]

• The following I/O expansion boards are supported:
DX200, DX100:

• JARCR-XOI01
• JARCR-XOI02
• JARCR-XOI03
The analog EW boards are not supported for the DX200/DX100.

NX100:
• JARCR-XOI01
• JARCR-XOI02
• JARCR-XOI03
• JANCD-XEW01-1
• JANCD-XEW01-2
• JANCD-XEW02

• When the new controller is created, this procedure can not be used. Prepare the cell 
registered the controller beforehand, and use the procedure of this section.

[VIRTUAL_SET]
VIRTUAL_SET=1
[RSW]
RSW=14
[BOARD]
SLOT# 0=JZNC-NIF02-2
SLOT# 1=JARCR-XOI01
SLOT# 2=
SLOT# 3=
SLOT# 4=JANCD-XEW01-1
     :
     :
     :
SLOT#15=

←Set this value to 1

←Do NOT change this.

←Do NOT change this.
←Write the name of the desired board
        (SLOT#1 to #15  are available to add boards)

NOTE
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3. Start MotoSim EG-VRC but do not open any cell.  (If already running, close all open cell).  On 
the [Controller] tab, in the [Boot] group, click the [Maintenance mode] button, the [Maintenance 
mode] dialog appears.  Click the [...] button form that dialog and select the VRC.BIN file located 
in the controller folder of the cell.  Then, click the [Start] button to launch the controller in 
Maintenance mode.  (For more detail about the controller maintenance mode, refer to section 
7.10 "VRC Maintenance Mode".)

4. From the Virtual Pendant main menu select {SYSTEM} - {SETUP}.  

Then select {IO Module} from the setup list.
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5. The list of “I/O MODULE” will display.  Confirm that the board that were added in the 
“HwEmu.ini” file are present.  .

Press [ENTER] twice.  A confirmation message will appear, select “Yes”

6. In the MotoSim-EG-VRC “Maintenance Mode” dialog, select the [End] button to exit the 
controller maintenance mode.

7. Open the cell containing the modified controller.  Display the Virtual I/O monitor and confirm that 

the added I/O boards are present.

If the added I/O module doesn’t display. 
Make sure that the “HwEmu.ini” file was properly modified and that there are no typo in the 
board name.
Make sure that the modified “HwEmu.ini” file and the selected “VRC.BIN”  are both located 
in the same controller folder of the same cell.

NOTE
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13.4.2 Adding I/O Board Module (FS100).

Procedure

1. When the cell is opened, save the cell and close it, and exit MotoSim EG-VRC.
2. With a text editor software (ex. Notepad) open the "HwEmu.ini" file located in the controller 

folder of the cell (the same folder that contains the VRC.BIN file).
3. Write the board name (ex. "LIO-08R") in the [BOARD] section, and save the file.

[HwEmu.ini]

4. Start MotoSim EG-VRC but do not open any cell.
On the [Controller] tab, in the [Boot] group, click the [Maintenance mode] button, the 
[Maintenance mode] dialog appears. Then, to launch the controller in Maintenance mode, 
operate in the "VRC Maintenance Mode" dialog. (For more detail about the controller 
maintenance mode, refer to section 7.10 "VRC Maintenance Mode".)

• The following I/O expansion boards are supported:
• LIO-08R (I/O expansion board)
• LIO-09R (I/O expansion board)
• CNTR01 (Counter board)

I/O expansion boards other than listed above and welding boards are not supported.
• When the new controller is created, this procedure can not be used. Prepare the cell 

registered the controller beforehand, and use the procedure of this section.

When this procedure is used, "SYPICK" instruction and "SYPLACE" instruction (used by high-speed 
picking) disappear from the command list. Then, use the following procedure with the virtual 
pendant.

1. Change the security mode to "MANAGEMENT MODE".
2. Select {SETUP} - {TEACHING COND.}.
3. Select {DATA} - {RESET INSTRUCTION}, and a confirmation dialog box will 

appear, select [YES] to reset instructions.

[BOARD]
SLOT# 1=LIO-08R
SLOT# 2=LIO-08R
SLOT# 3=
SLOT# 4=CNTR01
SLOT# 5=
SLOT# 6=
SLOT# 7=
SLOT# 8=

←Set this by default

←Set this by default

NOTE

NOTE
13-40

HW0485348
502 of 671



13  Applied Operation
13.4  Adding I/O Board Module

156225-1CD
5. Select {SYSTEM} - {SETUP} in the virtual pendant.

6. Select {IO Module} from the list in the {SETUP} display.

7. The list of [IO MODULE] is displayed. Confirm that the boards added in the "HwEmu.ini" file are 
present. After Confirming, click the [ENTER] button.
13-41

HW0485348
503 of 671



13  Applied Operation
13.4  Adding I/O Board Module

156225-1CD
8. The "SENSOR FUNCTION ALLOCATION" screen doesn't need any change. Press [ENTER] to 
go to the next screen.

9. The "EXTERNAL IO ALLOCATION(INPUT)" screen doesn't need any change. Press [ENTER] 
to go to the next screen.

10. The "EXTERNAL IO ALLOCATION(OUTPUT)" screen doesn't need any change. Press 
[ENTER] to go to the next screen.

11. A confirmation dialog box will appear, select the [YES] button.

12. In the MotoSim EG-VRC "VRC Maintenance Mode" dialog, select the [End] button to exit the 
controller maintenance mode.
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13. Open the cell containing the modified controller. Display the [Virtual I/O monitor] dialog and 

confirm that added I/O boards are present.

If the added I/O module doesn’t display. 
Make sure that the “HwEmu.ini” file was properly modified and that there are no typo in the 
board name.
Make sure that the modified “HwEmu.ini” file and the selected “VRC.BIN”  are both located 
in the same controller folder of the same cell.

NOTE
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13.5 Option Function Setting

The particular operation is available by setting option function.

Procedure

1. Start the controller in maintenance mode. On the [Controller] tab, in the [Boot] group, click the 
[Maintenance mode] button, the [Maintenance mode] dialog appears. For details refer to 
section 7.10 "VRC Maintenance Mode".

2. Select {SYSTEM} - {SETUP} in the virtual pendant.

3. Select [OPTION FUNCTION] in the {SETUP} display.

MotoSim EG-VRC supports the function in the section 1.2.1 "Optional Function of 
Controller" only.

NOTE
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4. Set the function used to "USED".
For detail of each function, please refer to the controller "Operator's Manual".
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13.6 Dual-Arm robot Setting

When the Dual-Arm robot (ex. SDA10-A00) is used, the job used "Coordinated Instruction" and 
"Parallel Start Instruction" can be created in MotoSim EG-VRC. This section describes how to setup 
Dual-Arm robots and how to activate optional functions such as "Coordinated Instruction" or "Parallel 
Start Instruction" of each controller.

Follow the flowchart below to setup Dual-Arm robots.

Creating Controller with a New VRC 

Controller (no file) 

Controller Initialization 

Setting “Coordinated Instruction” and 

“Parallel Start Instruction” 

Setting the calibration 

Registration the group combination 

Setting the robot model 

START 

END 

Operation in the 

“Maintenance Mode” 

Operation in the 

“Normal Mode” 

After setting, start the controller in the maintenance mode. 

After setting, start the controller in the normal mode. 

 

Exiting the maintenance mode 
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13.6.1 Dual-Arm robot Setting (DX100)

Dual-Arms are composed of right arm, left arm and one torso. When defining the control group of the 
controller during the initialization, three control groups need to be set. There are two robot groups (R1 
and R2) for the arms and one station group (S1) for the rotation of the torso.

To determine the robot model to select from the robot list, remove the "A00" part of the robot type and 
replace it by:

• X0* for the left arm robot (R1)
• Y0* for the right arm robot (R2)
• W0* for the torso rotation (S1)

For example for a SDA010D-A00 robot, the control groups should be set to SDA010D-X00, SDA010D-
Y00 and SDA010D-W00.

Procedure

1. Proceed the step 1 and 2 of section 7.1.1 "Create a New VRC Controller (no file)". Select some 
system version of the "DX100". When the operation is finished, the controller starts in the 
maintenance mode.

2. Proceed all steps of section 7.1.3 "Initializing the Controller (DX200, DX100, NX100)". At the 
Step 3, set the control group to the following settings.
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The "MECHANICAL SPEC" screen and "MOTOR SPEC" don't need any change. Press 
[ENTER] to go to the next screen.

3. From the main menu, select {SYSTEM} - {SETUP}.
4. From the setup list, select {OPTION FUNCTION}.

5. Select the "Parallel Start Instruction" and set its value to "4 Tasks". When the confirmation 
message displays, select "Yes" to make the change.
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6. Select the "Coordinated Instruction" and set its value to "Used". When the confirmation 
message displays, select "Yes" to make the change.

7. Close the controller "Maintenance Mode" by clicking the [Finish] button of the MotoSim EG-
VRC "Instruction Guide" dialog.

8. To set the robot models , proceed the step 4 of section 7.1.1 "Create a New VRC Controller (no 
file)".

9. To set the calibration data of the controller, proceed "Set calibration data base on robot model 
layout" of section 7.6.3 "Robot Calibration Setting".

10. Change the security mode to "MANAGEMENT MODE" in the virtual pendant.
11. Select {SETUP} - {GRP COMBINATION}, add the group combination (ex. "R1+R2", 

"R1+R2",…)
For detail of group combination, please refer to the "Controller Options: Instructions for 
Independent/Coordinated control function" manual. 
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13.6.2 Dual-Arm robot Setting (FS100)

Dual-Arms are composed of right arm, base axis of right arm, left arm and base axis of left arm. When 
defining the control group of the controller during the initialization, four control groups need to be set. 
There are two robot groups (R1 and R2) for the arms and two base axis group (B1, B2).

To determine the robot model to select from the robot list, remove the "A00" part of the robot type and 
replace it by:

• X0* for the left arm robot (R1)
• S0* for the base axis of the left arm robot (B1)
• Y0* for the right arm robot (R2)
• S0* for the base axis of the right arm robot (B2)

For example for a SDA010F-A00 robot, the control groups should be set to SDA010F-X00, SDA010F-
S00, SDA010F-Y00 and SDA010F-S00.

Procedure

1. Proceed the step 1 and 2 of section 7.1.1 "Create a New VRC Controller (no file)". Select some 
system version of the "FS100". When the operation is finished, the controller starts in the 
maintenance mode.

2. Proceed all steps of section 7.1.4 "Initializing the Controller (FS100)". At the Step 3, set the 
control group to the following settings.
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Then at the Step 4, set the connection to the following settings.

The "MECHANICAL SPEC" screen and "MOTOR SPEC" don't need any change. Press 
[ENTER] to go to the next screen.

3. From the main menu, select {SYSTEM} - {SETUP}.

 

13-50

HW0485348
513 of 671



  
13.6  Dual-Arm robot Setting

156225-1CD
4. From the setup list, select {OPTION FUNCTION}.

5. Select the "DUAL ARM FUNCTION" and set its value to "Used". When the confirmation 
message displays, select "Yes" to make the change.

6. Close the controller "Maintenance Mode" by clicking the [Finish] button of the MotoSim EG-
VRC "Instruction Guide" dialog.

7. To set the robot models , proceed the step 4 of section 7.1.1 "Create a New VRC Controller (no 
file)".

8. To set the calibration data of the controller, proceed "Set calibration data base on robot model 
layout" of section 7.6.3 "Robot Calibration Setting".

9. Change the security mode to "MANAGEMENT MODE" in the virtual pendant.
10. Select the {SETUP} - {GRP COMBINATION} menu in the virtual pendant.
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11. Press [SELECT], and select "ADD GROUP".

12. Set the "NO.1 CONTROL GROUP" to "R1", "NO.2 CONTROL GROUP" to R2 and "MASTER" 
to R1. Then click the [EXECUTE] button.

13. If the "R1+R2:R1" group combination set is created, the setting is finished.
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13.6.3  Dual-Arm robot Setting (NX100)

Dual-Arms are composed of right arm, left arm and one torso. When defining the control group of the 
controller during the initialization, three control groups need to be set. There are two robot groups (R1 
and R2) for the arms and one station group (S1) for the rotation of the torso.

To determine the robot model to select from the robot list, remove the "A00" part of the robot type and 
replace it by:

• X0* for the left arm robot (R1)
• Y0* for the right arm robot (R2)
• W0* for the torso rotation (S1)

For example for a SDA10-A00 robot, the control groups should be set to SDA10-X00, SDA10-Y00 and 
SDA10-W00.

Procedure

1. Proceed the step 1 and 2 of section 7.1.1 "Create a New VRC Controller (no file)". Select some 
system version of the "NX100". When the operation is finished, the controller starts in the 
maintenance mode.

2. Proceed all steps of section 7.1.3 "Initializing the Controller (DX200, DX100, NX100)". At the 
Step 3, set the control group to the following settings.

3. From the main menu, select {SYSTEM} - {SETUP}.
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4. From the setup list, select {OPTION FUNCTION}.

5. Select the "Parallel Start Instruction" and set its value to "4 Tasks". When the confirmation 
message displays, select "Yes" to make the change.

6. Select the "Coordinated Instruction" and set its value to "Used". When the confirmation 
message displays, select "Yes" to make the change.

7. Close the controller "Maintenance Mode" by clicking the [Finish] button of the MotoSim EG-
VRC "Instruction Guide" dialog.

8. To set the robot models , proceed the step 4 of section 7.1.1 "Create a New VRC Controller (no 
file)".

9. To set the calibration data of the controller, proceed "Set calibration data base on robot model 
layout" of section 7.6.3 "Robot Calibration Setting".

10. Change the security mode to "MANAGEMENT MODE" in the virtual pendant.
11. Select {SETUP} - {GRP COMBINATION}, add the group combination (ex. "R1+R2", 

"R1+R2",…)
For detail of group combination, please refer to the "Controller Options: Instructions for 
Independent/Coordinated control function" manual.
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13.7 External Axes Setting (Motor Gun)

The following example shows how to setup an external 
axis as a Motor Gun on a ES165N robot.  By default 
external axis are setup to rotate around the Z-axis.  This 
example explains how to change the default behavior of 
the external axis to make the Motor Gun model move 
linearly along the Z-axis. 

13.7.1 Initialization

Procedure:

Add a new controller with no CMOS.BIN according to the procedure of section 7.1.2 Create Controller 
with no CMOS.

1. When initializing the controller with the procedure of section 7.1.5 Initializing the Controller, at 
the “CONTROL GROUP” screen (step 4), enter the information as follows:

Press [ENTER] to go to the next screen.
2. The “CONNECT” screen doesn’t need any change.  Press [ENTER] to continue to the external 

axis setup screens. 
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3. The “AXIS CONFIG” defines the external axis mechanism type between “BALL-SCREW”, 
“RACK&PINION” or “ROTATION“.  The available types depends on the machine type selected 
in the “CONTROL GROUP” screen.  In the case of “GUN”, the only choice is “BALL-SCREW”.  
Press [ENTER] to go to the next screen.

4. In the “MECHANICAL SPEC” screen, define the “MOTION RANGE” (+ and -) of the axis.  The 
values are the soft limit of the external axis and will prevent the axis from moving outside of this 
range.
The “REDUCTION RATIO” is used to enter the ratio of the speed reducer.  Usually in the case 
of a Motor Gun there are none, so both values are set to 1.
The “BALL-SCREW PITCH” is the linear motion for one full revolution of the screw.  As a 
reference, most motors encoder have a resolution of 4096 pulses per revolution.  So in this 
example, a value of 4.096 mm/r means that the gun shaft will travel 0.001 mm for every pulse. 
Press [ENTER] to go to the next screen.
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5. In the “MOTOR SPEC” screen, if you know which hardware will be used, you may enter it.  
Otherwise, leave the default value.  For the “MOTOR” field, the choice will affect the encoder 
resolution.  The “SGMRS” motor series are fairly standard and have a encoder resolution of 
4096 pulses/revolution.
Press [ENTER] to go to the next screen.

6. In the “APPLICATION” screen, select “MOTOR GUN” as the application.
7. Continue the regular initialization procedure as per section 7.1.5 Initializing the Controller.  

Press the “Finish” button of the “Instruction Guide” window to reboot the controller in normal 
mode. 
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13.7.2 Model setup and motion

By default in MotoSim EG-VRC, the external axis are setup with the “world” model as a parent and the 
axis will rotate around the Z-axis.  In the case of a Motor Gun the external axis need to be moved to the 
end of the robot and the motor motion change to move the model linearly along the Z-axis.

Procedure:

1.  Once the controller has been added to the cell.  The robot model will be displayed in the middle 
of the cell.  The external axis will not have any model attached to it and will only be visible in the 
CADtree dialog. 

2. Display the CADTree dialog, then select the controller station (e.i. NX100-ST1).  Move this 
model to the robot TCP model (e.i. NX100-RB1_tcp) with the “Move Parent” function.

3. With the Virtual Pendant, define the robot TOOL.  This will change the robot TCP model (e.i. 
NX100-RB1_tcp) in MotoSim EG-VRC.

4. Add or create a model for the Motor Gun fixed part with the robot flange (NX100-RB1_flange) 
as the parent.
13-58

HW0485348
521 of 671



  
13.7  External Axes Setting (Motor Gun)

156225-1CD
5. Add or create a model for  the Motor Gun mobile part with the station axis model (NX100-
ST1_ex1) as a parent.

6. At this point, if the station axis is moved, the model will rotate around the Z-axis instead of 
moving along it.  To change this, save and close the cell.

7. With a text editor (such as “Notepad”), open the cell file (*.vcl).
In the controller section, under the station (ST1) section add the following line:

AXIS1=(TYPE=Z);.

Note that the ratio and offset can also be modified in this manner.  This maybe useful if the 
Motor Gun specific hardware is unknown.

AXIS1=(TYPE=Z)(RATIO=1.0)(OFFSET=0.0);
where:

AXIS* : Axis No. of the robot (begins with 1.)
TYPE: Direction to move (X, Y, Z, Rx, Ry or Rz)
RATIO: The distance moved (mm or rad) for each pulse
OFFSET: The initial move amount (mm or rad)

 

Model of the Motor Gun 
fixed parts 

Model of the Motor Gun 
mobile parts 

NOTE

 CELL_INIT 
{ 
VERSION=1, 1, 0, 0 
 
CONTROLLER(0) 
{ 
PATH=%CELPATH%¥NX100; 
NAME=NX100; 
RB1 
 { 
 NAME=NX100-RB1; 
 FILE=%CELPATH%¥NX100¥RB1¥ES165N-A00.mdl; 
 } 
ST1 
 { 
 NAME=NX100-ST1; 
 FILE=dummy; 
 AXIS1=(TYPE=Z); 
 } 
TRACE 
 { 
 ROBOT=NX100-RB1; 
 } 
} 
... 

Add this line 
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8. Save the text file and then reopen the cell file with MotoSim EG-VRC.  Confirm that the Motor 
Gun axis is working properly.

If the model doesn’t move in the proper direction, you may need to adjust the orientation of the 
station axis 1 location frame (e.i. NX100-ST1_EX1-POS) and then readjust the Motor Gun 
mobile part model.
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13.8 Setting of spot welding simulation

Electric gun of an external axis is set to the robot, and it explains the procedure for simulating the spot 

welding.

13.8.1 Initialize

Procedure:

A new controller is registered by the operational procedure of section 7.1.1 "Create a New VRC 
Controller (no file)".

1. When initializing the controller with the procedure of section 7.1.3 Initializing the Controller, at 
the “CONTROL GROUP“ screen (Step3), enter the information as follows:
Please refer to section 7.1.3 "Initializing the Controller (DX200, DX100, NX100)" for details of 

the controller's initialization.

• The simulation of the spot welding is a function that can be used only with DX200/DX100. 
It doesn't deal with other controllers.

• The simulation of spot gun change system is not supported.
• The following function keys for spot welding using motor gun are not supported.

  Manual spot welding ([INTERLOCK] + [./SPOT])
  Manual dry spot welding ([INTERLOCK] + [2/GUN CLOSE])
  Pressurizing ([INTERLOCK] +[8/PRESSURE])
  Releasing ([INTERLOCK] +[9/RELEASE])

When the spot welding simulation is done with two or more robots, it is necessary to set 
gun according to the robot.
Please select "GUN-1" each S1 and S2 when systems are two robots.

NOTE

NOTE
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2. Each item of the connection etc. keeps not changing, either [enter] being pushed, and it 
advancing to the function specification of a set screen of an external axis. Each item of the 
“MECHANICAL SPEC“ and the “MOTOR SPEC“ is set, [enter] is pushed, and it advances to the 
following screen.
Please refer to procedures 4 and 5 of section 13.7.1 "Initialization" for the setting of each item.

3. "MOTOR GUN" is selected by the usage.

4. The initialization setting is done according to procedure of section 7.1.3 "Initializing the 
Controller (DX200, DX100, NX100)".  The completion button of the “Controller Maintenance 
Mode Instructions ” is pushed.  A virtual pendant is restarted in the normal mode.

13.8.2 Setting of welded condition

It is variously set to simulate the spot welding.

Procedure:

1. To change the setting of the spot welding, the security mode is changed to "MANAGEMENT 
MODE". 

2. The main menu {SPOT WELDING} - {GUN PRESSURE} of a virtual pendant is selected.
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3. The setting of the gun pressurizing power is changed.
An appropriate value is input to this “TOUCH PRESS“ and “1ST PRESS“, the cursor is matched 
to the item of the “SETTING”, the [SELECT] or the [Space] key is pushed, and the “SETTING” is 

changed to "DONE".

4. The main menu {SPOT WELDING} - {GUN CONDITION} of a virtual pendant is selected.

This procedure does only necessary minimum setting. 
For detailed setting, please refer to each controller's “OPERATOR’S MANUAL (FOR SPOT 
WELDING USING MOTOR GUN)“.

NOTE
13-63

HW0485348
526 of 671



  
13.8  Setting of spot welding simulation

156225-1CD
5. The setting of the gun characteristic is changed.
An appropriate value is input to this “PULSE“ and “TORQUE“, the cursor is adjusted to the item 
of the “SETTING”, the [SELECT] or the [Space] key is pushed, and the “SETTING” is changed 

to "DONE".

6. To make changed gun pressurizing power and gun characteristic effective, the servo is turned 
off once. After that, it comes to be able to execute the simulation of the spot welding by turning 
on the servo again.

1) The emergency stop button is pushed, it puts into the emergency halt condition, 
and the servo is turned off.

2) The emergency stop button is pushed, and the emergency halt condition is released.

3) The servo is turned on pushing servo ON button.

This procedure does only necessary minimum setting. 
For detailed setting, please refer to each controller's “OPERATOR’S MANUAL (FOR SPOT 
WELDING USING MOTOR GUN)“.

It becomes impossible to do the playback of the welding job normally if the setting is not 
reflected. 
Please execute the procedure of servo OFF and turning on when you change the setting.

NOTE

 

 

  

SERVO ON Button EMERGENCY STOP Button 

NOTE
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13.8.3 Setting of welding machine

The welding machine can be simulated in MotoSim EG-VRC. 
It is necessary to set the communication time and the welding time with the welding machine to 
simulate the welding machine. 
On the [Controller] tab, in the [File Settings] group, click the [Welding Condition] button, the [Welding 

Condition]] dialog appears.

13.8.4 Making and control group setting of job

The control group of the job sets and it is necessary to set the group combination before making the job 
is started. 
Please refer to each controller's "OPERATOR'S MANUAL (FOR SPOT WELDING USING MOTOR 
GUN)" for details.

13.8.5 Setting of simulation of electric gun

Please refer to section 13.7 "External Axes Setting (Motor Gun)" for the setting to simulate electric gun.

“Welding Condition” Dialog Box

Item Description

[Communication Time (msec)] 
edit box

A fixed value of each welding machine is set

[Welding Time (msec)]
edit box

The welding time of each welding condition number specified by the welding 
instruction is set.
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13.9 Setting of Conveyor Synchronization

Set the conveyor synchronization for the robot, and it explains the procedure for the simulation of 

conveyor synchronization.

13.9.1 Overview Flowchart

Follow the flowchart below to create the environment.

• This function can not use depending on the system version of controller. Please refer to 
section section 15.6 "List of Function depending on the system version of controller".

• This function is available for 1 axis conveyor only. (2 axes and 3 axes conveyor can not 
be set conveyor synchronization.)

• This function can not use CMOS.BIN of a real robot.
• This function can not be used with high-speed playback function.Refer to section 7.5.4 

"Refresh Interval" about high-speed playback function.
• To simulate the job with high-speed picking, use the template function.

Refer to section 4.1.1 "Template Function" about template function.

NOTE

System Construction 

Controller Initialization

Setting of the option board (DX200, DX100, NX100) 

Setting of the I/O module (FS100) 

Setting of the file of the conveyor

Conveyor registration

Setting of the conveyor synchronization

Location of the conveyor

Creating and locating the works

Operating the conveyor

Teaching 

Display the move command with conveyor synchronization

Playback of the job with conveyor synchronization

Playback 
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13.9.2 System Construction

It explains the procedure from the new cell creation to creation the environment for creating the job with 
conveyor synchronization.

  Controller Initialization

Follow the procedure of section 7.1.1 "Create a New VRC Controller (no file)" to create a new VRC 
controller. After Creation, the cell is saved and closed.

 Setting of the option board (DX200, DX100, NX100)

Procedure

1. With text editor software (ex. Notepad) open the "OPTION_BOARD.ini" file located in the 
controller folder of the cell.

2. Edit the file as follows 

3. Start MotoSim EG-VRC in Maintenance mode. (For more detail the controller maintenance 
mode, refer to section 7.10 "VRC Maintenance Mode".)

4. From the Virtual Pendant main menu select {SYSTEM} - {SETUP}.
5. Then Select {OPTION BOARD} from the setup list.

 

DX200, DX100 NX100 

[SLOT0] 

NCP02=1 

CONVEYOR.ROM

=1 

[SLOT1] 

NCP02=0 

CONVEYOR.ROM

Set those value 

(Setting of the option board 1 for conveyor synchronization) 

File of conveyor synchronization #1 to #3 are available 

[SLOT0] 

YCP02=1 

CONVEYOR.RO

M=1 

[SLOT1] 

YCP02=0 

CONVEYOR.RO
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6. The option board set to "OPTION_BOARD.ini" file is displayed. Select the option board.

7. Set [YCP02] to [USED]. Push [Enter], and check message appears for three times, so select 
"Yes" all time.

8. To Exit the maintenance mode, click the [End] button on the [VRC Maintenance Mode] of 
MotoSim EG-VRC.

  Setting of the I/O module (FS100)

Procedure

1. Start MotoSim EG-VRC in Maintenance mode. (For more detail the controller maintenance 
mode, refer to section 7.10 "VRC Maintenance Mode".)

2. From the Virtual Pendant main menu select {SYSTEM} - {SETUP}.
3. Then Select {IO MODULE} from 
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4. Select the [DETAIL] of the [CNTR-01] in the [IO MODULE] display.

5. Set [CNTR-01] to [USED] and push [Enter].

6. The "SENSOR FUNCTION ALLOCATION" screen doesn't need any change. Press [ENTER] to 
go to the next screen.

7. The "EXTERNAL IO ALLOCATION (INPUT)" screen doesn't need any change. Press [ENTER] 
to go to the next screen.

 If the "CNTR-01" does not exist in the IO module list, it needs that the counter board is set. 
Then, use the step 1 to 3 in the procedure of section 13.4.2 "Adding I/O Board Module 
(FS100).", and proceed this section from the beginning.

NOTE
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8. The "EXTERNAL IO ALLOCATION (OUTPUT)" screen doesn't need any change. Press 
[ENTER] to go to the next screen.

9. A confirmation dialog box will appear, select the [YES] button.

10. In the MotoSim EG-VRC "VRC Maintenance Mode" dialog, select the [End] button to exit the 
controller maintenance mode.

 Setting of the file of the conveyor

Procedure

1. Open the Cell, and Change the security mode to "MANAGEMENT MODE".
2. From the Virtual Pendant main menu select {ROBOT} - {SETUP}.
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3. The setting of the conveyor condition is changed.
• Set the value depending on the real robot to [POS RESOLUTION] and [AVERAGED 

TRAVEL TIME], and Set [USED STATUS] to [USED].
• If the value of [POS RESOLUTION] is not set, [VERIFY ERROR (SENSOR 

PARAMETER)] alarm is occurred when [USED STATUS] is set to [USED].
• When [SEGMENT OVER] alarm is occurred during playback, change [AVERAGED 

TRAVEL TIME] to the value such as 200 ms.

  Conveyor registration

Refer to section 7.7.1 "Adding a Conveyor" about conveyor registration.
If there is the user coordinates corresponding to the conveyor in the controller, the following dialog box 
appears. Click [Yes] button, the conveyor is located corresponding to the user frame position.

 Setting of the conveyor synchronization

Refer to section 7.7.9 "Conveyor Synchronization" about setting the conveyor synchronization. Then, 
robots with conveyor synchronization function made automatically the user coordinates at the target 
conveyor position with the user coordinates number corresponding to the conveyor number.

This procedure does only necessary minimum setting.
For detailed setting, please refer to each controller's "INSTRUCTIONS FOR CONVEYOR 
SYNCHRONIZED FUNCTION".

NOTE
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  Location of the conveyor

Procedure

1. On the [Home] tab, in the [Model] group, click the [CadTree] button, the [CadTree] dialog 
appears. Select the conveyor model "CONVEYOR-NO [Conveyor Number] (ex. CONVEYOR-
NO1) ".

2. Click the [Pos] button. Set the location of the conveyor, and click the [OK] button. Then, robots 
with conveyor synchronization function made automatically the user coordinates location 
corresponding to the conveyor location.

 Creating and locating the works

Works are set on the conveyor.

Procedure

1. Set "[Conveyor Name]_TCP" as the parent model by pointing the cursor to "[Conveyor 
Name]_TCP" in the Cad Tree, and the work models are created.
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2. Works are set opposite the mark of the conveyor traveling direction (the triangle on the 
conveyor). When the line passes through the conveyor origin position (If STP is set other than 
zero by SYSTART command, when the line passes through the position set by STP), conveyor 
synchronization gets start running.

13.9.3 Teaching

  Operating the conveyor

The ways of operating the conveyor are Operation by conveyor operation panel or operation by position 
panel.

Refer to section 7.7.8 "Conveyor Operation Panel" and section 7.7.5 "Moving a Device" for detail.

  Teaching the conveyor synchronized move instructions (SYSTART, 
SYEND, SYMOV*)

Teach the conveyor synchronized move instructions by the virtual pendant. Please refer to 
"INSTRUCTIONS FOR CONVEYOR SYNCHRONIZED FUNCTION" of each the controller for details.

• Click the [INFORM LIST] button of the virtual pendant, the command list dialog is 
displayed. Click the [SENSOR] button in the displayed dialog, SYSTART command 
and SYEND command are available.

The position of conveyor in [Position] is reflected LS offset value of the each robot. When 
the other robot is selected, the position of conveyor in [Position] is changed, without the 
displayed conveyor is not operating.

NOTE
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• Click the [SHIFT] button and the [MOTION TYPE] button of the virtual pendant, MOV* 
command is changed to SYMOV* command. Then, click the [MOTION TYPE] button, 
the motion type is changed (SYMOVJ-> SYMOVL->SYMOVC). And, set the details.

13.9.4 Playback

  Playback of the job with conveyor synchronization

Procedure

1. On the virtual pendant, move the cursor in the job to the first step. Set the robot position to the 
position of starting the job.

2. On the job panel of the conveyor, move the cursor in the job to the first step. Set the conveyor 
position to the position of starting the job.

3. On the [Simulation] tab, in the [Playback] group, click the [Start] button

The [START] button of the virtual pendant can not use the conveyor synchronization. 
Please execute the job with the above procedure.
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13.10High-Speed Picking Simulation Function

This function is able to easily simulate "Conveyor Synchronized Function", "Conveyor Synchronized 

Function with Shift Functions" and "Continuous Operation Conveyor Synchronized Function".

13.10.1 Overview Flowchart

Follow the flowchart below to create the environment.The procedure is explained with the template cell 
"MPP3 S_PICKING".

 Creating a new cell from the template

Follow the procedure of section 4.1.1 "Template Function" to create a new VRC controller. Select the 
"MPP3S_PICKING" in the template list, and create a new cell.
A cell available to the high-speed picking simulation is created automatically.

 Location of the conveyors

If needed, the location of the conveyors is changed.
In the high-speed picking simulation function, the MPP3 robot picks the works from CONVEYOR-NO1, 
and places the works on the CONVEYOR-NO2.

• This function can be only used with the cells created from the template cell 
"MPP3_PICKING", "MPP3H_PICKING" and "MPK2_PICKING". This function can not be 
used with the other cells.

• This function can not be used with high-speed playback function.
Refer to section 7.5.4 "Refresh Interval" about high-speed playback function.

• Please do not modify the master job of a template cell.
• High-Speed picking cell before Ver 5.10 can not be used.

NOTE

 Creating a new cell from the template 

Location of the conveyors 

Setting the size and speed of the conveyors 

Automatic creation of the works 

Automatic creation of the pallets 

Playback 
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Procedure

1. On the [Home] tab, in the [Model] group, click the [CadTree] button, the [CadTree] dialog 
appears. 
Select the conveyor model "CONVEYOR-NO [Conveyor Number] (ex. CONVEYOR-NO1) ".

2. Click the [Pos] button. Set the location of the conveyor, and click the [OK] button.
Then, the user coordinates location of MPP3 robot (a light blue FRAME) is changed 
automatically corresponding to the conveyor location.

3. When the location about X direction of the conveyors is changed, the following setting is 
needed.
The synchronous starting position and the teaching position of a SYPICK/SYPLACE command 
are changed to suit a conveyor position. The synchronous starting position and the teaching 
position are specified with the following user variables.
    D000 : The synchronous starting position of SYPICK (STP)
    D001 : The teaching position of SYPICK (CTP)
    D002 : The synchronous starting position of SYPLACE (STP)
    D003 : The teaching position of SYPLACE (CTP)

For example, when the conveyor for pick is moved -1000 mm in the X direction, the 
synchronous starting position and the teaching position of SYPICK are added 1000 mm.

1) Select the {VARIABLE} - {DOUBLE} menu on the virtual pendant.
2) Add 1000000 to the value of D000 and D001.

   

D000, D001, D002 and D003 are set by the micrometer.NOTE
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1350mm 

1000mm 

When the work gets to the teaching position specified by 
SYPICK (1000 mm), the MPP3S robot starts picking the 
work. When the conveyor is moved -1000 mm in the 
traveling direction, the teaching position is needed to 
add 1000 mm. 

The user coordinates is set 
on the conveyor origin 
position. The difference 
from the origin position to 
the robot is 1000 mm. 

The robot positions on picking at above 
teaching position (in the user coordinates) 
are set to from P001 to P300. 
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 Setting the size and speed of the conveyors

If needed, the location of the conveyors is changed.
For details of the Conveyor Setting dialog, refer to section 7.7.1 "Adding a Conveyor" about conveyor 
registration.

Procedure

1. On the [Controller] tab, in the [External Device] group, click the [Conveyor Settings] button, the 
[Conveyor Setting] dialog appears.

2. Select the conveyor number to change.
3. Set the [L(mm)], [D(mm)], [H(mm)] of Model info.
4. Set the [Speed (mm/s)] of Motion info, and click the [OK] button.

 Location of the works

Set the information (ex. size of work, work interval on the conveyor, ...) , and models are created 
automatically.

Procedure

1. On the [Controller] tab, in the [External Device] group, click the [Conveyor Settings] button, the 
[Conveyor Setting] dialog appears.

2. Select the conveyor No.1, and click the [More] button to display [Model Creation for High-Speed 
Picking] section.

3. Set the work size to the [Width(mm)] and [Height(mm)].
4. Set the works position on the conveyor in the [Pick Position] list.
5. Click the [Make] button, the work models are added on the CONVEYOR-NO1.

For example, to set the works on the conveyor as below, the following procedure is operated.
• Works size : Width 100mm × Height 100mm
• The number of works : 5
• Work interval : 200mm

   

200mm 

100mm 

200mm 200mm 200mm 
100mm 

Travel Direction 
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(1) Set the [Work] as below,
[Width(mm)]     100.000
[Height(mm)]    100.000

(2) Set the [Work Position Batch Input] as below,
[X(mm)]    200.000
[Y(mm)]        0.000
[R(deg)]        0.000
[Number]      5

Uncheck the [Alternation Y] checkbox and the [Alternation R] checkbox.
(3) Click the [Input Work Position] button, and click the [OK] button in the displayed 

confirmation dialog box. The work locations are set in the [Pick Position] list.
(4) Click the [Make] button.

For detail of the dialog, refer to section "Location of the works" in the section "11.9.2 Advanced 
Setting".

 Location of the pallets

Set the information (ex. size of pallet, work interval on the pallet, ...) , and models are created 
automatically.

Procedure

1. On the [Controller] tab, in the [External Device] group, click the [Conveyor Settings] button, the 
[Conveyor Setting] dialog appears.

2. Select the conveyor No.2, and click the [More] button to display [Model Creation for High-Speed 
Picking] section.

3. Set the pallet size to the [W(mm)] and [L(mm)].
4. Set the works position on the conveyor in the [Pick Position] list.
5. Set the pallet interval on the conveyor and the number of interval to the [X(mm)] and [Number].
6. Click the [Make] button, the pallet models are added on the CONVEYOR-NO2.
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For example, to set the pallets on the conveyor as below, the following procedure is operated.
• Pallet size : Width 110mm × Length 130mm
• The number of pallets : 5
• Pallet interval : 200mm
• 1 work per pallet

(1) Set the [Pallet] as below,
[W(mm)]    110.000
[L(mm)]      130.000

(2) Set the first line of [Place Position] list as below,
[X(mm)]    -50.000
[Y(mm)]       0.000
[Z(mm)]       0.000
[R(deg)]       0.00

(3) Set the [Interval] in the [Pallet Position] section as below,
[X(mm)]    200.000
[Number]      5

(4) Click the [Make] button.

For detail of the dialog, refer to section "Location of the pallets" in the section Advanced Setting".

 
200mm 

130mm 

110mm 

Travel Direction 
X 

Y 
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 Playback

1. On the [Simulation] tab, in the [Playback] group, click the [Reset] button.

2. On the [Simulation] tab, in the [Playback] group, click the [Start] button.

The [START] button of the virtual pendant can not use high-speed picking simulation 
function. Please execute the job with the above procedure.

NOTE
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13.10.2 Advanced Setting

This section describes other settings used by high-speed picking simulation function.

 Location of the works

1.  In the [Conveyor setting] dialog, the width and height is set to [Work].

2. In the [Conveyor setting] dialog, to edit the [Pick Position] list, various work locations are 
enabled. The works are located on the conveyor, as many as of the number of lines in the [Pick 
Position] list.

• When the value is set to the [Y(mm)] in the [Pick Position] list as below, the works are 
located from side to side.

 

Heght Width 

Width 

            

50mm 

-50mm 

Travel Direction 
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• When the value is set to the [R(deg)] in the [Pick Position] list as below, the rotated 
works are located.

3. The [Pick Position] list can be set automatically with [Work Position Batch Input].

• When the values are set to the [Y(mm)] and [R(deg)] of the [Interval] and the [Input 
Work Position] button is clicked, that values are set to the [Y(mm)] and [R(deg)] of all 
lines in the [Pick Position] list.

If the [Input Work Position] button is clicked with the above setting, the works are located as 
below.

• The upper limit of the number of works is 300. 
• Once works increases, the playback might be slower.

             

30° 

-30° 

Travel Direction 

NOTE
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• When the [Alternation Y] checkbox and the [Alternation R] checkbox are checked and 
the [Input Work Position] button is clicked, the values are set to the [Y(mm)] and 
[R(deg)] of all lines in the [Pick Position] list with alternating positive and negative 
values.

If the [Input Work Position] button is clicked with the above setting, the works are located as 
below.

 Location of the pallets

1.  In the [Conveyor setting] dialog, the length of W direction and L direction are set to [Pallet].

2. In the [Conveyor setting] dialog, the number of pallets and the intervals are set to [Pallet].

3. In the [Conveyor setting] dialog, the work locations on a pallet are set to the [Place Position] list. 
This setting is applied to the all pallets. Set the locations of the center of works from pallet origin 
position to the [Place Position] list.

      

 

L W  

  
200mm 200mm 200mm 

X 

Y 
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• When one work is placed on the pallet, set the value to the [Place Position] list as 
below.
Set the value "width of work × (-0.5)" to the [X(mm)] of the first line.

• When two works are placed on the pallet back and forth, set the values to the [Place 
Position] list as below.
Set the value "width of work × (-0.5)" to the [X(mm)] of the first line, and  set the value 
"width of work × (-1.5) - the width of clearance" to the [X(mm)] of the second line.  In 
the below setting, the width of clearance is 1mm.

• When two works are placed on the pallet right and left, set the values to the [Place 
Position] list as below.
Set the value "width of work × 0.5 + the width of clearance" to the [Y(mm)] of the first 
line, and  set the value "width of work × (-0.5) - the width of clearance" to the [Y(mm)] 
of the second line.

• When two works are placed on the pallet one above the other, set the values to the 
[Place Position] list as below.
Set 0 to the [Z(mm)] of the first line, and set "height of work" to the [Z(mm)] of the sec-
ond line.

   

-50mm X 

Y 

   

-152mm -50mm X 

Y 

   

52mm 

-52mm 

X 

Y 

   

 

0mm 

100mm 

X 

Z 
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• When one work are rotated and placed on the pallet, set the values to the [R(deg)] in 
the [Place Position] list as below.

 Changing the timing of stream

If the [Start(mm)] in the [Conveyor Setting] dialog is changed, the timing of stream of works 
(CONVEYOR-NO1) or pallets (CONVEYOR-NO2) can be changed.
To set the timing of pallets slower than that of works, shift the [Start(mm)] of the CONVEYOR-NO2 to 
the minus direction. To set the timing of pallets faster than that of works, shift the [Start(mm)] of the 
CONVEYOR-NO2 to the plus direction. Note that the [Start(mm)] of the conveyors is set the negative 
value certainly. And, the same setting is enabled in setting the [Start(mm)] of the CONVEYOR-NO1.

• When the [Start(mm)] of the CONVEYOR-NO2 is shifted to the minus direction, the timing 
is as below.

• When the [Start(mm)] of the CONVEYOR-NO2 is shifted to the plus direction, the timing is 
as below.

Procedure

1. On the [Controller] tab, in the [External Device] group, click the [Conveyor Settings] button, the 
[Conveyor Setting] dialog appears.

2. Set the [Start(mm)] of the [Motion info], and click the [OK] button.

 

45° 

X 

Y 
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 Hand control signal setting

When the SYPICK/SYPLACE instructions are used, it needs that the general output signals are 
allocated for hand #1 to #4, to turn the hand (ex. vacuum pads) ON/OFF. That allocation is set in the 
[HAND CONTROL SIGNAL] display of the virtual pendant.

In the template "MPP3S_PICKING", OT OUTPUT 1 is allocated for Hand #1.
If needed, set the values to the [ON TIME] and the [OFF TIME].
For details, please refer to "FS100 OPTIONS INSTRUCTIONS SUPPLEMENTARY FOR CONVEYOR 
SYNCHRONIZED FUNCTION CONTINUOUS OPERATION CONVEYOR SYNCHRONIZED 
FUNCTION".
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13.10.3 High-Speed Picking Simulation for Multiple Controllers

High-Speed Picking Simulation for Multiple Controllers
This section explains to add the controller to the high-speed picking simulation cell.
This section uses the following cell to explain the environment setting.

 Sample

• Two MPP3S and two conveyors
• Ten works
• Five pallets (Two works per one pallet)

1000 ㎜ behind 

1000mm 1000mm 

800mm 800mm 

The synchronous starting position and 
the teaching position of Robot2 are 
same as Robot1. 

 
Creating a new cell from the template 

Adding the robot 

Setting the conveyor synchronization 

Distributing the work 

Setting the I/O Event 

Playback 
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 Creating a new cell from the template

Follow the procedure of section 13.10.1 "Overview Flowchart" to create a new cell from the template 
"MPP3S_PICKING". In this case, the position, size and speed of the conveyor are default.

 Adding the robot

Copy the controller and change the location of robot.

Procedure

1. Follow the procedure of section 7.2 "Copying a Controller from another Cell" to copy the 
"FS100-1" controller.

2.  On the [Home] tab, in the [Model] group, click the [CadTree] button, the [CadTree] dialog 
appears.
Select the added robot (ex. FS100-2-R01).
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3. Click the [Pos] button. Set the location of the robot, and click the [OK] button.

 Setting the conveyor synchronization

Set the conveyor synchronization of the added robot for CONVEYOR-NO1 and CONVEYOR-NO2.

Procedure

1. On the [Controller] tab, in the [External Device] group, click the [Conveyor Condition File] 
button, the [Conveyor Synchronization] dialog appears. 

2. Select the added controller name.

Be sure to locate the added robot to become the downstream side to the flow 
direction of a conveyor.
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3. Set the Condition File No.1 to the CONVEYOR-NO1 and the Condition File No.2 to the 
CONVEYOR-NO2, and click the [OK] button.

 Distributing the work

Set the distributing sequence of works for the added controller.
Distributing sequence is finished by re-executing the auto-creation the works and pallets.

Procedure

1. On the [Controller] tab, in the [External Device] group, click the [Conveyor Setting] button, the 
[Conveyor Setting] dialog appears.

2. Click the [More] button, to display [Model Creation for High-Speed Picking] section.
3. Select the conveyor No.1, and click the [Make] button.
4. Select the conveyor No.2, and click the [Make] button.

 Setting the I/O Event

To change the parent of work model with the action of picking, the I/O event is registered to the added 
controller. For details of the I/O event, refer to section section 8.3 "I/O Events".
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Procedure

1. On the [Simulation] tab, in the [I/O Settings] group, click the [I/O Event Manager] button, the [I/O 
Events] dialog appears. 

2. The following I/O events are registered to the added controller.

 Playback

1. On the [Simulation] tab, in the [Playback] group, click the [Reset] button.

2. On the [Simulation] tab, in the [Playback] group, click the [Start] button.

Controller I/O Signal Condition Event

FS100-2 OUT#0001 (#30030) ON SCRIPT : SYPICK

FS100-2 OUT#0001 (#30030) OFF SCRIPT : SYPLACE

FS100-2 OUT#0005 (#30034) ON SCRIPT : SYINIT

The [START] button of the virtual pendant can not use high-speed picking simulation 
function. Please execute the job with the above procedure.

NOTE
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13.10.4 Advanced Setting for Multiple Controllers

 Distributing the work

For multiple controllers, distributing sequence is finished by re-executing the auto-creation the works 
and pallets. Then, the number of picked works becomes equal by each robot.
For example, when two controllers exist, robot1 and robot2 pick by turns.

Ex.) One work is picked per one pallet by two controllers.(1 and 2 mean robot number)

Ex.) Two works are picked per one pallet by two controllers.(1 and 2 mean robot number) 

Ex.) Three works are picked per one pallet by two controllers.(1 and 2 mean robot number) 

 

1 2 1 2 

 
1 2 1 2 

 1 

2 
2 

2 
1 

1 
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 Changing the position of the limit switch

The synchronous starting position and the teaching position of a SYPICK/SYPLACE command are 
based on the limit switch of the conveyor.
In the high-speed picking simulation, the user coordinates of the controller are treated as a limit switch. 
UF#1 is for the conveyor 1 and UF#2 is for the conveyor 2. So, the position of the limit switch is 
changed by editing the user coordinates.
This section explains the procedure of changing the limit switch of robots2 into the conveyor starting 
point position with the cell created in the section 13.10.3 "High-Speed Picking Simulation for Multiple 
Controllers".

 Procedure

1. Seletct "FS100-2" with the ribbon  .
2. On the [Controller] tab, in the [File Settings] group, click the [User Frame] button, the [Set User 

Frame] dialog appear.
3. Change the X value of UF#1 and UF#2 into -2000mm.
4. Adjust the synchronous starting position and the teaching position of a SYPICK/SYPLACE 

command. Then, user coordinates were changed into -2000 mm, so the synchronous starting 
position and the teaching position of a SYPICK/SYPLACE command are added 1000 mm.

(1) Select the {VARIABLE} - {DOUBLE} menu on the virtual pendant.
(2) Change the value of D000, D001, D002 and D003 into 1800000.

5. Execute the distributing works.
(1) On the [Controller] tab, in the [External Device] group, click the [Conveyor Setting] button, 

the [Conveyor Setting] dialog appears.
(2) Click the [More] button, to display [Model Creation for High-Speed Picking] section.
(3) Select the conveyor No.1, and click the [Make] button.
(4) Select the conveyor No.2, and click the [Make] button.

6. Execute the playback.

2000mm 

1800mm 

User coordinates (the position of limit switch) 
is changed from -1000 ㎜ to -2000 ㎜. 

The synchronous starting position and 
the teaching position are added 1000 ㎜.
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13.10.5 Specifications of template cell "MPP3S_PICKING"

 Job for high-speed picking simulation

To simulate high-speed picking, the "SYPICK-SYPLACE" job is used.

0000 NOP
0001 DOUT OT#(1) OFF
0002 DOUT OT#(5) OFF
0003 TIMER T=0.010
0004 DOUT OT#(5) ON                         //initialize of work model location
0005 SET I000 1                                    //initialize of work counter
0006 SET I001 301                                //initialize of pallet counter
0007 SET I003 1                                    //initialize of counter for B variable
0008 CVQUE CV#(1)                             //clear conveyor queue (pick)
0009 CVQUE CV#(2)                             //clear conveyor queue (place)
0010 SYEND CV#(1)
0011 SYEND CV#(2)
0012 MOVL C00000 V=1000.0              //move to the standby position
0013 *LOOP
0014 SYPICK P[I000] V=4000.0 CV#(1) SFTA:P000 STP=800.000 OL=0.0
 CTP=D000 HAND#1 T=0.100 FLAG:B000
0015 CVQUE CV#(1)                             //clear the queue per picking
0016 SYPLACE P[I001] V=4000.0 CV#(2) SFTA:P000 STP=800.000 OL=0.0
 CTP=D001 HAND#1 T=0.100 FLAG:B000
0017 JUMP *CONTINUE IF B[I003]=0   //clear the queue per pallets
0018 CVQUE CV#(2)
0019 *CONTINUE
0020 INC I000                                        //add 1 to work counter
0021 INC I001                                        //add 1 to pallet counter
0022 INC I003                                        //add 1 to B variable counter
0023 JUMP *LOOP IF I000<=I002        //determine if SYPICK continues
0024 MOVL C00001 V=1000.0             //move to the standby position
0025 END
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 Variable allocation list

In this template cell, the below variables are used.

 IO allocation list

In this template cell, the below IO signals are used.

Variable Default Description

I000 1
I000 is used to the counter to access P001 to P300. It is initialized 
to 1 at the beginning of job, and be added 1 with each execution of 
SYPICK.

I001 301
I001 is used to the counter to access P301 to P600. It is initialized 
to 301 at the beginning of job, and be added 1 with each execution 
of SYPLACE.

I002 10
I002 is compared with I000 for loop condition for the job.
In creating the work models, it is set the number of works.

I003 1
I003 is used to the counter to access B001 to B300. It is initialized 
to 1 at the beginning of job, and be added 1 with each execution of 
SYPLACE.

D000 800000
D000 is set the teaching position of SYPICK instruction (unit: 
micrometer). Edit it if needed.

D001 800000
D001 is set the teaching position of SYPLACE instruction (unit: 
micrometer). Edit it if needed.

P000
X0, Y0, Z-150
Rx0, Ry0, Rz0

P000 is set the value of [SHIFT(A)] of SYPICK/SYPLACE 
instruction. Edit it if needed.

P001 - P300 ―

From P001 to P300 are used for [P-VAR ROBOT] of SYPICK 
instruction. 
In creating the work models, it is set the picking position based on 
the user frame #1.

P301 - P600 ―

From P301 to P600 are used for [P-VAR ROBOT] of SYPLACE 
instruction.
In creating the pallet models, it is set the picking position based on 
the user frame #2.

B001 - B300 ―

From B001 to B300 are used for determining if clear the queue of 
conveyor after the SYPLACE instruction.
Conveyor queue is cleared at the timing of changing the place 
position to the next pallet. The timing is calculated by the number of 
robot and the number of works per one pallet. When the pallet 
model is created, the above timing is calculated and stored.

Variable Default Description

OT1 OFF

OT1 is used to turn the hand ON/OFF with SYPICK?SYPLACE 
instruction. It outputs ON with SYPICK instruction, and outputs OFF 
with SYPLACE instruction. Then the model script [SYPICK] or 
[SYPLACE] is called by IO event, the work model is replaced.

OT5 OFF
OT5 outputs ON at the beginning of the job. Then the model script 
[SYINIT] is called by IO event, the work models locations are 
initialized.
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13.11Converting a MotoSim EG cell to MotoSim EG-VRC

MotoSim EG-VRC can convert and load files created by MotoSim EG but cannot playback the job and 
the robot operations are limited.  The MotoSim EG robot should be replace by the VRC corresponding 
robot type.  You can transfer the robot tooling and jobs to the new controller.

Procedure

1. Click the MotoSim EG-VRC button (  ), and select the [Open] - [Open] menu.

2. In the “File Type” field select “MotoSim EG cell (*.cel)”.  And then select the MotoSim EG cell to 
be converted.  Press [Open].

3. When the convertion confirmation message below appears, select “Yes” to convert the file to a 
“MotoSim EG-VRC (*.vcl)” file.  The cell will display normally but the robot is still a “MotoSim 
EG” robot and will have limited operation.
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4. On the [Controller] tab, in the [Setup] group, click the [New] button, the new controller can be 
created.  

In the “Create Controller with...” dialog select “No CMOS.BIN file”.  Proceed to add  the 
controller as per the procedure of section 7.1.2 “Create Controller without CMOS.BIN file”.
In the initialization step at the “CONTROL GROUP” screen, select the robot type that matches 
the “MotoSim EG” robot of the cell.
Complete the procedure.

5. Once the VRC controller and robot has been added, transfer all robot tooling model from the 
MotoSim EG robot to the VRC robot using the models “Set Parent” function from the CAD tree.  
(For details, refer to section 11.9.2 "Moving the Parent Model".)

New VRC robot Old MotoSimEG robot 
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6. You can set the location of the VRC robot to overlap the MotoSim EG robot. (For details, refer to 
section 11.5 "Positioning a Model".)

7. Delete the “MotoSim EG” robot from the cell.  (For details, refer to section 7.3 "Deleting a 
Controller".)  Save the cell. 

8. Using “Windows Explorer”, copy the job files (.JBI) and condition files (TOOL.CND, 
UFRAME.CND...) from the MotoSim EG robot folder to the VRC controller “Storage Card” 
folder.

9. Load the transfered files into the VRC controller.  (For details, refer to section 15.3.3 "Load 

controller data to MotoSim EG-VRC")

Unlike Windows, the VRC controller is case sensitive for the file names.  Condition file 
names need to be entered with all capital letters or they will not be detected in the “Storage 
Card” folder.  If this is not the case, rename the file name with Windows Explorer so that 
the names are written in capital letters.

Overlapping 
robot 

NOTE
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13.12Spot High Speed Spec Function

Set the spot high speed spec function for the robot, and it explains the procedure for the simulation of 

spot high speed spec function

• This simulation of the spot high speed spec function is a function that can be used only 
with the following controller.

Controller Types : DX200/DX100
System Version  : DX200 : Since DN1.40-00

DX100 : Since DS3.93-00
• This simulation of the spot high speed spec function is a function that can be used only 

with the following robots
DX200  Only spot welding model. 
DX100.

• The simulation of spot gun change system is not supported.
When the CMOS.BIN of the real controller is used to create the environment, delete the 
guns other than S1 by the Maintenance Mode of the virtual pendant.

Ex.) When the gun change system has S1, S2, S3, and S4, S2, S3, and S4 have to be 
deleted. To delete the guns other than S1, select the {SYSTEM} - {SETTING} - 
{CONTROL GROUP} with the Maintenance Mode of the virtual pendant.

NOTE

 

 

 

 

About S2, S3, and S4, Select  

{DETAIL} – {SELECT} – {NONE} to  

delete the gun. 
13-100

HW0485348
563 of 671



  
13.12  Spot High Speed Spec Function

156225-1CD
Procedure

1. A new controller for the simulation of the spot welding is registered by the operational 
procedure of section 13.8 "Setting of spot welding simulation". In this case, select the controller 
and robot as the above NOTE.

2. On the [Controller] tab, in the [Boot] group, click the [Maintenance mode] button, the 
[Maintenance mode] dialog appears. 

3. From the Virtual Pendant main menu select {SYSTEM} - {SETUP} - {OPTION FUNCTION}.
4. Select the "Spot High Speed Spec" and set its value to "Used". When the confirmation message 

displays, select "Yes" to make the change

5. In the case of DX200, proceed the step 7 next.
In the case of DX100, Select the "Detail" of "Gun Arm Control".
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6. Select the "Func." and set its value to "Enable". When the confirmation message displays, 
select "Yes" to make the change.

7. Click the "End" button of the "VRC Maintenance Mode" dialog.
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13.13Setting of Paint workpiece supplying system 
"MOTOFEEDER"

The MOTOFEEDER is the turntable-typed workpiece supplying equipment with the external 2-axis 
structure.
The operation including the paint operation can be performed by setting the initial settings, and creating 
paint programs.
This section describes the procedure from the initial settings to the playback.

The procedure of MOTOFEEDER registration is as below.

• MOTOFEEDER can be used only with the bellow controller.
Controller :          NX100
System Version : NS5.09-45

• Only one MOTOFEEDER can be registered per controller.

NOTE

 

Controller Initialization 

Relocation of robot and MOTOFEEDER

Master job Registration 

System Construction 

Paint job creating and registering 

Teaching 

Playback

Playback the paint job 

MOTOFEEDER model setting 
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13.13.1 Controller Initialization

The large rotary axis S1 and small rotary axis S2 are set as station axes. 
When the controller is initialized, the control group is set as one robot (R1) and two station axes (S1, 
S2).

 

Procedure

1. Proceed to the step 1and 2 of section 7.1.1 "Create a New VRC Controller (no file)" to create a 
new VRC controller".
Select "NS5.09-45" system version from "NX100". Operation is finished, the VRC Controller 
starts in maintenance mode.

2. Follow the procedure of section section 7.1.3 "Initializing the Controller (DX200, DX100, 
NX100)".
When asked for the "Control Group", select the model to suit the actual robot system as a guide 
for the following table.
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•  Registration of R1
MOTOFEEDER is registered in combination with EPX1250 or EPX2050, so select 
"EPX1250-A00*" or "EPX2050-A3**", "EPX2050-A5**", or "EPX2050-B5**". For With-
Manipulator Specification, EPX1250 is available only.

•  Registration of S1
Select "MF418A-S1".

•  Registration of S2
For High-Speed Rotation Specification, select "MF218A-S2". For Heavy Load 
Specification, select "MF418A-S2".

Actual robot system
Model registration on the VRC controller

R1 S1 S2

Arm Length: 1600mm, With Manipulator, 
High-Speed Rotation Specification

EPX1250

MF418A-S1

MF218A-S2

Arm Length: 1800mm, With Manipulator, 
High-Speed Rotation Specification

EPX1250

Arm Length: 1400mm, Without Manipulator, 
High-Speed Rotation Specification

EPX1250 / EPX2050

Arm Length: 1600mm, Without Manipulator, 
High-Speed Rotation Specification

EPX1250 / EPX2050

Arm Length: 1800mm, Without Manipulator, 
High-Speed Rotation Specification

EPX1250 / EPX2050

Arm Length: 1600mm, With Manipulator, 
Heavy Load Specification

EPX1250

MF418A-S2

Arm Length: 1800mm, With Manipulator, 
Heavy Load Specification

EPX1250

Arm Length: 1400mm, Without Manipulator, 
Heavy Load Specification

EPX1250 / EPX2050

Arm Length: 1600mm, Without Manipulator, 
Heavy Load Specification

EPX1250 /EPX2050

Arm Length: 1800mm, Without Manipulator, 
Heavy Load Specification

EPX1250 / EPX2050
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3. Set the value in the Connect display as a guide for the following table.

• EPX1250

• EPX2050

4. Set "ROTATION DIRECTION" of S1 and S2 to "REVERSE" in the motor spec display.

5. Set "APPLICATION" to "PAINT" in the application display. Then, press the [ENTER] button as 
default setting again, until controller initializing is finished.

 SV CN 1 2 3 4 5 6 7 8 9

R1 #1  - 1 2 3 4 5 6 - -

S1 #1  1 - - - - - - - -

S2 #1  -  - - - - - 1 -

TU BRK 1 2 3 4 5 6 7 8 9 CN 1 2 3 4 5 6 7 8 9 

#1  - 1 2 3 4 5 6 - - CV - 1 1 1 1 1 1 - - 

#1  1 - - - - - - - - CV 1 - - - - - - - - 

#1  1  - - - - - - - CV -  - - - - - 1 - 

 SV CN 1 2 3 4 5 6 7 8 9

R1 #1  1 2 3 4 5 6 - - -

S1 #1  - - - - - - 1 - -

S2 #1  -  - - - - - 1 -

TU BRK 1 2 3 4 5 6 7 8 9 CN 1 2 3 4 5 6 7 8 9 

#1  1 2 3 4 5 6 - - - CV 1 1 1 1 1 1 - - - 

#1  - - - - - - 1 - - CV - - - - - - 2 - - 

#1  -  - - - - - 1 - CV -  - - - - - 3 - 
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13.13.2 MOTOFEEDER model setting

After controller setting is finished, the Robot Settings dialog box is displayed. Set the MOTOFEEDER 
model to "Robot Model File" of ST1.

Procedure

1. Robots\NX100\MF-Family" folder under the MotoSim EG-VRC install folder contains Robot 
models of MOTOFEEDER. Select the model file (robotinf.dat) to "Robot Model File" of ST1 as a 

guide for the following table.

Model registration on the VRC controller Model File Folder

Arm Length: 1600mm, With Manipulator, High-Speed Rotation Specification MF216A

Arm Length: 1600mm, With Manipulator, High-Speed Rotation Specification 
(with spindle unit)

MF216A_SPINDLE

Arm Length: 1800mm, With Manipulator, High-Speed Rotation Specification MF218A

Arm Length: 1800mm, With Manipulator, High-Speed Rotation 
Specification(with Spindle unit)

MF218A_SPINDLE

Arm Length: 1400mm, Without Manipulator, High-Speed Rotation Specification MF214B

Arm Length: 1400mm, Without Manipulator, High-Speed Rotation 
Specification(with spindle unit)

MF214B_SPINDLE

Arm Length: 1600mm, Without Manipulator, High-Speed Rotation Specification MF216B

Arm Length: 1600mm, Without Manipulator, High-Speed Rotation 
Specification(with spindle unit)

MF216B_SPINDLE

Arm Length: 1800mm, Without Manipulator, High-Speed Rotation Specification MF218B

Arm Length: 1800mm, Without Manipulator, High-Speed Rotation 
Specification(with spindle unit)

MF218B_SPINDLE

Arm Length: 1600mm, With Manipulator, Heavy Load Specification MF416A

Arm Length: 1800mm, With Manipulator, Heavy Load Specification MF418A

Arm Length: 1400mm, Without Manipulator, Heavy Load Specification MF414B

Arm Length: 1600mm, Without Manipulator, Heavy Load Specification MF416B

Arm Length: 1800mm, Without Manipulator, Heavy Load Specification MF418B
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2. After set "Robot Model File" of S1, press the [OK] button without setting "Robot Model File" of 
S2.

3. Virtual pendant restarts. Then, the "The initialization file of a controller is loaded" dialog box is 
displayed, press the [OK] button.

13.13.3 Relocation of robot and MOTOFEEDER

When the robot is displayed, relocate the robot model and MOTOFEEDER model in the CADTREE 
dialog box.
The robot model and MOTOFEEDER model are registered as below.
When relocate them, relocate the dummy model of MOTOFEEDER as below.

 With Manipulator Specification

 Without Manipulator Specification

13.13.4 Master job Registration

The paint operation of MOTOFEEDER and robot is performed with the prepared control job and the 
created paint job. The prepared job calls the created paint job. So, the prepared Job needs to be 
registered as Master Job.
The prepared control job has already loaded, register it as below.

Procedure

1. Select {JOB} - {CTRL MASTER} on the virtual pendant.
2. Press the [Space] key at MASTER of MASTER JOB, select "SETTING MASTER JOB" and 

press the [Space] key.

The dummy model "(Controller Name)-MF" is created. 
Robot model and MOTOFEEDER model are registered 
under the dummy model.

The dummy model "(Controller Name)-MF" is created. 
MOTOFEEDER model is registered under the dummy 
model. Robot model is registered under the world 
model.
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3. Select "MASTER.JBI", and press the [Space] key.

13.13.5 Paint job creating and registering

Create the paint job as usage. (Refer to manual "MOTOFEEDER OPERATING INSTRUCTIONS" 
about the procedure of creating the paint job.)
To perform the operation including the MOTOFEEDER motion, register the created paint job in the 
registration table.

Procedure

1. Select {JOB} - {JOB REGISTRATION} on the virtual pendant.
2. Press the [Space] key at "JOB NAME" and select the paint job from job list.

Set the paint job for the small rotary axis A: No. 0001, and set the paint job for the small rotary 
axis B: No. 0002.

 Without Spindle Unit Specification

The job "SAMPLE1" has already loaded. (Control Group: R1 + S2)
Set the "SAMPLE1" to No.001 and No.002, you can see the MOTOFEEDER motion of "SAMPLE1".

 

Select {TABLE NUMBER: 1}

Register the paint job for the 
small rotate axis A 

Register the paint job for the 
small rotate axis B 
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 With Spindle Unit Specification

The job "SAMPLE2" has already loaded. (Control Group: R1)
Set the "SAMPLE2" to No.001 and No.002, you can see the MOTOFEEDER motion of "SAMPLE2".

13.13.6 Playback the paint job

To execute the paint job, use the MOTOFEEDER Operation BOX.
Select {Tool} - {I/O Monitor}, to display the Virtual I/O dialog box, and select the MOTOFEEDER 
Operation BOX.

After starting playback, press the button of Operating BOX, and the paint job is executed.

Item Description

[START] button The large rotary axis rotates, and the paint job is executed.

[COMPLETE] button The large rotary axis rotates. But, the paint job is not executed.

[Close work injection door] 
checkbox

Check this check box, the input of safeguarding is "ON". When execute 
playback, this check box needs to be checked.

[Continuation of a button push] 
button

Check this check box, keep the START button or the COMPLETE button 
pressed.
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13.143DPDF Output Function

This function outputs 3D PDF file containing the animation of a playback. The information on the 

3DPDF (e.g. title, company name, etc.) can be set with an output setting dialog.

*1 Adobe Reader is registered trademarks or trademarks of Adobe Systems Incorporated 
in the United States and/or other countries.

 RESTRICTION

• Only the current job is displayed on the job contents list. As for peripheral equipment 
(conveyor, press and gantry), only animation is played.

• When CALL JOB or PSTART is used, it can not move to the step in the job of called job.
• As for trace line, the trace lines are displayed when finishing the playback. To display the 

trace lines, the kind of line in the trace property needs to be set to "Normal" or "Thick".
• Operation of the ribbon menu under recording is limited as same as the time of a 

playback.
• It does not correspond to changing the color of the pulse limit warning or the interference 

check.
• It does not correspond to a cutting plane, a memo, a dimension line, and a markup, and 

target a point arrow of CAM function.
• The model which exists after the end of a playback is the target of animation. The model 

deleted during a playback (by the model command etc.) is not contained.
• The data of LINE and LINE2 format of MDL form cannot be displayed.
• Template file can use "3DPDF_Template_A4_US.pdf" and 

"3DPDF_Template_A4_no_joblist_US.pdf" only. If editing this file, 3DPDF is not outputted 
correctly.

• Do not delete the "3DPDF_Template_A4_US.pdf" and 
"3DPDF_Template_A4_no_joblist_US.pdf".

• NS4.69-A5 Controller is not supported.
• To use the 3DPDF function, Driver is set to "OpenGL". It is in [Options] dialog - [Graphic] 

tab - [Display].

• To open the outputted 3DPDF file, Adobe Reader is needed. The outputted 3DPDF files 

are not guaranteed to open on any PDF viewers other than Adobe Reader*1.
• Some Adobe Reader version can not open the 3DPDF file. Please use the latest version.
• If the animation is long, it takes a long time to open the 3DPDF files.

Only as a guide, when the animation is about three minute, it takes 30 seconds to open 
the 3DPDF file. This depends on the PC specifications.

NOTE
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13.14.1 Output Setting

On the [Simulation] tab, in the [Output] group, click the [Output Settings] of the [3DPDF]. [Output setting 
of 3DPDF] dialog is displayed.

Set each items on the [Output setting of 3DPDF] dialog.

Output setting of 3DPDF

Item Description

Format

Sets the file name of 3DPDF format. PDF file in the 
\Users\Pubilc\Documents\MOTOMAN\MotoSim EG-
VRC\Template\3DPDF folder is displayed. When installing MotoSim 
EG-VRC, "3DPDF_Template_A4_US.pdf" and 
"3DPDF_Template_A4_no_joblist_US.pdf" are copied to the 3DPDF 
folder. "3DPDF_Template_A4_US.pdf" is set by default.

Image path
Sets the JPG file of the logo image.
When this is not set, the logo of YASKAWA is displayed.

Title1 Sets the contents of title 1.

Title2 Sets the contents of title 2.

Company Sets the company name.

Unit Sets the unit name.
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Additioal Information

Sets the additional information. This is displayed as [Item] : [Data].
  [Item] : Sets the item name.
  [Data] : Sets the data.
[Add] button

  When input the [Item] and [Data] and press the [Add] button, the 
item is added to the list.

[Upd] button
When click the item of the list, the item is reflected to [Item] and 
[Data]. When change the contents of [Item] or [Data] and press the 
[Upd] button, the item of the list is changed.

[Del] button
When click the item of the list and press the [Del] button, the item of 
the list is deleted.

Speed of animation Sets the speed of the animation.

Frame Rate
Sets the number of the frame displayed per 1 second. 10 fps is set by 
default. If the 3DPDF operation is so slow, set this less than 10 fps. In 
this case, the animation is jumpy.

Smoothing
When enabled, The gap of the same model between frames is 
interpolated linearly. This is enabled by default.

Data compressing When enabled, the 3D data is compressed. This is enabled by default.

Save as Default
This setting of the cell is saved as a default setting of MotoSim EG-
VRC.

Restore Default
This setting of the cell is restored by a default setting of MotoSim EG-
VRC.

When the cell is a new created cell or created by MotoSim EG-VRC before Ver2015, a 
default setting of MotoSim EG-VRC is loaded. When this setting dialog is opened or a 
3DPDF file is created, the setting is saved in the cell folder. The setting in the cell folder will 
be loaded after that.

Output setting of 3DPDF

Item Description

NOTE
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The relation of each setup items and the screen of 3DPDF are as follows.

13.14.2 Outputting 3DPDF

Procedure

1. Select the controller and the job to output the job contents list. 
2. On the [Simulation] tab, in the [Output] group, click the [3DPDF] of the [3DPDF]. 

The process of 3DPDF outputting is executed. During the process, the following dialog is 
displayed.

During playback, click the [3DPDF] of the [3DPDF] in the [Output] group on the [Simulation] tab, 
the playback can be stopped. Then, the following dialog is displayed. Press the [Yes] button, the 
animation until stopping the playback is outputted. And Press the [No] button, the process of 
3DPDF outputting is finished.

 

 

Additional 
Informantion Title1 Title2 Image Path 

Company 

Unit 
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3. When finished the recording, the 3DPDF file is created in the cell folder and that file is named 
as "cell name".pdf. If the file already exists, the following dialog is displayed. When overwrite it, 
press the [OK] button. When want not to overwrite it, enter the new file name and press the [OK] 
button.

4. When the 3DPDF file creation is finished successfully, the following dialog is displayed. Press 
the [Yes] button, the cell folder is opened. Press the [No] button, the cell folder is not opened.

13.14.3 Display and Operation of 3DPDF

When open the 3DPDF file which created by 3DPDF_Template_A4_US.pdf as a format, it will be 
displayed as follows.

 

 
Playback time

Job contents list

View control button
(Default, Top, 
Side, Front)

Reset button

Repeat mode

3D view area 

Job and Control group

Instruction view 
area 

Play button 

Controller 
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Press the each button of [View Control] (the [Default] button, the [Top] button, the [Side] button and the 
[Front] button), the viewpoint of 3D view area is changed.
Press the [Play] button, the animation is played. Then, if check the [Repeat], the animation is played 
repeatedly. 
Press the [Reset] button, the robot moves to the start position of the animation.
When the controller is changed by the drop-down list, the contents of job name, control group, job list, 
and playback time are changed.
Click the move instruction in the job contents list, the robot moves to the teaching point. And, the 
information of the clicked line is displayed in the instruction view area.
The playback time of the job displayed in the job contents list is displayed in the lower right-hand corner 
of the page.

And, when open the 3DPDF file which created by 3DPDF_Template_A4_no_joblist_US.pdf as a format, 
it will be displayed as follows.
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In 3D view area, the viewpoint can be changed by mouse operation. The assignment of the viewpoint 
operation mode is as follows.

To display 3D view as full screen, right-click on the 3D view area and display the right-click menu, and 
select the [Full Screen Multimedia].

To end full screen, right-click on the 3D view area and display the right-click menu and select the [End 
Full Screen Multimedia], or press the [Esc] key of the keyboard.

Viewpoint Operation Mode Mouse Operation

Rotate Press-and-hold the left button and drag

Zoom

Rotate the scroll wheel
or
Press-and-hold the right button and drag upward or downward
or
Press the Shift key of the keyboard and press-and-hold the left 
button or the right button and drag upward or downward

Parallel

Press the Ctrl key of the keyboard and press-and-hold the left 
button and drag
or
Press-and-hold the left button and the right button and drag

Zoom in
Press the Ctrl key of the keyboard and press-and-hold the right 
button and drag
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 NOTE

• When left-click on the 3D view area, the model may be selected. By the setting of the 
Adobe Reader, the model will be not selected.

Procedure

1) Select [Edit] - [Prefernces…], and the [Prefernces] dialog is displayed.
2) In the [3D & Multimedia], Uncheck the [Enable selection for the Hand tool] of the [3D Tool 

Options].
• When playing the animation, the robot and the other models in the 3D view area may be 

displayed as bounding box. By the setting of the Adobe Reader, the bounding box will be 
not displayed.

Procedure

1) Select [Edit] - [Prefernces…], and the [Prefernces] dialog is displayed.
2) In the [3D & Multimedia], Set [None] to [Optimization Scheme for Low Framerate] of the 

[Auto-Degrade Options].
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13.15AVI Output Function

This function outputs AVI file containing the animation of a playback. The video resolution can be set 
with an output setting dialog. If operate the viewpoint during playback, the state is also reflected to the 

animation.

RESTRICTION

• The frame rate of AVI file changes by refresh interval of MotoSim EG-VRC. When refresh 
interval becomes small, the frame rate becomes big, so the animation becomes smoothly. 
But, the file size becomes big.

• When changing a viewpoint quickly, a minute movement of viewpoint can't be replicated 
right sometimes.

• Operation of the ribbon menu under recording is limited as same as the time of a 
playback.

• It does not correspond to changing the color of the pulse limit warning or the interference 
check.

• It does not correspond to a trace line, a cutting plane, a memo, a dimension line and a 
markup, and target a point arrow of CAM function.

• The model which exists after the end of a playback is the target of animation. The model 
deleted during a playback (by the model command etc.) is not contained.

• Showing and Hiding the weld spark model can't be replicated.
• There is a possibility that a PC will be heavily by lack of a memory depending on the 

length of the animation.

• To Open the outputted AVI file, the video playback software is needed. And, installation of 
a codec is needed depending on PC.

• A file size becomes big depending on the length of animation.
• Animation is played in time a playback takes actually, not playback time in the virtual 

controller.

NOTE
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13.15.1 Output Setting

On the [Simulation] tab, in the [Output] group, click the [Output settings] of the [AVI].
 [Output setting of AVI] dialog is displayed.

Set each items on the [Output setting of AVI] dialog.

Resolution

Sets the resolution of AVI. Selectable resolution are as follows.
• 1280x720
• 1024x768
• 640x480
• 320x240

Recording area is the specified size rectangle, and which center 
is the center of view area of MotoSim EG-VRC.
When AVI file output is started, the frame of recording area is 
displayed. For details, refer to the section section 13.15.2 
"Outputting AVI".

When the resolution becomes big, the image quality becomes delicately, but the file size 
becomes big.

 

 

Recording area

NOTE
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13.15.2 Outputting AVI

Procedure

1. Select the controller and the job to output the job.
2. On the [Simulation] tab, in the [Output] group, click the [AVI] of the [AVI]. The process of AVI 

outputting is executed. During the process, the following dialog is displayed.

When AVI file output is started, the frame of recording area is displayed on the MotoSim EG-
VRC window. The animation in this frame is saved to a AVI file.

Depending in the aspect ratio of MotoSim EG-VRC window, vertical lines or horizontal lines are 
not displayed in the window sometimes as below. In this case, the area outside the window is 
saved to the AVI file.

                        

During playback, click the [AVI] of the [AVI] in the [Output] group pm the [Simulation] tab, the 
playback can be stopped. Then, the following dialog is displayed. Press the [Yes] button, the 
animation until stopping the playback is outputted. And press the [No] button, the process of 

• The frame of output area cannot be changed. (e.g. mouse drag operation, etc.)
• When the window size is changed, the frame of output area is changed.
• The frame of output area is not saved to the AVI file.

NOTE
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AVI outputting is finished.

3. When finished the recording, the AVI file is created in the cell folder and that file is named as 
"cel name".pdf. If the file already exists, the following dialog is displayed. When overwrite it, 
press the [OK] button. When want not to overwrite it, enter the new file name and press the [OK] 
button.

4. AVI file creation is started, and the following dialog is displayed. During AVI file creation, the 
recorded contents is played back. And, MotoSimEG -VRC can't be operated any more entirely 
until output processing is completed.

5. When the AVI file creation is finished successfully, the following dialog is displayed. Press the 
[Yes] button, the cell folder is opened. Press the [No] button, the cell folder is not opened.

6. Outputted file can be played back by the video playback software.
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13.16Working Trace Function

13.16.1 Changing Trace Object

The tracking drawn by the working trace function is normally created and drawn as a model having 
"world" as the parent. Therefore, changing the name of the "Parent" in the Working Trace Configuration 
dialog box will change the parent of the tracking. For example, work is on the station and turns and the 
robot welds this work, if the parent is set to work, the working trace is drawn on the work.

Procedure

The procedure is explained with the "1con4robot.vcl" example.

1. On the [Simulation] tab, in the [Monitor] group, click the [Working Trace] button, the [Work-
ing Trace Manager] dialog appears.

2. Edit the setting of "WT3".
Select "WT3" on the list and click the [Edit] button.

3. Click the [...] button beside the "Parent" field to display the "Select Object" dialog box. 

Select "work" and click the [OK] button.

When the playback is canceled, the "work" model parent might be "DX100-R01".

NOTE
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4. Check the [Enable] check box, and click the [OK] button.

5. Edit the setting of "WT4".
For "WT4", execute same procedure from Step.2 to Step.4.
When the setting is completed, click the [Close] button of the [Working Trace Manager] 
dialog.
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6. Insert the comments to start drawing the working trace.
On the virtual pendant, show the "MASTER" job, and move the cursor to the step where 
R3 and R4 starts welding. "POS LEVEL" of that step is changed "PL=0". And, the following 
comments is inserted to the next of that step.
'DRW:WT3=ON
'DRW:WT4=ON

7. Insert the comments to start drawing the working trace.
Move the cursor to the step where R3 and R4 finishes welding. And, the following 
comments is inserted to the next of that step.
'DRW:WT3=OFF
'DRW:WT4=OFF

8. Start playback.
When start playback, the working trace is move according to the movement of "work".
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14 Options

14.1  Motor Load Estimate

The estimate torque (the unit: The rated torque is displayed as 100%) and speed (the unit: rpm) of each 
axis are displayed after the playback of the robot in a wavy graph.
And, an arbitrary DUTY calculation in the section and the step of the job can be retrieved from the wavy 
graph.

On the [Option Function] tab, in the [Estimate] group, click the [Motor Load Estimate] button, the [Motor 
Load Estimate] dialog appears.

The additional options sold separately are needed in order to use the following option 
functions of MotoSim EG-VRC or MotoSim EG-VRC-CadPack.

• YASKAWA does not warrant the result of this function. It should be used only as a guide. 
Because it is affected by Tool settings, Load condition of real robot, Lubricated condition 
of grease, and Temperature. 
Configure the following items of Tool setting collectively, Weight, Position of the center 
of gravity, and Inertia moment. Especially, when Weight item of Tool setting is set lower 
than real tool weight, this function makes wrong results.

• A wavy graph is an estimated torque when the job is executed. Therefore, the torque in 
the interruption (ex. the emergency stop) is not included.

• This function can be used only with the robot axes (external axes are not included).
• This function cannot be used with two or more robot system other than a dual-arm robot.
• This function can be used only with the specified system version of controllers, and this 

function can be used only with target robots of Motor Load Estimate with that system 
version. Please refer to section 13.5 “List of Function depending on the system version 
of controller".

NOTE

NOTE
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The vertical scale of left-side is torque, and right-side is speed.

Motor Load Estimate

Item Description

[SpeedGraph] check box The speeds of each axis are displayed.

[GraphSetting] button
The display range (horizontal axis and spindle) in a wavy graph and the re-
drawing intervals and the torque threshold are set.

[Save] button
The torque data every drawing time set with HartBeat is saved in text file 
(.TXT). Please refer to section 7.5.4 "Refresh Interval".

[Close] button The Torque Estimate display is closed.

 

 

 

 

Select the robot that displays 

the torque estimate.

Torque estimate 

display area. 

Search the step 

of the job. 

Select the axis that displays the 

torque estimate.
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Procedure

1. On the [Option Function] tab, in the [Estimate] group, click the [Motor Load Estimate] button, the 
[Motor Load Estimate] dialog appears.

2. Select the robot that displays the torque estimate.
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3. The job is executed, and the torque estimate of the selected robot is displayed.

4. Select the axis that displays the torque estimate in the check box of the axis. (The axis can be 
selected even before the job is executed.)
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5. Check the [SpeedGraph] box, the graphs of each axis speed are displayed with a dotted line.

 Duty calculation

1. Check the [DUTY Calc] check box.
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2. Pick the measurement beginning point.

3. Pick the measurement end point.

 

Pick the measurement 

beginning point. 

 

Pick the measurement 

end point. 
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4. The measurement result is displayed.

 Step Search

1. Check the [STEP Search] box.

2. Pick the point where it wants to search the step.

 

 

Pick the point where it 

wants to search the step. 
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3. The step number is displayed, and robot moves to the searched position.
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 Torque Threshold Setting

To set the torque threshold, the threshold is displayed on the graph. It can be checked whether the 
presumed torque of each axis is over the threshold value during the playback has been exceeded.

1. Click the [GraphSetting] button, and enter the value of [Torque Threshold] in the dialog.

2. The Threshold value is displayed in the graph area with a dotted red line.

3. After the playback of a job, if the presumed torque exceeded the threshold value, the dialog will 
be displayed as follows.

 

 

Torque Threshold
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 Graph Setting

The display range (horizontal axis and spindle) in the torque estimate display area (wavy graph) and 

the re-drawing intervals are set.

  Target robots for Moter Load Estimate

DX200

Graph Setting

Item Description

Side
Maximum value (ms) of a horizontal axis in a wavy graph and the number of 
scales are set.

Length(Torque)
Maximum value (%) of the spindle in a torque wavy graph and the number of 
scales are set. The number of scale is as common as Length(Speed).

Length(Speed)
Maximum value (rpm) of the spindle in a speed wavy graph and the number 
of scales are set. As for the number of scales, a setup of Length(Torque) is 
reflected.

Refresh interval (1-20) The interval of the re-drawing time of a wavy graph is set.

Torque Threshold(%) The threshold of torque is set.

[OK] button A set value of each item is reflected. (The Graph Setting doesn't close. )

[Close] button The Graph Setting is close.

Model Name
Robot Type

(Model File Name)
Remarks

MH180 MH180-A00 Added at Ver2015

MH225 MH225-A00 Added at Ver5.10

MS165 MS165-A00 Added at Ver2015

MS210 MS210-A00 Added at Ver5.10
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DX100

Model Name
Robot Type

(Model File Name)
Remarks

EP4000D EP4000D-J72 Added at Ver2.80

EP4000D EP4000D-K72 Added at Ver2.80

EP4000D EP4000D-L72 Added at Ver2.80

EPH130D EPH130D-A00 Added at Ver2.80

EPH130RLD PH13RLD-A00 Added at Ver2.80

EPH4000D EPH400D-JA0 Added at Ver2.80

EPH4000D EPH400D-KA0 Added at Ver2.80

EPH4000D EPH400D-LA0 Added at Ver2.80

ES165D ES0165D-A00 Added at Ver2.60

ES200D ES0200D-A00 Added at Ver2.72

HP20D HP0020D-A00 Added at Ver2.81

MH5LS MH005LS-A00 Added at Ver2.80

MH5S MH0005S-A00 Added at Ver5.00

MH50 MH00050-A00 Added at Ver5.00

MH165 MH00165-A00 Added at Ver2.72

MH200 MH00200-A00 Added at Ver2.80

MH215 MH00215-A00 Added at Ver2.80

MH250 MH00250-A00 Added at Ver2.80

MH250 MH00250-B00 Added at Ver2.80

MPK2 MPK0002-B01 Added at Ver2.60

SDA5D SDA005D-A00 Added at Ver4.00

SDA10D SDA010D-A00 Added at Ver2.80

SDA10D SDA010D-B00 Added at Ver2.80

SDA20D SDA020D-A00 Added at Ver2.81

SIA5D SIA005D-A00 Added at Ver4.00

SIA10D SIA010D-A00 Added at Ver2.81

SIA20D SIA020D-A00 Added at Ver2.60

SIA20D SIA020D-Y00 Added at Ver2.81
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FS100

Model Name
Robot Type

(Model File Name)
Remarks

MHJ MH0000J-A00 Added at Ver2.80

MH3F MH0003F-A00 Added at Ver2.72

MH5F MH0005F-A00 Added at Ver2.60

MH5LF MH005LF-A00 Added at Ver2.80

MPK2F MPK002F-A00 Added at Ver2.60

MPP3 MPP0003-A00 Added at Ver2.60

SDA5F SDA005F-A00 Added at Ver4.00

SDA10F SDA010F-A00 Added at Ver2.80

SIA5F SIA005F-A00 Added at Ver4.00

SIA10F SIA010F-A00 Added at Ver2.81

SIA20F SIA020F-A00 Added at Ver2.60
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14.2 Life Estimate

Life estimate value of each reducer (Unit: Hour) is displayed when playback is executed.

• YASKAWA does not warrant the result of this function. It should be used only as a guide. 
Because it is affected by Tool settings, Load condition of real robot, Lubricated condition 
of grease, and Temperature. 
Configure the following items of Tool setting collectively, Weight, Position of the center 
of gravity, and Inertia moment. Especially, when Weight item of Tool setting is set lower 
than real tool weight, this function makes wrong results.

• This function estimates the life of reducers from the normal result of playback. 
Therefore, the result of playback with interruption (ex. the emergency stop) is not 
included.

• This function can be used only with the robot axes. (external axes are not included.)
• This function cannot be used with two or more robot system other than a dual-arm robot.
• This function can be used only with the specified system version of controllers, and this 

function can be used only with target robots of Life Estimate with that system version. 
Please refer to section 13.5 “List of Function depending on the system version of 
controller".

Life Estimate

Item Description

[Save CSV] button
The result of Life Estimate, the used torque data, the used gravity moment, 
and the used speed data are saved in text file (.csv).

[Clipboard] button
The result of Life Estimate, the used torque data, the used gravity moment, 
and the used speed data are copied to the clipboard.

NOTE

 

 

 

Select the robot that displays the 

life estimate.
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Procedure

1. On the [Option Function] tab, in the [Estimate] group, click the [Life Estimate] button, the [Life 
Estimate] dialog appears.

2. Select the robot estimated the reducer life.

3. The job is executed, and Average speed[rpm], Maximum speed[rpm], Average torque[Nm], 

Maximum torque[Nm], and Speed Reducer Life[Hr] are displayed.

[Close] button The Life Estimate display is closed.

Reducer life time calculated by this function is that when the robot repeats this movement 
with this cycletime. The displaying areas exist for 7 axes, but the displaying areas of the 
Speed Reducer Life are displayed "0", when the axes are not working, the axes do not 
exist, or the axes are not included in Life Estimate.
If the robot has overhaul time, the value of Speed Reducer Life is displayed as [xxx  over] 
(xxx is overhaul time), when it exceed overhaul time.

Life Estimate

Item Description

NOTE
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  Target robots of Life Estimate

DX200

DX100

Model Name
Robot Type

(Model File Name)
Remarks

MH180 MH180-A00 Added at Ver2015

MH225 MH225-A00 Added at Ver5.10

MS165 MS165-A00 Added at Ver2015

MS210 MS210-A00 Added at Ver5.10

Model Name
Robot Type

(Model File Name)
Remarks

EP4000D EP4000D-J72 Added at Ver2.80

EP4000D EP4000D-K72 Added at Ver2.80

EP4000D EP4000D-L72 Added at Ver2.80

EPH130D EPH130D-A00 Added at Ver2.80

EPH130RLD PH13RLD-A00 Added at Ver2.80

EPH4000D EPH400D-JA0 Added at Ver2.80

EPH4000D EPH400D-KA0 Added at Ver2.80

EPH4000D EPH400D-LA0 Added at Ver2.80

ES165D ES0165D-A00 Added at Ver2.60

ES200D ES0200D-A00 Added at Ver2.72

 
 

 

 Axis is not working. Axes do not exist. Axes are not included 

in Life Estimate.
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FS100

Model Name
Robot Type

(Model File Name)
Remarks

HP20D HP0020D-A00 Added at Ver2.81

MH5LS MH005LS-A00 Added at Ver2.80

MH5S MH0005S-A00 Added at Ver5.00

MH50 MH00050-A00 Added at Ver5.00

MH165 MH00165-A00 Added at Ver2.72

MH200 MH00200-A00 Added at Ver2.80

MH215 MH00215-A00 Added at Ver2.80

MH250 MH00250-A00 Added at Ver2.80

MH250 MH00250-B00 Added at Ver2.80

SDA5D SDA005D-A00 Added at Ver4.00

SDA10D SDA010D-A00 Added at Ver2.80

SDA10D SDA010D-B00 Added at Ver2.80

SDA20D SDA020D-A00 Added at Ver2.81

SIA5D SIA005D-A00 Added at Ver4.00

SIA10D SIA010D-A00 Added at Ver2.81

SIA20D SIA020D-A00 Added at Ver2.60

SIA20D SIA020D-Y00 Added at Ver2.81

Model Name
Robot Type

(Model File Name)
Remarks

MHJ MH0000J-A00 Added at Ver2.80

MH3F MH0003F-A00 Added at Ver2.72

MH5F MH0005F-A00 Added at Ver2.60

MH5LF MH005LF-A00 Added at Ver2.80

MPK2F MPK002F-A00 Added at Ver2.60

MPP3 MPP0003-A00 Added at Ver2.60

MPP3S MPP003S-A00 Added at Ver4.10

SDA5F SDA005F-A00 Added at Ver4.00

SDA10F SDA010F-A00 Added at Ver2.80

SIA5F SIA005F-A00 Added at Ver4.00

SIA10F SIA010F-A00 Added at Ver2.81

SIA20F SIA020F-A00 Added at Ver2.60
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15 Appendix

15.1  Data Format

This section describes the formats of model data files and cell data files.

 Model File (*.mdl)

There are eight parts available for MotoSim EG as described later in " Each Part Format " of this 
section.
Data unit system is in millimeters (mm) and real numbers are available.  Use decimal point as required.

Model Color Settings

The color of each model can be set by using the basic color code function or using RGB.
The following describe each setting.

• RGB
RGB is created with the format RGB (0, 0, 0).
Each color proportion can be set by a number from 0 to 255.

Basic Color Code (QB Color) Function
Setting a number from 0 to 15 displays its corresponding color.
For example, setting BOX (4, 2) creates a red BOX model.

Number Color Number Color

0 Black 8 Gray

1 Blue 9 Light blue

2 Green 10 Light green

3 Cyan 11 Light cyan

4 Red 12 Light red

5 Magenta 13 Light magenta

6 Yellow 14 Light yellow

7 White 15 Light white

RGB (0, 0, 0)
Sets the proportion of blue.
Sets the proportion of green.
Sets the proportion of red.

<E.g.> RGB(255,255,255)
RGB(255,0,0)
RGB(0,255,0)
RGB(0,0,255)
RGB(0,0,0)

Color: White
Color: Red
Color: Green
Color: Blue
Color: Black
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Each Part Format

• BOX (color, num): Box form model
Described with data of width, length, height, X, Y, Z, Rx, Ry and Rz.
<Sample>

• BOX2 (color, num): Box form model
Described with data of width, length, height, X, Y, Z, Rx, Ry and Rz.
<Sample>

• CYLINDER (color, num): Cylinder form model
Described with data of lower face diameter, upper face diameter, height, number of divided faces, 
X, Y, Z, Rx, Ry and Rz.
<Sample>

BLOCK

{

BOX(RGB(255,0,0),2) Description

{

100.000,100.000,100.000,0.000,0.000,0.000 Width, length, height, 0, 0, 0

0.000,0.000,0.000,0.000,0.000,0.000 X, Y, Z, Rx, Ry, Rz

}

}

BLOCK

{

BOX2(RGB(255,0,0),2) Description

{

100.000,100.000,100.000,0.000,0.000,0.000 Width, length, height, 0, 0, 0

0.000,0.000,0.000,0.000,0.000,0.000 X, Y, Z, Rx, Ry, Rz

}

}

BLOCK

{

CYLINDER(RGB(255,0,0),2) Description

{

200.000,100.000,16.000,100.000,0.000,0.000
Lower face dia. height, No. of divided faces, 
upper face dia., 0, 0

0.000,0.000,0.000,0.000,0.000,0.000 X, Y, Z, Rx, Ry, Rz

}

}
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• CONE2 (color, num): Cone form model
Described with data of bottom diameter, height, number of divided faces, X, Y, Z, Rx, Ry and Rz.
<Sample>

• SPHERE(color,num): Spherical model
Described with data of diameter, number of divided faces, X, Y and Z.
<Sample>

• PIPE2 (color, num): Pipe form model
Described with data of lower face diameter, bottom plate thickness, upper face diameter, upper 
plate thickness, height, number of divided faces, X, Y, Z, Rx, Ry and Rz.
<Sample>

BLOCK

{

CONE2(RGB(255,0,0),2) Description

{

200.000,100.000,16.000,0.000,0.000,0.000
Bottom dia., height, No. of divided faces, 0, 
0, 0

0.000,0.000,0.000,0.000,0.000,0.000 X, Y, Z, Rx, Ry, Rz

}

}

BLOCK

{

SPHERE(RGB(255,0,0),2) Description

{

100.000,30.000,0,0,0,0 Diameter, No.of devided face, 0, 0, 0, 0

0.000,0.000,0.000,0,0,0 X, Y, Z, 0, 0, 0

}

}

BLOCK

{

PIPE2(RGB(255,0,0),2) Description

{

100.000,100.000,100.000,10.000,100.000,16.000
Lower face dia., bottom plate thickness, 
upper face dia., upper plate thickness, 
height, No. of divided faces

0.000,0.000,0.000,0.000,0.000,0.000 X, Y, Z, Rx, Ry, Rz

}

}
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• AXIS6 (color, num): Model having information only of position and posture
Described with data of X, Y, Z, Rx, Ry and Rz.
“num” sets the number of target points.
<Sample>

• LINE(color,num): Continuous line model
Described with data of X, Y and Z.
"num" sets the number of points.
<Sample>

• LINE2(color,num): Segmented line model
Described with data of X, Y and Z.
"num" sets the number of points.
<Sample>

BLOCK

{

AXIS6(RGB(255,0,0),3) Description

{

0.000,0.000,0.000,0.000,0.000,0.000 Point1 (X, Y, Z, Rx, Ry, Rz)

100.000,0.000,0.000,0.000,0.000,0.000 Point2 (X, Y, Z, Rx, Ry, Rz)

200.000,0.000,0.000,0.000,0.000,0.000 Point3 (X, Y, Z, Rx, Ry, Rz)

}

}

BLOCK

{

LINE(RGB(255,0,0),3) Description

{

0.000,0.000,0.000 Point1 (X, Y, Z)

100.000,200.000,300.000 Point2 (X, Y, Z)

500.000,235.000,111.000 Point3 (X, Y, Z)

}

}

BLOCK

{

LINE2(RGB(255,0,0),4) Description

{

253.000,353.000,686.000 Segment 1 Start (X, Y, Z)

89.000,254.000,79.000 Segment 1 End (X, Y, Z)

413.000,3.000,99.000 Segment 2 Start (X, Y, Z)

917.000,524.000,-48.000 Segment 2 End (X, Y, Z)

}

}
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• CUBE (color, num): Polygonal cube model
Data of polygonal cube are described with data of bottom and height.
A rectangular parallelepiped is composed of four points and one height, therefore, num is 5 in this 
case.
<Sample>

• FLOOR (color, num): Floor form model
Describes a plane meshed data string.
Described with data of number of divided faces (vertical and horizontal) and frame data of floor end 
point.

<Sample>

• FACE (color, num): Face model
Describes a face with the frame data of X, Y, and Z of each point.
In this case the face model is composed of three points on the face and the data for X, Y, Z, Rx, Ry 
and Rx, num is 4.
<Sample>

BLOCK

{

CUBE(RGB(255,0,0),5) Description

{

0.000,0.000,0.000 Start point1 (X, Y, Z)(= End point 4)

100.000,0.000,0.000 End point1 (X, Y, Z)(= Start point 2)

100.000,100.000,0.000 End point2 (X, Y, Z)(= Start point 3)

0.000,100.000,0.000 End point3 (X, Y, Z)(= Start point 4)

0.000,0.000,100.000 Offset value (X, Y, Z)

}

}

BLOCK

{

FLOOR(RGB(255,0,0),3) Description

{

6.000,6.000,0.000
No. of divided faces (X division No., Y 
division No., 0)

-1500.000,-3000.000,0.000 Floor end point1 (X, Y, Z)

1500.000,3000.000,0.000 Floor end point2 (X, Y, Z)

}

}

BLOCK

{

FACE(RGB(255,128,0),4) Description

{

0.000,0.000,0.000,0.000,0.000,0.000
X, Y, Z, Rx, Ry, Rz
Face is created with the following three 
points.

200.000,300.000,300.000,3,0,0 Point1 (X, Y, Z)

-200.000,300.000,300.000,0,0,0 Point2 (X, Y, Z)

-200.000,300.000,-300.000,0,0,0 Point3 (X, Y, Z)

}

}
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 Cell File

When constructing a cell, a cell file is created.  The following describe an example of a cell file

CELL_INIT
{
VERSION=1, 0, 0, 0

CONTROLLER(0)
{
PATH=%CELPATH%\NX100;
NAME=NX100;
RB1

{
NAME=HP6;
FILE=%CELPATH%\NX100\RB1\robotinf.dat;
}

TRACE
{
ROBOT=HP6;
}

}

MANIPULATOR
{
}

NSIMVIEW
{
CAMERAPOSITION=1.806423,3.445533,2.179023;
CAMERATARGET=0.594751,0.020004,0.705908;
CAMERAUPVECTOR=-0.161379,-0.341156,0.926049;
CAMERAFIELD=2.237789,1.568312;
USERVIEW

{
NO=0
NAME=
CAMERAPOSITION=0.000000,0.000000,0.000000;
CAMERATARGET=0.000000,0.000000,0.000000;
CAMERAUPVECTOR=0.000000,0.000000,0.000000;
CAMERAFIELD=0.000000,0.000000;
}

...
USERVIEW

{
NO=9
NAME=
CAMERAPOSITION=0.000000,0.000000,0.000000;
CAMERATARGET=0.000000,0.000000,0.000000;
CAMERAUPVECTOR=0.000000,0.000000,0.000000;
CAMERAFIELD=0.000000,0.000000;
}

}

NSIMLIGHT
{
LIGHT

{
NO=0
DEFINE=1;
ONOFF=1;
TYPE=0;
COLOR=RGB(255,255,255);
LIGHTPOSITION=0.000000,0.000000,0.000000;
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LIGHTTARGET=0.000000,0.000000,0.000000;
SCALLING=100.000000;
}

...
LIGHT

{
NO=4
DEFINE=0;
ONOFF=0;
TYPE=0;
COLOR=RGB(255,255,255);
LIGHTPOSITION=0.000000,0.000000,0.000000;
LIGHTTARGET=0.000000,0.000000,0.000000;
SCALLING=100.000000;
}

}

}
MODEL_INIT
{
MODEL

{
NAME=FLOOR;
PARENT=world;
FILENAME=%CELPATH%\models\floor.mdl;
COLOR=RGB(0,0,255);
HIDESEE=1;
OPACITY=0.50;
SCALE=1.000000;
AXIS6=0,0,0,0,0,0;
}

MODEL
{
NAME=Teacher;
PARENT=world;
FILENAME=dummy;
COLOR=RGB(0,0,255);
HIDESEE=256;
OPACITY=1.00;
SCALE=1.000000;
AXIS6=0,0,0,0,0,0;
}

MODEL
{
NAME=HP6;
PARENT=world;
FILENAME=%CELPATH%\NX100\RB1\robotinf.dat;
COLOR=RGB(0,0,255);
HIDESEE=1;
OPACITY=1.00;
SCALE=1.000000;
AXIS6=0,0,450,0,0,0;
}

MODEL
{
NAME=HP6_LK0;
PARENT=HP6_rm;
FILENAME=%CELPATH%\NX100\RB1\HP6_LK0.hsf;
COLOR=RGB(0,0,255);
HIDESEE=1;
OPACITY=1.00;
SCALE=1.000000;
AXIS6=0,0,-450,90,0,90;
}
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MODEL
{
NAME=HP6_LK1;
PARENT=HP6_link1;
FILENAME=%CELPATH%\NX100\RB1\HP6_LK1.hsf;
COLOR=RGB(0,0,255);
HIDESEE=1;
OPACITY=1.00;
SCALE=1.000000;
AXIS6=0,0,0,90,0,90;
}

...
MODEL

{
NAME=HP6_LK6;
PARENT=HP6_link6;
FILENAME=%CELPATH%\NX100\RB1\HP6_LK6.hsf;
COLOR=RGB(0,0,255);
HIDESEE=1;
OPACITY=1.00;
SCALE=1.000000;
AXIS6=0,0,0,0,0,0;
}

MODEL_RB
{
NAME=HP6_rm;
HIDESEE=1;
OPACITY=1.00;
}

MODEL_RB
{
NAME=HP6_link1;
HIDESEE=1;
OPACITY=1.00;
}

...
MODEL_RB

{
NAME=HP6_link6;
HIDESEE=1;
OPACITY=1.00;
}

MODEL_RB
{
NAME=HP6_flange;
HIDESEE=1;
OPACITY=1.00;
}

MODEL_RB
{
NAME=HP6_tcp;
HIDESEE=257;
OPACITY=1.00;
}

}
PAIR_INIT
{
}
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1) VERSION Command

• VERSION=1, 0, 0, 0
Describes the MotoSim EG version.

2) CONTROLLER Command

The CONTROLLER command describes data concerning controllers.
• CONTROLLER(0)

Describes the Controller No. 0.
When more than one controller is used, the controllers are provided with numbers 

CONTROLLER(0), CONTROLLER(1), CONTROLLER(2) .
• PATH=%CELPATH%\NX100;

Describes the directory path to which the CONTROLLER refers.
This directory needs a “VRC.BIN” file.

• NAME=NX100;
Describes the name of the CONTROLLER.

• Control Group sub-commands (RB1, BS1,ST1)
The control group sub-commands describes data concerning control groups.  There are three type 
of control group RB for robot, BS for base station and ST for station.  The type is followed by an 
index number.

• NAME=HP6;
Describes the name of the control group.

• FILE=%CELPATH%\NX100\RB1\robotinf.dat;
Describes the directory path constraining the robot models and file containing information on 
how the models are assemble together to make the robot.

• TRACE sub-command
Describes that trace points are displayed at playback.  

• ROBOT=HP6;
Name of the robot (control group) being traced.

• MODEL=HP6_tcp;
Name of  the model being traced.  If not specified, the robot TCP model is traced.

• PARENT=world;
Describes the name of the parent model.  If not specified, the parent is the “world” model.

• POINTS=1000;
Description of the maximum number of trace points.  If not specified, the value is  1000.

3) MANIPULATOR Command

The MANIPULATOR command describes functions to move models according to a robot axis value.  
Mainly used to move secondary link model of a robot.

4) NSIMVIEW Command

The NSIMVIEW command describes data related to the camera viewpoint.

5) NSIMLIGHT Command

The NSIMLIGHT command describes data related to the light type and position.
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6) MODEL_INIT Command

The MODEL_INIT command describes data concerning models.
• MODEL

Describes a MODEL.
• NAME=HP6-A00;

Describes the name of the MODEL.
• PARENT=world;

Describes the PARENT model of the MODEL.
• FILENAME=%CELPATH%\HP6-A00\HP6-A00-MDL.mdl;

Describes the directory path and MODEL file name to which the MODEL refers.
If no MODEL file exists, "dummy" is described.

• COLOR=RGB(0,0,255);
Describes the color of the MODEL.

• HIDESEE=1;
Describes the display bit of the MODEL.

• OPACITY=1.00;
Describes the opacity of the MODEL.

• SCALE=1.000000;
Describes the scale factor of the MODEL.

• AXIS6=0,0,450,0,0,0;
Describes the relative coordinates to the MODEL PARENT.

• MODEL_RB
Describes a robot joint model.  Robot joints model define the frame of a robot joint.  Only the 
NAME, HIDESEE and OPACITY values are defined (see above for description).

Default Models are:
• world

Starting point for all models.  It does not appear.
• worldframe

Displays the world position with a frame.
• Teacher

Displays a frame to create a target coordinate on any point.
• FLOOR

Displays world XY plane.

7) PAIR_INIT Command

The PAIR_INIT command describes pairs of models that are checked for collision when the collision 
detection function is active.
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15.2 Reading the CAD Data with MotoSim EG-VRC

The CAD data must be converted into a form readable for MotoSim EG-VRC before starting the reading 
operation.  The following flowchart shows the data conversion operations required for MotoSim EG-
VRC.

The CAD converters "PolyTrans" and "Inovate" are not included with MotoSim EG-VRC.  
Prepare such application software before the operation.  
        PolyTrans: Okino Computer Graphics (http://www.okino.com)
        Inovate: IRONCAD (http://www.ironcad.com)

User system Intermediate
CAD file

Intermediate
CAD file

Commercial
CAD converter MotoSim EG

CATIA V5,
SolidWorks,
and other 
output-enabled
CAD data  

HSF
format

HSF
format

Commercial
CAD converter

Other 
CAD data

Data formats
IGES, VRML,
DXF, etc.
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15.3 Storage Card

The FD/CF function of the Virtual Pendant is used to save or load MotoSim EG-VRC data such as 
edited jobs, condition files, etc. 

15.3.1 Folder Structure

The folder used to save or load data files is the “Storage Card” folder located under the controller folder 
of the cell (for example in the figure below: \Cells\Test\NX100).  Data saved or loaded are put in this 
folder.  Like with the real controller, it is possible to create sub-folder under the “Storage Card” folder, 
and also load/save data from those folders.

When the button in the virtual pendant is clicked, the target folder can be opened.

 
MotoSimEG－VRC 

CELLS 

TEST 

MODELS 

RB1 

TEST.VCL 

NX100 

RB2 

Storage Card 

Storage folder of file 
saved/loaded with the 
FC/CF Storage function 

system 
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15.3.2 Save controller data created with MotoSim EG-VRC 

Procedure

1. Select {FD/CF} - {SAVE} from the Virtual Pendant main menu.

2. Select the type of data to be saved.  For the figure below, {JOB} was selected.  The list of 
files (in this case, the list of jobs) will display.

3. Select the files to be saved by moving the cursor on the file name and, press the [Space-
bar] on the keyboard or click [Select] in the Virtual Pendant keypad.  The selected files will 

be marked by a star ★ mark on there left.
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4. Press [Enter].  Select [Yes] in the confirmation dialog box that will display.  The selected 
files will be saved in the “Storage Card”.

15.3.3 Load controller data to MotoSim EG-VRC

Procedure

1. Select {FD/CF} - {LOAD} from the Virtual Pendant main menu.

2. Select the type of data to be saved.  For the figure below, {JOB} was selected.  The list of 
files in the “Storage Card” folder (in this case, the list of jobs) will display.

Files cannot be overwritten.  If the files already exist, an error message will display. 
First delete the existing file or select a different folder, then proceed with the save 
operation.

Unlike Windows, the VRC controller is case sensitive for the file names.  File names need 
to be entered with all capital letters or they will not be detected in the “Storage Card” folder.  
If this is not the case, rename the file name with Windows Explorer so that the names are 
written in capital letters.

NOTE

NOTE
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3. Select the files to be loaded by moving the cursor on the file name and, press the [Space-
bar] on the keyboard or click [Select] on the Virtual Pendant keypad.  The selected files will 

be marked by a star ★ mark.

4. Press [Enter].  Select [Yes] in the confirmation dialog box that will display.  The selected 
files will be loaded to the MotoSim EG-VRC controller.

Job files cannot be loaded, if they already exist in the controller.
In such case, first rename or delete the existing job, then proceed with the load operation.

NOTE
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15.4 Standard function about DX200

:Enable, :Display only, :Disable 

Main Menu Main Menu Item Menu Menu Item
Corresp
ondence

JOB JOB JOB 

EDIT 

DISPLAY
ARC INFORMATION
(ARC) 

UTILITY SETUP SPECIAL RUN 

PARALLEL SHIFT JOB 

MIRROR SHIFT 

PAM 

ARC SHIFT CANCEL
(ARC)



SELECT JOB JOB 

EDIT 

DISPLAY FOLDER 

CREATE NEW JOB 

MASTER JOB 

JOB CAPACITY 

CYCLE 

JOB EDIT(PLAY) JOB WRITING 

EDIT 

DISPLAY FOLDER 

PLAY EDIT JOB LIST JOB WRITING 

EDIT 

DISPLAY FOLDER 

VARIABLE 

IN/OUT EXTERNAL INPUT 

EXTERNAL OUTPUT 

UNIVERSAL INPUT 

UNIVERSAL OUTPUT 

SPECIFIC INPUT 

SPECIFIC OUTPUT 

RIN 

CPRIN 

REGISTER 
15-16

HW0485348
620 of 671



15  Appendix
15.4  Standard function about DX200

156225-1CD
AUXILIARY RELAY 

CONTROL INPUT 

PSEUDO INPUT SIG 

NETWORK INPUT 

NETWORK OUTPUT 

ANALOG OUTPUT 

SV POWER STATUS 

LADDER PROGRAM 

I/O ALARM 

I/O MESSAGE 

REMOTE 

ANT. OUTPUT 

TERMINAL 

IO SIMULATION LIST 

SERVO ON FACTOR 

RB STOP FACTOR 
MONITOR 

ROBOT CURRENT POSITION 

COMMAND POSITION 

SERVO MONITOR 

WORK HOME POS 

SECOND HOME POS 

DROP AMOUNT 

POWER ON/OFF POS 

TOOL 

INTERFERENCE 

SHOCK SENS LEVEL 

USER COORDINATE 

HOME POSITION 

MANIPULATOR TYPE 

ANALOG MONITOR 

OVERRUN&S-SENSOR 

LIMIT RELEASE 

ARM CONTROL 

SHIFT VALUE 

SOFTLIMIT SETTING 
SHOCK SENS LV. 
(CURRENT)
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SYSTEM INFO VERSION 

MONITORING TIME 

CONTROLLER 
INFORMATION 

ALARM HISTORY 

I/O MSG HISTORY 

LOGDATA 

USER DEFINITION MENU 

SECURITY 

EX. MEMORY LOAD 

SAVE 

VERIFY 

DELETE 

FOLDER 

PARAMETER 

SETUP TEACHING COND. LANGUAGE LEVEL 
INSTRUCTION INPUT 
LEARNING



MOVE INSTRUCTION SET 
POSITION 

BUZZER WHEN POSITION 
TEACHING 

STEP ONLY CHANGING 

RECT/CYLINDRICAL 

TOOL NO. SWITCH 
TOOL NO. INTERLOCK 
FOR STEP ENTRY



CHECK AT P-VAR TOOL 
NO. CHANGE 

POS. TEACH ONLY JOG 
CONTROL GROUP 

JOB UNDELETE 
FUNCTION



DATA RESET INSTRUCTION 

OPERATE COND. SPEED DATA INPUT FORM 
CYCLE SWITCH IN TEACH 
MODE 

CYCLE SWITCH IN PLAY 
MODE 

CYCLE SWITCH IN LOCAL 
MODE



CYCLE SWITCH IN 
REMOTE MODE 

Main Menu Main Menu Item Menu Menu Item
Corresp
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SET CYCLE ON POWER 
ON 

SECURITY MODE WHEN 
POWER ON 

JOB STEP WHEN POWER 
ON



GENERAL OUT KEEP 
WHEN POWER ON 

OPERATE ENABLE EXTERNAL START 

PP START 

EXTERNAL MODE SWITCH 

EXTERNAL CYCLE 
SWITCH 

PP CYCLE SWITCH 

EXTERNAL SERVO ON 

PP SERVO ON 

DSW SERVO ON 

FUNCTION ENABLE MASTER JOB CHANGE 

RESERVED START 

RESERVED START JOB 
CHANGE 

JOB SELECT WHEN  PLAY 
MODE 

JOB SELECT WHEN 
REMOTE OR PLAY



I/O-VARIABLE CUSTOMIZE 
FUNCTION 

GENERAL I/O NAME DISP. 
ON JOB 

ANTICIPATION FUNCTION 

ALL AXES ANGLE DISP 
FUNCTION



CURSOR MOVE BY 
TOUCH(JOB) 

JOG COND. 

PLAYBACK COND. CHECK/MACHINE LOCK 

MASTER CALLING UP 
INITIAL MOVE SPEED OF 
ROBOT 

START METHOD AFTER 
ABSO OVER



SIGNAL NO. WHEN DROP 
VALUE OVER 

FUNCTION COND. 

DISPLAY COLOR COND. 

Main Menu Main Menu Item Menu Menu Item
Corresp
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15-19

HW0485348
623 of 671



15  Appendix
15.4  Standard function about DX200

156225-1CD
LOGDATA COND. 

DATE/TIME 

RESERVE JOB NAME 

USER ID 

SET SPEED 

KEY ALLOCATION 

JOG KEY ALLOC. 

WRONG DATA LOG 
ENERGY SAVING 
FUNCTION 

ENCODER MAINTENANCE 

SAFETY FUNC. M-SAFETY SIGNAL ALLOC 

TIMER DELAY SET 

SAFETY LOGIC CIRCUIT 

DISPLAY SETUP 
ARC WELDING
(ARC, JIGLESS 
ARC)

ARC START COND.  *1

ARC END COND.  *1

ARC AUX COND. 

POWER SOURCE COND. 

ARC WELD DIAG. 

WEAVING 

ARC MONITOR 

ARC MONITOR (SAMPL) 

APPLI COND.(ARC) 
APPLI COND.(JIGLESS 
ARC) *2

HANDLING HANDLING DIAG. 

SPOT WELDING 
(SPOT)

WELD DIAGNOSIS DATA CLEAR CURRENT POS 

I/O ALLOCATION 

GUN CONDITION 
SPOT POWER SOURCE 
COND.



APPLI COND. 
SPOT WELDING
(MOTOR GUN)

SPOT SUPERVISION 

CLEARANCE SETTING 

PRESSURE 

GUN PRESSURE 

Main Menu Main Menu Item Menu Menu Item
Corresp
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*1 Graphical setting display is not supported.

*2 WELDING SPEED PRIORITY can be used only.

*3 Please refer to section 1.2.1 "Optional Function of Controller" for the list of each 
optional function.

TIP DRESS CONDITION 

GENERAL WEAVING 

GENERAL DIAG. 

Maintenance mode

System INITIALIZE 

SETUP LANGUAGE 

CONTROL GROUP 

APPLICATION 

OPTION BOARD 

IO MODULE 

CMOS MEMORY 

DATE/TIME 

OPTION FUNCTION  *3

VERSION 

SECURITY 

FILE INITIALIZE 
EX. 
MEMORY

LOAD 

TOOL LANGUAGE BUILD 

DISPLAY SETUP 

Main Menu Main Menu Item Menu Menu Item
Corresp
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15.5 Standard function about DX100

:Enable, :Display only, :Disable 

Main Menu Main Menu Item Menu Menu Item
Corresp
ondence

JOB JOB JOB 

EDIT 

DISPLAY 

UTILITY SETUP SPECIAL RUN 

PARALLEL SHIFT JOB 

MIRROR SHIFT 

PAM 
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UNIVERSAL OUTPUT 

SPECIFIC INPUT 

SPECIFIC OUTPUT 

RIN 
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REGISTER 
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CONTROL INPUT 

PSEUDO INPUT SIG 

NETWORK INPUT 

NETWORK OUTPUT 
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I/O ALARM 

I/O MESSAGE 

REMOTE 

TERMINAL 

IO SIMULATION LIST 

ROBOT CURRENT POSITION 

COMMAND POSITION 

SERVO MONITOR 

WORK HOME POS 

SECOND HOME POS 

DROP AMOUNT 

POWER ON/OFF POS 

TOOL 

INTERFERENCE 

SHOCK SENS LEVEL 

USER COORDINATE 

HOME POSITION 

MANIPULATOR TYPE 

ANALOG MONITOR 

OVERRUN&S-SENSOR 

LIMIT RELEASE 

ARM CONTROL 

LINK SERVOFLOAT 

SHIFT VALUE 

SYSTEM INFO VERSION 

MONITORING TIME 

ALARM HISTORY 

I/O MSG HISTORY 

SECURITY 

EX. MEMORY LOAD 

SAVE 

VERIFY 

DELETE 

FOLDER 

PARAMETER 

SETUP TEACHING COND. DATA RESET INSTRUCTION 

LANGUAGE LEVEL 
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INSTRUCTION INPUT 
LEARNING 

MOVE INSTRUCTION SET 
POSITION 

BUZZER WHEN POSITION 
TEACHING



STEP ONLY CHANGING 

RECT/CYLINDRICAL 

TOOL NO. SWITCH 
TOOL NO. INTERLOCK 
FOR STEP ENTRY 

POS. TEACH ONLY JOG 
CONTROL GROUP 

JOB UNDELETE 
FUNCTION 

OPERATE COND. SPEED DATA INPUT FORM 
CYCLE SWITCH IN TEACH 
MODE 

CYCLE SWITCH IN PLAY 
MODE



CYCLE SWITCH IN LOCAL 
MODE 

CYCLE SWITCH IN 
REMOTE MODE 

SET CYCLE ON POWER 
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SECURITY MODE WHEN 
POWER ON 

JOB STEP WHEN POWER 
ON 

GENERAL OUT KEEP 
WHEN POWER ON



OPERATE ENABLE EXTERNAL START 

PP START 

EXTERNAL MODE SWITCH 

EXTERNAL CYCLE 
SWITCH 

PP CYCLE SWITCH 

EXTERNAL SERVO ON 

PP SERVO ON 

DSW SERVO ON 

FUNCTION ENABLE MASTER JOB CHANGE 

RESERVED START 

RESERVED START JOB 
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Corresp
ondence
15-24

HW0485348
628 of 671



15  Appendix
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156225-1CD
JOB SELECT WHEN 
REMOTE OR PLAY 

I/O-VARIABLE CUSTOMIZE 
FUNCTION 

GENERAL I/O NAME DISP. 
ON JOB



ANTICIPATION FUNCTION 

ALL AXES ANGLE DISP 
FUNCTION 

JOG COND. 

PLAYBACK COND. CHECK/MACHINE LOCK 

MASTER CALLING UP 
INITIAL MOVE SPEED OF 
ROBOT



START METHOD AFTER 
ABSO OVER 

SIGNAL NO. WHEN DROP 
VALUE OVER 

FUNCTION COND. 

DISPLAY COLOR COND. 

DATE/TIME 

RESERVE JOB NAME 

USER ID 

SET SPEED 

KEY ALLOCATION 

JOG KEY ALLOC. 

WRONG DATA LOG 
ENERGY SAVING 
FUNCTION



ENCODER MAINTENANCE 

DISPLAY SETUP 

ARC WELDING ARC START COND.  *1

ARC END COND.  *1

ARC AUX COND. 

POWER SOURCE COND. 

ARC WELD DIAG. 

WEAVING 

ARC MONITOR 

ARC MONITOR (SAMPL) 

APPLI COND.  *2

HANDLING HANDLING DIAG. 

Main Menu Main Menu Item Menu Menu Item
Corresp
ondence
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15.5  Standard function about DX100

156225-1CD
*1 Graphical setting display is not supported.

*2 WELDING SPEED PRIORITY can be used only.

*3 Please refer to section 1.2.1 "Optional Function of Controller" for the list of each 
optional function.

ARC WELDING 
(JIGLESS ARC)

ARC START COND.  *1

ARC END COND.  *1

ARC AUX COND. 

POWER SOURCE COND. 

ARC WELD DIAG. 

WEAVING 

ARC MONITOR 

ARC MONITOR (SAMPL) 

SPOT
WELDING

WELD DIAGNOSIS 

GENERAL WEAVING 

GENERAL DIAG. 

SPOT
WELDING

WELD DIAGNOSIS 

GUN PRESSURE 

PRESSURE 

CLEARANCE SETTING 

TIP INSTALLATION 

Maintenance mode

System INITIALIZE 

SETUP LANGUAGE 

CONTROL GROUP 

OPTION BOARD 

IO MODULE 

DATE/TIME 

OPTION FUNCTION  *3

VERSION 

SECURITY 

FILE INITIALIZE 
EX. 
MEMORY

LOAD 

SYSTEM RESTORE 

TOOL LANGUAGE BUILD 

DISPLAY SETUP 

Main Menu Main Menu Item Menu Menu Item
Corresp
ondence
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15.6  List of Function depending on the system version of controller

156225-1CD
15.6 List of Function depending on the system version 
of controller

 DX200

Function
Version

DN1.80-00

Motor load estimate 

Life estimate 

Reset Job 

Cycle time display 
Step end points display in the 
trace points



Collision step movement 

Conveyor synchronization 

Open the storage card folder 

Job Browser 

Lap Time Panel 

Working Trace 

Online Function 

Simple PP 

JobPad 
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15.6  List of Function depending on the system version of controller

156225-1CD
 DX100

Function
Version

DS3.93-00

Motor load estimate 

Life estimate 

Reset Job 

Cycle time display 
Step end points display in the 
trace points 

Collision step movement 

Conveyor synchronization 

Open the storage card folder 

Job Browser 

Lap Time Panel 

Working Trace 

Online Function 

Simple PP 

JobPad 
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156225-1CD
 FS100

Function
Version

FS3.20A-00 FS3.20B-00 FS3.20C-00 FS2.00-00

Motor load estimate    

Life estimate    

Reset Job    

Cycle time display    
Step end points display in the 
trace points    

Collision step movement    

Conveyor synchronization    

Open the storage card folder    

Job Browser    

Lap Time Panel    

Working Trace    

Online Function    

Simple PP    

JobPad    
15-29

HW0485348
633 of 671



15  Appendix
15.6  List of Function depending on the system version of controller

156225-1CD
 NX100

Function
Version

NS4.75-00 NS5.09-45 NS4.69-A5

Motor load estimate   

Life estimate   

Reset Job   

Cycle time display   

Step end points display in the 
trace points   

Collision step movement   

Conveyor synchronization   

Open the storage card folder   

Job Browser   

Lap Time Panel   

Working Trace   

Online Function   

Simple PP   

JobPad   
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15.7  List of Manipulator Models and Offset Values Supported by MotoSim EG-VRC

156225-1CD
15.7 List of Manipulator Models and Offset Values 
          Supported by MotoSim EG-VRC

 DX200

Model Name
Robot Type

(Model File Name)
Offset Value (mm) Remarks

ES165RDII ES165RD-J00 450 Added at Ver5.10

ES200RDII ES200RD-J00 450 Added at Ver5.11

MA1440 MA1440-A00 450 Added at Ver4.00

MA1440 MA1440-A10 450 Added at Ver2015

MA2010 MA02010-A00 505 Added at Ver5.20

MA2010 MA02010-A10 505 Added at Ver5.20

MC2000II MC02000-J00 680 Added at Ver2015SP1

MH5LSII MH005LS-J00 330 Added at Ver5.11

MH12 MH12-A00 450 Added at Ver4.00

MH24 MH00024-A00 505 Added at Ver5.20

MH50II MH00050-J00 540 Added at Ver5.10

MH50II-20 MH00050-J10 540 Added at Ver5.11

MH50II-35 MH00050-J20 540 Added at Ver5.10

MH80II MH00080-J00 540 Added at Ver5.20

MH110 MH110-A00 540 Added at Ver5.10

MH180 MH180-A00 650 Added at Ver4.01

MH225 MH225-A00 650 Added at Ver4.01

MH280II MH00280-J00 650 Added at Ver5.11

MH400II MH00400-J00 900 Added at Ver5.20

MH600 MH00600-A00 900 Added at Ver2015SP2

MPL80II MPL0080-J00 540 Added at Ver5.11

MPL100II MPL0100-J00 650 Added at Ver2015

MPL160II MPL0160-J00 880 Added at Ver2015

MPL300II MPL0300-J00 880 Added at Ver2015

MPO10 MPO0010-A00     0 Added at Ver2015SP1

MPO10 MPO0010-C00     0 Added at Ver2015SP1

MPO10 MPO0010-F00     0 Added at Ver2015SP1

MPX3500 MPX3500-A00     0 Added at Ver2015SP1

MPX3500 MPX3500-A10     0 Added at Ver2015SP1

MPX3500 MPX3500-C00     0 Added at Ver2015SP1

MPX3500 MPX3500-C10     0 Added at Ver2015SP1

MPX3500 MPX3500-F00     0 Added at Ver2015SP1

MPX3500 MPX3500-F10     0 Added at Ver2015SP1

MS100 MS100-A00 540 Added at Ver5.10

MS165 MS165-A00 650 Added at Ver4.01

MS210 MS210-A00 650 Added at Ver4.01

UP400RDII UP400RD-J00 10000 Added at Ver2015
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156225-1CD
VA1400II VA01400-J00 450 Added at Ver2015

Model Name
Robot Type

(Model File Name)
Offset Value (mm) Remarks
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156225-1CD
 DX100  

Model Name
Robot Type

(Model File Name)
Offset Value (mm) Remarks

DX1350D DX1350D-A00 480 Added at Ver2.60

EP4000D EP4000D-J72 740 Added at Ver2.72

EP4000D EP4000D-K72 740 Added at Ver2.72

EP4000D EP4000D-L72 740 Added at Ver2.72

EPH130D EPH130D-A00 730 Added at Ver2.45

EPH130RLD PH13RLD-A00 600 Added at Ver2.72

EPH4000D EPH400D-JA0 758 Added at Ver2.80

EPH4000D EPH400D-JB0 758 Added at Ver2.72

EPH4000D EPH400D-KA0 758 Added at Ver2.80

EPH4000D EPH400D-KB0 758 Added at Ver2.72

EPH4000D EPH400D-LA0 758 Added at Ver2.80

EPH4000D EPH400D-LB0 758 Added at Ver2.72

ES165D ES0165D-A00 650 Added at Ver2.00

ES165D-100 ES0165D-A10 650 Added at Ver2.81

ES165RD ES165RD-A00 450 Added at Ver2.20

ES200D ES0200D-A00 650 Added at Ver2.00

ES280D-230 ES0280D-A10 650 Added at Ver2.21

HP20D HP0020D-A00 505 Added at Ver2.00

HP20D-6 HP0020D-A10 505 Added at Ver2.40

HP20RD HP020RD-A00 305 Added at Ver2.21

IS300D IS0300D-A00 0 Added at Ver2.21

MA1400 MA01400-A00 450 Added at Ver2.00

MA1800 MA01800-A00 555 Added at Ver2.10

MA1900 MA01900-A00 505 Added at Ver2.00

MC2000 MC02000-A00 680 Added at Ver2.40

MFL2200D-2650 MFL050D-C20 827 Added at Ver2.45

MFL2200D-3600 MFS050D-A00     0 Added at Ver5.20

MFS2500D-4000 MFS060D-A00     0 Added at Ver4.00

MH5 MH00005-C00 330 Added at Ver2.21

MH5 MH00005-E00 330 Added at Ver2.24

MH5 MH00005-E10 330 Added at Ver2.24

MH5L MH0005L-C00 330 Added at Ver2.21

MH5LS MH005LS-A00 330 Added at Ver2.60

MH5S MH0005S-A00 330 Added at Ver2.60

MH6 MH00006-A00 450 Added at Ver2.00

MH6 MH00006-C00 450 Added at Ver4.00

MH6-10 MH00006-A30 450 Added at Ver2.21

MH6S MH0006S-A00 450 Added at Ver2.10

MH50 MH00050-A00 540 Added at Ver2.00

MH50-20 MH00050-A10 540 Added at Ver2.10

MH50-35 MH00050-A20 540 Added at Ver2.21

MH80 MH00080-A00 540 Added at Ver2.24

MH165 MH00165-A00 650 Added at Ver2.25
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MH165 MH00165-B00 650 Added at Ver2.25

MH165-100 MH00165-A10 650 Added at Ver2.81

MH200 MH00200-A00 650 Added at Ver2.80

MH215 MH00215-A00 650 Added at Ver2.21

MH250 MH00250-A00 650 Added at Ver2.40

MH250 MH00250-B00 650 Added at Ver2.40

MH400 MH00400-A0E 900 Added at Ver2.81

MPK2 MPK0002-A00 500 Added at Ver2.24

MPK2 MPK0002-B01 420 Added at Ver2.24

MPL80 MPL0080-A00 540 Added at Ver2.21

MPL100 MPL0100-A00 880 Added at Ver2.20

MPL160 MPL0160-A00 880 Added at Ver2.10

MPL300 MPL0300-A00 880 Added at Ver2.20

MPL500 MPL0500-A00 880 Added at Ver2.21

MPL800 MPL0800-A00 880 Added at Ver2.20

MS80 MS00080-A00 540 Added at Ver2.00

MS80W MS0080W-A00 540 Added at Ver2.40

MS80W MS0080W-B00 540 Added at Ver2.40

MS120 MS00120-A00 680 Added at Ver2.24

VD20S RVD800S6A1 508.5 Added at Ver2.27

VD35D-G4A RVD1230D6A1 556.5 Added at Ver2.27

VD35S-G4A RVD1230S6A1 556.5 Added at Ver2.27

VD40D RVD2200D6A1 624 Added at Ver2.72

VD40S RVD2200S6A1 624 Added at Ver2.72

VD95D RVD1450D6D1 679 Added at Ver2.27

SDA5D SDA005D-A00 900 Added at Ver2.22

SDA10D SDA010D-A00 1200 Added at Ver2.10

SDA10D SDA010D-B00 550 Added at Ver2.10

SDA20D SDA020D-A00 550 Added at Ver2.10

SIA5D SIA005D-A00 309.5 Added at Ver2.45

SIA10D SIA010D-A00 360 Added at Ver2.10

SIA20D SIA020D-A00 410 Added at Ver2.10

SIA20D SIA020D-Y00     0 Added at Ver2.21

SIA30D SIA030D-A00 598 Added at Ver2.81

SIA50D SIA050D-A00 540 Added at Ver2.00

UP120ED-165 UP120ED-A10 525 Added at Ver2.21

UP350D UP0350D-A00 900 Added at Ver2.10

UP350D-600 UP0350D-B30 900 Added at Ver2.24

UP400RD UP400RD-A00 1000 Added at Ver2.81

VA1400 VA01400-A00 450 Added at Ver2.00

VS50 VS00050-A00 540 Added at Ver2.00

Model Name
Robot Type

(Model File Name)
Offset Value (mm) Remarks
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 FS100

Model Name
Robot Type

(Model File Name)
Offset Value (mm) Remarks

BMDA3 BMDA003-A01 460 Added at Ver4.10

CSDA5F CSDA05F-B1A 500 Added at Ver5.10

CADA10F CSDA10F-A1A 1200 Added at Ver5.10

HP20F HP0020F-A00 505 Added at Ver2.81

MHJ MH0000J-A00 240 Added at Ver2.40

MH3BM MH003BM-A00 350 Added at Ver2.80

MH3F MH0003F-A00 290 Added at Ver2.40

MH5F MH0005F-A00 330 Added at Ver2.40

MH5LF MH005LF-A00 330 Added at Ver2.60

MH6F MH0006F-A00 450 Added at Ver2.81

MPK2F MPK002F-A00 420 Added at Ver2.60

MPK2F-5 MPK002F-A20 420 Added at Ver2.70

MPL160 MPL0160-A00 880 Added at Ver2.70

MPP3 MPP0003-A00     0 Added at Ver2.40

MPP3H MPP003H-A00     0 Added at Ver5.11

MPP3S MPP003S-A00     0 Added at Ver4.10

SDA5F SDA005F-A00 900 Added at Ver2.45

SDA10F SDA010F-A00 1200 Added at Ver2.40

SDA20F SDA020F-A00 550 Added at Ver5.10

SIA5F SIA005F-A00 309.5 Added at Ver2.70

SIA10F SIA010F-A00 360 Added at Ver2.44

SIA20F SIA020F-A00 410 Added at Ver2.44
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156225-1CD
 NX100  

Model Name
Robot Type

(Model File Name)
Offset Value (mm) Remarks

DA20 DA20-A00 559

DIA10 DIA10-A00 1037

DIA20 DIA20-A00 1050 Added at Ver2.10

DX1350N DX1350N-A00 480

EA1400N EA1400N-A00 450

EA1400N 
Ceiling Mounted Type

EA1400N-A10 450

EA1800N EA1800N-A00 555

EA1900N EA1900N-A00 505

EA1900N 
Ceiling Mounted Type

EA1900N-A10 505

ECD2500D-3700 ECD80D-A00     0 Added at Ver2.20

ECR200 ECR200-A00 735

ECR3J ECR3J-A00 290 Added at Ver2.20

ECR400R-200 ECR400R-A10 1005 Added at Ver2.20

ECR400R-400 ECR400R-B00 1005 Added at Ver2.20

ECS600N ECS600N-A01 730 Added at Ver2.21

EH80 EH80-A00 540

EH130 EH130-A00 650

EH130 EH130-A20 650

EH200 EH200-A00 730

EH200-150 EH200-A10 730

EP4000N EP4000N-J00 740

EP4000N EP4000N-J10 740

EP4000N EP4000N-J30 740

EP4000N EP4000N-J40 740

EP4000N EP4000N-J50 740

EP4000N EP4000N-J60 740

EP4000N EP4000N-K00 740

EP4000N EP4000N-K10 740

EP4000N EP4000N-K30 740

EP4000N EP4000N-K40 740

EP4000N EP4000N-K50 740

EP4000N EP4000N-K60 740

EP4000N EP4000N-L00 740

EP4000N EP4000N-L10 740

EP4000N EP4000N-L30 740

EP4000N EP4000N-L40 740

EP4000N EP4000N-L50 740

EP4000N EP4000N-L60 740

EPH130 EPH130-A00 730

EPH130 EPH130-C24 730

EPH130R EPH130R-A00 600
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EPH130RL EPH130RL-A00 600

EPH130RL EPH130RL-A54 600

EPH130RL-85 EPH130RL-A34 600

EPH130RL-85 EPH130RL-A60 600 Added at Ver1.42

EPH4000 EPH4000-J01 758

EPH4000 EPH4000-J11 758

EPH4000 EPH4000-J31 758

EPH4000 EPH4000-J41 758

EPH4000 EPH4000-J51 758

EPH4000 EPH4000-J60 758

EPH4000 EPH4000-J71 758 Added at Ver1.42

EPH4000 EPH4000-J81 758 Added at Ver1.20

EPH4000 EPH4000-JA0 758

EPH4000 EPH4000-K01 758

EPH4000 EPH4000-K11 758

EPH4000 EPH4000-K31 758

EPH4000 EPH4000-K41 758

EPH4000 EPH4000-K51 758

EPH4000 EPH4000-K60 758

EPH4000 EPH4000-KA0 758

EPH4000 EPH4000-L01 758

EPH4000 EPH4000-L11 758

EPH4000 EPH4000-L31 758

EPH4000 EPH4000-L41 758

EPH4000 EPH4000-L51 758

EPH4000 EPH4000-L60 758

EPH4000 EPH4000-LA0 758

EPL80 EPL80-A00 540

EPL160 EPL160-A00 880

EPL160 EPL160-A10 880

EPL300 EPL300-A00 880

EPL300 EPL300-A10 880

EPL500 EPL500-A00 880

EPL500 EPL500-A10 880

EPX1250 EPX1250-A000 310 Added at Ver2.80

EPX2050 EPX2050-A300 600 Added at Ver2.80

EPX2050 EPX2050-A500 600 Added at Ver2.80

EPX2700 EPX2700-A000 0 Added at Ver2.80

EPX2700 EPX2700-A100 0 Added at Ver2.80

EPX2750 EPX2750-A300 600 Added at Ver2.80

EPX2800 EPX2800-A000 795.5 Added at Ver2.80

EPX2800R EPX2800R-A000 817.5 Added at Ver2.80

EPX2900 EPX2900-A000 750 Added at Ver2.80

ES120N ES120N-A00 650 Added at Ver2.00

Model Name
Robot Type

(Model File Name)
Offset Value (mm) Remarks
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ES120N ES120N-A20 680 Added at Ver2.00

ES165N ES165N-A00 650

ES165N-100 ES165N-A10 650

ES165RN ES165RN-A00 450

ES200N ES200N-A00 650

ES200RN ES200RN-A00 450

ES200TN ES200TN-A00 650

ES200RN-120 ES200RN-A10 450

ES280N ES280N-A00 650

HP3 HP3-A00 300

HP3J HP3J-J00 290

HP3L HP3L-A00 300

HP3XF HP3XF-A00 300

HP3XF HP3XF-B00 300

HP5 HP5-A00 300

HP6 HP6-A00 450

HP6R HP6-R00 240

HP6R HP6-R10 240

HP6S HP6-A10 450

HP20 HP20-A00 505

HP20-6 HP20-A10 505

HP20 IP65 HP20-A20 505

HP20R HP20R-B2C 305 Added at Ver2.00

HP165 HP165-A00 650

IA20 IA20-A00 450

SDA10 SDA10-A00 1200

SDA10 SDA10-B00 550 Added at Ver2.10

SDA20 SDA20-A00 550 Added at Ver1.42

SIA10 SIA10-A00 360 Added at Ver1.20

SIA20 SIA20-A00 410 Added at Ver1.20

SP800N SP800N-A00 540

SSA2000 SSA3-A00 450

SSA2000
Ceiling Mounted Type

SSA3-A10 450

SSF2000 SSF6-A00 450

SSF2000R SSF6R-A20 240 Added at Ver2.00

UP20MN UP20MN-A00 540

UP50N UP50N-A00 540

UP50N UP50N-A51 540

UP50N UP50N-AA1 540 Added at Ver1.20

UP50N-80 UP50N-A10 540

UP50SN UP50N-A20 540

UP50SN UP50N-A71 540

UP50N-35 UP50N-A30 540

UP50RN-35 UP50RN-A10 450

Model Name
Robot Type

(Model File Name)
Offset Value (mm) Remarks
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156225-1CD
 MOTOPOS

UP120EN-165 UP120EN-A10 525

UP130RN UP130RN-B00 600 Added at Ver1.20

UP130RLN UP130RN-A2A 600

UP130RLN UP130RN-A2B 600

UP130RLN-85 UP130RN-A4A 600

UP350N UP350N-A00 900

UP350N-200 UP350N-A10 900

UP350N-500 UP350N-A20 900

UP350N-600 UP350N-A30 900

UP400RN UP400RN-A00 1000

Model Name Robot Type Model File Name Remarks

D200B-C00 MPD200B-C00 D200B-C00 Added at Ver2.45

D250B(A00) MPD250B-A00 D250B-A00

D250B(B00) MPD250B-B00 D250B-B00 Added at Ver2015

D500B(A00) MPD500B-A00 D500B-A00

D500B(B00) MPD500B-B00 D500B-B00 Added at Ver2015

D500B(A12) MPD500B-A12 D500B-A12

D700B(A00) MPD700B-A00 D700B-A00 Added at Ver2.20

S250B(A00) MPS250B-A00 S250B-A00

S500B(A00) MPS500B-A00 S500B-A00

S500E-A00 MPS500E-A00 S500E-A00 Added at Ver2015

T5000B MPT5000B-A00 T5000B-A00

Model Name
Robot Type

(Model File Name)
Offset Value (mm) Remarks
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156225-1CD
 MOTOFEEDER

Model registration on the VRC controller Model Name Remarks

Arm Length: 1600mm, With Manipulator, 
High-Speed Rotation Specification

MF216A Added at Ver2.80

Arm Length: 1600mm, With Manipulator, 
High-Speed Rotation Specification(with spindle unit)

MF216A_SPINDLE Added at Ver2.80

Arm Length: 1800mm, With Manipulator, 
High-Speed Rotation Specification

MF218A Added at Ver2.80

Arm Length: 1800mm, With Manipulator, 
High-Speed Rotation Specification(with Spindle unit)

MF218A_SPINDLE Added at Ver2.80

Arm Length: 1400mm, Without Manipulator, 
High-Speed Rotation Specification

MF214B Added at Ver2.80

Arm Length: 1400mm, Without Manipulator, 
High-Speed Rotation Specification(with spindle unit)

MF214B_SPINDLE Added at Ver2.80

Arm Length: 1600mm, Without Manipulator, 
High-Speed Rotation Specification

MF216B Added at Ver2.80

Arm Length: 1600mm, Without Manipulator, 
High-Speed Rotation Specification(with spindle unit)

MF216B_SPINDLE Added at Ver2.80

Arm Length: 1800mm, Without Manipulator, 
High-Speed Rotation Specification

MF218B Added at Ver2.80

Arm Length: 1800mm, Without Manipulator, 
High-Speed Rotation Specification(with spindle unit)

MF218B_SPINDLE Added at Ver2.80

Arm Length: 1600mm, With Manipulator, 
Heavy Load Specification

MF416A Added at Ver2.80

Arm Length: 1800mm, With Manipulator, 
Heavy Load Specification

MF418A Added at Ver2.80

Arm Length: 1400mm, Without Manipulator, 
Heavy Load Specification

MF414B Added at Ver2.80

Arm Length: 1600mm, Without Manipulator, 
Heavy Load Specification

MF416B Added at Ver2.80

Arm Length: 1800mm, Without Manipulator, 
Heavy Load Specification

MF418B Added at Ver2.80
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15.8  Frequently-Asked Questions

156225-1CD
15.8 Frequently-Asked Questions

 When the driver has been installed with USB type key connected to 
a personal computer

1. With the USB type key attached to a personal computer, delete the item registered as "USB 
Token" in Device Manager.

2. Uninstall the driver (Sentinel System Driver 5.41.1(32-bit)) with "Add/Remove Programs".
3. Install the driver with key detached from personal computer.

 When a older version key driver has been installed over a newer key 
driver version.

In such case, the key driver may not operate properly.
Uninstall the Sentinel System Driver with Windows "Add / Remove Programs" function.  Then reinstall 
the Sentinel key driver.  For details, please refer to section 1.4 "Hardware Key" of the manual.

 Cell file containing HSF files don't display properly

When cell file containing HSF model files, if the HSF format version is higher than the one currently 
supported by MotoSim EG-VRC, the HSF file may not display properly.  In the case that a newer 
MotoSim EG-VRC version displays the cell properly, the newer MotoSim EG-VRC can save the cell file 
in a previous MotoSim EG-VRC format.  This will also save the HSF file into the corresponding format 
version (Refer to section 4.3.2 "Save As" for details.)  If the HSF file was generated by a 3rd party 
software, look in the that software HSF export options to export the file in an HSF format version 
corresponding to you current version of MotoSim EG-VRC.

 MotoSim EG Cell file compatibility

MotoSim EG-VRC can convert and load files created by MotoSim EG but cannot playback the job and 
the robot operations are limited.  The MotoSim EG robot should be replace by the VRC corresponding 
robot type.  Please refer to section 13.7 "External Axes Setting (Motor Gun)". 
Cell file created with MotoSim EG-VRC cannot be used by MotoSim EG or MotoSim EG.  

 MotoSim EG-VRC - CadPack Cell file compatibility

Cell file created with MotoSim EG-VRC can be used by MotoSim EG-VRC-CadPack.  Cell file created 
with MotoSim EG-VRC-CadPack can also be used by MotoSim EG-VRC even if CAD data (IGES,SAT) 
was imported into the cell.  When saving the cell, the MotoSim EG-VRC-CadPack converts imported 
CAD data into HSF files.  Once that conversion is done, the regular MotoSim EG-VRC can open the file 
without problems. 
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 Graphic Driver Concerns

With MotoSim EG-VRC, some old version display adapters (graphic drivers) may not properly generate 
memos and dimension lines.  In those cases, it is necessary to upgrade the version of the display 
driver.  For Intel type adapter, verify that the version number is 6.14.10.4020 or later, otherwise please 
upgrade the display driver.

Version Verification Procedure

The following example is for a IntelR Graphics Controller on a Windows 2000 operating systems. 
1. With the mouse right click on the desktop and select "Properties" from the popup menu to 

display the Desktop Properties dialog. 

2. Select the "Display" tab.
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3. Click on the "Advanced" button to display the graphic driver property dialog.

4. Select the "IntelR Graphics Technology”ntab.

5. Verify the version. (The version is 6.13.01.3084.  An upgrade is necessary.)

Version Upgrade Procedure

Download the necessary file (i.e. Win2K_XP1410.exe) from the download site and execute it. (In this 
example, the http://support.intel.com/support/go/downloads site was used.)
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 Backup VRC.BIN file

If computer power shortage or an application error occurs when MotoSim EG-VRC is accessing the 
VRC.BIN file, the file may become corrupted and prevent the controller and Virtual Pendant to load 
properly.  As a safeguard, when the cell is saved, the previous copy of the VRC.BIN is kept as a 
backup.

To restore the backup copy of the VRC.BIN file:
1. Open the controller folder under the cell directory and rename the VRC.BIN.bak file to 

VRC.BIN.  
2. Start MotoSim EG-VRC but don’t open the cell yet.  If MotoSim EG-VRC is already running, 

close all the cells.
3. Start the controller in maintencae mode with the restored CMOS.BIN file On the [Controller] tab, 

in the [Boot] group, click the [Maintenance mode] button, and then selecting the newly renamed 
VRC.BIN. (For details, refer to section section 7.10 "VRC Maintenance Mode".)

4. Load the VRC.BIN on the Virtual Pendant, select {Compact Flash} - {LOAD CMOS}.  (This may 
take a few moments and warning message, indicating not to turn off the controller, appears at 
the bottom of the Virtual Pendant.  Wait until the message disappears before proceeding to 
another operation that may cause the controller to reboot or close. )

5. Once the VRC.BIN load is done, close the controller by pressing the “End” button of the “VRC 
Maintenance Mode” dialog.

6. Open the cell.

 Recovery method when an alarm occurs during the creation of a 
new controller.

When a new controller is created with the "VRC Controller (using CMOS.BIN file)" of an actual 
controller, alarms may display on the Virtual Pendant. 
In such case, use the following procedure:

1. Save the cell and then close it.
2. On the [Controller] tab, in the [Boot] group, click the [Maintenance mode] button, the 

[Maintenance mode] dialog appears. 

3. The VRC Maintenance Mode dialog will display.  Use the browsing button to select the 
VRC.BIN file located in the controller folder under the cell folder.  Once the VRC.BIN file is 
selected, press the [Start] button.  The controller will start in maintenance mode and display the 
Virtual Pendant (it may take a few moments).
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The procedures below corresponds to various alarm.

Alarm 0320 Verify error (I/O Module)

(1) Select {System} - {Setup}.
(2) Select [I/O Module].

(3) Press the [Enter] key twice.  When the confirmation message displays, select [Yes]. 
(4) Press the [End] button of the [VRC Maintenance Mode] dialog to close the 

controller.  
(5) When all the step above are completed.  Reopen the cell.

Alarm 0020 Communication Error(CPU)

(1) Select {System} - {Setup}.
(2) Select [Options].

(3) Press the [Enter] key.  When the confirmation message displays, select [Yes]. 
(4) Press the [End] button of the [VRC Maintenance Mode] dialog to close the 

controller.  
(5) When all the step above are completed.  Reopen the cell. 
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Alarm 0060 Communication Error (IO Module) [16]

(1) Select {System} - {Setup}.
(2) Select [Options].

(3) Press the [Enter] key.  When the confirmation message displays, select [Yes]. 
(4) Select [IO Module].
(5) When the [IO Module] displays, press the [Enter] key twice.
(6) When the confirmation message displays, select [Yes].
(7) Press the [End] button of the [VRC Maintenance Mode] dialog to close the 

controller.  
(8) When all the step above are completed.  Reopen the cell. 

Error 3100 Total checksum error

The CMOS cannot be loaded because the “VRC.BIN” version is from a controller version incompatible 
with the selected VRC version.
In such case, retrieve the individual data files from the actual controller and load them in the VRC 
controller.

1. On the pendant of the actual controller, select [FD/CF] - [SAVE] and save:
• All the files from the JOB, FILE /GENERAL DATA, I/O DATA, SYSTEM DATA  section.
• The "BATCH PARAMETER (ALL.PRM)" file under the PARAMETER section.

2. In MotoSim EG-VRC, select [Controller] - [New Controller] and add a new controller with "No 
CMOS.BIN file".
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Please refer to section 7.1 "Adding a New Controller" for more details.

3. Copy the individual files retrieved from the actual controller in the "Storage Card" folder under 
the controller folder of the cell. 

4. On the Virtual Pendant, select [FD/CF] - [LOAD]

 Trouble shooting when virtual pendant doesn't accept operation 
after newly making controller (Nothing is displayed on the screen).

When a virtual pendant starts in the ordinary mode after completing CMOS loading operation in the 
maintenance mode when newly making it by setting "VRC Controller (using CMOS.BIN file)" when the 
controller newly makes it, a virtual pendant might not accept the operation at all (Even if the menu is 
selected, nothing is displayed on the screen).

When this phenomenon is generated, it restores it according to the following procedures.

1. After the cell is preserved, the cell is closed. 
2. On the [Controller] tab, in the [Boot] group, click the [Maintenance mode] button.

3. [VRC Maintenance Mode] appears.
Select "VRC.BIN" that exists in the controller folder below the folder where the cell exists, Push 
[Start] , and the maintenance mode is started.

4. Select [SYSTEM]-[SETUP]. 

When initializing this new controller, make sure to select the same settings as the actual 
controller (the control group and application must match to be able to load the individual 
files).

When loading the individual files, please proceed in the following order:
(1) PARAMETER file
(2) I/O DATA files
(3) Other files

Please refer to section 15.3 "Storage Card" for details.

NOTE

NOTE
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5. Select [OPTION BOARD].

6. Because the confirming message displays to push [enter], select [yes]. 
7. The “IO MODULE” screen displays it continuously. Select [SYSTEM]-[SETUP]-[IO MODULE] 

When it is not displayed.

8. Because the confirming message displays to push [enter] twice, select [yes].
9. The [End] is selected by the [VRC Maintenance Mode], and the maintenance mode is ended.
10. The restoration operation is completed above. Please open the cell again.

 Caution on setting up two or more 4-axis robots (ex. MPL300) to the 
one controller

On creating a new controller without a New VRC Controller (no file), If two or more 4-axis robots are set 
up to the one controller, use the following procedure certainly.
Basically, the following procedure is equal to that of section 7.1.1 "Create a New VRC Controller (no 
file)", but Setting on the [CONNECT] display of "Initialize the controller in the step 3" is used the 
following procedure.

The procedure is explained with setting up the two 4-axis robots to the one controller.
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Procedure

1. Proceed to the step 1 to 3 of section 7.1.3 "Initializing the Controller (DX200, DX100, NX100)".
2. On setting [CONNECT] in the step 4 of section 7.1.3 "Initializing the Controller (DX200, DX100, 

NX100)", change [SV] from "#1" to "#2".

3. Proceed to the step 5 to 10 of section 7.1.3 "Initializing the Controller (DX200, DX100, NX100)".

 Way to make the display speed faster

When the large CAD data is used, the Collision Detection function is used, or the performance of using 
PC is low, the display process can not executed smoothly, so the simulation speed may be lower.
If the above symptoms occurred, do the following operation, and the display performance may be made 
better.

• Raise the number of Refresh Interval
The number of redrawing is reduced, so the load of redrawing is reduced.

→ For details, please refer to the section 7.5.4 "Refresh Interval".
• Reduce the number of trace or Delete the trace

The number of drawing trace is reduced, so the load of drawing trace is reduced.
→ For details, please refer to the section 7.9 "Trace".

• Enable "Back Plane Culling" of models
The back plane of the CAD data is hidden, so the CAD data is displayed faster.

→ For details, please refer to the section section 11.4 "Editing a Model".
• Raise the Culling Threshold of Framerate Optimization

Model data which displayed size is smaller than the selected pixel on the display are not displayed, 
so the model is displayed faster.

→ For details, please refer to the section 12.5 "Performance Settings".
• Hide the shadow

The shadow is hidden, so the load of drawing shadow is reduced.
→ For details, please refer to the section 12.1.4 "Shadow".
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• Disable "Smooth Transition"
The viewpoint changes without "Smooth Transition", it changes immediately.

→ For details, please refer to the section 12.1.2 "Smooth Transition".
• Drawing performance is measurable.

On the [Home] tab, in the [Tools] group, click the [Measure Performance] button, the screen of 
MotoSimEG-VRC begins rotation and displays the number of drawing frames per second. If it 
measures before and after setting change and the following red frame numerical value becomes 
large, it is shown that drawing performance is going up.

 Solution in case characters is missing from the screen of Moto-
SimEG-VRC in Windows7

When a character is missing from the screen of MotoSimEG-VRC in Windows7, please change 
character size by the following procedure.

1. Open the {Display} of Control Panel.
To open {Display}, Click the [Start] button, and [Control Panel].
(a) In the case of "View by" is "Category":

Click the [Appearance and Personalization] and [Display].
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(b) In the case of "View by" is "Large icons" or "Small icons":
Click the [Display].

2. In [Make it easier to read what's on your screen], Select the [Smaller - 100%] button, and click 
the [Apply] button.

 Docking Window

Some windows are dockable with any of the four directions of the main screen.
In MotoSim EG-VRC, the following windows are dockable.

• Position Panel
• OLP
• CadTree
• Variable Monitor
• Pulse Recorder
• Lap Time Panel
• Collision Detection
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Docking Operation

When the window is dragged to another position, the guide diamond is displayed in order to re-dock the 
window.

When the dragged window reaches the location where want to dock it , move the pointer over the 
corresponding portion of the guide diamond. The designated area is shaded. To dock the window in the 
position indicated, release the mouse button.

Guide Diamond 
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Floating Operation

Drag the window, and release the mouse button at places other than the guide diamond.
However, the window is "Auto Hide" enabled (  ), the window can not be floated. So, make the 

window "Auto Hide" disabled (  ), and float the window..

To Enable Auto Hide

Click the pushpin icon on the title bar of the 
window, the window becomes "Auto Hide" 

enabled (  ). The window slides out of the 
way. When a window is auto-hidden, its name 
appears on a tab at the edge of the main 
window.

To use the window, point to the tab so that the 
window slides back into view.

 

Drag 

 
Click 

The window slides out 

The name appears 
on a tab 

 
Point to the tab 

The window appears 
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To Disable Auto Hide

Click the pushpin icon again on the title bar of the window, the window becomes "Auto Hide" disabled ( 

 ).

Docking Operation with Two or More Windows

When two or more dockable windows show, it can dock not only with the main window but with another 
window. However, the window is "Auto Hide" enabled (  ), the window can not be floated. So, make 

the window "Auto Hide" disabled (  ), and dock the window. 

Floating Operation with Two or More Windows

Drag the window, and release the mouse button at places other than the guide diamond.
Please refer to the "Floating Operation" for details.

The window slides out of the way when use a 
different window.

 

The window 
slides out 

 
Drag to the another window 

Release the mouse button 

The window is docked 
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Docking Operation as Tab with Two or More Windows

When two or more dockable windows show, Windows are dockable also as a tab.

Drag the window and move the pointer over the center of the guide diamond (   ) or drag to the title 

bar of another dockable window and release the mouse button.

Floating Operation as Tab with Two or More Windows

To float the window shown as the tab, drag it, and release the mouse button at places other than the 
guide diamond.
However, the window is "Auto Hide" enabled (  ), the window can not be floated. So, make the 

window "Auto Hide" disabled (  ), and dock the window.

                   

Drag to the another window 

Release the mouse
button

The window is docked

   

Drag 
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 Quick Access Toolbar

"Quick Access Toolbar" is convenient to execute a command quickly, without not changing a ribbon tab 

or displaying a menu from the MotoSim EG-VRC button (  ). 

If prepopulate the quick access toolbar with the frequently used commands, the button of the 
commands can always be displayed.

1. To customize the quick access toolbar, click the the following button. (  )

2. When add the "Open" command to the quick access toolbar, click the "Open" menu. When add 
the other commands, click the "More commands..." menu. The "Customize" dialog appears.

 
 

Quick Access Toobar 

 
 
 

Customize the quick 
access toolbar 
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3.  Select the tab name by "Choose commands from" list box, and the commands is displayed. 
Select the command, and click the [Add] button.

4. The added command is displayed in the right side list. Click the [OK] button.

Then the command is added to the quick access toolbar.

To delete the command button from the quick access toolbar, right-click the target button, 
and click the "Remove from Quick Access Toolbar on the shortcut menu" menu.
When add or remove the two or more buttons, it can be operated efficiently in the 
"Customize" dialog.

NOTE
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 Comparison Table with the New Menu from the Old Menu and the 
Old Tool Bar

Old Menu and the Old Tool Bar New Menu

File

New  -  - 

Open  -  - 

Close

Save  - 

Save As  - 

Open Sample Cell  -  - 

Template  -  - 

Exit  - 

Edit

Undo [Home] - [Edit] - 

Redo [Home] - [Edit] - 

Copy [Home] - [Tools] - 

Screen

Camera Scope

Zoom To Extents [Home] - [View] - 

Direction

View [Home] - [View] - 

Side [Home] - [View] - 

Top [Home] - [View] - 
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Front [Home] - [View] - 

View Manager [Home] - [View] - 

Select Model
[Home] - [Model] - 

Pick Mode

[Home] - [Pick] - Free

Vetex

Center

Edge

Pick  Object

[Home] - [Pick] - Models

Frames

Lines

Points

Floor

Line Size [Home] - [Screen] - 

Small

Medium

Large

Frame Display
[Home] - [Screen] - 

Rendering Mode
[Home] - [Screen] - 

FlatShading

GourandShading

Wireframe

SmoothTransition

Light Manager [Home] - [Screen] - 

Shadow [Home] - [Screen] - 

Old Menu and the Old Tool Bar New Menu
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Memo [Home] - [Screen] - 

Dimension Line [Home] - [Screen] - 

Markup

[Home] - [Screen] - Freehand

Circle

Rectangle

Notes

Cutting Planes

[Home] - [Screen] - X-Cutting Planes

Y-Cutting Planes

Z-Cutting Planes

Measure

Distance [Home] - [Measurement] - 

Angle [Home] - [Measurement] - 

Controller

New Controller [Controller] - [Setup] - 

Copy Controller [Controller] - [Setup] - 

Delete Controller [Controller] - [Setup] - 

Select Controller/Robot

Controller Setting

Tool Data
[Controller] - [File Settings] - 

Old Menu and the Old Tool Bar New Menu
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User Frame Data
[Controller] - [File Settings] - 

Open a folder external 
storage [Controller] - [VPP] - 

Reboot Controller [Controller] - [Boot] - 

Boot 
MaintenanceMode [Controller] - [Boot] - 

Refrash Interval [Home] - [Settings] - 

Servo Emulation [Simulation] - [Playback] - 

Welding Condition [Controller] - [File Settings] - 

Cube Area Update & 
Display

[Controller] - [File Settings] - 
Delete Cube Area 
Model

Safety Function

[Controller] - [File Settings] - 

Safety Function 
File

Tool 
Interference 
Model

Robot 
Approximate 
Model

Robot Setting

Property [Controller] - [Robot] - 

ReachView [Controller] - [Robot] - 

Calibration [Controller] - [File Settings] - 

Device

[Controller] - [External Device] - Add Conveyor

Ade Press

Add Gantry

Old Menu and the Old Tool Bar New Menu
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SoftLimit Setting [Controller] - [External Device] - 

Job Panel [Controller] - [External Device] - 

Conveyor Operation 
Panel

[Controller] - [External Device] - 

Conveyor Setting [Controller] - [External Device] - 

Conveyor 
Synchoronization

[Controller] - [External Device] - 

Playback

Cycle Time [Simulation] - [Playback] - 

Start
[Simulation] - [Playback] - 

Hold [Simulation] - [Playback] - 

Step Next
[Simulation] - [Playback] - 

Step Back
[Simulation] - [Playback] - 

Reset Job [Simulation] - [Playback] - 

Trace [Simulation] - [Monitor] - 

Model

New Model

Edit Model

Hide/See

Model

Frame

Name

Wiring View

Model Attribute

Set Parent

Old Menu and the Old Tool Bar New Menu
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Move Parent

Set File Path

Rename

Set Position

Property

Edit

Cut

Copy

Patsh

Delete

Fine

Model Tree View

Refresh View

Expand Tree

Models List

Save Model Group

Load Model Group

Model Script Editor
[Simulation] - [Model Simulation] - 

Tool

CAD Tree [Home] - [Model] - 

Positon Panel
[Home] - [Teaching] - 

OLP [Home] - [Teaching] - 

Job Shift

I/O Monitor
[Simulation] - [Monitor] - 

I/O Events
[Simulation] - [I/O Settings] - 

Old Menu and the Old Tool Bar New Menu
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I/O Connections
[Simulation] - [I/O Settings] - 

Variable Monitor
[Simulation] - [Monitor] - 

Lap Time Panel
[Simulation] - [Monitor] - 

StafeMaster [Simulation] - [Playback] - 

Collision Detection
[Simulation] - [Collision] - 

Sensing Definition
[Simulation] - [Settings] - 

Pulse Record
[Simulation] - [Monitor] - 

Paing Setting
[Simulation] - [Settings] - 

Show Speed Graph
[Simulation] - [Monitor] - 

Execute Soft [Home] - [Tools] - 

Execute JobBraowser
[Home] - [Teaching] - 

Option
 - 

[Home] - [Settings] - 

CAM

[Home] - [Teaching] - 
Create Job Form CAM

Load Robot Settings

Option Tool

Motor Load Estimate
[Option Function] - [Estimate] - 

Life Estimate
[Option Function] - [Estimate] - 

Old Menu and the Old Tool Bar New Menu
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View

Toolbar

File Bar

Edit Bar

Playback Bar

CAD Bar

View Bar

Controller Bar

Memo Bar

Cutting Bar

Mesure Bar

Status Bar

Japanese

Windows

Cascade

Tile Horizontally

Tile Vertically

Split

Help

Help  - 

CAM Help  - 

Version

Performance [Home] - [Tools] - 

Toolbar Only

[Controller] - [VPP] - 

[Home] - [Operation Handle] - 

[Home] - [Operation Handle] - 

Old Menu and the Old Tool Bar New Menu
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[Home] - [Operation Handle] - 

[Home] - [Operation Handle] - 

[Home] - [Operation Handle] - 

[Home] - [Operation Handle] - 

Old Menu and the Old Tool Bar New Menu
15-82

HW0485348
670 of 671



HEAD OFFICE
2-1 Kurosakishiroishi, Yahatanishi-ku, Kitakyushu 806-0004, Japan
Phone   +81-93-645-7703 Fax   +81-93-645-7802

100 Automation Way, Miamisburg, OH 45342, U.S.A. 
Phone   +1-937-847-6200 Fax   +1-937-847-6277

YASKAWA America Inc. (Motoman Robotics Division)

Bredbandet 1 vån. 3 varvsholmen 392 30 Kalmar, Sweden
Phone   +46-480-417-800 Fax   +46-480-417-999

YASKAWA Nordic AB

Yaskawastrasse 1, 85391 Allershausen, Germany
Phone   +49-8166-90-100 Fax   +49-8166-90-103

YASKAWA Europe GmbH Robotics Divsion )

9F, Kyobo Securities Bldg., 26-4, Yeouido-dong, Yeongdeungpo-gu, Seoul 150-737, Korea
Phone   +82-2-784-7844 Fax   +82-2-784-8495

YASKAWA Electric Korea Co., Ltd

151 Lorong Chuan, #04-02A, New Tech Park, Singapore 556741
Phone   +65-6282-3003 Fax   +65-6289-3003

YASKAWA Electric (Singapore) PTE Ltd.

No7 Yongchang North Road, Beijing E&T Development Area China 100176
Phone   +86-10-6788-2858 Fax   +86-10-6788-2878

YASKAWA SHOUGANG ROBOT Co. Ltd.

#426, Udyog Vihar, Phase- IV, Gurgaon, Haryana, India
Fax   +91-124-475-8542Phone   +91-124-475-8500

YASKAWA  India Private Ltd. (Robotics Division)

YASKAWA Electric (China) Co., Ltd.
22/F One Corporate Avenue No.222, Hubin Road, Huangpu District, Shanghai 200021, China
Phone  +86-21-5385-2200          Fax  86-21-5385-3299 

YASKAWA Electric (Thailand) Co., Ltd.
59,1st-5th Floor, Flourish Building, Soi Ratchadapisek 18,Ratchadapisek Road, 
Huaykwang, Bangkok 10310, THAILAND
Phone   +66-2-017-0099            Fax   +66-2-017-0199

12F, No.207, Sec. 3, Beishin Rd., Shindian District, New Taipei City 23143, Taiwan
Fax   +886-2-8913-1513Phone   +886-2-8913-1333

YASKAWA  Electric Taiwan Corporation 

Secure Building-Gedung B Lantai Dasar & Lantai 1 JI. Raya Protokol Halim Perdanakusuma, 
Jakarta 13610, Indonesia

Fax   +62-21-2982-6741Phone   +62-21-2982-6470

PT. YASKAWA  Electric Indonesia 

Specifications are subject to change without notice
for ongoing product modifications and improvements.

MANUAL NO. 

1HW0485348

MotoSim EG-VRC
OPERATION MANUAL
FOR WINDOWS

671 of 671


	1 Introduction
	1.1 Overview of MotoSim EG-VRC
	1.1.1 Difference of the operation from 5.00

	1.2 Notice and Restriction about MotoSim EG-VRC
	1.2.1 Optional Function of Controller
	1.2.2 Using data saved from a real controller with MotoSim EG-VRC
	1.2.3 Using MotoSim EG-VRC data on a real controller
	1.2.4 Function depending on the system version of controller
	1.2.5 Restriction of Function of Controller
	1.2.6 Accuracy
	1.2.7 Hardware Requirements
	1.2.8 Supported robot model

	1.3 Environment Required for MotoSim EG-VRC
	1.4 Hardware Key
	1.5 Installing MotoSim EG-VRC
	1.6 Definition of Terms
	1.7 Folder Configuration

	2 MotoSim EG-VRC Quick Tour
	2.1 Overview
	2.2 Cell Construction
	2.3 Creation of Models
	2.3.1 Creating a Workpiece and a Workpiece Stand
	2.3.2 Editing Tool Data
	2.3.3 Adding a Tool Model
	Creating and Adding a Tool Model with the CAD Function
	Reading the HSF Format Model


	2.4 Setting of Target Points (AXIS6 Model)
	2.5 Teaching
	2.5.1 Creating a New Job
	2.5.2 Teaching the Standby Position
	2.5.3 Determining the Welding Approach Posture
	2.5.4 Teaching the Welding Start Position
	2.5.5 Teaching the Welding End Position
	2.5.6 Teaching the Torch Retraction
	2.5.7 Returning to the Standby Position
	2.5.8 Verifying Each Step
	2.5.9 Editing a JOB
	Modifying Steps Position
	Adding Steps
	Deleting Steps or Instructions


	2.6 Playback

	3 Offline Teaching Procedure
	3.1 Operation Flow

	4 Creating and Editing a Cell
	4.1 Creating a New Cell
	4.1.1 Template Function
	Registration of Template
	Rename the Template
	Delete the template
	Create the new cell from the template


	4.2 Opening a Cell
	4.3 Storing a Cell
	4.3.1 Save
	4.3.2 Save As

	4.4 Exiting a Cell and MotoSim EG-VRC

	5 Displays
	5.1 MotoSim EG-VRC Display
	5.1.1 Ribbon
	MotoSim EG-VRC button
	Home
	Controller
	Simulation
	Option Function

	5.1.2 Mouse Operation Switching Bar
	Viewpoint Operation Switching Bar


	5.2 Virtual Pendant
	5.2.1 DX200 Virtual Pendant
	Virtual Pendant Button
	Virtual Pendant Keypad
	Keyboard Layout

	5.2.2 DX100 Virtual Pendant
	Virtual Pendant Button
	Virtual Pendant Keypad
	Keyboard Layout

	5.2.3 FS100 Virtual Pendant
	Virtual Pendant Button
	Virtual Pendant Keypad
	Keyboard Layout

	5.2.4 NX100 Virtual Pendant
	Virtual Pendant Button
	Virtual Pendant Keypad
	Keyboard Layout

	5.2.5 Input with keyboard
	Input the job name or folder name
	Input the label name



	6 Display Operation
	6.1 Viewpoint Operation Tools
	6.1.1 Viewpoint Operation with the Mouse
	Right Mouse Button Operation

	6.1.2 Preset Viewpoint Operation
	Viewpoint Operation with the View Manager
	Using Shortcuts
	Smooth Transition


	6.2 Light Manager Operation
	Adding and Modifying Lights
	Deleting Lights
	Light Sources

	6.3 Displaying Shadows
	6.4 Pick Settings
	Pick Mode Setting
	Pick Object Setting
	Pick method and screen display

	6.5 Markup
	6.5.1 Freehand
	6.5.2 Circle
	6.5.3 Rectangle
	6.5.4 Notes
	Adding a Note
	Deleting a Note
	Relocating a Note


	6.6 Memo
	Creating a Memo
	Deleting a Memo
	Relocating a Memo

	6.7 Cutting Planes
	6.7.1 X-Cutting Planes
	Displaying the X-Cutting Plane
	Deleting the X-Cutting Plane
	Changing Display of the X-Cutting Plane

	6.7.2 Y-Cutting Planes
	Displaying the Y-Cutting Plane
	Deleting the Y-Cutting Plane
	Changing Display of the Y-Cutting Plane

	6.7.3 Z-Cutting Planes
	Displaying the Z-Cutting Plane
	Deleting the Z-Cutting Plane
	Changing the Z-Cutting Plane


	6.8 Measure Distance
	6.9 Measure Angle
	6.10 Measure Line
	Creating a Dimension Line
	Deleting a Dimension Line
	Relocating a Dimension Line

	6.11 Changing the Rendering Mode
	6.12 Other Display Operations
	6.12.1 Changing Frame Width
	6.12.2 Copying the Image
	6.12.3 Dividing a Cell Window
	6.12.4 Printing the Image


	7 Controller and Robot Settings
	7.1 Adding a New Controller
	7.1.1 Create a New VRC Controller (no file)
	7.1.2 Create VRC Controller (using CMOS.BIN file or ALL.PRM file)
	7.1.3 Initializing the Controller (DX200, DX100, NX100)
	7.1.4 Initializing the Controller (FS100)
	7.1.5 Defining the Robot Home Position

	7.2 Copying a Controller from another Cell
	7.3 Deleting a Controller
	7.4 Select Controller
	7.5 Controller Setting
	7.5.1 Tool Editor
	Setting the Tool Load Information

	7.5.2 User Frame
	7.5.3 Reboot Controller
	7.5.4 Refresh Interval
	Setting of high-speed playback function

	7.5.5 Servo Emulation
	7.5.6 Cube Interference Area
	Displaying the Cube Interference Area
	Deleting the Cube Interference Area
	Setting the Cube Interference Area


	7.6 Robot Settings
	7.6.1 Robot Property
	7.6.2 Reach View
	7.6.3 Robot Calibration Setting

	7.7 Peripheral Equipment
	7.7.1 Adding a Conveyor
	Adding a Conveyor
	Conveyor Setting

	7.7.2 Adding a Press
	7.7.3 Adding a Gantry
	7.7.4 Modifying the Soft Limit of a Device
	7.7.5 Moving a Device
	7.7.6 Programming a Device
	Select Job
	Input of Coordinates (AxisInput)

	7.7.7 Other Operations with devices
	Deleting a Device
	I/O Signals for Devices

	7.7.8 Conveyor Operation Panel
	7.7.9 Conveyor Synchronization

	7.8 Cycle Time
	7.9 Trace
	7.9.1 Trace Manager
	7.9.2 Trace Properties
	7.9.3 Trace Copy

	7.10 VRC Maintenance Mode
	7.11 Displaying model / Editing Data of Safety Function
	7.11.1 Displaying Robot Range Limit
	Area Combination

	7.11.2 Editing the Safety Function Data
	Robot Range Limit Data
	Axis Range Limit Data
	Axis Speed Monitor Data
	Speed Limit Data
	Tool Angle Monitor Data
	Tool Change Monitor Data

	7.11.3 Displaying the Tool Interference Model
	7.11.4 Displaying the Robot Approximate Model

	7.12 Working Trace
	7.12.1 Working Trace Manager
	7.12.2 Working Trace Property
	7.12.3 Specify the Start Point and End Point


	8 Tool Functions
	8.1 Position Panel
	Pulse
	Joint
	Robot
	Base
	Tool
	User
	Work
	8.1.1 Work Frame Setting
	8.1.2 Fix TCP
	8.1.3 Robot Position Configuration

	8.2 I/O Monitor
	8.2.1 Dedicated and General I/O
	8.2.2 Expanded Digital I/O
	8.2.3 Analog I/O (EW Board)
	JANCD-XEW01-1
	JANCD-XEW01-2
	JANCD-XEW02

	8.2.4 Inputs and Outputs
	DX200, DX100, NX100
	FS100


	8.3 I/O Events
	8.3.1 I/O Event Manager
	8.3.2 I/O Event Property

	8.4 I/O connection
	8.4.1 Management of I/O connection
	8.4.2 I/O Connection setting
	PLC setting


	8.5 Variable Monitor
	8.6 Lap Time Panel
	8.7 Stage Master
	8.8 Pulse Recorder
	8.9 Teaching
	8.9.1 OLP
	OLP Function Pick Method and Display
	Selecting [Position] in the "Move Mode" section: (Other items set at default)
	Selecting [Position] and [Orientation] in the "Move Mode" section: (Other items set at default)
	Selecting "Move to External Reference Point"
	Selecting [CurModel] in the "Operation Object" section

	8.9.2 Operation Handle
	Grid Settings
	Display Settings
	Handle Display
	Each Axis Operation
	TCP Handle
	Elbow Handle
	OLP Drag
	Model Handle

	8.9.3 Visual Path Edit Function
	RESTRICTION
	Setting
	Show/Hide the Visual Path
	Edit the Teaching Position
	Edit the contents of instruction
	Right-button menu


	8.10 Collision Detection
	8.10.1 Collision Detection Dialog
	8.10.2 Collision Model Group Setting
	Collision Model Group Display
	Auto-registration of the collision model group
	Collision Model Group Detail Display

	8.10.3 Collision Definition Setting
	Collision Definition Dialog


	8.11 Sensing Option Setting
	8.12 Spray Model for Paint
	8.13 Speed Graph Function
	8.13.1 Basic usage
	8.13.2 Trace Settings
	8.13.3 Graph Settings
	Graph Settings Dialog
	I/O Signal Setting Dialog

	8.13.4 Playback
	8.13.5 Graph Operations
	Graph Data Copy


	8.14 Running an External Software
	8.15 Job Browser
	When starting Job Browser for the first time
	Main Window
	Sub Window
	Right-click menu
	Job Tree Tab
	Search Tab
	Bookmark Tab

	8.16 Model Library
	8.16.1 Introduction
	8.16.2 Model Import (Work Type)
	8.16.3 Model Import (Tool Type)
	8.16.4 Add the model to the model library
	8.16.5 Edit Model of Model Library
	8.16.6 Delete Model of Model Library
	8.16.7 Export the Model of Model Library to Other PC

	8.17 Simple PP
	Main Display
	Right-button menu
	8.17.1 Job Select
	8.17.2 Job Create
	8.17.3 Job Copy
	8.17.4 Job Delete
	8.17.5 Search
	8.17.6 Job Edit
	8.17.7 Replace Inform
	8.17.8 Teaching with Operation Handle
	8.17.9 Book Mark

	8.18 JobPad
	Main Window
	Job Create
	Select Job
	Find
	Replace
	Error String
	Input Support
	Setting


	9 Online Function
	9.1 Automatic Construction
	9.1.1 Create a New VRC Controller (Network)

	9.2 Network Function
	9.3 Monitor Function
	9.3.1 Connect
	9.3.2 Disconnect

	9.4 File Manager
	9.4.1 File Manager Dialog
	Menu
	Tool Button
	Right-button Click Menu

	9.4.2 Option
	9.4.3 Connect to a Real Controller
	9.4.4 File Open
	9.4.5 File Compare
	9.4.6 File Copy


	10 Debug Function
	10.1 Change to Debug Mode
	10.2 Set/Release the break point
	10.3 BreakPoint List
	10.4 Job Stack
	10.5 Debug Monitor
	10.5.1 Insert Monitoring Data

	10.6 Operation in Break
	10.6.1 Execution
	10.6.2 Step Over
	10.6.3 Step In
	10.6.4 Step Out


	11 Model Editing
	11.1 Cad Tree
	11.1.1 Outline of the Cad Tree
	11.1.2 Tree Structure
	11.1.3 Opacity Settings
	11.1.4 Teacher
	11.1.5 Mouse-Driven Model Editing
	Right Mouse Button Operation

	11.1.6 Position Input Area
	11.1.7 Layout function

	11.2 Creating a New Model
	Creating a Model from an Existing Model
	Creating a Dummy Model

	11.3 Editing a Part
	11.3.1 Displaying the File Data Editing Dialog Box
	11.3.2 Registering a Part
	11.3.3 Part Types
	BOX
	BOX2
	CYLINDER
	CONE2
	SPHERE
	PIPE2
	AXIS6
	LINE
	LINE2
	CUBE
	FLOOR
	FACE
	“Teacher” Section of the Parts Editing Dialog Box


	11.4 Editing a Model
	Cut
	Copy
	Paste
	Delete
	Add
	Rename
	Property

	11.5 Positioning a Model
	11.6 Editing Multiple Models (Model List)
	11.7 Searching a Model
	11.8 Saving and Reading a Model Group
	Saving a Model Group
	Reading a Model Group
	Syntax of the ModelInfo.dat

	11.9 Changing and Moving the Parent Model
	11.9.1 Changing the Parent Model
	11.9.2 Moving the Parent Model

	11.10 Changing a Model File
	11.11 Reading a Model
	11.12 Model Script
	11.12.1 Model Script Editor
	11.12.2 Model Commands
	Starting Time of Each Command in Model Script

	11.12.3 Display of script input assistance
	11.12.4 Execute Model Script while playback

	11.13 Reduce HSF File
	11.14 CAD Data Import <CadPack Option>
	CAD Data Import

	11.15 Changing the Coordinate Origin of CAD Data <CADPack Option>
	11.16 CAD Data Export
	Export


	12 Configuration Settings
	12.1 Graphical Settings
	12.1.1 Background Color
	12.1.2 Smooth Transition
	12.1.3 Display
	12.1.4 Shadow
	12.1.5 Frame & AXIS6
	12.1.6 Level of Detail
	Generating the Level of Detail Data


	12.2 Markup Settings
	12.3 Robot Option Settings
	12.4 Language and Unit Settings
	12.5 Performance Settings
	12.6 Mouse Customization
	12.7 CAD Import/Export <CadPack Option>
	12.7.1 CAD Import
	12.7.2 IGES/SAT Export

	12.8 Show Teach Point <CadPack Option>

	13 Applied Operation
	13.1 Teaching Using OLP Function
	What is OLP Function?
	13.1.1 Teaching Operation Setup
	13.1.2 Position Designation in Free Mode
	13.1.3 Position Designation in Vertex Mode
	13.1.4 Position Designation in Center Mode
	13.1.5 Position Designation in Edge Mode
	13.1.6 Designation with Orientation Mode
	Designation with Z-Axis Mode

	13.1.7 Pick Object Filter
	13.1.8 Changing of Operation Object
	13.1.9 Move to External Reference Point
	13.1.10 Synchronous Base Axis Move to Target Point
	Robot with Single Servotrack
	Robot with Multiple Servotracks

	13.1.11 Position Designation with move slave function

	13.2 Trace Function
	13.2.1 Changing Trace Object
	13.2.2 Changing Trace Parent

	13.3 Collision Detection Setting
	Collision model group registration
	Collision definition registration
	Start collision detection

	13.4 Adding I/O Board Module
	13.4.1 Adding I/O Board Module (DX200, DX100, NX100).
	13.4.2 Adding I/O Board Module (FS100).

	13.5 Option Function Setting
	13.6 Dual-Arm robot Setting
	13.6.1 Dual-Arm robot Setting (DX100)
	13.6.2 Dual-Arm robot Setting (FS100)
	13.6.3 Dual-Arm robot Setting (NX100)

	13.7 External Axes Setting (Motor Gun)
	13.7.1 Initialization
	13.7.2 Model setup and motion

	13.8 Setting of spot welding simulation
	13.8.1 Initialize
	13.8.2 Setting of welded condition
	13.8.3 Setting of welding machine
	13.8.4 Making and control group setting of job
	13.8.5 Setting of simulation of electric gun

	13.9 Setting of Conveyor Synchronization
	13.9.1 Overview Flowchart
	13.9.2 System Construction
	Controller Initialization
	Setting of the option board (DX200, DX100, NX100)
	Setting of the I/O module (FS100)
	Setting of the file of the conveyor
	Conveyor registration
	Setting of the conveyor synchronization
	Location of the conveyor
	Creating and locating the works

	13.9.3 Teaching
	Operating the conveyor
	Teaching the conveyor synchronized move instructions (SYSTART, SYEND, SYMOV*)

	13.9.4 Playback
	Playback of the job with conveyor synchronization


	13.10 High-Speed Picking Simulation Function
	13.10.1 Overview Flowchart
	Creating a new cell from the template
	Location of the conveyors
	Setting the size and speed of the conveyors
	Location of the works
	Location of the pallets
	Playback

	13.10.2 Advanced Setting
	Location of the works
	Location of the pallets
	Changing the timing of stream
	Hand control signal setting

	13.10.3 High-Speed Picking Simulation for Multiple Controllers
	Sample
	Creating a new cell from the template
	Adding the robot
	Setting the conveyor synchronization
	Distributing the work
	Setting the I/O Event
	Playback

	13.10.4 Advanced Setting for Multiple Controllers
	Distributing the work
	Changing the position of the limit switch

	13.10.5 Specifications of template cell "MPP3S_PICKING"
	Job for high-speed picking simulation
	Variable allocation list
	IO allocation list


	13.11 Converting a MotoSim EG cell to MotoSim EG-VRC
	13.12 Spot High Speed Spec Function
	13.13 Setting of Paint workpiece supplying system "MOTOFEEDER"
	13.13.1 Controller Initialization
	13.13.2 MOTOFEEDER model setting
	13.13.3 Relocation of robot and MOTOFEEDER
	With Manipulator Specification
	Without Manipulator Specification

	13.13.4 Master job Registration
	13.13.5 Paint job creating and registering
	Without Spindle Unit Specification
	With Spindle Unit Specification

	13.13.6 Playback the paint job

	13.14 3DPDF Output Function
	RESTRICTION
	13.14.1 Output Setting
	13.14.2 Outputting 3DPDF
	13.14.3 Display and Operation of 3DPDF
	NOTE


	13.15 AVI Output Function
	13.15.1 Output Setting
	13.15.2 Outputting AVI

	13.16 Working Trace Function
	13.16.1 Changing Trace Object


	14 Options
	14.1 Motor Load Estimate
	Duty calculation
	Step Search
	Torque Threshold Setting
	Graph Setting
	Target robots for Moter Load Estimate

	14.2 Life Estimate
	Target robots of Life Estimate


	15 Appendix
	15.1 Data Format
	Model File (*.mdl)
	Cell File

	15.2 Reading the CAD Data with MotoSim EG-VRC
	15.3 Storage Card
	15.3.1 Folder Structure
	15.3.2 Save controller data created with MotoSim EG-VRC
	15.3.3 Load controller data to MotoSim EG-VRC

	15.4 Standard function about DX200
	15.5 Standard function about DX100
	15.6 List of Function depending on the system version of controller
	DX200
	DX100
	FS100
	NX100

	15.7 List of Manipulator Models and Offset Values Supported by MotoSim EG-VRC
	DX200
	DX100
	FS100
	NX100
	MOTOPOS
	MOTOFEEDER

	15.8 Frequently-Asked Questions
	When the driver has been installed with USB type key connected to a personal computer
	When a older version key driver has been installed over a newer key driver version.
	Cell file containing HSF files don't display properly
	MotoSim EG Cell file compatibility
	MotoSim EG-VRC - CadPack Cell file compatibility
	Graphic Driver Concerns
	Backup VRC.BIN file
	Recovery method when an alarm occurs during the creation of a new controller.
	Trouble shooting when virtual pendant doesn't accept operation after newly making controller (Nothing is displayed on the screen).
	Caution on setting up two or more 4-axis robots (ex. MPL300) to the one controller
	Way to make the display speed faster
	Solution in case characters is missing from the screen of MotoSimEG-VRC in Windows7
	Docking Window
	Quick Access Toolbar
	Comparison Table with the New Menu from the Old Menu and the Old Tool Bar





